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Matrox License Agreement, Warranty, and Service

A. Matrox software license agreement for single-user products
By installing the software, you, the original purchaser, indicate your acceptance of these terms. If you do not 
agree to the terms of this agreement, please return your Matrox product to your Matrox representative.

This Matrox software, any included sample images and other files (the “Software”), is copyrighted by Matrox 
Electronic Systems Ltd. All rights are reserved. You are granted a license to use the Software only, subject to the 
following restrictions and limitations:

1 The license is to you the original purchaser only, and is not transferable without written permission of Matrox.

2 You may install the Software on an unlimited number of computers owned or leased by you in any location. 
However, you must use the Software on a single computer owned or leased by you at a time in conjunction for 
the purpose of operating the Matrox hardware. 

3 For the purposes of clarity, notwithstanding the fact that you may install the Software on more than one 
computer owned or leased by you, you may not use the Software on more than a single machine at a time, 
even if you own or lease more than one machine, without the express written consent of Matrox.

4 You may make back-up copies of the Software for your own use only, subject to the use limitations of this 
license.

5 You may not engage in, nor permit third parties to engage in, any of the following:

a Providing or disclosing the Software to third parties.
b Providing use of the Software in a computer service business, network, time-sharing, multiple CPU, or 

multi user arrangement to users who are not individually licensed by Matrox.
c Making alterations or copies of any kind in the Software (except as specifically permitted above).
d Attempting to disassemble, decompile, or reverse-engineer the Software in any way.
e Granting sublicenses, leases, or other rights in the Software to others.
f Making copies, or verbal or media translations of the user's guide.

g Making telecommunication data transmissions of the Software.

Matrox reserves the right to terminate this license without prejudice to any additional recourses Matrox may have 
against you if you violate any of its terms and conditions.

B. Software limited warranty
MATROX WARRANTS TO YOU, THE ORIGINAL PURCHASER, WHO PROVIDES AN ADEQUATE 
PROOF OF PURCHASE, THAT THE MEDIA ON WHICH THE SOFTWARE IS RECORDED IS FREE 
FROM DEFECTS IN MATERIALS AND WORKMANSHIP UNDER NORMAL USE, AND THAT THE 
SOFTWARE WILL PERFORM SUBSTANTIALLY AS DESCRIBED IN THE RELATED 
DOCUMENTATION PROVIDED BY MATROX FOR A PERIOD OF NINETY (90) DAYS FROM THE DATE 
OF PURCHASE. 

MATROX PROVIDES YOU THE SOFTWARE AND RELATED DOCUMENTATION ON AN “AS IS” BASIS 
WITHOUT ANY WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT 
NOT LIMITED TO ANY IMPLIED WARRANTY OF MERCHANTABILITY, NON-INFRINGEMENT OR 
FITNESS FOR A PARTICULAR PURPOSE AS WELL AS THE WARRANTY AGAINST HIDDEN OR 
LATENT DEFECTS, ALL OF WHICH MATROX SPECIFICALLY DISCLAIMS (AND YOU, THE 
ORIGINAL PURCHASER, BY ACCEPTING THE PRODUCT, SPECIFICALLY ACCEPTS SUCH 
DISCLAIMER AND WAIVER) TO THE MAXIMUM EXTENT PERMITTED BY LAW. THE ENTIRE RISK 
AS TO THE RESULTS AND PERFORMANCE OF THE SOFTWARE IS ASSUMED BY YOU. SHOULD 
THE SOFTWARE PROVE DEFECTIVE, YOU (AND NOT MATROX, ITS DISTRIBUTORS OR DEALERS) 
ASSUME THE ENTIRE COST OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

MATROX DOES NOT WARRANT THAT THE OPERATION OF THE SOFTWARE WILL BE 
UNINTERRUPTED OR ERROR-FREE, THAT DEFECTS IN THE SOFTWARE WILL BE CORRECTED, OR 
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THAT THE SOFTWARE WILL MEET YOUR REQUIREMENTS OR PERFORM WITH ANY 
HARDWARE OR SOFTWARE PROVIDED BY THIRD PARTIES.

C. End-user registration
Before using your Matrox product, please take a moment to register your product in the Matrox Support 
section of our website at www.matrox.com/video/support. The information you provide will assist Matrox 
to quickly diagnose and correct any problem that might arise when using the product. Only registered end 
users are entitled to customer support.

D. Hardware limited warranty
MATROX WARRANTS TO YOU, THE ORIGINAL PURCHASER, WHO PROVIDES AN ADEQUATE 
PROOF OF PURCHASE, THAT THE MATROX HARDWARE PRODUCTS WILL BE FREE FROM 
FACTORY DEFECTS FOR A PERIOD OF THREE (3) YEARS FROM THE DATE OF PURCHASE. 
MATROX WILL REPAIR OR REPLACE, AT THE CHOICE OF MATROX, THE MATROX 
HARDWARE PRODUCTS WHICH PROVE TO BE DEFECTIVE DURING THE WARRANTY 
PERIOD, PROVIDED THAT THEY ARE RETURNED TO MATROX, SUBJECT TO THE 
FOLLOWING LIMITATIONS:

Matrox's limited warranty covers only those defects which arise as a result of normal use of the hardware 
and does not apply to any:

$ improper or inadequate maintenance;

$ incompatibilities due to the user's hardware or software applications with or in which the Matrox 
product interfaces;

$ product of a special or custom-made nature;

$ unauthorized modification or misuse;

$ improper installation, misapplication or negligence;

$ operation outside the product's environmental specifications;

$ improper site preparation or maintenance;

$ software;

$ other causes that do not relate to a product defect;

$ defects or damage suffered as a result of force majeure (including theft);

$ defects or damage suffered as a result of normal wear and tear, and/or

$ stolen goods.

If Matrox receives from you, during the applicable warranty period notice of a defect in a warranted 
hardware product and the defective Matrox product in question, Matrox shall at its sole option, either repair 
or replace the product, and shall return the repaired product or a replacement product within a reasonable 
delay. The replacement product may not be new, provided that it has functionality at least equal to that of 
the product being replaced. This warranty is valid in any country where Matrox hardware products are 
distributed by Matrox or its authorized dealers.

This limited warranty statement gives you specific legal rights. You may also have other rights which vary 
from state to state in the United States, from province to province in Canada, and from country to country 
elsewhere in the world. 

E. Limitations of warranty
EXCEPT FOR THE SOFTWARE LIMITED WARRANTY AND HARDWARE LIMITED WARRANTY 
STATEMENTS, NEITHER MATROX NOR ANY OF ITS THIRD PARTY SUPPLIERS MAKES ANY 
OTHER WARRANTY OF ANY KIND, WHETHER EXPRESSED OR IMPLIED, WITH RESPECT TO 
MATROX PRODUCTS. MATROX SPECIFICALLY DISCLAIMS (AND YOU, BY ACCEPTING THE 
MATROX PRODUCT, SPECIFICALLY ACCEPTS SUCH DISCLAIMER AND WAIVES) ALL OTHER 
ox License Agreement, Warranty, and Service 
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WARRANTIES, EITHER EXPRESSED OR IMPLIED, INCLUDING BUT NOT LIMITED TO THE IMPLIED 
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR OR INTENDED 
PURPOSE OR USE AND THE WARRANTY AGAINST LATENT DEFECTS, WITH RESPECT TO THE 
HARDWARE AND/OR SOFTWARE. MATROX FURTHER DISCLAIMS ANY WARRANTY THAT 
MATROX PRODUCTS, IN WHOLE OR IN PART, WILL BE FREE FROM INFRINGEMENT OF ANY 
THIRD PARTY INTELLECTUAL PROPERTY OR PROPRIETARY RIGHTS.

TO THE EXTENT THAT THESE LIMITED WARRANTY STATEMENTS ARE INCONSISTENT WITH 
THE LAW OF THE LOCALITY WHERE YOU PURCHASED THE MATROX PRODUCT, THESE LIMITED 
WARRANTY STATEMENTS SHALL BE DEEMED MODIFIED TO BE CONSISTENT WITH SUCH 
LOCAL LAW. UNDER SUCH LOCAL LAW, CERTAIN LIMITATIONS OF THESE LIMITED WARRANTY 
STATEMENTS MAY NOT APPLY TO YOU.

TO THE EXTENT ALLOWED BY LOCAL LAW, THE REMEDIES PROVIDED IN THESE LIMITED 
WARRANTY STATEMENTS ARE YOUR SOLE AND EXCLUSIVE REMEDIES.

F. Limitations of liability
EXCEPT FOR THE OBLIGATIONS SPECIFICALLY SET FORTH IN THE SOFTWARE LIMITED 
WARRANTY AND HARDWARE LIMITED WARRANTY STATEMENTS, IN NO EVENT SHALL 
MATROX BE LIABLE FOR ANY DIRECT, INDIRECT, SPECIAL, INCIDENTAL, CONSEQUENTIAL, 
FORESEEABLE OR UNFORESEEABLE, OR PUNITIVE DAMAGES, WHETHER BASED ON 
CONTRACT, TORT, DELICT OR ANY OTHER LEGAL THEORY AND WHETHER ADVISED OF THE 
POSSIBILITY OF SUCH DAMAGES, AND/OR DAMAGES ARISING FROM THE LOSS OF USE, DATA, 
PRODUCTION REVENUE AND/OR PROFIT OF IN CONNECTION WITH THE MATROX PRODUCT OR 
ANY BUSINESS INTERRUPTION. WITHOUT PREJUDICE TO THE FOREGOING, ANY LIABILITY OF 
MATROX FOR ANY BREACH OF WARRANTY SHALL BE LIMITED TO THE AMOUNT PAID BY YOU 
FOR THE DEFECTIVE HARDWARE IN QUESTION.

TO THE EXTENT ALLOWED BY LOCAL LAW, MATROX'S ENTIRE LIABILITY AND YOUR 
EXCLUSIVE REMEDY SHALL BE THE REPAIR OR REPLACEMENT OF ANY DEFECTIVE PRODUCT 
DURING THE WARRANTY PERIOD. MATROX DOES NOT OFFER ANY OTHER WARRANTY WITH 
RESPECT TO MATROX HARDWARE OR SOFTWARE OR ANY OTHER HARDWARE OR SOFTWARE.

YOU SHALL BE RESPONSIBLE FOR ALL APPLICABLE TAXES, DUTIES AND CUSTOMS FEES ON 
ANY REPLACEMENT UNIT, AS WELL AS ALL TRANSPORT, INSURANCE, STORAGE AND OTHER 
CHARGES INCURRED ON ALL RETURNED PRODUCTS.

G. Indemnification disclaimer
Matrox disclaims and shall have no obligation to indemnify or defend you or any third party in respect of any 
actual or alleged infringement of any actual or pending patents, copyright or other intellectual property rights. 
Matrox shall have no liability arising out of any such actual or alleged intellectual property infringement.

MATROX SPECIFICALLY MAKES NO REPRESENTATION AND DISCLAIMS ALL EXPRESS OR 
IMPLIED WARRANTIES OF MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE AND 
NONINFRINGEMENT.

H. Unauthorized use
THE MATROX LICENSED SOFTWARE AND ANY DOCUMENTATION RELATED THERETO ARE NOT 
DESIGNED, INTENDED, OR AUTHORIZED FOR USE IN ANY TYPE OF SYSTEM OR APPLICATION IN 
WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD CREATE A SITUATION WHERE 
PERSONAL INJURY OR DEATH MAY OCCUR (E.G., MEDICAL SYSTEMS, LIFE SUSTAINING OR LIFE 
SAVING SYSTEMS). Should the LICENSEE license or use the Matrox Licensed Software for any such 
unintended or unauthorized use, the Licensee shall indemnify and hold Matrox and its officers, subsidiaries and 
affiliates harmless against all claims, costs, damages, and expenses, and reasonable attorney fees arising out of, 
directly or indirectly, any claim of product liability, personal injury or death associated with such unintended or 
Matrox License Agreement, Warranty, and Service
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unauthorized use, even if such claim alleges that Matrox was negligent regarding the design or manufacture 
of the Licensed Software.

I. Choice of law
This Agreement shall be governed by and interpreted in accordance with the laws of the Province of 
Quebec, excluding any conflict of laws provisions. All disputes arising out of this Agreement shall be 
subject to the exclusive jurisdiction of the courts of the Province of Quebec, district of Montreal, and the 
parties agree and submit to the personal and exclusive jurisdiction and venue of these Courts.

J. Procedure for returning goods
No returned goods, for service or otherwise, will be accepted without prior authorization from Matrox. To 
obtain return authorization, contact Matrox Customer Support (see the contact information at 
www.matrox.com/video/support). Once approved, Matrox will contact you with your Returned 
Merchandise Authorization (RMA) number. Matrox cannot be responsible for units returned without an 
RMA number. Matrox will advise you of the shipping address. The packaging must indicate the RMA 
number on the outside. It is strongly recommended that a copy of the original packing slip which states the 
serial number of the items you're returning be included with the returned merchandise. This will speed up 
processing.

Each individual, returned unit or group of units MUST have an RMA number issued by Matrox. Matrox 
must authorize the number of units grouped under one RMA number. Any units received without prior 
approval by Matrox will be returned to you freight collect.

You shall be responsible for the cost of consolidated freight (one way only) for warranty units from your 
location to the location designated by Matrox. Once repaired, Matrox will incur the cost of consolidated 
freight for warranty units to your location.
ox License Agreement, Warranty, and Service 

http://www.matrox.com/video/support


v

Matrox End-user VFW Software Codec License Agreement (“Agreement”)

IMPORTANT - PLEASE READ THIS LICENSE AGREEMENT CAREFULLY BEFORE INSTALLING, 
COPYING OR USING THE SOFTWARE. THIS IS A LEGAL AGREEMENT BETWEEN YOU THE END USER 
(“END USER”) AND MATROX ELECTRONIC SYSTEMS LTD. (“MATROX”) CONCERNING THE MATROX 
VIDEO FOR WINDOWS SOFTWARE CODEC PACKAGE (COLLECTIVELY, THE “SOFTWARE”) WHICH END 
USER WISHES TO USE FOR PERSONAL USE. END USER ACKNOWLEDGES AND AGREES THAT IT WILL 
BE LEGALLY BOUND BY THE TERMS OF THIS AGREEMENT. 

Supported formats: DV/DVCAM, DVCPRO, DVCPRO50, DVCPRO HD, MPEG-2 I-frame SD, MPEG-2 I-frame 
HD (includes 720p, full-size 1080i/p, and 1440x1080i/p), MPEG-2 I-frame SD + Alpha, MPEG-2 I-frame HD + 
Alpha, Offline HD, HDV and EZ-HDV (playback only), Uncompressed 8-bit and 10-bit SD, Uncompressed 8-bit and 
10-bit HD, Uncompressed 8-bit and 10-bit SD + Alpha, Uncompressed 8-bit and 10-bit HD + Alpha, EZ-MXF 
(playback only), and Motion-JPEG (playback only).

1. License
Matrox hereby grants the End User a non-exclusive, non-transferable, royalty-free, right to use and copy in 
object code form the Software for internal purposes in conjunction with a Matrox product only (the “Purpose”), 
subject to the terms and conditions of this Agreement. End user shall only use the Software on a single computer 
at a time. End User must maintain all copyright notices on all copies of the Software. Matrox may make changes 
to the Software at any time without prior notice. In addition, Matrox is under no obligation whatsoever to update, 
maintain, or provide new versions of the Software or to provide any support in connection with the Software.

2. Restrictions
End User agrees that it will not: (a) sell, rent, assign or transfer or grant a sublicense of the Software or the 
license contained herein to any other party; (b) adapt, alter, modify, prepare derivative works from, merge or 
transfer the Software; (c) break or attempt to break the protection algorithm, reverse engineer, reverse assemble, 
reverse compile or otherwise translate the Software or any portion thereof, even if permitted under any provision 
of any applicable laws; (d) use Matrox's name, logo or trademark to market its own products; (e) use, reproduce 
alter and redistribute the Software in whole or in part other than for the Purpose.

End User may not use the Software for any unlawful purpose, including infringement of the copyrights or other 
propriety rights of others, or in any illegal manner or for creation or distribution of unlawful content. End User 
agrees to indemnify Matrox for any and all claims arising from any violation by it of the terms of this License 
Agreement.

End User acknowledges that the Software is subject to export laws and agrees to comply with all applicable 
international and national laws that apply to these products.

3. Copyright and ownership
End User acknowledges and agrees that the Software and all associated documentation, including logos, names 
and other support materials furnished in this package are exclusively owned by Matrox and/or its suppliers. The 
Software codes, structure and organization are the valuable trade secrets of Matrox. The Software and all 
associated documentation are also protected by copyright laws and international copyright treaties, as well as 
other intellectual property laws and treaties. No title to the intellectual property in the Software, the 
documentation, magnetic/optical/solid-state media or any other material provided therewith is transferred to End 
User by this Agreement. This Agreement does not convey to End User an interest in or to the Software, but only 
a limited right to use the Software in accordance with the terms of this Agreement. The Software is licensed to 
End User and not sold.
Matrox End-user VFW Software Codec License Agreement (“Agreement”)
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4. Exclusion of warranty
MATROX PROVIDES TO END USER THE SOFTWARE AND RELATED DOCUMENTATION ON AN 
“AS IS” BASIS WITHOUT ANY WARRANTY OF ANY KIND, EITHER EXPRESSED OR IMPLIED 
INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTY OF MERCHANTABILITY, 
NON-INFRINGEMENT OR FITNESS FOR A PARTICULAR PURPOSE AS WELL AS THE 
WARRANTY AGAINST HIDDEN OR LATENT DEFECTS, ALL OF WHICH MATROX 
SPECIFICALLY DISCLAIMS (AND THE CUSTOMER BY ACCEPTING THE PRODUCT 
SPECIFICALLY ACCEPTS SUCH DISCLAIMER AND WAIVER) TO THE MAXIMUM EXTENT 
PERMITTED BY LAW. THE ENTIRE RISK AS TO THE RESULTS AND PERFORMANCE OF THE 
SOFTWARE IS ASSUMED BY END USER. SHOULD THE SOFTWARE PROVE DEFECTIVE, END 
USER (AND NOT MATROX, ITS DISTRIBUTORS OR DEALERS) ASSUMES THE ENTIRE COST 
OF ALL NECESSARY SERVICING, REPAIR OR CORRECTION.

MATROX DOES NOT WARRANT THAT THE SOFTWARE WILL MEET END USER'S 
REQUIREMENTS OR THAT IT'S OPERATION WILL BE ERROR-FREE.

MATROX HAS NO OBLIGATION TO INDEMNIFY, DEFEND OR HOLD END USER HARMLESS 
FROM AND AGAINST ANY CLAIM THAT ANY THIRD PARTY SOFTWARE INFRINGES ANY 
THIRD PARTY PATENT, COPYRIGHT, TRADEMARK OR OTHER INTELLECTUAL PROPERTY 
RIGHT. END USER WILL PROMPTLY NOTIFY MATROX IN WRITING OF ANY SUCH CLAIM. 

MATROX HAS NO OBLIGATION TO INDEMNIFY, DEFEND OR HOLD END USER HARMLESS 
FROM AND AGAINST ANY CLAIMS OF INFRINGEMENT OF INTELLECTUAL PROPERTY THAT 
READS UPON OR IS INFRINGED BY A GENERALLY RECOGNIZED AUDIO, VIDEO, 
TECHNOLOGY OR PATENT STANDARD OR RECOMMENDATIONS, INCLUDING WITHOUT 
LIMITATION AVC/H.264, IEEE 1394, JPEG, JPEG2000, MPEG-1, MPEG-2 AND MPEG-4.

5. Limitation of Liability
A) Each party as well as any of its officers, employees, suppliers, agents or subcontractors shall under no 
circumstance whatsoever and whether a claim is based on breach of contract or warranty, infringement or 
any other intellectual property claims, negligence, strict liability in tort or otherwise or arises under any 
other doctrine in law or equity, be liable to or have to indemnify the other party for:

(i) Indirect, special, incidental, punitive and consequential damages, whether foreseeable or 
unforeseeable, and even if advised of the possibility of such damages or losses;

(ii) Damages arising from loss of use, data, profits, production revenue, bargain, business, revenues, 
anticipated savings, opportunities, investment or loss or production, wasted expenditures, costs of 
substitute goods or services and generally any kind of economic, commercial and financial loss 
arising directly or indirectly out of or in connection with this Agreement, including without 
limitation all such damages and losses resulting from the use of the Software, any mistakes, errors, 
delays, defects, failures, defaults, interruptions or generally any acts or omissions, whether or not the 
party has been advised of the possibility of such damages or losses. The total and cumulative liability 
from one party to the other party arising from or in connection with this Agreement (whether 
liabilities arise from breach of contract or warranty, negligence, strict liability in tort or otherwise or 
under any other doctrine in law or equity) shall under no circumstance exceed the aggregate of all 
fees and payments actually received by Matrox from End User under this Agreement.

B) Matrox will have no obligations under this section or otherwise with respect to any infringement claim 
in whole or in part based upon any direct, contributory or other infringement related to the licensed 
Software, or the use thereof, with respect to (including conformance to) any standards promulgated, revised 
or maintained by a standards organization, standards bodies or similar private or public organization, 
including, without limitation, the various standards promulgated by the MPEG Licensing Authority, LLC 
(or MPEG LA). Matrox has no obligation to indemnify, defend or hold End User harmless from and against 
any claims of infringement of intellectual property that reads upon or is infringed by a generally recognized 
ox End-user VFW Software Codec License Agreement (“Agreement”) 
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audio, video, technology or patent standard or recommendations, including without limitation AVC/H.264, IEEE 
1394, JPEG, JPEG2000, MPEG-1, MPEG-2 and MPEG-4.

6. Confidentiality
Except as licensed hereunder, End User shall treat the Software and all related information as confidential 
information and refrain from making any such information or the Software itself available to any other person. 
End User will take commercially reasonable precautions to safeguard the confidentiality of the Software, 
including those taken by End User to protect its own trade secrets. The obligation of confidentiality shall not 
apply or shall cease to apply to any information that (a) was known to End User independently of its receipt 
hereunder; (b) is or becomes publicly available without breach of this Agreement; or (c) is disclosed by End User 
pursuant to court order or other requirement imposed by law, provided that Matrox is given a reasonable 
opportunity to object to or restrict such disclosure requirement to the extent practicable, and then such disclosure 
shall be permitted only subject to the terms and conditions of such order or other legal requirement.

7. Termination
This Agreement is effective until terminated. End User may terminate this Agreement at any time by destroying 
all copies of the Software and related materials. This Agreement is conditioned upon End User's continued 
compliance with the Agreement and will terminate automatically and irrevocably if End User fails to comply 
with any material term or condition of this Agreement. Matrox will provide written notice to End User of such 
termination in advance where practical, or otherwise promptly following such termination. Such termination is 
without prejudice to Matrox's other rights hereunder at law or in equity. In event of termination, End User must 
destroy all copies of the Software and related materials and certify in writing and under oath that all such copies 
have been destroyed, and End User's license and rights under this Agreement shall terminate. In the event of 
termination of this Agreement, the provisions of Sections 2, 3, 4, 6, 7, 8 and 10 shall survive and will remain in 
full force and effect.

8. General
8.1 Matrox shall not be liable for delay or failure in performance resulting from acts beyond its reasonable 
control, including but not limited to acts of God, acts of war, terrorism, riot, fire, flood, or other disaster, acts of 
government, strike, lockout, communication line or power failure.

8.2 End User shall not have the right to assign the benefit of this Agreement without the prior written permission 
from Matrox and then only under such conditions as Matrox may reasonably determine.

8.3 If any provision of this Agreement is declared by a body of competent jurisdiction to be invalid, such 
provision shall be severed from this Agreement and the other provisions shall remain in full force and effect.

8.4 A term or condition of this Agreement can be waived or modified only with the written consent of both 
parties. Forbearance or indulgence by either party in any regard shall not constitute a waiver of the term or 
condition to be performed, and either party may invoke any remedy available under this Agreement or by law 
despite such forbearance or indulgence.

8.5 The relationship between Matrox and you is that of an independent contractor and its customer and under no 
circumstances shall either party, its agents or employees be deemed agents or representatives of the other party. 
Neither party shall have the right to enter into any contracts or commitments in the name of or on behalf of the 
other party in any respect whatsoever. In addition, neither party shall hold itself out to anyone, or otherwise 
represent, that it has any such authority vis-a-vis the other party.

Both parties agree to comply with all applicable laws, rules, regulations, orders and ordinances of the state, 
province and/or country where it resides and in any other state, province and/or country with jurisdiction over it 
or its activities in performance of its obligations hereunder, including without limitation all applicable duty, 
taxes, import and/or export regulations and all licensing or permit requirements.

8.6 This Agreement and any schedule attached hereto contains the complete and exclusive statement of the 
agreement between the parties and supersedes all prior and contemporaneous agreements, including, but not 
Matrox End-user VFW Software Codec License Agreement (“Agreement”)
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limited to, understandings, proposals, negotiations, representations or warranties of any kind whether oral 
or written with respect to the subject matter hereof. No oral or written representation which is not expressly 
contained in this Agreement is binding on Matrox or End User.

8.7 This Agreement will be governed by and construed in accordance with the laws of the Province of 
Quebec. The United Nations Convention on Contracts for the International Sale of Goods shall not apply to 
this Agreement.

9. Unauthorized use
THE MATROX LICENSED SOFTWARE AND ANY DOCUMENTATION RELATED THERETO ARE 
NOT DESIGNED, INTENDED, OR AUTHORIZED FOR USE IN ANY TYPE OF SYSTEM OR 
APPLICATION IN WHICH THE FAILURE OF THE LICENSED SOFTWARE COULD CREATE A 
SITUATION WHERE PERSONAL INJURY OR DEATH MAY OCCUR (E.G., MEDICAL SYSTEMS, 
LIFE SUSTAINING OR LIFE SAVING SYSTEMS). Should the LICENSEE license or use the Matrox 
Licensed Software for any such unintended or unauthorized use, the Licensee shall indemnify and hold 
Matrox and its officers, subsidiaries and affiliates harmless against all claims, costs, damages, and 
expenses, and reasonable attorney fees arising out of, directly or indirectly, any claim of product liability, 
personal injury or death associated with such unintended or unauthorized use, even if such claim alleges 
that Matrox was negligent regarding the design or manufacture of the Licensed Software.

10. Choice of law
This Agreement shall be governed by and interpreted in accordance with the laws of the Province of 
Quebec, excluding any conflict of laws provisions. All disputes arising out of this Agreement shall be 
subject to the exclusive jurisdiction of the courts of the Province of Quebec, district of Montreal, and the 
parties agree and submit to the personal and exclusive jurisdiction and venue of these Courts.
ox End-user VFW Software Codec License Agreement (“Agreement”) 
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Introducing Matrox MXO2

This chapter lists the MXO2 
system requirements, explains 
the battery requirements and 
guidelines, and describes the 
MXO2 documentation.
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Welcome to Matrox MXO2
Matrox MXO2 products connect to your desktop computer or laptop to provide 
broadcast-quality video input/output, monitoring, and up/down/cross conversion. 
MXO2 streamlines your workflow with supported video editing applications, and 
provides WYSIWYG output when working with many popular compositing and 
animation programs. You also get HDMI video monitoring with calibration 
controls.

Matrox MXO2 products with Matrox MAX technology have a dedicated 
hardware processor that accelerates the encoding of H.264 files for resolutions 
ranging from iPod to HD. This lets you quickly and easily create H.264 files for 
Blu-ray Disc, the web, and mobile devices.

Matrox MXO2 system requirements
Matrox MXO2 products require a computer system with the following 
configuration:

• A computer that supports Streaming SIMD Extensions 2 (SSE2), such as an 
Intel Pentium 4 or AMD Athlon 64 or later.

• Dual-CPU, or one dual-core CPU.

• Microsoft Windows 7 Professional, Ultimate, or Home Premium (64-bit) 
with Service Pack 1.

• 4 GB of RAM.

• One free PCIe slot on a desktop computer to install the Matrox PCIe host 
adapter, or one free ExpressCard/34 slot on a laptop to install the Matrox 
PCIe host ExpressCard/34 adapter.

• We recommend an HDMI monitor that supports the following:

$ An HDMI input resolution of 1920×1080 for previewing all HD formats.

$ 1:1 pixel mapping for displaying your MXO2 output at its exact 
resolution, and for use with the Matrox HDMI Calibration Utility.

Supported programs
• Adobe Premiere Pro 5.5.2, Adobe Media Encoder 5.5.1, Encore 5.1, After 

Effects 10.5, Photoshop 12.1, and Flash Media Live Encoder 3.2.

• Avid Media Composer 6.0.1.

• Autodesk 3ds Max 2009 and Combustion 2008 (32-bit only).

• eyeon Fusion 6.1.

• NewTek LightWave 3D 10.

• Microsoft Expression Encoder 4.
pter 1, Introducing Matrox MXO2
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Check our website for equipment information
For up-to-date information about system requirements and MXO2-compatible 
devices, check the Matrox MXO2 Support section of our website at 
www.matrox.com/video/support.

¡ Important To use Matrox MXO2 with Avid editing software, you must use an 
Avid-certified system as listed in the System Recommendations section of the 
Matrox MXO2 Support section of our website at 
www.matrox.com/video/support.

Battery requirements and guidelines for MXO2
¦ Note This section does not apply to Matrox MXO2 Rack and Matrox MXO2 

Mini as they cannot be powered by a battery.

As an alternative to using an AC outlet, you can use a battery to power Matrox 
MXO2 or MXO2 LE. To avoid damage to your MXO2 system and peripheral 
devices when using a battery, please observe the following requirements and 
guidelines. For instructions on how to connect a battery, see “Powering MXO2” 
on page 14 or “Powering MXO2 LE” on page 32.

• Use a standard self-protected (fused) battery with a nominal voltage of 12V, 
13.2V, or 14.4V. A higher-voltage battery will damage your MXO2 system.

• Disconnect MXO2 from the battery when not in use. Do not leave MXO2 
connected to the battery when not in use as this may damage your MXO2 
system and/or battery.

• Do not power your MXO2 using your vehicle’s battery via the power socket.

²Caution To avoid damage to your MXO2 system and peripheral devices, use a 
Matrox-recommended battery. For a list of batteries recommended for use with 
your MXO2, visit the Matrox MXO2 Support section of our website at 
www.matrox.com/video/support.

About this manual
This manual provides you with information about installing and using your 
Matrox MXO2 hardware and software.

Style conventions
The following style conventions are used in this manual:

• The names of files, folders, and manuals appear in italics. For example:

$ The data is stored in the Sample.wav file.

$ The file is located in your C:\Windows\System folder.

$ Please refer to your Matrox MXO2 Release Notes.
Battery requirements and guidelines for MXO2
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• Menus and commands that you need to choose are displayed in the form 
Menu > Command. For example, File > Save means click File in the 
menu bar, then click Save in the menu that appears.

• The names of keys are displayed in small capital bold letters, such as the 
CTRL key.

• A plus (+) sign is used to indicate combinations of keys and/or mouse 
operations. For example:

$ CTRL+C means to hold down the CTRL key while pressing the C key.

$ SHIFT+click means to hold down the SHIFT key while you click an item 
with the mouse.

How video formats are expressed
With the exception of NTSC and PAL, all SD and HD video formats are 
expressed in the Matrox MXO2 documentation as follows:

VRp or i or PsF @ n fps 

Where:

• VR is the vertical resolution. For 1440×1080 video, however, both the 
horizontal and vertical resolutions are specified.

• p or i or PsF represents progressive, interlaced, or progressive segmented 
frame video.

• n fps is the frame rate in frames per second.

Here are some examples:

• 480p @ 23.98 fps Represents 720×480 progressive video at 23.98 frames 
per second.

• 720p @ 59.94 fps Represents 1280×720 progressive video at 59.94 
frames per second.

• 1440x1080i @ 29.97 fps Represents 1440×1080 interlaced video at 29.97 
frames per second. This format is used for HDV 1080i material.

• 1080i @ 29.97 fps Represents full-size 1920×1080 interlaced video at 
29.97 frames per second.

Last-minute information
Any important information that wasn’t available for inclusion in this manual by 
publication time is provided to you in the Matrox MXO2 Release Notes.
pter 1, Introducing Matrox MXO2
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Installing Your Matrox MXO2

Hardware and Software
This chapter explains how to 
install the Matrox MXO2 
hardware and software.
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Before you install your Matrox MXO2 hardware
Read the following information carefully before attempting to install Matrox 
MXO2 hardware.

Start with a functioning system
Before attempting any Matrox MXO2 installation, you should have a computer 
with a supported Windows operating system fully installed and functioning 
smoothly. This will avoid potential problems later on.

Avoid costly damage
Static electricity from your body can damage your Matrox PCIe host adapter or 
your computer. Although you may not notice it, static electricity is generated 
every time you move. It’s often too small to cause a spark, but it can still cause 
damage to sensitive electronic components or at least reduce their lifespan.

To avoid damage, please observe the following precautions:

• Do not remove your Matrox PCIe host adapter from its antistatic bag until 
you’re ready to install it. Before removing the card, place the package within 
easy reach of the area where you intend to perform the installation.

• You should avoid touching the chips and other components on the circuit 
board. Try to handle the card by its edges.

• Try to work in an area where the relative humidity is at least 50%.

• Do not wear wool or synthetic clothing. These fabrics tend to generate more 
static electricity than cotton, which is best for this kind of work.

• Turn off the power switches on your computer and its connected 
components.

Once you’ve opened your computer, drain static electricity from your body by 
touching a bare metal surface on your computer chassis before you install or 
remove any parts of your system. If you have a grounding wrist strap, use it while 
handling and installing any components in your computer.

Installing your Matrox PCIe adapter
The Matrox PCIe adapter is the interface between your MXO2 and computer. 
Matrox provides dedicated adapters for use with desktop computers or laptops. 
Use the Matrox PCIe host adapter with your desktop computer, and the Matrox 
PCIe host ExpressCard/34 adapter with your laptop.
pter 2, Installing Your Matrox MXO2 Hardware and Software
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Installing your PCIe host adapter (for desktops)
The Matrox PCIe host adapter is designed to operate in your desktop computer’s 
PCIe slot. For detailed instructions on how to perform the following steps, refer 
to your computer’s documentation.

1 Shut down your system, unplug the power cord and all the cables from the 
unit, and open your computer’s chassis.

2 Insert the Matrox PCIe host adapter in an available PCIe slot in your 
computer, and secure the adapter into place.

3 Close your computer’s chassis, and reconnect the power cord and all the 
cables to the computer.

Installing and removing your PCIe host 
ExpressCard/34 adapter (for laptops)
The Matrox PCIe host ExpressCard/34 adapter is designed to operate in your 
laptop’s ExpressCard/34 slot. You must shut down your laptop before installing 
the Matrox PCIe host ExpressCard/34 adapter. To install the Matrox PCIe host 
ExpressCard/34 adapter, connect the Matrox PCIe cable to the host 
ExpressCard/34 adapter, and then insert the host adapter in your laptop’s 
ExpressCard/34 slot until the adapter clicks into place.

You must shut down your laptop before removing the Matrox PCIe host 
ExpressCard/34 adapter from your laptop’s ExpressCard/34 slot.

¡ Important Do not disconnect the PCIe cable from the Matrox PCIe host 
ExpressCard/34 adapter when your laptop is running.

ExpressCard/34 slot

Matrox PCIe 
ExpressCard/34 
adapterPCIe 

cable

²Caution To ensure functionality and avoid damaging the PCIe cable or 
host connector, the side labeled “B” on the PCIe cable connector must face 
the top of the Matrox PCIe ExpressCard/34 adapter.
Installing your Matrox PCIe adapter
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Installing Matrox Mtx.utils
Matrox Mtx.utils Setup installs the MXO2 device drivers, and all the software 
required to use your MXO2 hardware with supported programs. If you plan on 
using MXO2 with a supported video editing application, make sure that the 
application is installed before installing Matrox Mtx.utils. You should also install 
any third-party programs for which you want to install the Matrox WYSIWYG 
plug-ins, such as Adobe After Effects, Adobe Photoshop, and eyeon Fusion.

You can install Matrox Mtx.utils on a computer with or without the MXO2 
hardware connected. To download and install the latest version of Matrox 
Mtx.utils, visit the MXO2 Support section of our website at 
www.matrox.com/video/support. You can also contact your Matrox 
representative for the latest software.

Remarks
• Matrox Mtx.utils Setup installs software for Matrox MXO2 as well as the 

Matrox CompressHD card. You can therefore use your Matrox MXO2 
hardware with CompressHD. For details on using CompressHD, see your 
Matrox CompressHD Installation and User Guide.

• If you want to use a Matrox Convert DVI product with MXO2 on the same 
system, you must install Matrox MtxConvert.utils instead of Matrox 
Mtx.utils. Matrox MtxConvert.utils is available in the “Downloads” section 
of the Matrox Support website under “Combo Software” for your Convert 
DVI product.

Updating your MXO2 firmware
When you install the MXO2 software while your MXO2 hardware is powered 
and connected to your computer, the Mtx.utils Setup program automatically 
verifies the firmware on your MXO2 hardware and updates it if required. If you 
install Mtx.utils on a computer without the MXOX2 hardware, the next time you 
start your computer with your MXO2 hardware connected, Mtx.utils Setup will 
update your MXO2 firmware if needed.

²Caution Do not disconnect or power off MXO2, or interrupt the firmware update 
during the update process. Doing so may damage your MXO2 hardware.

Installing the Matrox effect patterns
The Matrox plug-in for Adobe Premiere Pro includes Matrox wipes that you can 
apply to clips in your Matrox projects as explained in Chapter 10, “Setting Up 
Matrox Effects with Adobe Premiere Pro.” In order to apply the Matrox wipes, 
you must install Matrox Mtx.utils as well as the Matrox effect patterns (GFX) 
files. The Matrox effect patterns are available for download with Matrox MXO2 
software releases that support Adobe Premiere Pro in the MXO2 Support section 
of our website at www.matrox.com/video/support.
pter 2, Installing Your Matrox MXO2 Hardware and Software
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Installing additional Matrox WYSIWYG plug-ins 
or removing unneeded plug-ins

When you install Matrox Mtx.utils, you are prompted to install the Matrox 
WYSIWYG plug-ins for any supported programs that are currently installed on 
your system. If after you’ve installed Matrox Mtx.utils you want to install 
additional Matrox WYSIWYG plug-ins, or re-install or remove a currently 
installed plug-in, you can update your system by choosing Start > All 
Programs > Matrox Mtx.utils > Update Matrox WYSIWYG Plug-ins. 
You’ll be prompted to specify which plug-ins you want to install, re-install, or 
remove. For more information about the programs supported and required 
settings, see Chapter 12, “Using the Matrox WYSIWYG Plug-ins.”

¦ Note To install the Matrox WYSIWYG plug-in for a program, you must first 
install that program.

Installing the Matrox VFW software codecs on 
a system without the MXO2 hardware

The Matrox Video for Windows (VFW) software codecs let you render and play 
back Matrox .avi files in your VFW programs without having to install Matrox 
Mtx.utils and the Matrox MXO2 hardware. This flexibility allows you to use a 
remote editing workstation to create a rough cut of your project, and then copy 
the project and assets to your MXO2 system to finish the job.

¦ Note If you’ve installed Matrox Mtx.utils, you do not need to install the 
Matrox VFW software codecs because Matrox Mtx.utils installs all the Matrox 
codecs on your system.

The Matrox VFW software codecs are available for download in the 
“Downloads” section of the Matrox Support website at 
www.matrox.com/video/support.

Updating your display card’s drivers
For the best performance when using your MXO2 system with Adobe Premiere 
Pro, you should update the drivers for your display card with the latest drivers 
available from your display card’s manufacturer. For example, if you’re using 
Adobe Premiere Pro with a supported NVIDIA display card for GPU 
acceleration, it’s recommended that you update your system with the latest 
drivers for your card from NVIDIA.

¡ Important If you’re using Matrox MXO2 with Avid editing software, you 
must use an Avid-certified system with a specific display card and driver as listed 
in the System Recommendations section of the Matrox MXO2 Support section of 
our website at www.matrox.com/video/support.
Installing additional Matrox WYSIWYG plug-ins or removing unneeded plug-ins
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Updating drivers for using DV-1394 devices 
with Adobe Premiere Pro

To avoid capture or export to tape issues when using DV-1394 devices with 
Adobe Premiere Pro on Matrox MXO2, make sure that the drivers on your 
system are up to date (card drivers, chipset and BIOS drivers, etc.), and that you 
have the latest Windows updates. If you experience issues using DV-1394 
devices, you must change the 1394 host controller driver on your system as 
follows:

1 In Control Panel, choose Hardware and Sound > Device Manager.

2 Double-click IEEE 1394 Bus host controllers.

3 Right-click the name of your 1394 host controller, and choose Update 
Driver Software.

4 When prompted, selected Browse my computer for driver software.

5 Select Let me pick from a list of device drivers on my computer.

6 In the provided dialog box, make sure that Show compatible hardware is 
selected, and from the list of available device drivers, select 1394 OHCI 
Compliant Host Controller (Legacy).

7 Click Next to install the driver.

¡ Important Make sure that your DV-1394 device is turned off when you 
connect it to your system, and turn the device on only after Windows has started.

Setting Matrox MXO2 as your default audio 
playback device

You can use Matrox MXO2 as your output device for playing back audio using 
Windows Driver Model (WDM)-based applications on your Windows system, 
such as Windows Media Player and Adobe Soundbooth. To set MXO2 as your 
default sound playback device in Windows, do the following:

1 Choose Start > Control Panel > Hardware and Sound > Sound, and 
click the Playback tab. 

2 Right-click Matrox WDM audio device LE, and click Set as Default 
Device.
pter 2, Installing Your Matrox MXO2 Hardware and Software
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Note about using sleep and hibernation modes 
with MXO2

Before setting your computer to sleep or hibernation mode, make sure that you 
first quit any application that is using your Matrox MXO2 hardware, such as 
Matrox A/V Tools. As well, never disconnect or remove your Matrox MXO2 
hardware when your computer is in sleep or hibernation mode (always shut down 
your computer first).

Removing your Matrox MXO2 software
You can remove the various Matrox MXO2 software components as follows:

• To remove Matrox Mtx.utils from your computer, choose Start > All 
Programs > Matrox Mtx.utils > Uninstall Matrox Mtx.utils.

• To remove the Matrox effect patterns from your computer, choose Start > 
All Programs > Matrox Effect Patterns > Uninstall Matrox Effect 
Patterns.

• To remove the Matrox VFW software codecs from a computer without 
Matrox Mtx.utils, choose Start > All Programs > Matrox VFW 
Software Codecs > Uninstall Matrox VFW Software Codecs.
Note about using sleep and hibernation modes with MXO2
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Connecting External Devices to

Matrox MXO2
This chapter shows how to 
supply power and connect 
external devices to Matrox 
MXO2.
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Cha
¦ Note This chapter explains how to connect external devices to Matrox MXO2 
only. For another MXO2 product, see Chapter 4, “Connecting External Devices 
to Matrox MXO2 Rack,” Chapter 5, “Connecting External Devices to Matrox 
MXO2 LE,” or Chapter 6, “Connecting External Devices to Matrox MXO2 
Mini.”

Available MXO2 connections
Matrox MXO2 features a full compliment of professional inputs and outputs, and 
allows you to connect multiple devices for up to five user-selectable simultaneous 
video outputs.

MXO2 video connections
• One HD HDMI input and one HD/SD HDMI output, both with up to eight 

channels of embedded audio support. The HDMI input/output supports YUV 
and RGB devices.

• One HD/SD SDI input and two HD/SD SDI outputs with up to eight 
channels of embedded audio. Both SDI outputs simultaneously output the 
same video and embedded audio.

• One HD/SD analog component input/output, one S-Video input/output, and 
one composite input/output.

• Analog black burst reference input.

MXO2 audio connections
• Two balanced analog XLR inputs (stereo pair).

• Four balanced analog XLR outputs (two stereo pairs).

• One AES/EBU stereo input/output.

• Two unbalanced analog RCA inputs (stereo pair).

• Six unbalanced analog RCA outputs (for surround sound monitoring).

Powering MXO2
Supply power to MXO2 using an AC outlet via the Matrox external power supply 
and a power cord, or using a battery via the Matrox battery power cable. Matrox 
MXO2 connects to the battery via a 4-pin XLR connector. For information on 
how to connect your battery to portable video equipment, such as Matrox MXO2, 
contact the battery manufacturer. Before connecting MXO2 to a battery, please 
read the “Battery requirements and guidelines for MXO2” on page 3.

MXO2 power functionality
MXO2 features a power button that you can use to turn the MXO2 on and off. To 
turn your MXO2 on, press the power button. To turn off your MXO2, press and 
hold the power button for at least two seconds.
pter 3, Connecting External Devices to Matrox MXO2
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¡ Important When MXO2 is connected to a computer that is running, do not 
disconnect MXO2 from its power source, or power off MXO2. Shut down your 
computer before removing power from MXO2. If using a battery to power 
MXO2, ensure that the battery is sufficiently charged.

OR
External 
power supply

Female 4-pin 
XLR cable Battery on a

universal battery 
adapter

Matrox battery 
power cable

To AC 
outlet

Power cord

Power button

²Caution When 
disconnecting the power 
supply from MXO2, 
make sure that you slide 
back the casing on the 
connector to release the 
locking mechanism.

MXO2
(side view)
Powering MXO2
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Connecting MXO2 to your computer
Connect MXO2 to your computer using the Matrox PCIe cable and the 
appropriate Matrox PCIe host adapter.

Ensuring proper PCIe cable connection
To ensure functionality and avoid damaging the PCIe cable or host connector 
when connecting MXO2 to your computer, the PCIe cable must be connected to 
your MXO2 and host connector as shown below:

To Matrox PCIe ExpressCard/34 adapter

To Matrox PCIe host adapter

“B” side of PCIe cable must face the side 
labeled “XI LINK” on the Matrox PCIe 
host adapter.

“B” side of PCIe cable must face the 
top of the Matrox PCIe 
ExpressCard/34 adapter.

To Matrox MXO2
“B” side of PCIe cable must face the side 
labeled “HOST” on MXO2.
pter 3, Connecting External Devices to Matrox MXO2
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Using the Matrox PCIe host adapters
For MXO2 to be detected on your desktop computer, power must be supplied to 
MXO2 (see “Powering MXO2” on page 14), and it must be connected to your 
computer before starting up your system.

¡ Important Do not disconnect the Matrox PCIe cable from the adapter, or 
MXO2, when your computer is running. Shut down your laptop before removing 
the Matrox PCIe host Expresscard/34 adapter from your laptop’s ExpressCard/34 
slot.

OR

Matrox PCIe host 
ExpressCard/34 
adapter

Matrox PCIe 
host adapter

PCIe cable

²Caution To ensure functionality and 
avoid damaging the PCIe cable or host 
connector, you must connect the PCIe 
cable as shown in “Ensuring proper PCIe 
cable connection” on page 16.

To your laptop’s ExpressCard/34 
slot (see “Installing and removing 
your PCIe host ExpressCard/34 
adapter (for laptops)” on page 7).

MXO2
(side view)
Connecting MXO2 to your computer
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MXO2 RS-422 serial connection
MXO2’s RS-422 serial connector lets you use RS-422 device control with a 
supported video editing application when capturing material and exporting your 
sequence to tape. This serial connection supports any device that uses the RS-422 
SMPTE time code protocol, such as a VTR or digital disk recorder. For 
information on how to configure Matrox RS-422 device control settings in Adobe 
Premiere Pro, see “Setting up Matrox RS-422 device control” on page 107.

RS-422 serial cable

RS-422 device

MXO2
(side view)
pter 3, Connecting External Devices to Matrox MXO2
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Typical Matrox MXO2 connections
In the following typical connection examples, we’ve connected a monitor to view 
the signal that will be recorded, and separate source and record decks. You may, 
however, use the same deck as both your source and record device by making the 
input and output connections to a single deck. For details on the Matrox MXO2 
connectors, see Appendix B, “Matrox MXO2 Connectors.”

Analog component video connections
In this illustration, we’re using analog component connectors for video, XLR 
connectors for audio, and an HDMI connector for video monitoring. The video is 
genlocked using a tri-level sync generator.

Source
(Deck 1)

Recorder 
(Deck 2)

HDMI 
monitor

MXO2 Outputs

MXO2 Inputs

Tri-level
sync
generator
Typical Matrox MXO2 connections
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Digital video connections
In this illustration, we’re using SDI connectors for video and audio, an SDI 
connector for video monitoring, and we’re monitoring the audio on a surround 
sound speaker system through RCA connectors. The video is genlocked using a 
tri-level sync generator.

Recorder (Deck 2)Video monitor Surround sound
speaker system

Source
(Deck 1)

Tri-level
sync
generator

MXO2 Outputs

MXO2 Inputs
pter 3, Connecting External Devices to Matrox MXO2
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Connecting External Devices to

Matrox MXO2 Rack
This chapter shows how to 
rack mount, supply power, and 
connect external devices to 
Matrox MXO2 Rack.
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Cha
¦ Note This chapter explains how to connect external devices to Matrox MXO2 
Rack only. For another MXO2 product, see Chapter 3, “Connecting External 
Devices to Matrox MXO2,” Chapter 5, “Connecting External Devices to Matrox 
MXO2 LE,” or Chapter 6, “Connecting External Devices to Matrox MXO2 
Mini.”

Available MXO2 Rack connections
Matrox MXO2 Rack features a full compliment of professional inputs and 
outputs, and allows you to connect multiple devices for up to five user-selectable 
simultaneous video outputs.

MXO2 Rack video connections
• One HD HDMI input and one HD/SD HDMI output, both with up to eight 

channels of embedded audio support. The HDMI input/output supports YUV 
and RGB devices.

• One HD/SD SDI input and two HD/SD SDI outputs with up to eight 
channels of embedded audio. Both SDI outputs simultaneously output the 
same video and embedded audio.

• One HD/SD analog component input/output, one S-Video input/output, and 
one composite input/output.

• One analog black burst reference input and loop-through output.

MXO2 Rack audio connections
• Four balanced analog XLR inputs (two stereo pairs).

• Eight balanced analog XLR outputs (four stereo pairs).

• Two AES/EBU stereo inputs/outputs.

Rack mounting your MXO2 Rack
Use the supplied rackmount brackets to mount your Matrox MXO2 Rack to a 
standard 19-inch rack. The rackmount brackets can be used to either front or rear 
mount your MXO2 Rack. You can also mount MXO2 Rack so that it’s recessed 
to allow more space for cables. MXO2 Rack takes up two vertical rack unit 
spaces.

1 Unpack the two rackmount brackets and their eight mounting screws.

²Caution Use only the screws supplied with your MXO2 Rack to attach the 
rackmount brackets to your MXO2 Rack. If you use screws that are larger or 
longer than the ones supplied, you can damage your equipment. 

2 Depending if you want to front or rear mount your MXO2 Rack, position the 
rackmount brackets so that the bracket face is either towards the front 
(connector side) or the back of your MXO2 Rack.
pter 4, Connecting External Devices to Matrox MXO2 Rack
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3 MXO2 Rack can be recess mounted to allow extra space for connectors and 
cables. Depending on your mounting needs, align the screw holes on each 
rackmount bracket with the desired screw holes on either side of the MXO2 
Rack.

²Caution For stability and safety, whichever mounting method you choose, 
make sure to fasten each rackmount bracket to MXO2 Rack using all four 
supplied screws.

4 Using a hand screwdriver only (no power screwdrivers), carefully tighten 
each screw until snug. Do not overtighten!

5 Fasten your MXO2 Rack to the standard 19-inch rack as per your rack’s 
instructions.

Front rackmounting

Rear rackmounting

Recessed rackmounting

Rackmount 
bracket MXO2 Rack
Rack mounting your MXO2 Rack
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Powering MXO2 Rack
You can power MXO2 Rack using an AC outlet and an IEC-C13 power cord. To 
turn off your MXO2 Rack, unplug it from the AC outlet while your computer is 
shut down.

¡ Important When MXO2 Rack is connected to a computer that is running, do 
not disconnect MXO2 Rack from its power source. Shut down your computer 
before removing power from MXO2 Rack.

To AC 
outlet

IEC-C13
power cord

MXO2 Rack
ter 4, Connecting External Devices to Matrox MXO2 Rack
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Connecting MXO2 Rack to your computer
Connect MXO2 Rack to your computer using the Matrox PCIe cable and the 
appropriate Matrox PCIe host adapter.

Ensuring proper PCIe cable connection
To ensure functionality and avoid damaging the PCIe cable or host connector 
when connecting MXO2 Rack to your computer, the PCIe cable must be 
connected to your MXO2 Rack and host connector as shown below:

To Matrox PCIe ExpressCard/34 adapter

To Matrox PCIe host adapter

“B” side of PCIe cable must face the side 
labeled “XI LINK” on the Matrox PCIe 
host adapter.

“B” side of PCIe cable must face the 
top of the Matrox PCIe 
ExpressCard/34 adapter.

To Matrox MXO2 Rack
“B” side of PCIe cable must face the side 
labeled “HOST” on MXO2.
Connecting MXO2 Rack to your computer
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Using the Matrox PCIe host adapters
For MXO2 Rack to be detected on a desktop computer, power must be supplied 
to MXO2 Rack (see “Powering MXO2 Rack” on page 24), and it must be 
connected to your computer before starting up your system.

¡ Important Do not disconnect the Matrox PCIe cable from the adapter, or 
MXO2 Rack, when your computer is running. Shut down your laptop before 
removing the Matrox PCIe host Expresscard/34 adapter from your laptop’s 
Expresscard/34 slot.

OR

Matrox PCIe host 
ExpressCard/34 
adapter

Matrox PCIe 
host adapter

PCIe cable

²Caution To ensure functionality and 
avoid damaging the PCIe cable or host 
connector, you must connect the PCIe 
cable as shown in “Ensuring proper PCIe 
cable connection” on page 25.

To your laptop’s ExpressCard/34 
slot (see “Installing and removing 
your PCIe host ExpressCard/34 
adapter (for laptops)” on page 7).

MXO2 Rack
pter 4, Connecting External Devices to Matrox MXO2 Rack
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MXO2 Rack RS-422 serial connection
The Matrox MXO2 Rack RS-422 serial connector lets you use RS-422 device 
control with a supported video editing application when capturing material and 
exporting your sequence to tape. This serial connection supports any device that 
uses the RS-422 SMPTE time code protocol, such as a VTR or digital disk 
recorder. For information on how to configure Matrox RS-422 device control 
settings in Adobe Premiere Pro, see “Setting up Matrox RS-422 device control” 
on page 107.

RS-422 serial cable

RS-422 device

MXO2 Rack
(partial view)
MXO2 Rack RS-422 serial connection
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Typical Matrox MXO2 Rack connections
In the following typical connection examples, we’ve connected a monitor to view 
the signal that will be recorded, and separate source and record decks. You may, 
however, use the same deck as both your source and record device by making the 
input and output connections to a single deck. For details on the Matrox MXO2 
Rack connectors, see Appendix B, “Matrox MXO2 Connectors.”

Analog component video connections
In this illustration, we’re using analog component connectors for video, XLR 
connectors for audio, and an HDMI connector for video monitoring. The video is 
genlocked using a tri-level sync generator.

Recorder (Deck 2)

HDMI 
monitor

MXO2 Rack (partial view)

MXO2 Rack (partial view)

Tri-level
sync
generator Source

(Deck 1)

To another devic
reference input.
not used, termin
the signal with a
BNC 75-ohm 
terminator.
pter 4, Connecting External Devices to Matrox MXO2 Rack
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Digital video connections
In this illustration, we’re using SDI connectors for video and audio, an SDI 
connector for video monitoring, and we’re monitoring the audio on a surround 
sound speaker system through XLR connectors. The video is genlocked using a 
tri-level sync generator.

Recorder 
(Deck 2)

Video 
monitor

Surround sound
speaker system

Source
(Deck 1)

Tri-level
sync
generator

MXO2 Rack (partial view)

MXO2 Rack (partial view)

To another device’s 
reference input. If not used, 
terminate the signal with a 
BNC 75-ohm terminator.
Typical Matrox MXO2 Rack connections
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Connecting External Devices to

Matrox MXO2 LE
This chapter shows how to 
supply power and connect 
external devices to Matrox 
MXO2 LE.
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Cha
¦ Note This chapter explains how to connect external devices to Matrox 
MXO2 LE only. For another MXO2 product, see Chapter 3, “Connecting 
External Devices to Matrox MXO2,” Chapter 4, “Connecting External Devices to 
Matrox MXO2 Rack,” or Chapter 6, “Connecting External Devices to Matrox 
MXO2 Mini.”

Available MXO2 LE connections
Matrox MXO2 LE features a full compliment of professional inputs and output, 
and allows you to connect multiple devices for up to five user-selectable 
simultaneous video outputs.

MXO2 LE video connections
• One HD HDMI input and one HD/SD HDMI output, both with up to eight 

channels of embedded audio support. The HDMI input/output supports YUV 
and RGB devices.

• One HD/SD SDI input and two HD/SD SDI outputs with up to eight 
channels of embedded audio. Both SDI outputs simultaneously output the 
same video and embedded audio.

• One HD/SD analog component input/output, one S-Video input/output, and 
one composite input/output.

• Analog black burst reference input.

MXO2 LE audio connections
• Two balanced analog XLR inputs/ouputs (stereo pair).

• Two unbalanced analog RCA inputs/ouputs (stereo pair).

Powering MXO2 LE 
Supply power to MXO2 LE using an AC outlet via the Matrox external power 
supply and a power cord, or using a battery. Matrox MXO2 LE connects to the 
battery via a 4-pin XLR connector. For information on how to connect your 
battery to portable video equipment, such as Matrox MXO2 LE, contact the 
battery manufacturer. Before connecting MXO2 LE to a battery, please read the 
“Battery requirements and guidelines for MXO2” on page 3.

MXO2 LE power functionality
MXO2 LE features a power button that you can use to turn the MXO2 LE on and 
off. To turn your MXO2 LE on, press the power button. To turn off your 
MXO2 LE, press and hold the power button for at least two seconds.

¡ Important When MXO2 LE is connected to a computer that is running, do not 
disconnect MXO2 LE from its power source, or power off MXO2 LE. Shut down 
pter 5, Connecting External Devices to Matrox MXO2 LE
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your computer before removing power from MXO2 LE. If using a battery to 
power MXO2 LE, ensure that the battery is sufficiently charged.

OR
External 
power supply

Battery on a 
universal battery 
adapter

To AC 
outlet

Power cord

Power button

MXO2 LE
(side view)

Female 4-pin 
XLR cable
Powering MXO2 LE
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Connecting MXO2 LE to your computer
Connect MXO2 LE to your computer using the Matrox PCIe cable and the 
appropriate Matrox PCIe host adapter.

Ensuring proper PCIe cable connection
To ensure functionality and avoid damaging the PCIe cable or host connector 
when connecting MXO2 LE to your computer, the PCIe cable must be connected 
to your MXO2 LE and host connector as shown below:

To Matrox PCIe ExpressCard/34 adapter

To Matrox PCIe host adapter

“B” side of PCIe cable must face the side 
labeled “XI LINK” on the Matrox PCIe 
host adapter.

“B” side of PCIe cable must face the 
top of the Matrox PCIe 
ExpressCard/34 adapter.

To Matrox MXO2 LE
“B” side of PCIe cable must face the side 
labeled “HOST” on MXO2.
pter 5, Connecting External Devices to Matrox MXO2 LE
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Using the Matrox PCIe host adapters
For MXO2 LE to be detected on your desktop computer, power must be supplied 
to MXO2 LE (see “Powering MXO2 LE” on page 32), and it must be connected 
to your computer before starting up your system.

¡ Important Do not disconnect the Matrox PCIe cable from the adapter, or 
MXO2 LE, when your computer is running. Shut down your laptop before 
removing the Matrox PCIe host Expresscard/34 adapter from your laptop’s 
ExpressCard/34 slot.

OR

Matrox PCIe host 
ExpressCard/34 
adapter

Matrox PCIe 
host adapter

PCIe cable

²Caution To ensure functionality and 
avoid damaging the PCIe cable or host 
connector, you must connect the PCIe 
cable as shown in “Ensuring proper PCIe 
cable connection” on page 34.

To your laptop’s ExpressCard/34 
slot (see “Installing and removing 
your PCIe host ExpressCard/34 
adapter (for laptops)” on page 7).

MXO2 LE
(side view)
Connecting MXO2 LE to your computer
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MXO2 LE RS-422 serial connection
MXO2 LE’s RS-422 serial connector lets you use RS-422 device control with a 
supported video editing application when capturing material and exporting your 
sequence to tape. This serial connection supports any device that uses the RS-422 
SMPTE time code protocol, such as a VTR or digital disk recorder. For 
information on how to configure Matrox RS-422 device control settings in Adobe 
Premiere Pro, see “Setting up Matrox RS-422 device control” on page 107..

RS-422 serial cable

RS-422 device

MXO2 LE
(side view)
pter 5, Connecting External Devices to Matrox MXO2 LE
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Typical Matrox MXO2 LE connections
In the following typical connection examples, we’ve connected a monitor to view 
the signal that will be recorded, and separate source and record decks. You may, 
however, use the same deck as both your source and record device by making the 
input and output connections to a single deck. For details on the Matrox 
MXO2 LE connectors, see Appendix B, “Matrox MXO2 Connectors.”

Analog component video connections
In this illustration, we’re using analog component connectors for video, XLR 
connectors for audio, and an HDMI connector for video monitoring. The video is 
genlocked using a tri-level sync generator.

Source
(Deck 1)

Recorder 
(Deck 2)

HDMI 
monitor

MXO2 LE Outputs

MXO2 LE Inputs

Tri-level
sync
generator
Typical Matrox MXO2 LE connections
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Digital video connections
In this illustration, we’re using SDI connectors for video and audio, an SDI 
connector for video monitoring, and we’re monitoring the audio on a surround 
sound speaker system through an HDMI connector. The video is genlocked using 
a tri-level sync generator.

Recorder (Deck 2)Video monitor Surround sound
speaker system

Source
(Deck 1)

Tri-level
sync
generator

MXO2 LE Outputs

MXO2 LE Inputs
pter 5, Connecting External Devices to Matrox MXO2 LE
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Matrox MXO2 Mini
This chapter shows how to 
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Cha
¦ Note This chapter explains how to connect external devices to Matrox MXO2 
Mini only. For another MXO2 product, see Chapter 3, “Connecting External 
Devices to Matrox MXO2,” Chapter 4, “Connecting External Devices to Matrox 
MXO2 Rack,” or Chapter 5, “Connecting External Devices to Matrox MXO2 
LE.”

Available MXO2 Mini connections
Matrox MXO2 Mini provides inputs and outputs for connecting external devices, 
including HDMI, analog component, S-Video, and composite video devices.

MXO2 video and audio connections
• One HD HDMI input and one HD/SD HDMI output, both with up to eight 

channels of embedded audio support. The HDMI input/output supports YUV 
and RGB devices.

• One HD/SD analog component input/output, or one S-Video input/output 
and one composite input/output.

¦ Note S-Video input/output is available by using the provided S-Video 
adapters (see “Connecting S-Video devices to MXO2 Mini” on page 44).

• Two unbalanced analog RCA audio inputs/outputs (stereo pair).

Powering MXO2 Mini
You can supply power to MXO2 Mini using an AC outlet via the Matrox external 
power supply cable. To turn MXO2 Mini off, unplug the Matrox external power 
supply cable from the AC outlet while your computer is shut down. 

¡ Important When MXO2 Mini is connected to a computer that is running, do 
not disconnect MXO2 Mini from its power source. Shut down your computer 
before removing power from MXO2 Mini.

MXO2 Mini power supply and adapter plugs
MXO2 Mini provides an external power supply cable with international adapter 
plugs for use in different regions.

• To remove an adapter plug from the Matrox power adapter, hold down the 
button labeled PUSH on the power adapter, and then slide the adapter plug 
up until it releases from the power adapter.

• To insert an adapter plug into the Matrox power adapter, ensure that the 
adapter plug is properly aligned with the corresponding slot on the power 
adapter, and then slide the adapter plug down into the power adapter until it 
locks into place.
pter 6, Connecting External Devices to Matrox MXO2 Mini
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Removing an adapter plug Inserting an adapter plug

Power 
adapter

Adapter 
plug

To AC 
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MXO2 Mini

Power supply
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Powering MXO2 Mini
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Connecting MXO2 Mini to your computer
Connect MXO2 Mini to your computer using the Matrox PCIe cable and the 
appropriate Matrox PCIe host adapter.

Ensuring proper PCIe cable connection
To ensure functionality and avoid damaging the PCIe cable or host connector 
when connecting MXO2 Mini to your computer, the PCIe cable must be 
connected to your MXO2 Mini and host connector as shown below:

To Matrox PCIe ExpressCard/34 adapter

To Matrox PCIe host adapter

“B” side of PCIe cable must face the side 
labeled “XI LINK” on the Matrox PCIe 
host adapter.

“B” side of PCIe cable must face the 
top of the Matrox PCIe 
ExpressCard/34 adapter.

To Matrox MXO2 Mini
“B” side of PCIe cable must face the side 
labeled “HOST” on MXO2.
pter 6, Connecting External Devices to Matrox MXO2 Mini
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Using the Matrox PCIe host adapters
For MXO2 Mini to be detected on your desktop computer, power must be 
supplied to MXO2 Mini (see “Powering MXO2 Mini” on page 40), and it must 
be connected to your computer before starting up your system.

¡ Important Do not disconnect the Matrox PCIe cable from the adapter, or 
MXO2 Mini, when your computer is running. Shut down your laptop before 
removing the Matrox PCIe host Expresscard/34 adapter from your laptop’s 
ExpressCard/34 slot.

OR

Matrox PCIe host 
ExpressCard/34 
adapter

Matrox PCIe 
host adapter

PCIe cable

²Caution To ensure functionality and avoid 
damaging the PCIe cable or host connector, you 
must connect the PCIe cable as shown in 
“Ensuring proper PCIe cable connection” on 
page 42.

To your laptop’s ExpressCard/34 
slot (see “Installing and removing 
your PCIe host ExpressCard/34 
adapter (for laptops)” on page 7).

MXO2 Mini
Connecting MXO2 Mini to your computer
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Connecting S-Video devices to MXO2 Mini
To support S-Video connections on MXO2 Mini, your MXO2 Mini kit includes 
two S-Video adapter cables (one for S-Video input and one for S-Video output).

¦ Note When you connect an S-Video device to MXO2 Mini, you won’t be able 
to connect an analog component device at the same time.

S-Video adapter 
cable

MXO2 Mini

To S-Video OUT connector 
on source device

To S-Video IN connector on 
output device
pter 6, Connecting External Devices to Matrox MXO2 Mini
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Typical Matrox MXO2 Mini connections
In the following typical connection examples, we’ve connected a monitor to view 
the signal that will be recorded, and separate source and record decks. You may, 
however, use the same deck as both your source and record device by making the 
input and output connections to a single deck. For details on the Matrox MXO2 
Mini connectors, see Appendix B, “Matrox MXO2 Connectors.”

Analog component video connections
In this illustration, we’re using component connectors for video, RCA connectors 
for audio, and an HDMI connector for video monitoring. The video is genlocked 
to the input source using MXO2 Mini’s built-in genlock.

Source
(Deck 1)

Recorder 
(Deck 2)

HDMI 
monitor

MXO2 Mini
Typical Matrox MXO2 Mini connections
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HDMI video connections
In this illustration, we’re using HDMI for video, RCA connectors for audio, and 
S-Video for video monitoring. The video is genlocked to the input source using 
MXO2 Mini’s built-in genlock.

¦ Note When using HDMI connections, the embedded uncompressed HDMI 
audio is also available.

Recorder 
(Deck 2)

Source
(Deck 1)

MXO2 Mini

S-Video 
monitor
pter 6, Connecting External Devices to Matrox MXO2 Mini
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Calibrating Your HDMI Monitor

for Video
This chapter explains how to 
use the Matrox HDMI 
Calibration Utility to calibrate 
your RGB HDMI monitor for 
video.
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Overview
The Matrox HDMI Calibration Utility is a unique tool designed to calibrate your 
RGB HDMI monitor or television so that it performs like a traditional broadcast 
video monitor. This utility provides a wizard that walks you through the 
calibration process using specially designed patterns to effectively identify and 
compensate for the processing errors that may be present in your HDMI monitor. 
The Matrox HDMI Calibration Utility calibrates your monitor’s black and white 
levels, white point, gamma response, and hue and chroma.

This utility is optimized for calibrating HDMI LCD/LED monitors or televisions 
that support 1:1 pixel mapping, which allows you to view the output on your 
HDMI monitor at its exact resolution without any scaling. Although instructions 
are provided for calibrating plasma HDMI monitors, and HDMI monitors that do 
not support 1:1 pixel mapping, a blue-only filter will be required for the color 
calibration (hue and chroma). Some HDMI monitors feature a built-in blue-only 
mode that you can use for color calibration. If your HDMI monitor does not have 
a built-in blue-only mode, you can use a proper third-party blue-only filter (for 
example, a blue gel filter, or blue-only calibration glasses) that completely blocks 
out all colors except for blue. Because some blue-only filters do not block out 
colors effectively, the Matrox HDMI Calibration Utility includes a blue-only 
filter test that you can use to determine if your blue-only filter is adequate for 
color calibration.

¦ Note To ensure that the Matrox HDMI Calibration Utility displays correctly, 
your computer screen’s resolution must be 1280×800 or higher, and the 
Windows DPI scaling option for text must be set to the default size. For details on 
how to change your screen resolution and DPI scaling setting for text, see your 
Windows documentation.

Calibrating your HDMI monitor
The Matrox HDMI Calibration Utility provides on-screen instructions to 
calibrate your HDMI monitor. At the end of the calibration process, you must 
save your calibration settings to a file. Once saved, the calibration settings are 
automatically loaded as your system’s current calibration settings. If you’re 
calibrating more than one HDMI monitor, you can calibrate and save settings for 
each monitor and load the corresponding settings at any time (see “Loading 
Matrox HDMI calibration settings” on page 50). You can later choose to enable 
or disable the loaded calibration settings (see “Enabling and disabling the Matrox 
HDMI calibration settings” on page 50).

The Matrox HDMI Calibration Utility uses the Matrox WYSIWYG Control 
Panel to display the specially designed patterns that are required to calibrate your 
HDMI monitor. Therefore, you’ll need to configure your Matrox WYSIWYG 
output settings as explained in this section. For more information about using the 
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Matrox WYSIWYG Control Panel, see “Configuring the Matrox WYSIWYG 
Control Panel” on page 196.

¡ Important When running the Matrox HDMI Calibration Utility, make sure 
that you don’t run any other application that uses your Matrox MXO2 hardware, 
such as Adobe Premiere Pro, or any other application that displays Matrox 
WYSIWYG output.

°To run the Matrox HDMI Calibration Utility:

1 Ensure that your HDMI monitor is connected to the HDMI output on your 
MXO2, turn the HDMI monitor on, and allow it to warm up for about 20 or 
30 minutes.

2 Right-click the  icon on your Windows taskbar and configure your 
Matrox WYSIWYG output settings as follows:

$ Enable WYSIWYG Output must be selected.

$ Choose Output Configuration and on the Video Output page, set the 
HDMI output to RGB - calibrated. This is required in order to run the 
Matrox HDMI Calibration Utility and output the adjusted RGB HDMI 
video to your HDMI monitor.

$ All other required Matrox WYSIWYG output settings will be 
automatically set by the HDMI Calibration Utility.

3 Click OK to save your video output settings.

4 Right-click the  icon on your Windows taskbar, and choose Matrox 
HDMI Calibration Utility.

5 Follow the onscreen instructions to calibrate your HDMI monitor.

6 When prompted at the end of the calibration process, save your calibration 
settings to a file anywhere on your system. Once saved, your settings are 
automatically loaded as your system’s current HDMI calibration settings. 
You can later choose to enable or disable the loaded calibration settings (see 
“Enabling and disabling the Matrox HDMI calibration settings” on page 50).

¦ Note The calibration settings file is saved as an .mtx file. If you cancel the 
HDMI calibration, or close the utility at any time before saving the calibration 
settings, the current calibration settings will be lost.
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Loading Matrox HDMI calibration settings
After calibrating your HDMI monitor and saving your calibration settings to a 
file (see “Calibrating your HDMI monitor” on page 48), the calibration settings 
are automatically loaded as the current HDMI calibration settings for your 
system. You can, however, load another HDMI calibration settings file at any 
time, but only one calibration settings file can be loaded for your system at any 
given time. Once loaded, you can enable or disable the calibration settings (see 
“Enabling and disabling the Matrox HDMI calibration settings” on page 50).

¦ Note If your system has multiple users, the loaded calibration settings apply to 
the logged on user only.

1 Right-click the  icon on your Windows taskbar, choose Output 
Configuration and on the Video Output page, set the HDMI output to 
RGB - calibrated.

2 Click OK to save your video output settings.

3 Right-click the  icon on your Windows taskbar, and choose Matrox 
HDMI Calibration Utility.

4 From the Welcome page, click Load Settings.

5 When prompted, select your desired .mtx calibration settings file, and then 
click Open.

Enabling and disabling the Matrox HDMI 
calibration settings

The HDMI calibration settings that are loaded for your system (see “Loading 
Matrox HDMI calibration settings” on page 50) can be enabled or disabled. 
When using a program that supports Matrox MXO2 video output, you can 
configure the Matrox video output settings for that program to enable or disable 
the loaded HDMI calibration settings. For example, you can configure the MXO2 
video output settings that you want to use with Matrox A/V Tools as explained in 
“Specifying your video output settings” on page 170 and “Specifying your video 
output settings (MXO2 Mini)” on page 174.

When you set the HDMI video output to RGB - calibrated, the video that is 
output from the MXO2 HDMI output will have the color settings that are saved in 
the currently loaded calibration file. This is used when you want to monitor video 
on your RGB HDMI monitor.

To disable the loaded calibration settings and output HDMI video from MXO2 
with its native color settings, set the HDMI video output to YUV or RGB - 
native, depending on the HDMI device you connected to the MXO2 HDMI 
output. For example, you can set the HDMI video output to RGB - native when 
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you want to output native RGB HDMI video to an HDMI recorder to perform an 
export to tape.

¦ Note When you configure your Matrox WYSIWYG output settings, the 
settings apply to all programs that display Matrox WYSIWYG output. This 
means that when you set the HDMI video output to RGB - calibrated using the 
Matrox WYSIWYG Control Panel, the currently loaded calibration settings will 
be applied when you preview HDMI video using any program that displays 
Matrox WYSIWYG output, such as Adobe After Effects. For more information 
about using the Matrox WYSIWYG Control Panel, see “Configuring the Matrox 
WYSIWYG Control Panel” on page 196.
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Your notes
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Creating a new project on Matrox MXO2
You can create a new project for editing on Matrox MXO2 as explained in your 
Avid documentation, with the following exceptions:

• Avid supports only standard raster dimensions for projects created on 
Matrox MXO2 hardware. This means that when you create an HD project on 
MXO2, the raster dimension will be set to 1280×720 for a 720p project, or 
1920×1080 for a 1080i/p project. You can, however, still import, export, and 
play back thin raster material in your HD project.

• Matrox MXO2 supports YCbCr video only. If you set your project’s color 
space to RGB, your Avid editing application will convert your material to 
YCbCr for output on Matrox MXO2. To capture video using your Matrox 
MXO2 hardware, your project’s color space must be set to YCbCr.

Defining your playback settings
The Matrox Playback Settings dialog box provides settings that you can use to 
configure your video and audio outputs on Matrox MXO2 for playing back 
material in Avid Media Composer. You can open the Matrox Playback 
Settings dialog box using any of the following methods:

• Choose Tools > Hardware Setup.

• Click the Settings tab in the Project window, and then double-click Video 
Output (this is the method explained in the step-by-step instructions).

• Click the Hardware tab in the Audio Project Settings dialog box, and 
then click the Hardware Setup ( ) button.

¦ Note The Monitor Volume ( ) button in the Timeline window can be used 
as a shortcut to open the Matrox Playback Settings dialog box, and therefore 
does not work as described in your Avid documentation. For details on how to 
adjust various audio output settings on MXO2, see “Specifying your audio output 
settings” on page 64.

Specifying your video output settings
This section explains how to specify your video output settings for Matrox 
MXO2, MXO2 Rack, and MXO2 LE. For MXO2 Mini, see “Specifying your 
video output settings (MXO2 Mini)” on page 58.

You can specify various settings to configure the main and secondary outputs 
from your MXO2 system. Some of the settings are predetermined for you based 
on your project’s video format. For a list of the supported video output formats, 
see “Playback using Avid Media Composer” on page 276.
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°To specify your video output settings:

1 Click the Settings tab in the Project window, and then double-click Video 
Output.

2 In the Matrox Playback Settings dialog box, click the Video Output tab.

3 Under Main Output and Secondary Output, you can specify the settings 
you want for your main and secondary outputs from MXO2. Depending on 
your project’s video format, you may not be able to change some of the 
settings.

$ Format Use this to select the video format you want for your outputs. 
Be aware that the format you select may not be supported on all the 
MXO2 outputs. For a list of the supported video output formats, see 
“Playback using Avid Media Composer” on page 276.

$ Pulldown Method Depending on your project’s frame rate and the 
current video output format, the pulldown method may be automatically 
set to Standard 2:3.

$ Aspect Ratio Conversion Use this to specify how you want your 
video to be output when upscaling or downscaling:
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• 16x9 Letterbox Outputs the widescreen 16:9 picture in letterbox 
mode by adding black bars at the top and bottom of the picture for 
display on a standard 4:3 television screen.

• 4x3 Pillarbox Outputs the standard 4:3 picture in pillarbox mode by 
adding black bars to the left and right sides of the picture for display on 
a widescreen 16:9 television screen.

• Anamorphic Outputs the widescreen 16:9 picture as horizontally 
compressed 4:3 video, which retains the picture’s full vertical 
resolution for display on a widescreen television. To display the video 
with the correct proportions on an NTSC or PAL monitor, select the 
16:9 display setting on the monitor.

• Center Cut Outputs the widescreen 16:9 picture by evenly cropping 
the left and right sides of the picture for display on a standard 4:3 
television screen.

• Center Zoom Outputs the standard 4:3 picture by evenly cropping 
the top and bottom edges of the picture for display on a widescreen 
16:9 television screen.

¦ Note When aspect ratio conversion is applied to both the main and 
secondary outputs, the same setting will be applied to both outputs.

4 Under Analog Output, you can specify your analog output format, NTSC 
setup level, and output type.

$ Format Use this to specify whether you want the format for the analog 
outputs to be the same as the main or secondary output.

$ Output Type Specifies the analog video output type. If you’re 
outputting SD analog video, the output type will be set to All Available to 
indicate that the output will be available on all the analog outputs. If 
you’re outputting HD analog video, the output type will be set to 
Component.

$ Setup (NTSC) Use this to select the setup level you want for your 
NTSC analog video:

• 0 IRE Applies a setup level of 0 IRE. You should select this option 
only when working with a commercial DV device that uses the 
Japanese analog NTSC setup of 0 IRE. For example, if the video 
appears too bright when you play back DV clips on your NTSC 
monitor, you can change the setup to 0 IRE to output your DV clips at 
the correct brightness.

• 7.5 IRE Applies the standard NTSC setup level of 7.5 IRE.

$ YUV/RGB Select YUV or RGB - native to set the type of video signal 
that is sent from the component output. For example, select RGB - native 
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if you connected the component output to a device that accepts an RGB 
signal.

5 Under HDMI Output, you can specify your HDMI output format and type.

$ Format Use this to specify whether you want the format for your 
HDMI output to be the same as the main or secondary output.

$ YUV/RGB Select the type of video signal that you want to be sent from 
the HDMI output:

• YUV Outputs YUV HDMI video. Select this only if you connected 
the HDMI output to a device that accepts a YUV signal.

• RGB - calibrated Outputs adjusted RGB HDMI video using the 
currently loaded Matrox HDMI calibration settings for your HDMI 
monitor or television. For details on calibrating your HDMI monitor 
and loading calibration settings using the Matrox HDMI Calibration 
Utility, see Chapter 7, “Calibrating Your HDMI Monitor for Video.”

• RGB - native Outputs native RGB HDMI video that does not apply 
any calibration compensation. This is useful when you want to output 
RGB HDMI video to a device other than an HDMI monitor or 
television, such as an HDMI recorder to perform an export to tape.

$ 3D Viewing Mode Select the 3D signal type that you want to be sent 
from the HDMI output to your 3D monitor (this feature may not be 
supported on some 3D monitors):

• Disabled Select this if you’re not outputting 3D video, or to disable 
3D video output. You can still monitor 3D video, but you must select 
the correct viewing mode on your 3D monitor manually.

• Side-by-side Outputs horizontally compressed side-by-side 3D 
video (also referred to as side-by-side horizontal).

• Over/Under Outputs over/under 3D video (also referred to as top 
bottom).

¡ Important If your project’s Stereoscopic setting is anything other than 
Side by side, Over/Under, or Full, make sure that you set the 3D Viewing 
Mode to Disabled. For example, if your project’s Stereoscopic setting is 
Off or Leading Eye, you must disable the 3D video output in order to 
properly view the HDMI output.

6 Under SDI Output, specify whether you want the format for your SDI 
output to be the same as the main or secondary output.

7 Under Advanced, you can specify advanced video output settings.

$ Analog SC/H Phase Use this slider to advance or delay your analog 
video output’s subcarrier phase with respect to the horizontal sync of the 
genlock source (for composite video only).
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$ Allow Super White/Allow Super Black Select Allow Super White 
to allow the highest luminance level of your video output to exceed the 
standard maximum white level. Select Allow Super Black to allow the 
lowest luminance level of your video output to fall below the standard 
black level. These options apply to all video outputs.

¦ Note Super white and super black should not be allowed when producing 
your final video production for broadcast.

8 Click OK to save your settings.

Specifying your video output settings (MXO2 
Mini)
You can specify various settings to configure your main analog output and 
secondary HDMI output from the MXO2 Mini. Some of the settings are 
predetermined for you based on your project’s video format. For a list of the 
supported video output formats, see “Playback using Avid Media Composer” on 
page 276.
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°To specify your video output settings:

1 Click the Settings tab in the Project window, and then double-click Video 
Output.

2 In the Matrox Playback Settings dialog box, click the Video Output tab.

3 Under Priority Output (never blanked), select either Analog or HDMI to 
indicate whether you want the analog or HDMI output to have priority (never 
be blanked) when MXO2 Mini needs to blank either the main or secondary 
output to perform additional scaling on the video output. Additional scaling 
is needed when your main and secondary output formats don’t match and the 
video quality for playback is set to anything other than Full Quality. For 
example, if you select Analog as your priority output, then the secondary 
HDMI output will be blanked whenever MXO2 Mini needs to perform 
additional scaling on the video output.

4 Under Analog Output (Main), you can specify the settings you want for 
your main analog output from MXO2 Mini. Under HDMI Output 
(Secondary) you can specify the settings you want for your secondary 
HDMI output. Depending on your project’s video format, you may not be 
able to change some of the settings.
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$ Format Use this to select the video format you want for your outputs. 
For a list of the supported video output formats, see “Playback using Avid 
Media Composer” on page 276.

$ Pulldown Method Depending on your project’s frame rate and the 
current video output format, the pulldown method may be automatically 
set to Standard 2:3.

$ Setup (NTSC) Use this to select the setup level you want for your 
NTSC analog video (applies to main analog output only):

• 0 IRE Applies a setup level of 0 IRE. You should select this option 
only when working with a commercial DV device that uses the 
Japanese analog NTSC setup of 0 IRE. For example, if the video 
appears too bright when you play back DV clips on your NTSC 
monitor, you can change the setup to 0 IRE to output your DV clips at 
the correct brightness.

• 7.5 IRE Applies the standard NTSC setup level of 7.5 IRE.

$ Aspect Ratio Conversion Use this to specify how you want your 
video to be output when upscaling or downscaling:

• 16x9 Letterbox Outputs the widescreen 16:9 picture in letterbox 
mode by adding black bars at the top and bottom of the picture for 
display on a standard 4:3 television screen.

• 4x3 Pillarbox Outputs the standard 4:3 picture in pillarbox mode by 
adding black bars to the left and right sides of the picture for display on 
a widescreen 16:9 television screen.

• Anamorphic Outputs the widescreen 16:9 picture as horizontally 
compressed 4:3 video, which retains the picture’s full vertical 
resolution for display on a widescreen television. To display the video 
with the correct proportions on an NTSC or PAL monitor, select the 
16:9 display setting on the monitor.

• Center Cut Outputs the widescreen 16:9 picture by evenly cropping 
the left and right sides of the picture for display on a standard 4:3 
television screen.

• Center Zoom Outputs the standard 4:3 picture by evenly cropping 
the top and bottom edges of the picture for display on a widescreen 
16:9 television screen.

$ Output Type (for analog output) For your main analog output, you can 
select Component, or Composite & S-Video if you’re outputting SD 
analog video. If you’re outputting HD analog video, the output type will 
be set to Component (and the composite and S-Video outputs will be 
invalid). 
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$ YUV/RGB (for analog output) Select YUV or RGB - native to set the 
type of video signal that is sent from the component output. For example, 
select RGB - native if you connected the component output to a device 
that accepts an RGB signal.

$ YUV/RGB (for HDMI output) Select the type of video signal that you 
want to be sent from the HDMI output:

• YUV Outputs YUV HDMI video. Select this only if you connected 
the HDMI output to a device that accepts a YUV signal.

• RGB - calibrated Outputs adjusted RGB HDMI video using the 
currently loaded Matrox HDMI calibration settings for your HDMI 
monitor or television. For details on calibrating your HDMI monitor 
and loading calibration settings using the Matrox HDMI Calibration 
Utility, see Chapter 7, “Calibrating Your HDMI Monitor for Video.”

• RGB - native Outputs native RGB HDMI video that does not apply 
any calibration compensation. This is useful when you want to output 
RGB HDMI video to a device other than an HDMI monitor or 
television, such as an HDMI recorder to perform an export to tape.

$ 3D Viewing Mode Select the 3D signal type that you want to be sent 
from the HDMI output to your 3D monitor (this feature may not be 
supported on some 3D monitors):

• Disabled Select this if you’re not outputting 3D video, or to disable 
3D video output. You can still monitor 3D video, but you must select 
the correct viewing mode on your 3D monitor manually.

• Side-by-side Outputs horizontally compressed side-by-side 3D 
video (also referred to as side-by-side horizontal).

• Over/Under Outputs over/under 3D video (also referred to as top 
bottom).

¡ Important If your project’s Stereoscopic setting is anything other than 
Side by side, Over/Under, or Full, make sure that you set the 3D Viewing 
Mode to Disabled. For example, if your project’s Stereoscopic setting is 
Off or Leading Eye, you must disable the 3D video output in order to 
properly view the HDMI output.

5 Under Advanced, select Allow Super White to allow the highest 
luminance level of your video output to exceed the standard maximum white 
level. Select Allow Super Black to allow the lowest luminance level of your 
video output to fall below the standard black level. These options apply to 
both the main analog output and secondary HDMI output.

¦ Note Super white and super black should not be allowed when producing 
your final video production for broadcast.

6 Click OK to save your settings.
Defining your playback settings



62

Cha
Specifying your genlock settings

¦ Note This section does not apply to Matrox MXO2 Mini.

You can select the source to which you want to genlock all devices connected to 
your MXO2 system, as well as adjust the timing settings for all video outputs 
from MXO2. For examples of how to connect an external sync source to your 
system, see “Typical Matrox MXO2 connections” on page 19, “Typical Matrox 
MXO2 Rack connections” on page 28, and “Typical Matrox MXO2 LE 
connections” on page 37.

¦ Note These genlock settings are used during playback only. During capture, 
MXO2 genlocks to your selected video input source.

°To specify your genlock settings:

1 Click the Settings tab in the Project window, and then double-click Video 
Output.

2 In the Matrox Playback Settings dialog box, click the Genlock tab.

3 From the Genlock Source list, select one of the following:

$ Internal Genlock to MXO2’s internal reference signal. Select this 
option only if you don’t have an external sync generator or other reliable 
external video sync source.

$ Black Burst Broadcast Quality Genlock to an external analog sync 
source connected to the reference (REF) input on MXO2. This must be a 
stable sync source, such as an external sync generator (bi-level black burst 
for SD or tri-level sync for HD), or a source VTR that has a built-in TBC.
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$ SDI, Composite, Component, S-Video, and HDMI Input Genlock to 
your SDI, composite, component, S-Video, or HDMI video source 
connected to the video input on MXO2.

Remarks
• The status of your genlock source will be displayed, such as Locked or 

Not Locked, to indicate whether or not MXO2 is presently locked to 
your selected genlock source. When you change the genlock source, 
distorted video and silent audio will be output until MXO2 locks to the 
new genlock source.

• If MXO2 is unable to lock to your genlock source, it will automatically 
lock to the internal reference. However, if MXO2 is unable to do this, 
you’ll need to manually set the genlock to Internal or select a different 
genlock source.

4 Under Genlock Video Format, select your external genlock source’s video 
format. When the genlock source is set to Internal, the genlock video format 
is set to your main video output format.

¡ Important To ensure good output results, make sure that your genlock 
source’s video format is compatible with the MXO2 video output format.

5 Under Advanced Settings, drag the Horizontal Delay and Vertical Delay 
sliders to adjust the horizontal and vertical timing of your video outputs with 
respect to your genlock source. This lets you compensate for cable delays 
within your system.

6 Click OK to save your settings.
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Specifying your audio output settings
The simultaneous audio outputs on your Matrox MXO2 hardware allow you to 
send your audio to a variety of devices at the same time. Your Avid editing 
application and Matrox provide various settings to configure your audio output 
on MXO2.

°To specify your audio output settings:

1 Click the Settings tab in the Project window, and then double-click Audio 
Project.

2 In the Audio Project Settings dialog box, click the Output tab and specify 
your desired audio output settings as explained in your Avid documentation. 
To map tracks directly to audio output channels on your Matrox hardware, 
click the Mix Mode Selection button to select Direct Out, and then select an 
output channel on MXO2 for each audio track in your sequence.

Remarks
$ The Allow 16 channel output option is not supported on MXO2.

$ For surround sound HDMI audio output, Matrox MXO2 supports the 5.1 
and 7.1 SMPTE settings only.

$ Matrox MXO2 supports the Audio tool so that you can monitor the global 
output level of your sequence. If needed, you can use the Output Gain 
(master attenuator) slider to adjust the overall output volume for all tracks.

3 Click the Hardware tab in the Audio Project Settings dialog box, and 
then click the Hardware Setup ( ) button.
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4 Under Analog Audio Volume, drag the sliders to adjust the volume of your 
analog audio output. By default, the sliders are locked so that they move 
together. To move each slider independently, click the lock button ( ) to 
disable it.

5 Under SDI Audio Output Format, select the bit depth you want for your 
embedded SDI audio output (20-bit or 24-bit). This setting is not available 
on MXO2 Mini.

6 Under HDMI Audio Output, select Output only two audio channels if 
you want to output two audio channels from the MXO2 HDMI output, 
instead of eight channels. This option is especially useful for HDMI 
monitors that don’t accept more than two audio channels.

7 Select Use system sound card if you want to use your system’s sound card 
to output audio played back from your sequence. Make sure this option is 
cleared if you want audio to be output from your MXO2 system (this ensures 
accurate A/V sync during playback).

8 Click OK to save your settings.
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Defining your capture settings
The Matrox Capture Settings dialog box provides settings that allow you to 
capture material from any of your MXO2 system’s video and audio inputs. The 
settings available are based on your project’s video format and your input source 
(video is always captured to your project’s video format). For a list of the 
supported capture formats, see Appendix C, “Matrox MXO2 Supported Input 
and Capture Formats.” For a list of the supported video output formats for 
previewing your captured video, see “Supported video output formats during 
capture” on page 278.

To capture video and audio on Matrox MXO2, make sure that your video input 
and audio input sources in the Capture tool are set to Matrox. For details on 
how to capture material using Avid Media Composer, see your Avid 
documentation.

If you want to capture material using RS-422 device control, you can connect the 
RS-422 connector on Matrox MXO2, MXO2 Rack, or MXO2 LE to the RS-422 
serial device control port on your source device (see “MXO2 RS-422 serial 
connection” on page 18, “MXO2 Rack RS-422 serial connection” on page 27, or 
“MXO2 LE RS-422 serial connection” on page 36). On Matrox MXO2 Mini, 
you must use a suitable adapter (RS-232 to RS-422 or USB to RS-422 adapter) to 
connect the serial device control port on your source device to your 
computer.When configuring your deck for RS-422 device control, the RS-422 
connector on your MXO2 hardware is usually identified as the COM3 port.

°To specify your capture settings:

1 Do one of the following:

$ Click the Settings tab in the Project window, and then double-click 
Video Input.
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$ In the Capture tool, click the Hardware Setup ( ) button.

2 From the Input Type list, select the type of equipment you’re using for 
capture:

$ Broadcast-quality Source Select this if your source device is 
broadcast-quality. This setting provides the best capture results for most 
devices.

$ Consumer-quality Source Select this if you’re having problems 
capturing video because your source device doesn’t meet 
broadcast-quality standards. For example, the capture may be interrupted 
when you try to capture from certain composite and S-Video devices, 
especially from low-quality VCRs. If this happens, selecting 
Consumer-quality Source will allow the video to be captured, but you 
may experience dropped frames during the capture.

¦ Note For any change to the input type to take effect, you must restart Avid 
Media Composer and open your project again.

3 From the Video Input Source list, select the type of video you want to 
capture. For example, to capture material from your composite source, select 
Composite. The available video input sources depend on your project’s 
video format.
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4 From the Video Input Format list, select the video format that matches 
your source video. If required, your source video will be scaled during 
capture to match your project’s video format. The formats available depend 
on your selected input source. For information about the supported capture 
formats, see Appendix C, “Matrox MXO2 Supported Input and Capture 
Formats.”

5 From the Input Aspect Ratio list, select the aspect ratio of your SD source 
video (4:3 or 16:9). For example, to capture SD video that was recorded 
using the standard TV screen format, select 4:3. To capture SD video that 
was recorded using the widescreen 16:9 format, select 16:9. If you’re 
capturing HD video, the Input Aspect Ratio will be set to 16:9.

6 Under Aspect Ratio Conversion, specify the type of aspect ratio 
conversion that you want to be applied to your captured video (used when 
upscaling or downscaling video during capture):

$ 16x9 Letterbox Captures the widescreen 16:9 picture as letterbox 
video by adding black bars at the top and bottom of the picture for display 
on a standard 4:3 television screen.

$ 4x3 Pillarbox Captures the standard 4:3 picture as pillarbox video by 
adding black bars at the left and right sides of the picture for display on a 
widescreen 16:9 television screen.

$ Center Cut Captures the widescreen 16:9 picture by evenly cropping 
the left and right sides of the picture for display on a standard 4:3 
television screen.

$ Center Zoom Captures the standard 4:3 picture by evenly cropping the 
top and bottom edges of the picture for display on a widescreen 16:9 
television screen.

$ None No aspect ratio conversion is applied. If your project and source 
video have different aspect ratios, the video will be captured as 
horizontally or vertically compressed (anamorphic) video.

7 If you’re working in a 1080p project, from the Video Output Format list, 
select the format (p or PsF) that you want for previewing your captured 
video. For example, if you’re capturing to 1080p @ 25 fps, you can choose 
to output 1080p or 1080PsF @ 25 fps video for preview.

8 Under Audio Input Source, select your audio source. For example, if you 
want to capture the embedded audio of your HDMI source, select HDMI 
(embedded audio). Your audio input source may be set for you based on 
your selected video input source.

¦ Note When capturing HDMI embedded audio, only uncompressed 
embedded audio is supported.
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9 Select Use Automatic Gain Control (AGC) if you want the gain of your 
composite or S-Video input signal to be adjusted automatically to 
compensate for very bright or dark images. This improves the brightness or 
contrast of your picture.

10 Click OK to save your settings.

Remarks
• To capture video on Matrox MXO2, your project’s color space must be set to 

YCbCr.

• Matrox MXO2 supports the Audio tool so that you can monitor and adjust 
your audio input levels for capture.

• Capture on Matrox MXO2 is not supported for a 24p NTSC, 24pPAL, or 
720p/29.97 project.

• When Matrox MXO2 is outputting video for previewing your captured 
video, attempting to open the Matrox Playback Settings dialog box will 
stop the video preview and the Capture tool will lose the focus. However, 
the Matrox Playback Settings dialog box will not open unless you attempt 
to open it a second time.

Exporting your sequence to tape
You can record your sequence onto tape using device control or manually as 
explained in your Avid documentation. Before exporting to tape, set your desired 
playback settings as explained in “Defining your playback settings” on page 54. 
For a list of the supported video output formats, see “Playback using Avid Media 
Composer” on page 276.

To export to tape without device control, simply play back your sequence and 
record the output from any of the available outputs on your MXO2 system. If 
your recorder supports RS-422 device control, you can connect the RS-422 
connector on Matrox MXO2, MXO2 Rack, or MXO2 LE to the RS-422 serial 
device control port on your recorder (see “MXO2 RS-422 serial connection” on 
page 18, “MXO2 Rack RS-422 serial connection” on page 27, or “MXO2 LE 
RS-422 serial connection” on page 36). On Matrox MXO2 Mini, you must use a 
suitable adapter (RS-232 to RS-422 or USB to RS-422 adapter) to connect the 
serial device control port on your recorder to your computer. When configuring 
your deck for RS-422 device control, the RS-422 connector on your MXO2 
hardware is usually identified as the COM3 port.

To record the output from your MXO2 system using device control with the 
Digital Cut tool, make sure that the Output Mode is set to Real-Time. For 
details on using the Digital Cut tool, see your Avid documentation.

¡ Important If you want to downconvert a 720p/23.976, 1080p/23.976, or 
1080p24 sequence to SD to record a digital cut, you must change your project’s 
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format (project type) to SD. For example, to downconvert a 720p/23.976 or 
1080p/23.976 sequence to NTSC to record a digital cut, you must change the 
project type to 23.976p NTSC. You can then select the output format that you 
want in the Digital Cut tool.
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Using Matrox MXO2 with Adobe

Premiere Pro
This chapter explains how to 
define various settings for 
using Matrox MXO2 with 
Adobe Premiere Pro. This 
includes creating a new Matrox 
project, and specifying your 
sequence and export settings.
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Running antivirus software with Adobe 
Premiere Pro

To avoid having dropped frames or other performance issues when working with 
your Matrox project, make sure that you disable any antivirus scanning of files 
while running Adobe Premiere Pro. If possible, schedule your antivirus scanning 
at a time when you’re not using Premiere Pro, such as overnight or on the 
weekend.

Creating a new Matrox project
Creating a new Matrox project involves specifying the location of your scratch 
disks and selecting a Matrox sequence preset.

°To create a new Matrox project:

1 Start Adobe Premiere Pro and click the New Project icon. The New 
Project dialog box appears. You can leave all the settings on the General 
page at the default settings. For details on changing these settings, see your 
Adobe Premiere Pro documentation.

2 Click the Scratch Disks tab, and use the Browse button to select an 
appropriate A/V drive for each scratch disk type. When specifying the 
location of your scratch disks, make sure you follow the recommendations in 
your Adobe Premiere Pro documentation. For example, store your video and 
audio files on a separate hard drive dedicated to your media assets.

¥ Tip Specifying the same scratch disk settings for all your projects will help 
shorten the amount of time it takes to open new or existing projects.

3 From the Location list, select where you want to save your project.

4 In the Name box, specify a name for your project.

5 Click OK to save your settings. The New Sequence dialog box opens on 
the Sequence Presets page.

6 Under Available Presets, select the preset that matches the type of 
sequence you want to create from the appropriate Matrox folder. For 
example, if you want to create an NTSC sequence and work in a standard 4:3 
editing environment, expand the 720×486 and NTSC folders under
Matrox - SD, then select the Standard preset. 

¦ Note To work with PAL DV clips, make sure that you select a Matrox 
DV-PAL sequence preset.

7 In the Sequence Name box, specify a name for your sequence.

8 Click OK to apply the settings.

¦ Note If you want to export your sequence to a DV-1394 device other than 
DVCPRO HD, you’ll need to copy or import your Matrox sequence into a native 
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Adobe Premiere Pro sequence. For more details about exporting to tape, see 
“Exporting your sequence to tape” on page 111.

Creating a custom Matrox NTSC sequence 
preset for NTSC XDCAM IMX clips

If you want to work with NTSC XDCAM IMX clips in a Matrox sequence and 
export your sequence to NTSC IMX format, you’ll need to create a custom 
Matrox NTSC preset for your sequence and change the Fields setting to Upper 
Field First as follows:

1 In the New Sequence dialog box under Available Presets, select the 
Matrox NTSC Standard or Widescreen preset, depending on the type of 
XDCAM IMX clips you have.

2 Click the Settings tab, and from the Fields list, select Upper Field First.

3 Click Save Preset, enter a name for your preset (such as Matrox NTSC for 
XDCAM IMX), and click OK.

For more information about creating custom presets, see your Adobe Premiere 
Pro documentation.

Defining your player settings
By default, each monitor in Adobe Premiere Pro (Source Monitor, Program 
Monitor, Trim Monitor, etc.) uses the Adobe Player to play material. However, in 
order to also preview the video simultaneously on your video monitor when 
working with Matrox MXO2, your player settings need to be set to use the 
Matrox Player. To do this, choose Edit > Preferences > Player Settings and 
choose Matrox Player as the default player.

Remarks
• When using the Multi-Camera Monitor to preview a multi-camera sequence, 

you can choose between single-camera preview (active camera only) and 
quad-camera preview (all four camera previews) on your video monitor. For 
single-camera preview, select Show Preview Monitor in the Multi-Camera 
Monitor menu. For quad-camera preview, clear Show Preview Monitor.

• You can also use the Matrox Player to preview video played back from the 
timeline on your video monitor when working in Adobe Encore. To set the 
default project player to Matrox Player in Adobe Encore, go to the 
Advanced page of the Project Settings dialog box.
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Displaying warnings in Adobe Premiere Pro’s 
Events panel

Matrox MXO2 uses Adobe Premiere Pro’s Events panel to issue certain error 
messages and warnings. To display these, choose Window > Events. For more 
information about using the Events panel, see your Adobe Premiere Pro 
documentation.

A note about realtime playback capabilities
In most cases, Matrox clips and clips supported by Adobe Premiere Pro that don’t 
have effects, and match the frame size and aspect ratio of your sequence will play 
back in real time. For example, an XDCAM EX or P2 720p @ 29.97 fps clip will 
be realtime in any Matrox 720p sequence. You can also apply various realtime 
effects as explained in Chapter 10, “Setting Up Matrox Effects with Adobe 
Premiere Pro.”

When Premiere Pro requires clips to be rendered, a red render bar appears above 
the clips on the timeline. After playing back your sequence, a red bar will appear 
over any sections of the sequence that have dropped frames. To ensure that you 
don’t have dropped frames when you export your sequence to tape, you should 
play back your sequence and render all sections that have a red render bar before 
performing your export.

Remarks
• For the best quality output when previewing a sequence that has an 

interlaced video format, make sure that you choose Display Both Fields in 
the Program Monitor menu.

• If you set the playback resolution in the Program Monitor to anything other 
than full resolution, a yellow render bar may appear above realtime sections 
of the timeline. However, these sections will still play back in real time.

Defining your sequence settings
The Matrox Playback Settings dialog box has several pages that you can use to 
specify various settings for editing in Adobe Premiere Pro on Matrox MXO2. 
When you select a Matrox sequence preset, a Matrox editing mode is 
automatically set for your sequence, and many settings are optimized for editing 
on Matrox MXO2.

¡ Important The general and audio output settings in the Matrox Playback 
Settings dialog box apply to your entire project. All other settings, however, are 
specific to your sequence. Any video output settings you specify for a particular 
video format will be applied the next time you create a new Matrox sequence in 
that same format. If you change any of the video output settings, the new settings 
will be applied to all previously created sequences that have that video format in 
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your project. For example, if you create a new NTSC sequence, the settings you 
apply for that new NTSC sequence will also be applied to any previously created 
NTSC sequences in your project.

Specifying your general settings
To specify your general sequence settings on Matrox MXO2:

1 Choose Sequence > Sequence Settings and click the Playback 
Settings button. 

2 Click the General tab.

3 Under Video Processing Format, select either 8-bit or 10-bit to indicate 
the bit depth you want to use for processing video in a sequence. When the 
video output for an HD sequence is downconverted to NTSC or PAL, or 
when you are working with a 1440×1080i/p sequence, the video processing 
format will be set to 8-bit.

¦ Note If you select a 10-bit video processing format, you’ll be able to capture 
clips to Matrox 10-bit uncompressed format only. If you also want your 
previews to be rendered to 10-bit format, make sure that you configure the 
Matrox uncompressed codec to 10-bit for your video previews as explained 
in “Defining your video preview settings” on page 90.

4 Use the Preroll/Postroll frames for audio scrubbing sliders to specify the 
number of audio frames you want to be played before/after the location of 
the current-time indicator when you scrub a sequence. This lets you hear 
more audio to help you better identify sounds when scrubbing. For example, 
if you set the number of preroll frames for audio scrubbing to 3, you will 
hear the audio for the current frame and three previous frames when you 
scrub a frame in a sequence.

¦ Note To return a slider to it’s default setting, click its D button. This button 
is available for all sliders in the Matrox dialog boxes.
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5 Under Realtime Engine, you can select the options you want for using 
Matrox RT technology:

$ Enable Matrox RT technology Select this to enable Matrox RT 
technology, which provides realtime Matrox effects and acceleration of 
many Premiere Pro effects. You can clear this option if you want the 
realtime performance of your project to depend only on the capabilities of 
Premiere Pro and your computer system.

$ Premiere Pro Accelerated Effects Select the options you want for 
your realtime/accelerated Premiere Pro effects (available only when 
Matrox RT technology is enabled):

• Accelerate effects and transitions Select this if you want realtime 
playback of Premiere Pro effects and transitions that support this 
feature as explained in Chapter 10, “Setting Up Matrox Effects with 
Adobe Premiere Pro.” Because Matrox emulates Premiere Pro’s native 
version of these effects and transitions, if you don’t like the emulation 
you can clear this option to revert to Premiere Pro’s native version that 
requires rendering.

• Accelerate Motion Select this if you want realtime playback of 
Premiere Pro’s Motion effect. You can clear this option to turn off the 
Matrox acceleration and revert to Premiere Pro’s version that requires 
rendering.

6 Under Error Reporting, select Report dropped frames or lost genlock 
on playback if you want to be warned each time frames are dropped or the 
genlock source signal is lost when you play back video from the Timeline 
panel. Otherwise, clear this option.

¦ Note Once playback of your sequence has stopped, a red bar will appear 
over sections that have dropped frames, even if you don’t choose to report 
dropped frames. To ensure that your sequence will play back without dropped 
frames, you should render all sections identified with red bars as explained in 
your Adobe Premiere Pro documentation.

7 Under Sequence Playback, clear Postroll after stop if you don’t want any 
postroll when you stop the playback of a sequence. When you do this, the 
playback will stop at the current-time indicator, and you’ll see a slight jump 
in the video output when the playback stops (but the correct frame will be 
displayed).

8 Click OK to save your settings and return to the Sequence Settings dialog 
box.
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Specifying your video output settings
This section explains how to specify your video output settings for Matrox 
MXO2, MXO2 Rack, and MXO2 LE. For MXO2 Mini, see “Specifying your 
video output settings (MXO2 Mini)” on page 81.

You can specify various settings to configure the main and secondary outputs 
from your MXO2 system. Some of the settings are predetermined for you based 
on your sequence’s video format. For a list of the supported video output formats, 
see “Playback using Adobe Premiere Pro, Matrox A/V Tools, and Matrox 
WYSIWYG” on page 272.

°To specify your video output settings:

1 Choose Sequence > Sequence Settings and click the Playback 
Settings button. 

2 Click the Video Output tab.
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3 Under Main Output and Secondary Output, you can specify the settings 
you want for your main and secondary outputs from MXO2. Depending on 
your sequence’s video format, you may not be able to change some of the 
settings.

$ Format Use this to select the video format you want for your outputs. 
Be aware that the format you select may not be supported on all the 
MXO2 outputs. For a list of the supported formats, see “Playback using 
Adobe Premiere Pro, Matrox A/V Tools, and Matrox WYSIWYG” on 
page 272.

$ Pulldown Method If this setting is available, select the pulldown 
method you want to be applied to your video output (Standard 2:3 or 
Advanced 2:3:3:2). Depending on your sequence’s frame rate and the 
current video output format, a pulldown method may automatically be 
selected.

$ Aspect Ratio Conversion Use this to specify how you want your 
video to be output when upscaling or downscaling:

• 16x9 Letterbox Outputs the widescreen 16:9 picture in letterbox 
mode by adding black bars at the top and bottom of the picture for 
display on a standard 4:3 television screen.

• 4x3 Pillarbox Outputs the standard 4:3 picture in pillarbox mode by 
adding black bars to the left and right sides of the picture for display on 
a widescreen 16:9 television screen.

• Anamorphic Outputs the widescreen 16:9 picture as horizontally 
compressed 4:3 video, which retains the picture’s full vertical 
resolution for display on a widescreen television. To display the video 
with the correct proportions on an NTSC or PAL monitor, select the 
16:9 display setting on the monitor.

• Center Cut Outputs the widescreen 16:9 picture by evenly cropping 
the left and right sides of the picture for display on a standard 4:3 
television screen.

• Center Zoom Outputs the standard 4:3 picture by evenly cropping 
the top and bottom edges of the picture for display on a widescreen 
16:9 television screen.

¦ Note When aspect ratio conversion is applied to both the main and 
secondary outputs, the same setting will be applied to both outputs.

4 Under Analog Output, you can specify your analog output format, NTSC 
setup level, and output type:

$ Format Use this to specify whether you want the format for the analog 
outputs to be the same as the main or secondary output.
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$ Output Type Specifies the analog video output type. If you’re 
outputting SD analog video, the output type will be set to All Available to 
indicate that the output will be available on all the analog outputs. If 
you’re outputting HD analog video, the output type will be set to 
Component.

$ Setup (NTSC) Use this to select the setup level you want for your 
NTSC analog video:

• 0 IRE Applies a setup level of 0 IRE. You should select this option 
only when working with a commercial DV device that uses the 
Japanese analog NTSC setup of 0 IRE. For example, if the video 
appears too bright when you play back DV clips on your NTSC 
monitor, you can change the setup to 0 IRE to output your DV clips at 
the correct brightness.

• 7.5 IRE Applies the standard NTSC setup level of 7.5 IRE.

$ YUV/RGB Select YUV or RGB - native to set the type of video signal 
that is sent from the component output. For example, select RGB - native 
if you connected the component output to a device that accepts an RGB 
signal.

5 Under HDMI Output, you can specify your HDMI output format and type.

$ Format Use this to specify whether you want the format for your 
HDMI output to be the same as the main or secondary output.

$ YUV/RGB Select the type of video signal that you want to be sent from 
the HDMI output:

• YUV Outputs YUV HDMI video. Select this only if you connected 
the HDMI output to a device that accepts a YUV signal.

• RGB - calibrated Outputs adjusted RGB HDMI video using the 
currently loaded Matrox HDMI calibration settings for your HDMI 
monitor or television. For details on calibrating your HDMI monitor 
and loading calibration settings using the Matrox HDMI Calibration 
Utility, see Chapter 7, “Calibrating Your HDMI Monitor for Video.”

• RGB - native Outputs native RGB HDMI video that does not apply 
any calibration compensation. This is useful when you want to output 
RGB HDMI video to a device other than an HDMI monitor or 
television, such as an HDMI recorder to perform an export to tape.

$ 3D Viewing Mode Select the 3D signal type that you want to be sent 
from the HDMI output to your 3D monitor:

• Disabled Select this if you’re not outputting 3D video, or to disable 
3D video output. You can still monitor 3D video, but you must select 
the correct viewing mode on your 3D monitor manually.
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• Side-by-side Outputs horizontally compressed side-by-side 3D 
video (also referred to as side-by-side horizontal).

• Over/Under Outputs over/under 3D video (also referred to as top 
bottom).

¦ Note This feature may not be supported on some 3D monitors.

6 Under SDI Output, specify whether you want the format for your SDI 
output to be the same as the main or secondary output.

7 Under Advanced, you can specify advanced video output settings.

$ Analog SC/H Phase Use this slider to advance or delay your analog 
video output’s subcarrier phase with respect to the horizontal sync of the 
genlock source (for composite video only).

$ Allow Super White/Allow Super Black Select Allow Super White 
to allow the highest luminance level of your video output to exceed the 
standard maximum white level. Select Allow Super Black to allow the 
lowest luminance level of your video output to fall below the standard 
black level. These options apply to all video outputs.

¦ Note Super white and super black should not be allowed when producing 
your final video production for broadcast.

8 Click OK to save your settings.
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Specifying your video output settings (MXO2 
Mini)
You can specify various settings to configure your main analog output and 
secondary HDMI output from the MXO2 Mini. Some of the settings are 
predetermined for you based on your sequence’s video format. For a list of the 
supported video output formats, see “Playback using Adobe Premiere Pro, 
Matrox A/V Tools, and Matrox WYSIWYG” on page 272.

°To specify your video output settings:

1 Choose Sequence > Sequence Settings and click the Playback 
Settings button. 

2 Click the Video Output tab.

3 Under Analog Output (Main), you can specify the settings you want for 
your analog output from MXO2 Mini. Under HDMI Output (Secondary) 
you can specify the settings you want for your secondary HDMI output. 
Depending on your sequence’s video format, you may not be able to change 
some of the settings.

$ Format Use this to select the video format you want for your outputs. 
For a list of the supported formats, see “Playback using Adobe Premiere 
Pro, Matrox A/V Tools, and Matrox WYSIWYG” on page 272.
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$ Pulldown Method If this setting is available, select the pulldown 
method you want to be applied to your video output (Standard 2:3 or 
Advanced 2:3:3:2). Depending on your sequence’s frame rate and the 
current video output format, a pulldown method may automatically be 
selected.

$ Setup (NTSC) Use this to select the setup level you want for your 
NTSC analog video (applies to main analog output only):

• 0 IRE Applies a setup level of 0 IRE. You should select this option 
only when working with a commercial DV device that uses the 
Japanese analog NTSC setup of 0 IRE. For example, if the video 
appears too bright when you play back DV clips on your NTSC 
monitor, you can change the setup to 0 IRE to output your DV clips at 
the correct brightness.

• 7.5 IRE Applies the standard NTSC setup level of 7.5 IRE.

$ Aspect Ratio Conversion Use this to specify how you want your 
video to be output when upscaling or downscaling:

• 16x9 Letterbox Outputs the widescreen 16:9 picture in letterbox 
mode by adding black bars at the top and bottom of the picture for 
display on a standard 4:3 television screen.

• 4x3 Pillarbox Outputs the standard 4:3 picture in pillarbox mode by 
adding black bars to the left and right sides of the picture for display on 
a widescreen 16:9 television screen.

• Anamorphic Outputs the widescreen 16:9 picture as horizontally 
compressed 4:3 video, which retains the picture’s full vertical 
resolution for display on a widescreen television. To display the video 
with the correct proportions on an NTSC or PAL monitor, select the 
16:9 display setting on the monitor.

• Center Cut Outputs the widescreen 16:9 picture by evenly cropping 
the left and right sides of the picture for display on a standard 4:3 
television screen.

• Center Zoom Outputs the standard 4:3 picture by evenly cropping 
the top and bottom edges of the picture for display on a widescreen 
16:9 television screen.

$ Output Type (for analog output) For your main analog output, you can 
select Component, or Composite & S-Video if you’re outputting SD 
analog video. If you’re outputting HD analog video, the output type will 
be set to Component (and the composite and S-Video outputs will be 
invalid). 

$ YUV/RGB (for analog output) Select YUV or RGB - native to set the 
type of video signal that is sent from the component output. For example, 
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select RGB - native if you connected the component output to a device 
that accepts an RGB signal.

$ YUV/RGB (for HDMI output) Select the type of video signal that you 
want to be sent from the HDMI output:

• YUV Outputs YUV HDMI video. Select this only if you connected 
the HDMI output to a device that accepts a YUV signal.

• RGB - calibrated Outputs adjusted RGB HDMI video using the 
currently loaded Matrox HDMI calibration settings for your HDMI 
monitor or television. For details on calibrating your HDMI monitor 
and loading calibration settings using the Matrox HDMI Calibration 
Utility, see Chapter 7, “Calibrating Your HDMI Monitor for Video.”

• RGB - native Outputs native RGB HDMI video that does not apply 
any calibration compensation. This is useful when you want to output 
RGB HDMI video to a device other than an HDMI monitor or 
television, such as an HDMI recorder to perform an export to tape.

$ 3D Viewing Mode Select the 3D signal type that you want to be sent 
from the HDMI output to your 3D monitor:

• Disabled Select this if you’re not outputting 3D video, or to disable 
3D video output. You can still monitor 3D video, but you must select 
the correct viewing mode on your 3D monitor manually.

• Side-by-side Outputs horizontally compressed side-by-side 3D 
video (also referred to as side-by-side horizontal).

• Over/Under Outputs over/under 3D video (also referred to as top 
bottom).

¦ Note This feature may not be supported on some 3D monitors.

4 Under Advanced, select Allow Super White to allow the highest 
luminance level of your video output to exceed the standard maximum white 
level. Select Allow Super Black to allow the lowest luminance level of your 
video output to fall below the standard black level. These options apply to 
both the main analog output and secondary HDMI output.

¦ Note Super white and super black should not be allowed when producing 
your final video production for broadcast.

5 Click OK to save your settings.
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Specifying your genlock settings

¦ Note This section does not apply to Matrox MXO2 Mini.

You can select the source to which you want to genlock all devices connected to 
your MXO2 system, as well as adjust the timing settings for all video outputs 
from MXO2.

For examples of how to connect an external sync source to your system, see 
“Typical Matrox MXO2 connections” on page 19, “Typical Matrox MXO2 Rack 
connections” on page 28, and “Typical Matrox MXO2 LE connections” on 
page 37. When using Matrox RS-422 device control with an analog device, you 
need to connect an external broadcast-quality analog sync source, such as a 
tri-level sync generator, as shown in the illustrations.

°To specify your genlock settings:

1 Choose Sequence > Sequence Settings and click the Playback 
Settings button.

2 Click the Genlock tab.

3 From the Genlock Source list, select one of the following:

$ Internal Genlock to MXO2’s internal reference signal. Select this 
option only if you don’t have an external sync generator or other reliable 
external video sync source.

$ Black Burst Broadcast Quality Genlock to an external analog sync 
source connected to the reference (REF) input on MXO2. This must be a 
stable sync source, such as an external sync generator (bi-level black burst 
for SD or tri-level sync for HD), or a source VTR that has a built-in TBC.

$ Analog Input, SDI Input, and HDMI Input Genlock to your analog, 
SDI, or HDMI video source connected to the video input on MXO2.
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¦ Note The status of your genlock source will be displayed, such as Locked 
or Not Locked, to indicate whether or not MXO2 is presently locked to your 
selected genlock source. When you change the genlock source, distorted video 
and silent audio will be output until MXO2 locks to the new genlock source.

4 Under Genlock Video Format, select your genlock source’s video format. 
If you can’t select a video format, make sure that your genlock source 
matches the specified video format. When the genlock source is set to 
Internal, the genlock video format is set to your main video output format.

5 Under Advanced Settings, drag the Horizontal Delay and Vertical Delay 
sliders to adjust the horizontal and vertical timing of your video outputs with 
respect to your genlock source. This lets you compensate for cable delays 
within your system.

6 Click OK to save your settings.
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Specifying your audio output settings
The audio output page lets you adjust various settings for your audio output from 
your MXO2 system. For example, you can adjust the volume of your analog 
audio output before or while playing back clips, and choose to output audio 
through your system’s sound card instead of your MXO2 system.

°To specify your audio output settings:

1 Choose Sequence > Sequence Settings and click the Playback 
Settings button.

2 Click the Audio Output tab.

3 Under Analog Audio Volume, drag the sliders to adjust the volume of your 
analog audio output. By default, the sliders are locked so that they move 
together. To move each slider independently, click the lock button ( ) to 
disable it.

4 Under SDI Audio Output Format, select the bit depth you want for your 
embedded SDI audio output (20-bit or 24-bit). This setting is not available 
on MXO2 Mini.

5 Under HDMI Audio Output, select Output only two audio channels if 
you want to output two audio channels from the MXO2 HDMI output, 
instead of eight channels. This option is especially useful for HDMI 
monitors that don’t accept more than two audio channels.
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¦ Note This option is available only if your sequence has a 5.1 or 16-channel 
master audio track. Otherwise, only two HDMI audio channels are output by 
default.

6 Select Use system sound card if you want to use your system’s sound card 
to output audio played back from your sequence. Make sure this option is 
cleared if you want audio to be output from your MXO2 system (this ensures 
accurate A/V sync during playback). For any change to this option to take 
effect, you’ll be required to restart Adobe Premiere Pro and open your 
project again.

7 Click OK to save your settings.

Specifying your DV-1394 output settings
You can choose to output a Matrox sequence over the 1394 interface to perform 
an export to a DVCPRO HD device.

¦ Note DV-1394 export to DVCPRO HD is supported for 1080i @ 25 fps, 
29.97 fps, and 720p @ 59.94 fps sequences only. For more information about 
exporting to a DVCPRO HD device, see “Exporting to a DVCPRO HD device 
using DV-1394 device control” on page 115.

°To specify your DV-1394 output settings:

1 Choose Sequence > Sequence Settings and click the Playback 
Settings button. 

2 Click the DV-1394 Output tab.

3 Select Enable 1394 output for export to tape if you want your sequence 
to be output over the 1394 interface when you perform an export to tape (that 
is, when you choose File > Export > Export to Tape). This lets you record 
your sequence to a DVCPRO HD device.

¡ Important Because this option requires additional system resources, you 
may find that when this option is selected some effects that were previously 
realtime will drop frames and require rendering (you’ll see a red bar over 
these segments after playing back your sequence). Therefore, you should 
select this option only when you want to export your sequence to a 
DVCPRO HD device.

4 Click OK to save your settings and return to the Sequence Settings dialog 
box.
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Specifying your closed captioning settings

¦ Note This section does not apply to Matrox MXO2 Mini.

You can specify various settings for playing back and exporting to tape closed 
captions that you’ve attached to your sequence on Matrox MXO2. For example, 
you can choose to embed the closed captioning data in the SDI VANC output for 
display on an SDI video monitor that supports closed captioning. You can also 
choose to overlay the closed captions on all the Matrox MXO2 video outputs for 
display on video monitors that don’t have a closed captioning feature.

For details on how to attach a closed caption data file to your sequence, see your 
Adobe Premiere Pro documentation. To determine your video monitor’s 
capabilities for displaying closed captioning, check your video monitor’s 
documentation.

°To specify your closed captioning settings:

1 Choose Sequence > Sequence Settings and click the Playback 
Settings button. 

2 Click the Closed Captioning tab.

3 Under Embedding Options, select the options that you want for 
embedding the closed captioning data in the Matrox MXO2 video output 
during playback:

$ Embed in SDI VANC Select this to embed the closed captioning data in 
the SDI video output’s VANC for display on an SDI video monitor.

$ Embed in SDI line 21 (NTSC) Select this to embed the closed 
captioning data in line 21 of the VBI portion of the SDI video output for 
display on an SDI NTSC video monitor.

$ Embed in analog line 21 (NTSC) Select this to embed the closed 
captioning data in line 21 of the VBI portion of the analog video output 
for display on an analog NTSC video monitor.

¡ Important Embedding closed captioning in the video output is supported 
only when the frame rate of the video output matches your sequence’s frame 
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rate. If the frame rate is converted at the output, such as when you apply a 
pulldown, you can still display the closed captions by selecting Enable 
overlay on output as explained below.

4 Under Video Output Display, select Enable overlay on output to overlay 
the closed captions on all the MXO2 video outputs, which lets you display 
closed captioning on video monitors that don’t have a closed captioning 
feature. This option will be available only if closed captioning display is 
enabled in the Adobe Premiere Pro Program Monitor menu.

¦ Note Selecting Enable overlay on output may cause dropped frames in 
your video output. If you select this option and also choose to embed the closed 
captioning in the video output, you should turn off the closed captioning 
feature for all video monitors connected to the MXO2 video outputs to avoid 
simultaneously displaying both the embedded and overlaid closed captions.

5 Click OK to save your settings and return to the Sequence Settings dialog 
box.
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Defining your video preview settings
When you select a Matrox sequence preset, an appropriate Matrox preview file 
format and codec are automatically set for previewing your video on MXO2. 

Depending on your sequence’s video format, you can select a different Matrox 
codec to render your video previews. For details on configuring the Matrox 
MPEG-2 I-frame codec settings, see “Selecting your MPEG-2 I-frame settings” 
on page 100.

Remarks
• The Matrox DVCPRO HD codec is supported for rendering video previews 

in 1080i @ 25 fps and 29.97 fps sequences only. 

• For an SD sequence, make sure that the preview file format matches your 
sequence’s format (standard or widescreen).

• To use the Matrox MPEG-2 I-frame codec for rendering video previews in 
an NTSC or 486p sequence, select the appropriate MPEG-2 I-frame preview 
file format, such as MPEG-2 I-frame NTSC Standard for a Matrox NTSC 
standard sequence.

For details on specifying additional settings for your video previews, see your 
Adobe Premiere Pro documentation.
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Defining your capture settings
The Matrox Capture Settings dialog box has pages that you can use to specify 
your settings for capturing video and audio in Adobe Premiere Pro on Matrox 
MXO2. The settings available are based on your sequence’s video format and 
your input source (video is always captured to your sequence’s editing video 
format). For a list of the supported capture formats, see Appendix C, “Matrox 
MXO2 Supported Input and Capture Formats.” For a list of the supported video 
output formats for previewing your captured video, see “Supported video output 
formats during capture” on page 278.

If you want to capture material using RS-422 device control, see “Setting up 
Matrox RS-422 device control” on page 107. If you want to capture material 
from a DV-1394 device using device control, you can use Adobe DV/HDV 
device control as explained in your Adobe Premiere Pro documentation.

¦ Note When you specify your capture settings on Matrox MXO2, VU meters 
can be displayed to let you monitor your audio input levels. For more 
information, see “Monitoring audio levels for capture” on page 98.

Specifying your video capture settings
Matrox MXO2 lets you capture your video to MPEG-2 I-frame or an 
uncompressed format, depending on your sequence’s video format. For example, 
if you’re working with an SD sequence (such as NTSC), you can capture to 
MPEG-2 I-frame format to create .avi files for use in your Premiere Pro projects. 
For certain HD sequences, you can also capture DVCPRO HD material natively 
over the DV-1394 interface to an .avi file.

When working with an SD sequence, you can choose to capture video to an .m2v 
file for DVD authoring using Adobe Encore. For details about specific limitations 
when capturing to Matrox .m2v files, see “Notes about capturing to Matrox .m2v 
files” on page 99.

°To specify your video capture settings:

1 Choose Project > Project Settings > General.

2 From the Capture Format list, select Matrox AVI to capture to an .avi file, 
or Matrox M2V to capture to an .m2v file (for SD sequences only). 

¦ Note If you want to capture DV material other than DVCPRO HD natively 
over the 1394 interface, you need to use a native Adobe Premiere Pro DV or 
HDV capture format. For details on how to capture material in Adobe Premiere 
Pro, see your Adobe Premiere Pro documentation.
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3 Click the Configure button, then click the Video Capture Settings tab.

4 Under Input Device, select the device from which you want to capture 
material (this may be automatically set for you based on your sequence’s 
video format):

$ MXO2, MXO2 Rack, MXO2 LE, or MXO2 Mini to capture material from 
a device connected to MXO2.

$ DV-1394 to capture material from a DV-1394 device connected to your 
system. For capture to a Matrox .avi file, DV-1394 input is supported only 
for native DVCPRO HD capture when working with 1080i, 1080p 
@ 29.97 fps, and 720p @ 23.98 fps, 25 fps, 29.97 fps, and 59.94 fps 
sequences. For capture to a Matrox .m2v file, DV-1394 input is supported 
for all SD sequences.

¦ Note Capturing audio from a DV-1394 device is not supported for a 720p 
@ 25 fps sequence.

5 If you’re capturing material from a device connected to MXO2, from the 
Input Source list, select the type of input you want to capture. For example, 
to capture material from your HDMI source, select HDMI. If you’re 
capturing material from a DV-1394 device, the name of the device will 
appear in the Input Source box. The available input sources depend on your 
sequence’s video format.

¦ Note If Matrox MXO2 can’t detect your source device when you start a 
capture, you’ll receive an error message. Either black video will be captured 
or the capture won’t be able to start until a valid input signal is present. In 
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either case, you must make sure that your source device is switched on and 
properly connected to MXO2 to properly capture the video.

6 From the Input Format list, select the video format that matches your 
source video. If required, your source video will be scaled during capture to 
match your sequence’s video format. The formats available depend on your 
selected input source. For information about the supported capture formats, 
see Appendix C, “Matrox MXO2 Supported Input and Capture Formats.”

7 From the Input Aspect Ratio list, select the aspect ratio of your SD source 
video (4:3 or 16:9). For example, to capture SD video that was recorded 
using the standard TV screen format, select 4:3. To capture SD video that 
was recorded using the widescreen 16:9 format, select 16:9. If you’re 
capturing HD video, the Input Aspect Ratio will be set to 16:9.

8 Under Capture Format, select your desired capture format from the list. If 
you’re capturing DVCPRO HD material to an .avi file from a DV-1394 
device, the video will be captured natively over the DV-1394 interface and 
the Capture Format will be set to Native DVCPRO HD. If you’re 
capturing to an .m2v file, the Capture Format will be set to Matrox 
MPEG-2 IBP.

$ Matrox 8-bit Uncompressed Captures video to 8-bit uncompressed 
format.

$ Matrox 10-bit Uncompressed Captures video to 10-bit 
uncompressed format. This is the only capture format available for a 
sequence that has a 10-bit video processing format, and is not available 
for an 8-bit sequence. 

¦ Note If you want to capture to a format other than Matrox 10-bit 
Uncompressed, you can switch the video processing format (on the General 
page) to 8-bit, and then change back to 10-bit after you’ve completed your 
capture.

$ Matrox MPEG-2 I-frame Captures video to MPEG-2 intra-frame 
format using the 4:2:2 Profile @ Main Level at a selected data rate (SD 
resolution only). 

$ Matrox MPEG-2 I-frame  HD Captures video to MPEG-2 intra-frame 
format using the 4:2:2 Profile @ High Level at a selected data rate (HD 
resolution only). This is the only capture format available for a 
1440×1080i sequence.

9 If you’re capturing to a Matrox MPEG-2 format, click the Configure button 
to configure your MPEG-2 settings. For details on the available settings, see 
“Selecting your MPEG-2 I-frame settings” on page 100 or “Selecting your 
MPEG-2 IBP settings” on page 102. Once you’ve configured your settings, 
click OK to return to the Matrox Capture Settings dialog box.
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10 Under Aspect Ratio Conversion, specify the type of aspect ratio 
conversion that you want to be applied to your captured video (used when 
upscaling or downscaling video during capture only):

$ 16x9 Letterbox Captures the widescreen 16:9 picture as letterbox 
video by adding black bars at the top and bottom of the picture for display 
on a standard 4:3 television screen.

$ 4x3 Pillarbox Captures the standard 4:3 picture as pillarbox video by 
adding black bars at the left and right sides of the picture for display on a 
widescreen 16:9 television screen.

$ Anamorphic Captures the widescreen 16:9 picture as horizontally 
compressed 4:3 video, which retains the picture’s full vertical resolution 
for display on a widescreen television. To display the video with the 
correct proportions on an NTSC or PAL monitor, select the 16:9 display 
setting on the monitor.

$ Center Cut Captures the widescreen 16:9 picture by evenly cropping 
the left and right sides of the picture for display on a standard 4:3 
television screen.

$ Center Zoom Captures the standard 4:3 picture by evenly cropping the 
top and bottom edges of the picture for display on a widescreen 16:9 
television screen.

11 If you’re capturing Panasonic VariCam material, select Enable VariCam 
capture (supported only for a 720p @ 23.98 fps or 25 fps sequence). 
Matrox MXO2 will remove the redundant (filler) frames from the VariCam 
input during capture and create a clip in the same format as your sequence 
for editing. 

¡ Important When you select Enable VariCam capture, audio cannot be 
captured. When batch capturing VariCam clips, you must indicate that you 
want to capture video only by selecting Video on the Logging pane of the 
Capture panel under Setup.

12 Select Use Automatic Gain Control (AGC) if you want the gain of your 
composite or S-Video input signal to be adjusted automatically to 
compensate for very bright or dark images. This improves the brightness or 
contrast of your picture.

13 From the Input Type list, select the type of equipment you’re using for 
capture:

$ Broadcast-quality Source Select this if your source device is 
broadcast-quality. This setting provides the best capture results for most 
devices.

$ Consumer-quality Source Select this if you’re having problems 
capturing video because your source device doesn’t meet 
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broadcast-quality standards. For example, the capture may be interrupted 
when you try to capture from certain composite and S-Video devices, 
especially from low-quality VCRs. If this happens, selecting 
Consumer-quality Source will allow the video to be captured, but you 
may experience dropped frames during the capture.

¦ Note For any change to the input type to take effect, you must restart 
Premiere Pro and open your project again.

14 If you’re working in a 1080p @ 23.98 fps, 24 fps, 25 fps, or 29.97 fps 
sequence, from the Output Format list, select the format (p or PsF) that you 
want for previewing your captured video. For example, if you’re capturing to 
1080p @ 25 fps, you can choose to output 1080p or 1080PsF @ 25 fps video 
for preview.

15 Click OK to save your settings and return to the Project Settings dialog 
box. 

Specifying your audio capture settings
You can specify various audio capture settings, such as to specify your input 
source and the type of audio files (either stereo .wav or mono .wav) that you want 
to create when capturing audio on Matrox MXO2.

Remarks
• When you capture to an .avi file on Matrox MXO2, the clip’s video and 

audio are saved to the .avi file, and the clip’s audio is also saved to one or 
more separate .wav files. You could choose to edit the separate .wav files 
using audio post-processing software, such as Adobe Soundbooth.

• When you capture to an .m2v file on Matrox MXO2, the clip’s associated 
audio is always saved to one or more separate .wav files.

°To specify your audio capture settings:

1 Choose Project > Project Settings > General.

2 From the Capture Format list, select Matrox AVI to capture to an .avi file, 
or Matrox M2V to capture to an .m2v file (for SD sequences only).
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3 Click the Configure button, then click the Audio Capture Settings tab:

4 From the Input Source list, select your audio source. For example, if you 
want to capture the embedded audio of your HDMI source, select HDMI 
(embedded audio). Your audio input source may be set for you based on 
your selected video input source.

¦ Note When capturing HDMI embedded audio, only uncompressed 
embedded audio is supported.

5 Under Capture Format, select the bit-depth for your captured audio files. If 
you’re capturing from a DV-1394 device, the Capture Format will be set to 
16-bit.

6 If you want the VU meters to be displayed each time you configure your 
Matrox MXO2 capture settings or open the Capture panel to start a capture, 
select Show VU meters. This option is not available if you’re working with 
1080i/p @ 29.97 fps video and using a 10-bit video processing format. For 
details on using the VU meters, see “Monitoring audio levels for capture” on 
page 98.

7 If you experience dropped frames during capture, select Disable audio 
preview to disable the audio preview only while you’re capturing material.

8 Under Capture Files, indicate whether you want to capture to stereo or 
mono audio files, and select which channels you want to save to separate 
.wav files.
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$ From the File Type list, select Stereo to save your captured audio to 
stereo .wav files, or Mono to save your captured audio to mono .wav files. 
If you’re capturing an .m2v clip, the File Type will be set to Stereo.

$ From the Filename lists, select which stereo pairs or mono channels you 
want to save to your .wav files (up to four stereo files or up to eight mono 
files depending on the type of audio being captured). Select None for the 
particular .wav files you don’t want to be created, or click the D (default) 
button for each Filename list if you want to capture only channels 1 and 
2. When Matrox MXO2 saves each .wav file, it assigns a .Stereo.wav or 
.Mono.wav suffix to the base name you gave for the associated video file. 
For example, if you’ve named your video file MyFile.avi, the associated 
stereo audio files would be named MyFile.Stereo1.wav, 
MyFile.Stereo2.wav, etc. 

Remarks
$ The channels that you choose to save to the first stereo.wav file or first 

two mono.wav files will be embedded in the associated .avi file. When 
you import your .avi file to the Project panel, the clip’s separate .wav files 
will also be imported, and the embedded audio in the .avi file will be 
ignored. The clip’s .avi file and first associated .wav file, however, will 
appear as a single Movie clip in your project. The embedded audio in the 
.avi file will be used only if the .avi file does not have any associated .wav 
files. Therefore, if you perform audio post processing on your .avi files, 
make sure you delete the associated .wav files so that only the embedded 
audio in the .avi files will be used in your project.

$ When performing an audio-only capture, Matrox MXO2 supports capture 
of only one stereo pair. Your first stereo or first two mono channels will be 
saved to a single stereo .wav file (any other channels will be ignored). 
When MXO2 saves the .wav file of an audio-only capture, it does not 
assign the .Stereo.wav suffix to the filename. 

9 Click OK to save your settings and return to the Project Settings dialog 
box. 
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Monitoring audio levels for capture
If you select Show VU meters on the Audio Capture Settings page, each 
time you configure your Matrox MXO2 capture settings or open the Capture 
panel to start a capture in Adobe Premiere Pro, VU meters will be displayed to let 
you monitor the levels of your currently selected audio input source.

As you play your audio source, the color of the input level is green at or below
–12 dBSF, yellow between –12 and –6 dBFS, and red above –6 dBFS. The 
clipping detectors will “light up” (become red) whenever audio clipping occurs. 
The peak level indicators are thin lines that show the highest level recently 
reached. These indicators will show the peak level for about two seconds or until 
a higher peak level is reached.

If needed, adjust the audio level on your source device to keep the average input 
level between –30 and –10 dBSF.

Clipping detectors

Peak level indicators
pter 9, Using Matrox MXO2 with Adobe Premiere Pro



99
Notes about capturing to Matrox .m2v files
When capturing to Matrox .m2v files, keep the following points in mind:

• Automatic scene detection (Scene Detect) is not supported, but batch capture 
is supported.

• Batch capture to Matrox .m2v files is not frame accurate.

• An associated .xmp metadata file is created for all captured and logged 
(offline) .m2v clips. These files are created in your specified video capture 
folder, and contain time code and other information that you provided for 
your .m2v clips, such as tape name, description, and scene. You can open the 
.xmp files in Adobe Bridge. Take care not to delete the .xmp files and always 
keep them with their associated .m2v files. Otherwise, you won’t be able to 
batch capture logged .m2v clips, and the time code information won’t appear 
for your .m2v clips in the Project panel.

• Matrox .m2v files are to be used for DVD authoring with Adobe Encore. 
However, if you want to use your Matrox .m2v clips in Adobe Premiere Pro, 
be aware of the following issues:

$ The associated .wav files for your .m2v clips are not automatically 
imported to the Project panel.

$ When performing a batch capture of .m2v clips, the captured video and 
audio clips won’t be automatically imported to the Project panel. Because 
you won’t be able to link the logged (offline) clips to the captured files on 
disk, you’ll have to import the batch captured .m2v clips manually. As 
well, if you recapture clips using batch capture, captured video clips will 
be imported automatically only if you choose to delete the original media 
files from disk.

$ When you place a Matrox .m2v clip on a video track, an empty associated 
.wav clip will be placed on an audio track beneath it. To get rid of this 
clip, select it in the sequence and choose Clip > Unlink. Once you’ve 
unlinked the .wav from the .m2v, you can select the .wav clip on the audio 
track and delete it.

$ It’s recommended that you don’t add handles (extra frames) to your 
captured .m2v clips. If you do, the handles will be appropriately trimmed 
from the video when you add the clip to your sequence, but the handles 
won’t be trimmed from the associated audio.
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Selecting your MPEG-2 I-frame settings
When you select the Matrox MPEG-2 I-frame or Matrox MPEG-2 I-frame HD 
format to render or capture video, you can specify various settings for the 
MPEG-2 I-frame compression. 

°To select your MPEG-2 I-frame settings: 

1 Click the Configure button. This displays a dialog box similar to the 
following:

2 Drag the Data Rate slider until your desired data rate is displayed. The 
higher the data rate you select, the better the video quality will be. The range 
of available data rates depends on whether you’re using the Matrox MPEG-2 
I-frame HD or SD format.

¡ Important Depending on the capabilities of your system, you may drop 
frames if you select a data rate higher than 125 Mb/sec.

3 To apply advanced settings to your MPEG-2 I-frame file, click the 
Advanced button.

¦ Note The default advanced settings should provide good results for most 
applications. We recommend that you change these settings only when needed 
for special purposes. 

4 Under Rounding Type, select one of the following:

$ MPEG-2 Rounds the AC coefficients up to the nearest whole number 
when calculating the quantization coefficient. 

$ Matrox Custom Truncates the AC coefficients to the lowest whole 
number when calculating the quantization coefficient. In some cases, this 
setting may yield less artifacts in graphics.

5 Under DC Precision, select the bit-depth precision of the DC intra block.
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¦ Note The higher the DC precision value that’s used to capture or render 
your video, the more likely that the DC content will be increased at the expense 
of the AC content in the encoded stream. This may result in lowering the 
overall quality of the compressed stream at a specified data rate. 

6 Under Zig Zag Type, select one of the following:

$ Regular Sets the regular (default) zig zag scanning pattern of the AC 
coefficient of the DCT block as defined in the ISO/IEC 13818-2 (figure 
7-2) specification documentation.

$ Alternate Sets an alternate zig zag scanning pattern of the AC 
coefficient of the DCT block as defined in the ISO/IEC 13818-2 (figure 
7-3) specification documentation. Use this setting when capturing or 
rendering video at a high data rate (that is, at a data rate of about 50 
Mb/sec for SD video, or 100 Mb/sec or higher for HD video).

7 Select the Force Frame-based DCT setting to render macroblocks as 
frames rather than as fields. In some cases, graphics will yield less artifacts if 
this option is selected.

8 Click OK to save your settings.
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Selecting your MPEG-2 IBP settings
When capturing video to a Matrox .m2v file using Adobe Premiere Pro, the 
capture format is set to Matrox MPEG-2 IBP. You can specify various settings for 
the MPEG-2 IBP compression.

°To select your MPEG-2 IBP settings:

1 Click the Configure button. This displays a dialog box similar to the 
following:

2 Under Data Rate (Mb/sec), you can select the encoding type and data rate 
for the MPEG-2 IBP compression.

$ Encoding type From this list, select one of the following:

• Constant bit rate (CBR) Video is compressed at your selected 
target data rate, which is useful when you need to limit or predict the 
size of your .m2v file. However, if your video is very complex (such as 
scenes with many colors or sharp edges), you’ll need to select a high 
data rate to avoid having frames of very blocky video in your file.
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• Variable bit rate (VBR) Video is compressed at varying data rates 
based on the complexity of the video. The target data rate you select is 
used as the average data rate for the compression.

$ Min, Target, and Max sliders Use these sliders to select your desired 
data rate. The higher the target data rate you select, the better the video 
quality will be. Only the Target slider will be available if you selected 
Constant bit rate (CBR). If you selected Variable bit rate (VBR), all 
three sliders will be available so that you can set the minimum, target, and 
maximum data rates for the video compression.

¦ Note Adobe Encore requires CBR-encoded .m2v files longer than about two 
minutes to be transcoded. VBR-encoded .m2v files do not require transcoding 
in Adobe Encore.

3 Under GOP Structure, you can customize the GOP structure for the 
MPEG-2 IBP compression as follows:

$ GOP length Determines the number of frames in the GOP (Group of 
Pictures).

$ Subgroup length Determines the subgroup length of B-frames and 
P-frames in the GOP, after the initial I-frame. For example, a subgroup of 
3 appears as “BBP,” and a subgroup of 2 appears as “BP.” The available 
subgroup lengths depend on your selected GOP length.

4 Under Profile, select one of the following MPEG-2 profiles:

$ 4:2:0 This profile uses 4:2:0 luminance/chrominance sampling and is 
suitable for broadcast transmission and distribution on DVD. You must 
select this profile if you’re capturing to an .m2v file for DVD authoring.

$ 4:2:2 This profile uses 4:2:2 luminance/chrominance sampling and is 
suitable for high-quality distribution and archiving.

5 Under Motion Estimation, drag the slider to adjust the quality of the 
motion estimation used for the video compression. The default setting gives 
good results for most video. However, if you have a lot of fast motion in your 
video, such as fast-paced sports footage, you can get better results by 
dragging the slider to the right (towards Slow/High quality). This improves 
the quality of the motion estimation, but decreases the speed of the video 
compression. Alternately, if you have mostly slow-paced video, you may 
want to drag the slider to the left (towards Fast/Low quality) to decrease 
the quality of the motion estimation and speed up the video compression.

6 Click OK to save your settings.
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Exporting to a Matrox .avi file
Several software codecs are included with Adobe Premiere Pro so that you can 
export your video to different formats. Your Matrox MXO2 system adds several 
Matrox codecs to the ones included with Premiere Pro to allow you to export 
your sequence to a Matrox .avi file.

If you have a Matrox MXO2 product with MAX technology, you can also export 
your sequence to a Matrox MAX H.264 file as explained in Chapter 15, “Using 
the Matrox MAX H.264 Codec with Adobe Software.”

°To export your sequence to a Matrox .avi file:

1 Unless you want to export your entire sequence, position the work area bar 
over the section of the sequence you want to export.

2 Choose File > Export > Media. This opens the Export Settings dialog 
box.

3 From the Format list, select Matrox AVI.

¦ Note Although the Microsoft AVI format also lets you export your sequence 
to a Matrox .avi file using Matrox codecs, it uses Video for Windows (VFW) 
codecs only. To obtain the best performance when exporting material from 
Adobe Premiere Pro to a Matrox .avi file, you must select the Matrox AVI 
format for your exports.

4 From the Preset list, select the video format you want for your exported file.

5 Select Export Audio if you want to export both video and audio (Export 
Video is always selected.)
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¦ Note Exported audio will be embedded in your .avi file. Matrox MXO2 
does not support audio-only exports to an .avi file.

6 Click the Video tab. Under Codec, an appropriate Matrox codec is 
automatically selected for you based on your selected preset. You can change 
the codec if you want.

$ Matrox DV/DVCAM Renders video to DV or DVCAM format.

$ Matrox DVCPRO Renders video to DVCPRO format.

$ Matrox DVCPRO50 Renders video to DVCPRO50 or D-9 format.

$ Matrox DVCPRO HD Renders video to DVCPRO HD format.

$ Matrox MPEG-2 I-frame Renders video to MPEG-2 intra-frame 
format using the 4:2:2 Profile @ Main Level (for SD resolutions) or High 
Level (for HD resolutions) at a selected data rate.

$ Matrox 8-bit Uncompressed Renders video to 8-bit uncompressed 
format.

$ Matrox 10-bit Uncompressed Renders video to 10-bit uncompressed 
format. 
Exporting to a Matrox .avi file
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7 If you’re exporting to Matrox MPEG-2 I-frame format, click the Configure 
button to select your MPEG-2 I-frame settings (see “Selecting your MPEG-2 
I-frame settings” on page 100).

8 Under Video, appropriate settings are applied based on your selected preset. 
You can customize these settings as follows:

$ Frame Size Sets the width and height for your exported video. The 
available frame sizes depend on your selected codec.

$ Frame Rate Sets the frame rate for the video format to which you are 
rendering. The available frame rates depend on your selected frame size.

$ Field Type Specifies the order in which the video fields are displayed, 
such as Upper First for interlaced HD video, or Progressive for all 
progressive video formats. The available field types depend on your 
selected codec, frame size, and frame rate.

$ Aspect Ratio This is set to 16:9 when exporting to HD. When 
exporting to SD, you can select 4:3 to export to the standard TV screen 
format, or 16:9 to export to the widescreen 16:9 format.

$ De-interlace video If you’re exporting interlaced video to a 
progressive format (such as 1080i to 720p), select this option to 
de-interlace the video for display on a monitor that displays lines 
progressively, such as an LCD or computer monitor. (This option won’t be 
present if you’re exporting to an interlaced format or your source video is 
progressive.)

$ Maintain aspect ratio when scaling Select this option if you’re 
scaling your source video for export, and you want to maintain your 
source video’s aspect ratio. Your source video will be exported as 
pillarbox video when exporting to a larger aspect ratio, or letterbox video 
when exporting to a smaller aspect ratio. If this option is not selected, 
scaled video that doesn’t match the specified aspect ratio for export will 
be exported as anamorphic video.

9 From the Source Range list in the Source panel, select the range you want 
to export, such as Work Area.

10 Click Queue to send your export request to Adobe Media Encoder, or click 
Export to immediately start your export.

For information about other export settings and using Adobe Media Encoder, see 
your Adobe Media Encoder documentation.
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Exporting a Matrox NTSC or 486p sequence to 
Adobe Premiere Pro 720x480 formats

When you choose File > Export > Media to export a sequence, Adobe 
Premiere Pro provides the MPEG2-DVD export format in the Export Settings 
dialog box, which lets you export your sequence to a DVD-compliant MPEG-2 
file suitable for use with most DVD authoring programs, such as Adobe Encore. 
To export a Matrox NTSC or 486p sequence to a 720×480 MPEG2-DVD format 
or any other Adobe Premiere Pro 720×480 format, you must crop the height of 
the video by applying cropping on the Source page of the Export Settings 
dialog box as follows:

For details on how to export to MPEG2-DVD and other Adobe Premiere Pro 
720×480 formats, see your Adobe Premiere Pro documentation.

Setting up Matrox RS-422 device control
Matrox RS-422 device control lets you control any device that supports the 
RS-422 SMPTE time code protocol when capturing or exporting material to tape 
in Adobe Premiere Pro. To use this device control, you must connect your source 
device or recorder as follows:

• On Matrox MXO2, MXO2 Rack, and MXO2 LE, you can connect the 
RS-422 connector on your MXO2 hardware to the serial device control port 
on your source device or recorder using an RS-422 serial cable (see “MXO2 
RS-422 serial connection” on page 18, “MXO2 Rack RS-422 serial 
connection” on page 27, or “MXO2 LE RS-422 serial connection” on 
page 36). Alternately, you can use a suitable adapter (RS-232 to RS-422 or 
USB to RS-422 adapter) to connect the serial device control port on your 
source device or recorder to your computer.

• On Matrox MXO2 Mini, you must use a suitable adapter (RS-232 to RS-422 
or USB to RS-422 adapter) to connect the serial device control port on your 
source device or recorder to your computer.

Crop settings

Sequence format
Direct export from Adobe 

Premiere Pro
Export from Adobe 

Media Encoder

NTSC Top = 4, Bottom = 2 Top = 3, Bottom = 3

486p Top = 4, Bottom = 2 Top = 4, Bottom = 2
Exporting a Matrox NTSC or 486p sequence to Adobe Premiere Pro 720x480 
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°To configure your RS-422 device control settings:

1 Choose Edit > Preferences > Device Control.

2 From the Devices list, select Matrox RS-422 Device Control, and click 
Options to display the following dialog box:

3 From the Port list, select Matrox RS-422 if you’ve connected your device 
to the RS-422 connector on your MXO2 hardware (not available on MXO2 
Mini), or select the COM port on your computer to which you’ve connected 
your device.

4 From the Time Source list, select the time source to be used for controlling 
your device:

$ LTC Longitudinal Time Code recorded on a track adjacent to the video 
(this is the default time source). This type of time code can be read at all 
tape speeds, except still.

$ VITC Vertical Interval Time Code that is recorded onto the vertical 
blanking interval of the video. This type of time code can be read 
whenever an image is displayed, but not usually during high-speed 
operation.

$ LTC+VITC Select this if you want your device to decide which type of 
time code to use in different operational modes (recommended only if 
you’re sure that the two types of time code match on your tape).
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$ Control Track Select this if you want to use only your tape’s control 
track as the time source. Because using the control track is not as reliable 
as LTC or VITC for device control, you should select this option only if 
you’re having problems using the time code on your tape.

5 From the Time Base list, select the time base that matches your tape, such as 
30 fps Drop Frame if you’re using NTSC video with drop frame time code, 
or 25 fps if you’re using PAL video.

6 Select Use VTR’s internal cue if the Matrox RS-422 device control is 
having problems cueing your VTR, such as when you cue to a specific In or 
Out point. Because using the VTR’s internal cueing method slows down the 
cueing, you should select this option only if you’re experiencing problems 
cueing to a time code when using RS-422 device control.

7 Under Capture, use the Time Code Offset to specify the number of frames 
to adjust the start time for capture, if needed. For example, if your captures 
are starting three frames too early (that is, three frames before your specified 
In point), enter a time code offset of 3. Alternately, if your captures are 
starting three frames too late, enter a time code offset of -3. 

8 Under Export to Tape, you can specify various settings that enable you to 
obtain a frame-accurate export to tape. For an example of how to calibrate 
your device for frame-accurate recording, see “Obtaining a frame-accurate 
export to tape using Matrox RS-422 device control” on page 114.

$ Device Edit Mode Select one of the following modes to specify the 
editing capabilities of your recorder:

• Auto Edit Select this if your recorder supports edit commands and 
has auto edit capabilities. Devices that support this mode perform 
frame-accurate recording. Therefore, you won’t need to make any 
adjustments to the Mark In and Out time code offsets, and those 
settings won’t be available.

• Basic Edit Select this if your recorder supports edit commands, but 
does not have auto edit capabilities. When using this mode, you may 
need to adjust the Mark In time code offset, but the recording should be 
accurate at the Out point.

• Edit Not Supported Select this if your recorder doesn’t support any 
edit commands. In this case, you will probably need to specify both a 
Mark In and a Mark Out time code offset, and you won’t be able to 
perform an insert edit (the options to perform an insert edit won’t be 
available in the Matrox RS-422 Export to Tape dialog box).

¥ Tip If you’re not sure if your device supports edit commands, try 
performing an export to tape using the different edit modes, starting with 
Auto Edit. If your device doesn’t support the selected edit mode, the 
recording will either not start or nothing will get recorded on the tape.
Setting up Matrox RS-422 device control
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$ Mark In/Out Time Code Offset These offsets specify the number of 
frames to adjust the recording start and stop times if the recording doesn’t 
start at your specified In point and stop at your specified Out point on the 
tape. For example, if the recording starts three frames before the In point, 
set the Mark In Time Code Offset to 3 (or -3 if the recording starts three 
frames too late). You should adjust the Mark In time code offset first, 
because once this setting is accurate your device may also be accurate at 
the Out point.

$ Playback Offset Specifies the number of frames to offset the playback 
of your sequence for export to tape. For example, if playback starts too 
late and you’re missing the first three frames of your sequence recorded 
on the tape, enter an offset of -3. Alternately, if playback starts too early 
and the first three frames of your sequence are repeated, enter an offset of 
3. Before changing this offset, you must first make any required 
adjustments to the Mark In and Mark Out time code offsets.

9 Click OK to save your settings.

For details on capturing with device control, see your Adobe Premiere Pro 
documentation. For information about exporting your Matrox sequence to tape, 
see “Exporting your sequence to tape” on page 111.

Requirements for using Matrox RS-422 device 
control
When using Matrox RS-422 device control, keep the following points in mind:

• You must set your device to Remote or VTR mode.

• When using an analog RS-422 device on MXO2, MXO2 Rack, or MXO2 
LE, you must genlock to an external broadcast-quality analog sync source. If 
you’re using an SDI RS-422 device and you don’t have an external 
broadcast-quality analog sync source, you can genlock to your SDI video 
source for capture. For export to tape, you can set your genlock source to the 
MXO2 internal reference and configure the setting on your deck to genlock 
to the SDI video input. For details on how to set your genlock source, see 
“Specifying your genlock settings” on page 84.

• You must stripe your tapes with continuous and consecutive time code. You 
can stripe your entire tape with time code by recording black video for the 
duration of the tape. Avoid having the time code counter reset to 00:00:00:00 
during the striping.

• When capturing material, make sure that you don’t specify any preroll or 
time code offset value in the Device Control section of the Settings pane. 
Instead, a preroll of about five seconds will automatically be applied, and 
you must specify any required time code offset in the Matrox RS-422 
Device Control Settings dialog box.
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Exporting your sequence to tape
To export your Matrox sequence to tape without using device control, simply 
play back your sequence and record the output from any of the available outputs 
on your MXO2 system. If your recorder supports RS-422 device control, you can 
export your sequence to tape using Matrox RS-422 device control as explained in 
“Exporting to tape using Matrox RS-422 device control” on page 112.”

To export your Matrox sequence to a DVCPRO HD device over the 1394 
interface, you can use Adobe DV/HDV device control as explained in “Exporting 
to a DVCPRO HD device using DV-1394 device control” on page 115. To export 
to a DV-1394 device other than DVCPRO HD, you must copy or import your 
Matrox project into a native Adobe Premiere Pro project and use Adobe 
DV/HDV device control as explained in your Adobe Premiere Pro 
documentation.

Avoiding issues when exporting to tape
Keep the following points in mind when exporting to tape using device control:

• To avoid repeated or missing frames when performing a DV-1394 export to 
tape with device control, add about five seconds of black video or color bars 
to the start and end of your sequence.

• To avoid having discontinuous (broken) time code recorded onto your tape 
when using Matrox RS-422 device control, set your recorder to generate 
time code internally based on time code already present on the tape (this 
setting is called INT REGEN on some devices). Don’t use free run or 
external time code regeneration mode.

• Because Matrox RS-422 device control requires a preroll, don’t start the 
export to tape within the first ten seconds on your tape or at a time code less 
than 00:00:10:00.

• To avoid repeated frames or broken time code when performing an assemble 
edit using Matrox RS-422 device control, add ten seconds or more of black 
video or color bars to the end of your sequence.
Exporting your sequence to tape
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Exporting to tape using Matrox RS-422 device 
control
With Matrox RS-422 device control, you can perform either an insert or assemble 
edit to record your Matrox sequence onto tape as follows:

1 Open your project, activate the Matrox sequence that you want to export to 
tape, and position the work area bar over the section of the sequence that you 
want to export.

2 If you haven’t already done so, play back your sequence and render any 
non-realtime sections that are identified with a red render bar.

3 Make sure that you’ve properly connected your recorder and configured 
Matrox RS-422 device control as explained in “Setting up Matrox RS-422 
device control” on page 107. 

4 Load a striped recordable tape into your recorder, and set your recorder to 
Remote or VTR mode.

5 Choose File > Export > Tape to display the following dialog box:
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6 To review or change your RS-422 device control settings, click Device 
Options. This displays the Matrox RS-422 Device Control Settings 
dialog box as explained in “Setting up Matrox RS-422 device control” on 
page 107 (except you won’t be able to change the specified port).

7 Under Export to Tape Mode, you can specify the type of export you want 
to perform and the tracks you want to be recorded:

$ Format Determines the video format for the export to tape. The 
available formats depend on your currently selected video output settings 
(see “Specifying your video output settings” on page 77 and “Specifying 
your video output settings (MXO2 Mini)” on page 81).

$ Assemble Records all tracks (video and audio) sequentially onto the 
tape. The control track and previously recorded material on the tape will 
be replaced with the material recorded from your sequence.

$ Insert Records selected tracks (video and/or audio), without affecting 
the control track. This lets you perform a video or audio dub. For 
example, you can choose to record only video, only selected audio tracks, 
or video and selected audio tracks from your sequence.

¦ Note Check your device’s documentation to determine its recording 
capabilities for assemble and insert editing. To perform an insert edit, the edit 
mode for Matrox RS-422 device control must be set to Auto Edit or Basic 
Edit as explained in “Setting up Matrox RS-422 device control” on page 107.

8 Use the transport controls to play back your tape. The current time code of 
your tape appears in the text box above the transport controls. You can also 
use the J, K, and L shortcut keys to control the shuttle. Press J to shuttle left, 
L to shuttle right, and K to stop. Pressing J or L multiple times increases the 
speed of the shuttling.

9 Specify where you want the recording to start and stop as follows:

$ Click the Set In Point button ( ) to specify where you want the 
recording to start, or enter the required time code in the In box.

$ Click the Set Out Point button ( ) to specify where you want the 
recording to stop, or enter the required time code in the Out box. 
Alternately, you can select Duration and enter the duration you want for 
the recording. The Out point will then be calculated for you. By default, 
the duration is set to the duration of the work area. You can click Reset at 
any time to set the duration back to the duration of the work area.

¦ Note When Out is selected, the duration is calculated based on your 
selected In and Out points. When Duration is selected, the Out point is 
calculated based on your specified In point and duration.

10 Click Export to start the export to tape.
Exporting your sequence to tape
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Obtaining a frame-accurate export to tape 
using Matrox RS-422 device control
In order to obtain a frame-accurate export to tape when using Matrox RS-422 
device control, there are various settings that you may need to adjust in the 
Matrox RS-422 Device Control Settings dialog box:

• The Mark In Time Code Offset and Mark Out Time Code Offset 
determine when your device starts and stops recording on the tape. If the 
recording doesn’t start on the tape at your specified In point and stop at your 
specified Out point, you can adjust these offsets so that the recording 
starts/stops earlier or later. 

¦ Note Adjusting the Mark In and Out time code offsets won’t be required if 
your recorder has auto edit capabilities and you set the edit mode for export 
to tape to Auto Edit as explained in “Setting up Matrox RS-422 device 
control” on page 107.

• The Playback Offset determines when your sequence starts playing back. 
Depending on your system, you may need to adjust this offset so that your 
sequence starts playing back earlier or later.

Here’s an example of how to calibrate your RS-422 device for frame-accurate 
export to tape:

1 Stripe an NTSC tape with continuous and consecutive time code starting at 
00:00:00:00.

2 Create a new Matrox NTSC sequence with a bars and tone clip at least ten 
seconds long containing time code starting at 00:00:00:00. Make sure you 
place the clip at the start of your sequence.

¥ Tip You can create a bars and tone clip by right-clicking in the Project 
panel and choosing New Item > Bars and Tone. You can add time code to 
the clip by applying a Timecode effect as explained in your Adobe Premiere 
Pro documentation.

3 Set up Matrox RS-422 device control with the Mark In Time Code Offset, 
Mark Out Time Code Offset, and Playback Offset for export to tape set 
to 0 (see “Setting up Matrox RS-422 device control” on page 107).

4 Export your sequence to tape and set the In point for the recording to 
00:00:10:00 and the Out point for the recording to 00:00:20:00 (see 
“Exporting to tape using Matrox RS-422 device control” on page 112).

5 When the export to tape is finished, play back your tape and check where the 
recording started. For example, if the bars and tone clip started recording at 
00:00:09:25 on your tape (five frames before your specified In point), then 
you need to set the Mark In Time Code Offset to 5. Alternately, if the 
recording started at 00:00:10:05 (five frames after your specified In point), 
then you need to set the Mark In Time Code Offset to -5.
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6 Make any required adjustment to the Mark In Time Code Offset in the 
Matrox RS-422 Device Control Settings dialog box, and perform another 
export to tape with the same settings (In point at 00:00:10:00 and Out point 
at 00:00:20:00.)

7 When the export to tape is finished, play back your tape and make sure that 
your bars and tone clip stopped recording at 00:00:20:00 (the recording 
should have started at 00:00:10:00). For example, if the recording stopped at 
00:00:19:25 (five frames before your specified Out point), then you need to 
set the Mark Out Time Code Offset to 5.

8 Once you’ve made any required adjustments to the Mark In and Out time 
code offsets and ensured that your bars and tone clip starts and stops 
recording at your specified In and Out points, perform another export to tape 
with the In point for the recording set to 00:00:30:00.

9 When the export to tape is finished, go to 00:00:30:00 on your tape, and 
check which frame from your sequence has been recorded. You should see 
frame 00:00:00:00 from your bars and tone clip at 00:00:30:00 on your tape, 
with no repeated frames. For example, if frame 00:00:00:00 has been 
repeated for the next five frames, then your sequence started playing back 
five frames too early and you need to set the Playback Offset to 5. 
Alternately, if you see frame 00:00:00:05 from your bars and tone clip 
recorded at 00:00:30:00, then the sequence playback started five frames too 
late and you need to set the Playback Offset to -5.

Exporting to a DVCPRO HD device using 
DV-1394 device control
When working with a Matrox 1080i @ 25 fps, 29.97 fps, or 720p @ 59.94 fps 
sequence, you can choose to export your sequence to a DVCPRO HD device over 
the 1394 interface using Adobe DV/HDV device control.

¡ Important To export a 720p @ 23.98 fps, 29.97 fps, or 59.94 fps sequence to a 
DVCPRO HD device over the 1394 interface, you must first export your 
sequence to a Matrox .avi file using the Matrox DVCPRO HD codec in 720p @ 
59.94 fps format, import your Matrox .avi file to a new 720p @ 59.94 fps 
sequence, and then export your sequence to tape. DV-1394 export to DVCPRO 
HD is not supported for any other 720p format. For more information, see 
“Preparing a 720p sequence for export to a DVCPRO HD device” on page 116.

°To export your sequence to tape over the 1394 interface:

1 Open the project and activate the sequence you want to export to tape.

2 If you’re exporting a 1080i @ 25 fps or 29.97 fps sequence, play back your 
sequence and render any non-realtime sections that are identified with a red 
render bar using the Matrox DVCPRO HD codec (see “Defining your video 
preview settings” on page 90).
Exporting your sequence to tape
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3 Make sure your DV-1394 device is properly connected and turned on, and 
that you’ve enabled the DV-1394 output for export to tape as explained in 
“Specifying your DV-1394 output settings” on page 87.

4 If you’re using a camcorder, switch it to VTR mode. 

5 Load a striped recordable tape into your DV-1394 device.

6 Make sure that you’ve set up Adobe DV/HDV device control as explained in 
your Adobe Premiere Pro documentation. 

7 Choose File > Export > Export to Tape.

For information about exporting your sequence to tape using Adobe Premiere 
Pro, see your Adobe Premiere Pro documentation.

Preparing a 720p sequence for export to a DVCPRO HD 
device
In order to export a Matrox 720p @ 23.98 fps, 29.97 fps, or 59.94 fps sequence to 
a DVCPRO HD device over the 1394 interface, you must first export your 
sequence to a Matrox .avi file using the Matrox DVCPRO HD codec in 720p @ 
59.94 fps format as follows:

1 Activate the Matrox sequence that you want to export, and choose File > 
Export > Media to open the Export Settings dialog box.

2 From the Format list, select Matrox AVI.

3 From the Preset list, select DVCPRO HD 1280x720p@59.94 fps. 
Appropriate export settings are automatically applied, and the codec is set to 
Matrox DVCPRO HD (no configuration settings are required).

4 Click Export to start your export.

Once the export has finished, create a new Matrox 720p @ 59.94 fps sequence, 
import your Matrox .avi file, and place it on the timeline. You can now export the 
new sequence to tape as explained in “Exporting to a DVCPRO HD device using 
DV-1394 device control” on page 115.
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Premiere Pro
This chapter explains how to 
set up realtime Matrox effects 
such as color corrections and 
wipes using the Matrox plug-in 
for Adobe Premiere Pro.
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Available effects
The Matrox plug-in for Adobe Premiere Pro lets you set up the following 
realtime1 Matrox effects in your Matrox projects2:

• Color corrections.

• Chroma key and luma key effects.

• Chroma clamper effect.

• Wipes.

The following Adobe effects are also accelerated for realtime playback:

• Black and white.

• Crop.

• Timecode.

• Motion.

• Video opacity (fades).

• Additive dissolve, cross dissolve, dip to black, and dip to white transitions.

• Speed changes.

• Graphics overlays using single-frame graphics files with an alpha-key 
channel.

When you install Matrox Mtx.utils, all the Matrox effects are added to Adobe 
Premiere Pro. You set up Matrox effects in your projects the same way as other 
effects included with your Adobe software. For example, you apply a Matrox 
wipe to your clips in Adobe Premiere Pro just as you would any other type of 
transition, except that the controls provided let you create a Matrox wipe, as 
explained in this chapter. For instructions on setting up Adobe Premiere Pro 
effects and transitions, refer to your Adobe documentation.

¥ Tip You can filter the Effects panel to show only the effects and transitions that 
are accelerated by your Matrox hardware by clicking the  button at the top of 
the Effects panel.

1 Applying certain Adobe Premiere Pro settings to your clips may require you to render 
your effects, such as when you apply Field Options, Frame Hold, or Interpret Footage 
settings.

2 The Matrox color correction, chroma key, luma key, and chroma clamper effects are 
also available in Adobe After Effects.
pter 10, Setting Up Matrox Effects with Adobe Premiere Pro



119
How to apply a Matrox video effect in Adobe 
Premiere Pro

The Matrox plug-in for Adobe Premiere Pro allows you to apply several Matrox 
video effects to your clips. To apply a Matrox video effect, drag the desired effect 
from the Effects panel onto the clip in the Timeline panel.

By default, the Matrox video effects are found in the Matrox bin under Video 
Effects.

¥ Tips
• You can also apply preconfigured Matrox video effects found in the Matrox 

Effect Presets bin under Presets.

• If you can’t see the Effects panel, choose Window > Effects. If you can’t 
see the Effect Controls panel, choose Window > Effect Controls.

How to apply a Matrox video transition in 
Adobe Premiere Pro

In Adobe Premiere Pro, the Matrox wipe transitions are found in the Matrox bin 
under Video Transitions in the Effects panel.

There are numerous methods to create transitions in Premiere Pro. Use the 
method that works best for you to apply your Matrox wipes. For information on 
applying transitions, see your Adobe Premiere Pro documentation.
How to apply a Matrox video effect in Adobe Premiere Pro
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Applying a mask to your Matrox effects
The Matrox color correction, chroma key, and luma key effects allow you to add 
a mask to define the area where you want to apply your effect. For example, you 
may want to apply a color correction to only one area of your clip and leave the 
rest of the clip untouched. 

°To adjust the mask properties: 

Click the triangle next to Mask to expand the property list. 

The properties under Mask let you control the area on the clip where you want to 
apply the mask. You can enter the values you want in the text boxes or drag the 
appropriate sliders (Left, Right, Top, and Bottom).

• Left Adjusts the left edge of your mask.

• Right Adjusts the right edge of your mask.

• Top Adjusts the top edge of your mask.

• Bottom Adjusts the bottom edge of your mask.

• Select Mask Displays a dialog box in which you can apply your mask 
settings (see “Using Select Mask” on page 121).

• Invert Inverts the mask so that your effect is applied outside the mask, 
instead of within the mask.
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Using Select Mask 
To apply a mask to your Matrox effect using the Select Mask dialog box, click 
the triangle next to the Select property to expand it, then click the Select Mask 
button:

The Select Mask dialog box allows you to apply a mask in two ways:

• Click and drag directly in the Select Mask window to create the rectangular 
area where you wish to apply the mask.

You can resize the mask area by dragging any side of the rectangle. For ex-
ample, dragging the right side of the rectangle adjusts the right edge of the 
mask area. To resize the entire mask area at once, drag one of the corners 
(the corner that’s diagonally opposite the corner you are moving will remain 
stationary).

• Use the Left, Right, Top, and Bottom controls to adjust any edge of your 
mask by a given number of pixels. You can enter values in the text boxes or 
drag the sliders to resize your mask area. For example, drag the Left slider to 
adjust the left edge of your mask area.
Applying a mask to your Matrox effects
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Creating a Matrox primary color correction
Color correction is important for all productions, whether you want to achieve 
continuity when cutting between shots, ensure broadcast safe levels, or establish 
and emphasize a “look.” Matrox color correction provides basic proc amp 
control, three-way color correction complete with master, shadows, midtones, 
and highlights control, and input and output level control. You can also easily 
match colors with a reference shot. For more information about color matching, 
see “Matching colors between two clips” on page 133.

¥ Tip Adobe Premiere Pro includes a workspace setup that is optimized for 
working with clips and effects to facilitate color correction. To prepare your 
workspace for color correction, choose Window > Workspace > Color 
Correction.

°To set up a Matrox primary color correction:

Click the triangle next to Matrox Color Correction (Primary) or Matrox Color 
Correction (Primary - Advanced) to expand the property list.

¦ Note The RGB Curves and Tonal Range settings are available only with the 
advanced versions of the Matrox primary and secondary color correction effects. 
Because the advanced versions of these effects require additional system 
resources, you should apply them only if you want to use the RGB Curves or 
Tonal Range settings.

• Enable Split View Select this option to split your clip into two sections in 
the Program Monitor and on your video monitor. One section will display 
your clip as you adjust the color correction controls, and the other section of 
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the clip will remain unchanged. For more information, see “Using Split 
View” on page 124.

¡ Important This option is for preview only. You should clear it before you 
render your clip, otherwise the split will appear in your video output.

• Proc Amps The processing amplifier (proc amp) controls allow you to 
adjust different aspects of your clip:

$ Hue Adjusts the tint of the colors in the image.

$ Saturation Adjusts the saturation (vividness) of the image’s colors.

$ Contrast Adjusts the difference in luminance between the lightest and 
darkest areas of the image.

$ Brightness Adjusts the level of black in the image.

• RGB Curves Lets you use curves to adjust the red, green, and blue color 
channels of your clip individually, or use a master curve to adjust all color 
channels simultaneously. For more information, see “Using RGB curves” on 
page 126.

• Color Balance These controls let you adjust the mixture of colors in your 
clip.

$ Tonal Range Allows you to fine-tune the tonal ranges of your clip by 
reducing the range of pixels included for shadows, midtones, or 
highlights. For more information, see “Adjusting tonal range” on 
page 128.

$ Graphical Allows you to see a graphical representation of your changes 
when you adjust the color balance settings. You can also modify most of 
the color balance settings directly within the graph. For more information, 
see “Using the color balance graph” on page 129.

$ Numerical Lets you adjust your color balance settings numerically by 
entering values in the text boxes, or by dragging the corresponding sliders. 
You can adjust the Hue, Saturation, and Luminance for each tonal 
range.

• Master (Hue, Saturation, and Luminance) Affects all areas of 
your clip from the lightest white to the darkest black.

• Shadows (Hue, Saturation, and Luminance) Affects the darkest 
areas of your clip.

• Midtones (Hue, Saturation, and Luminance) Affects the areas 
with tones between the darkest and lightest areas of your clip.

• Highlights (Hue, Saturation, and Luminance) Affects the lightest 
areas of your clip.

• Luma Mapping
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$ Graphical Allows you to see a graphical representation of your changes 
when you adjust the luma mapping settings. You can also modify the 
luminance of your clip directly within the graph. For more information, 
see “Using the luma mapping graph” on page 135.

$ Numerical Lets you adjust the luma mapping settings numerically by 
entering values in the text boxes, or by dragging the corresponding sliders. 

• Input Levels (Black and White)  These controls let you fine-tune 
your clip’s brightness and contrast by changing the luminance value 
that represents black, white, or gray. Doing so expands or compresses 
the range of luminance levels in your clip, which increases or decreases 
your clip’s tonal range.

For example, by increasing the black value, you set black in your clip 
to a higher luminance value, which compresses the luminance range 
and darkens your clip proportionally.

• Output Levels (Black and White) These controls let you map the 
values under Input Levels to any level of black and white. You can 
reduce contrast in your clip, or reverse the luminosity of your clip by 
setting black to a higher value than white.

• Gamma Use this to adjust the midtones in your clip without 
adjusting black or white.

• Mask  Allows you to apply a mask to your effect. For more information, 
see “Applying a mask to your Matrox effects” on page 120.

Using Split View
The Split View option allows you to split your clip in two for preview on your 
Program Monitor and your video monitor. One section displays your clip as you 
adjust the color correction controls, while the other section of the clip remains 
unchanged.

There are two ways to enable Split View. You can select the Enable Split View 
option in the Effect Controls panel, or work directly in Adobe Premiere Pro’s 
Program Monitor using your mouse. 
pter 10, Setting Up Matrox Effects with Adobe Premiere Pro



125
Working with Split View in the Program Monitor 
To activate the Split View controls in the Program Monitor, click the Transform 
icon ( ) beside the name of the Matrox color correction effect in the Effect 
Controls panel. The Split View button will appear in the upper left corner of the 
Program Monitor: 

Enable Split View by clicking the Split View button. You can then drag the 
handles on the corners of the split rectangle to define the area you want to split. 
You can also drag the split rectangle to move it to a specific region of your clip. 
The area within the split view rectangle will display any color correction you 
make, while the area outside remains unchanged. 

In the following example, the split view rectangle has been moved to display the 
color correction in the area surrounding part of the Chinese character on the wall: 

Remarks
• The Split View option is for preview only. You should disable it before 

rendering your material, otherwise the split will appear in your video output.

• If you enable Split View and create a mask outside the split view rectangle, 
you will not be able to see it. The mask will only be visible when you move 
the split view rectangle directly over it. If you invert a mask that is not in the 
split view rectangle area, the whole clip will be inverted since the mask is 
ignored.

Split View button
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Using RGB curves

¦ Note The RGB Curves settings are available only with the advanced versions 
of the Matrox primary and secondary color correction effects.

With RGB curves, you can individually adjust the red, green, and blue color 
channels across the entire tonal range of your clip, or adjust all three color 
channels simultaneously with a master curve. RGB curves allow you to achieve 
color effects that would be difficult, if not impossible, to achieve using the Color 
Balance settings, and also give you a high degree of control over the color 
channels in each tonal range. For example, you can easily add a red, green, or 
blue tint to your clip, or use the master curve as a way to adjust the brightness and 
contrast of your clip.

Each curve is displayed on a grid with the horizontal axis representing the input 
or current pixel value, and the vertical axis representing the output value of the 
pixel after the curve adjustment is applied. By default, a curve starts as a straight 
line with two end points, one at the bottom left of the grid (shadows), and the 
other at the top right of the grid (highlights). Before any adjustments are made, 
each point on the curve has the same input and output value. 

0 Default end point 
(shadows)

1 Default end point 
(highlights)

0

1
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Click the R, G, or B button to select the curve corresponding to the color channel 
you want to adjust, or click the Master button for the master curve, and then drag 
the curve to obtain your desired effect. For example, click the R button and drag 
the top right end point towards the top left of the grid to increase the slope of the 
curve and add red to the clip. Drag that same point towards the bottom right of 
the grid to decrease the slope of the curve and remove red from the clip. Clicking 
the Enable button will show/hide any adjustments you have made to the RGB 
channels at any time (you do not need to click Enable to start adjusting the 
curves). 

¥ Tip For increased precision, hold down the ALT key while you drag the curve, 
or the CRTL key to change your cursor into a crosshair that will help you align 
your curve to the grid. 

You can add up to 14 control points to each curve in addition to the two default 
end points. These control points act as anchors that allow you to lock your curve 
so adjustments can be applied only to specific tonal ranges. Click on a curve to 
add control points, and hold the SHIFT key while clicking a control point to 
delete it (end points cannot be deleted). Adjusting the points in the top right area 
of the grid affects highlights, the middle area affects midtones, and the bottom 
left area affects shadows. For example, the following S-shaped master curve adds 
contrast in the midtones range, without creating any completely black or white 
areas. 
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If you want to reset the Master, R, G, or B curve to its default setting at any time, 
click the appropriate Reset button.

¥ Tip By applying a mask to your clip, you can adjust the RGB channels for that 
specific area of your clip, or invert the mask to isolate that same area from being 
affected by your RGB adjustments.

Adjusting tonal range

¦ Note The Tonal Range settings are available only with the advanced versions 
of the Matrox primary and secondary color correction effects.

Using the tonal range curves allows you to fine-tune the range of pixels that are 
affected when you make a color correction to the shadows, midtones, or 
highlights of your clip using the color balance graph. For more information, see 
“Using the color balance graph” on page 129. 

The histogram shows the distribution of pixels in each tonal range of your clip. In 
the following example, the histogram represents a clip with a high amount of 
shadows (left), a lesser amount of midtones (middle), and an even lesser amount 
of highlights (right).

Click the Shadows, Midtones, or Highlights button to select the curve 
corresponding to the tonal range you want to adjust, and then drag the curve as 
desired to reduce the number of pixels to be included in each tonal range. 

¦ Note You cannot increase the number of pixels in a tonal range. For example, 
you can’t extend the shadows curve into the highlights range.

Red curve Reset button

0 Shadows 1 Midtones 2 Highlights

0 1 2
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Using the color balance graph
The color balance graph allows you to modify the Color Balance settings for 
each tonal range directly within the color maps. You can also perform an auto 
balance or a color match using the buttons beneath the color maps. For more 
information, see “Performing an auto balance” on page 132 and “Matching 
colors between two clips” on page 133. Depending on which color map you use, 
you can adjust your clip globally, or only the shadows, midtones, or highlights.

You can drag the handle in the center of any color map to adjust the color balance 
(Hue and Saturation) for a specific tonal range, such as to adjust the color 
balance globally throughout your clip using the Master color map, or adjust the 
color balance of only the shadows using the Shadows color map. Drag the 
handle toward a color you want to increase in your clip, or away from a color you 
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want to decrease. For example, if you move the handle towards red, you also 
decrease cyan by the same amount, as shown in the following diagram:

¥ Tip For increased precision, hold down the ALT key while you drag the handle.

If you want to reset the color balance (Hue and Saturation) setting, click the 
Reset Color Balance button under the color map you are using.

To adjust the luminance for a tonal range, drag the corresponding luminance 
slider under the appropriate color map. For example, if you want to adjust the 

MAGENTARED

YELLOW BLUE

CYANGREEN

Reset Color 
Balance button
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luminance for only the shadows, drag the luminance slider under the Shadows 
color map.

Luminance 
slider
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Performing an auto balance
Before matching colors, you can perform an auto balance on your target clip to 
automatically apply a color shift to your clip to compensate for different lighting 
conditions. To do this, click the Auto Balance button under the corresponding 
color map and use the eyedropper to select the area you want to correct in your 
clip. For example, to balance your clip’s highlights, click the Auto Balance 
button under the Highlights color map, and click (or click and drag) on the 
lightest area of your clip. The auto balance is performed immediately.

¦ Note To perform an auto white balance, click the Auto White Balance button 
under the Master color map, and click (or click and drag) on a white or light gray 
area of your clip.

Auto Balance 
button
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Matching colors between two clips
You can perform a color match to match colors between two clips (such as skin 
tone, sky, etc.). The color match lets you select colors from a reference clip to 
match to your target clip. You can affect the colors globally (Master), or just the 
Shadows, Midtones, or Highlights. 

You can select the colors for your reference color and match color by either 
clicking the Color Picker button or the eyedropper.

The eyedropper can be used in two ways:

• Click the eyedropper button and click on the desired color in your clip.

• Click the eyedropper button and click and drag anywhere on your clip to 
create a rectangular area containing the color you want to select. The 
selected color will be an average of the pixel information contained within 
the rectangle.

°To perform a color match:

1 Prepare your workspace for color correction by choosing Window > 
Workspace > Color Correction.

2 Open your target clip (clip that contains the colors you want to correct) in the 
Source Monitor.

¦ Note For best results when using a target clip that has multiple effects 
applied to it, create a nested sequence and open it in your Source Monitor 
before performing the color match. For more information about creating 
nested sequences, see your Adobe Premiere Pro documentation.

3 Apply the Matrox Color Correction effect to your target clip on the 
timeline.

4 Use the controls under the Reference Monitor to move to a frame in your 
reference clip that contains the colors you want to match.

5 Use the controls under the Source Monitor to go to the frame in your target 
clip that contains the colors you want to match to your reference clip.

EyedropperColor Picker button
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6 Select a reference color from your reference clip by using the Reference 
Color eyedropper under the color map you want to affect (Master, 
Shadows, Midtones, or Highlights). 

7 For example, to match a very dark color in your reference clip to your target 
clip, click the Reference Color eyedropper under the Shadows color map, 
and click (or click and drag) on the desired color in your reference clip.

8 Select a match color from your target clip in the Source Monitor window by 
using the Match Color eyedropper under the corresponding color map 
(Master, Shadows, Midtones, or Highlights).

Reference Color eyedropper

Match Color eyedropper
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Using the luma mapping graph
To modify your luma mapping values directly in the graph, click the triangle next 
to the Luma Mapping Graphical property to expand it:

• Map This is the default view when you first expand the Graphical 
property. You can drag the handles in the graph to adjust the Input and 
Output levels for black and white, as well as the Gamma.

• Plot Click this button to plot the luminance values in the current frame of 
your clip to the histogram (the plot will reflect any color correction changes 
you’ve made). Each luminance value present in your image appears as a 
vertical line in the histogram. A longer line indicates a higher amount of 
pixels in your image of that line’s luminance value. You can drag the handles 
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Black 
Level
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2 Output 
Black 
Level
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White 
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in the graph to adjust the Input and Output levels for black and white, as 
well as the Gamma.

• Auto Black Click this to define the darkest pixels in your clip as black. 
The intermediate luminance values are proportionally redistributed. 

• Auto White Click this to define the lightest pixels in your clip as white. 
The intermediate luminance values are proportionally redistributed.

¦ Note If you want to restore the default luminance values at any time, click 
the Restore Default Values button.
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Creating a Matrox secondary color correction
Matrox secondary color correction offers all the properties found in Matrox 
primary color correction, with the added capability of limiting the color 
correction to a specific range of pixels using the selective key properties. For 
example, secondary color correction can be used to change the color of a dress, 
deepen the background sky color, or to achieve an effect where only one object or 
person remains in color while the rest of the image becomes black and white. For 
details on how to isolate a color and make the rest of the clip black and white, see 
“Creating a color pass effect” on page 146.

¥ Tip Adobe Premiere Pro includes a workspace setup that is optimized for 
working with clips and effects to facilitate color correction. To prepare your 
workspace for color correction, choose Window > Workspace > Color 
Correction.

°To set up a Matrox secondary color correction:

Click the triangle next to Matrox Color Correction (Secondary) or Matrox 
Color Correction (Secondary - Advanced) to expand the property list.

¦ Note The RGB Curves and Tonal Range settings are available only with the 
advanced versions of the Matrox primary and secondary color correction effects. 
Because the advanced versions of these effects require additional system 
resources, you should apply them only if you want to use the RGB Curves or 
Tonal Range settings.
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• Enable Split View Select this option to split your clip into two sections in 
the Program Monitor and on your video monitor. One section will display 
your clip as you adjust the color correction controls, and the other section of 
the clip will remain unchanged. For more information, see “Using Split 
View” on page 124.

• Proc Amps The processing amplifier (proc amp) controls allow you to 
adjust different aspects of your clip:

$ Hue Adjusts the tint of the colors in the image.

$ Saturation Adjusts the saturation (vividness) of the image’s colors.

$ Contrast Adjusts the difference in luminance between the lightest and 
darkest areas of the image.

$ Brightness Adjusts the level of black in the image.

• RGB Curves Lets you use curves to adjust the red, green, and blue color 
channels of your clip individually, or use a master curve to adjust all color 
channels simultaneously. For more information, see “Using RGB curves” on 
page 126.

• Color Balance These controls let you adjust the mixture of colors in your 
clip.

$ Tonal Range Allows you to fine-tune the tonal ranges of your clip by 
reducing the range of pixels included for shadows, midtones, or 
highlights. For more information, see “Adjusting tonal range” on 
page 128.

$ Graphical Allows you to see a graphical representation of your changes 
when you adjust the color balance settings. You can also adjust and 
modify most of the color balance settings directly within the graph. For 
more information, see “Using the color balance graph” on page 129.

$ Numerical Lets you adjust your color balance settings numerically by 
entering values in the text boxes, or by dragging the corresponding sliders. 
You can adjust the Hue, Saturation, and Luminance for each tonal 
range.

• Master (Hue, Saturation, and Luminance) Affects all areas of 
your clip from the lightest white to the darkest black.

• Shadows (Hue, Saturation, and Luminance) Affects the darkest 
areas of your clip.

• Midtones (Hue, Saturation, and Luminance) Affects the areas 
with tones between the darkest and lightest areas of your clip.

• Highlights (Hue, Saturation, and Luminance) Affects the lightest 
areas of your clip.

• Luma Mapping
pter 10, Setting Up Matrox Effects with Adobe Premiere Pro



139
$ Graphical Allows you to see a graphical representation of your changes 
when you adjust the luma mapping settings. You can also modify the 
luminance of your clip directly within the graph. For more information, 
see “Using the luma mapping graph” on page 135.

$ Numerical Lets you adjust your luma mapping settings numerically by 
entering values in the text boxes, or by dragging the corresponding sliders. 

• Input Levels (Black and White)  These controls let you fine-tune 
your clip’s brightness and contrast by changing the luminance value 
that represents black, white, or gray. Doing so expands or compresses 
the range of luminance levels in your clip, which increases or decreases 
your clip’s tonal range.

For example, by increasing the black value, you set black in your clip 
to a higher luminance value, which compresses the luminance range 
and darkens your clip proportionally.

• Output Levels (Black and White) These controls let you map the 
values under Input Levels to any level of black and white. You can 
reduce contrast in your clip, or reverse the luminosity of your clip by 
setting black to a higher value than white.

• Gamma Use this to adjust the midtones in your clip without 
adjusting black or white.

• Mask  Allows you to apply a mask to your effect. For more information, 
see “Applying a mask to your Matrox effects” on page 120.

• Selective Key The selective key settings allow you to apply the color 
correction effect to a specific range of pixels in your clip. Performing a 
selective key is similar to performing a chroma or luma key, however, with a 
selective key you are applying color correction to the keyed area instead of 
transparency. For example, if you use the selective key properties to select 
red as your Hue color, the color correction will be applied to the red regions 
in your clip. You can enable each keyer (Hue, Saturation, and Luma) 
individually, or enable all three at the same time to get the desired results. 

$ Graphical Allows you to see a graphical representation of your changes 
when you adjust the selective key Numerical settings. You can also 
modify the settings directly within the graph and perform an auto key. For 
more information, see “Using the selective key graph” on page 142.

$ Numerical Lets you adjust your key settings numerically by entering 
values in the text boxes, or by dragging the corresponding sliders.

• Hue Key This type of key lets you select areas to be keyed (affected 
by the color correction) based on their hue.

$ Enable Select this to enable the Hue Key properties and hue key 
indicator in the selective key graph.
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$ Hue Use this to rotate the indicator around the perimeter of the color 
spectrum so that you can select different hues (colors) on which to key.

$ Aperture Use this to widen or narrow the aperture of the indicator 
to increase or decrease the range of colors on which you want to key.

$ Softness Sets the amount of softness applied to the range of colors 
specified in the aperture region.

• Saturation Key This lets you select colors to be keyed (affected by 
the color correction) based on their saturation value. Pale colors have a 
low saturation value, while vivid colors have a high saturation value.

$ Enable Select this to enable the Saturation Key properties and 
saturation key indicator in the selective key graph.

$ Low Clip Use this to select the lower saturation values to be keyed. 

$ Low Gain Use this to set the range of saturation values you want 
to be partially affected based on the value set by the Low Clip control. 
As you increase the Low Gain setting, more pixels are partially 
affected by the color correction. If you decrease the Low Gain control, 
less pixels are partially affected.

A Low Gain setting of 100 provides the widest range for maximum 
color correction. Alternately, a gain setting of 0 creates a key where 
saturation values are either completely affected or left untouched. You 
can think of the Low Gain control as defining an “Affected to 
Untouched” range for keying the pale colors in your image.

$ High Gain This control is similar to the Low Gain setting, except 
you use it to set the range of higher saturation values you want to be 
partially affected based on the value set by the High Clip control. As 
you increase the High Gain setting, less pixels are partially affected 
by the color correction. If you decrease the High Gain setting, more 
pixels are partially affected. You can think of the High Gain control 
as defining an “Untouched to Affected” range for keying the vivid 
colors of your image.

$ High Clip This control is similar to Low Gain, except you use it to 
select the higher saturation values to be keyed.

¦ Note The values you can select using the Low Clip and Low Gain 
controls are dependent on the High Clip and High Gain controls, and 
vice versa. This prevents the low and high controls from keying on 
the same values.

• Luma Key This type of key lets you select areas to be keyed (affected 
by the color correction) based on their luminance value.

$ Enable Select this to enable the Luma Key properties and luma key 
indicator in the selective key graph.
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$ Low Clip Use this to select the lower (darker) luminance values to 
be keyed. A Low Clip setting of 0 represents black, and a setting of 
255 represents white. Intermediate settings represent different shades 
of gray, from very dark to very light gray.

$ Low Gain Use this to set the range of luminance values you want 
to be partially affected based on the value set by the Low Clip control. 
As you increase the Low Gain setting, more luminance values 
become partially affected by the color correction.

A Low Gain setting of 100 provides the widest range for maximum 
color correction. Alternately, a gain setting of 0 creates a key where 
the luminance values are either completely affected or left untouched. 
You can think of the Low Gain control as defining an “Affected to 
Untouched” range for keying the dark areas of your image.

$ High Gain This control is similar to Low Gain, except you use it 
to set the range of luminance values you want to be partially affected 
based on the value set by the High Clip control. You can think of the 
High Gain control as defining an “Untouched to Affected” range for 
keying the lighter areas of your image.

$ High Clip This control is similar to Low Clip, except you use it to 
select the higher (brighter) luminance values to be keyed.

¦ Note The values you can select using the Low Clip and Low Gain 
controls are dependent on the High Clip and High Gain controls, and 
vice versa. This prevents the low and high controls from keying on 
the same luminance values.

• Invert Key Select this to invert the key selection, giving you the 
opposite result of what you originally selected. 

• Show Key as Output Select this to display the matte used to define 
your selective key region. This enables you to further refine your key. 
Areas that are completely affected by the color correction are white, 
untouched areas are black, and gray areas are partially affected.

• Expand Outside Mask Applies the color correction settings outside 
the mask area. This setting is especially useful when setting up a color 
pass effect where you have several objects of the same color but want to 
retain the color for only one object. For more information, see 
“Creating a color pass effect” on page 146.
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Using the selective key graph
The selective key graph allows you to modify your selective key settings (Hue 
Key, Saturation Key, and Luma Key) directly in the graph. You can also 
perform an auto key.

• Map This is the default view when you first expand the graphical property. 
You can drag the handles to move the indicator to different regions in the 
graph to adjust the Hue Key, Saturation Key, and Luma Key settings.

In order to see the indicator and handles, you have to enable the key setting you 
want to use. For example, if you want to adjust the Hue Key properties, you need 
to click the Hue button in the selective key graph or select the Enable option in 
the Hue Key numerical properties. In the following graph, the Hue properties 
have been enabled. 

• Plot Click this button to plot the colors and luminance values that are 
present in the current frame of your clip. You can drag the handles to move 
the indicator to different regions in the graph to adjust the Hue Key, 
Saturation Key, and Luma Key properties. The luma plot histogram shows 
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each luminance value present in your image as a vertical line. A longer line 
indicates a higher amount of pixels in your image of that line’s luminance 
value. 

• Hue Click this button to enable or disable the Hue Key properties (Hue, 
Aperture and Softness). When enabled you will be able to see the Hue 
Key indicator and handles to modify the Hue Key properties in the selective 
key graph.

• Sat Click this button to enable or disable the Saturation Key properties 
(Low Clip, Low Gain, High Gain, and High Clip). When enabled you will 
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be able to see the Sat Key indicator and handles to modify the Saturation 
Key properties in the selective key graph.

• Lum Click this button to enable or disable the Luma Key properties (Low 
Clip, Low Gain, High Gain, and High Clip). When enabled you will be 
able to see the Lum Key indicator and handles to modify the Luma Key 
properties in the selective key graph.

• For both the Saturation Key and Luma Key properties, you can lock and 
move all the handles at the same time in the selective key graph by pressing 
SHIFT and then dragging any handle. If you press CTRL you can lock and 
move either the Low Clip and Low Gain handles or High Gain and High 
Clip handles. 

0 Low Clip 1 Low Gain 2 High Gain 3 High Clip

0 Low Clip 1 Low Gain 2 High Gain 3 High Clip

0123

0

1 2

3

pter 10, Setting Up Matrox Effects with Adobe Premiere Pro



145
¦ Note If you want to reset the hue, saturation, and luma key properties to the 
default settings at any time, click the appropriate Reset button.

• Show Key Click this button to display the matte used to define your 
selective key region. This enables you to further refine your key. Areas that 
are completely affected by the color correction are white, untouched areas 
are black, and gray areas are partially affected.

• Auto Key Click this button to automatically key on the most common 
color at the current frame (except gray). Selecting Auto Key affects values 
for the Hue Key, Saturation Key, and the Luma key properties. 
Alternately, you can use the auto key eyedropper to select a color on which 
you want to key. 

• The auto key eyedropper can be used in two ways:

$ Click the eyedropper button and click on a color on which you want to 
key.

$ Click the eyedropper button and click and drag anywhere on your clip to 
create a rectangular area containing the color on which you want to key. 
The selected color will be an average of the pixel information contained 
within the rectangle.

You can further refine your auto key color by using the plus and minus eye-
droppers. 

For example, if you selected light red as your auto key color and would like a 
dark red color in your clip to be included in the auto key, you can use the 
plus eyedropper to select that dark red in your clip. To remove colors from 
your auto key, use the minus eyedropper. 

¦ Note The Show Key mode and any color correction applied will be 
temporarily deactivated in the Program Monitor when using an eyedropper. 

Saturation Key 
Reset button

Auto key 
eyedropper

Plus and minus 
eyedroppers
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This allows you to see the original colors of your clip before any modifications 
were made.

• Indicator Click this button to turn the indicator lines on or off.

• Handles Click this button to turn the handles for the indicator lines on or 
off.

Creating a color pass effect
You can use the Matrox secondary color correction to create a color pass effect to 
convert your clip to black and white, with the exception of one specified color. 
This can be useful if you want to isolate a single color to make it prominent. 

In the following example, the pink color of the girl’s shirt has been retained, 
while the rest of the clip has been converted to black and white:

°To perform a color pass effect:

1 Click the Auto Key eyedropper in the selective key graph and click and drag 
anywhere on your clip to create a rectangular area containing the color you 
want to isolate.

2 Under Proc Amps, set the Saturation to 0.

3 Select Invert Key.

If you have more than one object of the same color but you want to isolate only 
one of those objects, you can apply a mask and use the Expand Outside Mask 
option to isolate the area that contains the color you want to remain intact. For 
example, if you have a clip that has two roses that are the same red and you 
would like only one of them to remain red, you can do the following.

°To perform a color pass effect using the Expand Outside Mask option:

1 Click the auto key eyedropper in the selective key graph and click and drag 
anywhere on your clip to create a rectangular area containing the color you 
want to isolate.

2 Under Proc Amps set the Saturation to 0.

3 Select Invert Key.

Pink shirt is isolated, 
while the rest of clip is 
grayscale.
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4 Apply a mask surrounding the colored object you want to remain intact (see 
the next section, “Applying a mask to your Matrox effects).

5 Select Expand Outside Mask.

Overview of the Matrox chroma key effects
You can apply a Matrox chroma key or chroma key shadow effect to make certain 
areas of a foreground image transparent based on a color in that image, so that an 
underlying image can show through.

In the following example of a chroma key effect, our foreground image is a video 
clip of a woman sitting in front of a green backdrop, and our underlying image is 
a video clip of a sand dune:

By chroma keying on the particular shade of green in the backdrop of the 
foreground image, the backdrop area becomes transparent and the corresponding 
area of the underlying image shows through in the composite image as follows:

¡ Important The chroma key shadow effect includes controls for fine-tuning 
shadows in your effect. It is best to use the chroma key shadow effect when you 
are performing a chroma key without any additional effects. If you want to apply 

Foreground image Underlying image

+

Result of chroma key

=
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additional effects to your chroma key, you will get more desirable results by 
using the chroma key effect without shadow controls. For example, if you want to 
apply an Adobe Motion effect to your chroma key, you should use the chroma 
key effect and not the chroma key shadow effect.

Creating a chroma key or chroma key shadow 
effect

To set up a Matrox chroma key or chroma key shadow effect, click the triangle 
next to Matrox Chroma Key/Matrox Chroma Key Shadow to expand the 
property list: 

• Graphical Provides a graphical representation of the chroma key controls 
that you can use to select your key colors, and also lets you perform an auto 
key. 

$ Map Lets you select your key colors within a circular graph that 
contains a color spectrum.

$ Plot Displays a plot of the colors present in your clip so that you can 
select the particular colors on which you want to key.
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$ Show Key Click this button to display the matte used to create your key 
effect. This enables you to further refine your key. For example, when you 
display the matte, your key color (such as green) appears as black, and 
opaque areas appear as white. If you notice some white spots that you 
want to key, you can adjust the key controls until the undesired white 
spots disappear.

$ Auto Key Click this button to automatically key on the most common 
color at the current frame in your clip (except gray).

For details on selecting key colors within the graph or performing an auto 
key, see “Using the chroma key graph to modify key colors and perform an 
auto key” on page 151.

¦ Note You must expand the Graphical property in order to see the indicator 
when adjusting the chroma key controls.

• Hue Use this to rotate the indicator around the perimeter of the color 
spectrum so that you can select different hues (colors) on which to key.

• Aperture Use this to widen or narrow the aperture of the indicator to 
increase or decrease the range of colors on which you want to key.

• Saturation Use this to select colors that have a particular saturation value. 
Pale colors have a low saturation value and are located at or near the center 
of the spectrum. Vivid colors have a high saturation value and are located at 
or near the perimeter of the spectrum. Because pale colors have low 
saturation, you’ll find them more difficult to key on than the vivid colors.

• Saturation Threshold Use this to proportionally increase or decrease the 
region outside of your saturation range. This controls how closely the 
Saturation value must match the key color before a region becomes 
transparent.

For example, after applying a chroma key effect to a foreground image that 
includes dark areas or shadows that you want to preserve in your effect, you 
may find that these areas have become semi-transparent. By adjusting the 
Saturation Threshold, you can eliminate the key color from these dark 
areas, so that they’ll become completely opaque.

• Softness Use this to soften the edges of your key by blending parts of 
your foreground image with your underlying image. This makes certain 
areas of your foreground image partially transparent instead of completely 
transparent or opaque.

• Spill Removal Use this to remove the contamination (spill) that your key 
color may leave on or around the edges of your foreground image. Spill is 
usually caused by light reflecting from your solid color backdrop (key color) 
onto your foreground image. Spill Removal replaces your key color from 
the “spill areas” with the opposite color in the spectrum, which returns a 
more natural look to these areas.
Creating a chroma key or chroma key shadow effect
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• Chroma Suppression Use this to remove any tint that your key color 
imposes on your foreground image. For example, if your solid color 
backdrop (key color) is green and you are using a person in your foreground 
image, the person’s skin may have a green tint. You can adjust the Chroma 
Suppression to replace the green tint with the opposite color in the 
spectrum to return the person’s skin to a more natural-looking color.

¦ Note The following properties (Luminance and Shadow Suppression) 
are only available in the chroma key shadow effect.

• Luminance Use this to adjust the luminance of your shadow. Negative 
values increase the brightness of the shadow, while positive values decrease 
the brightness.

• Shadow Suppression Use this to make shadows in your clips less 
apparent. A higher value indicates less shadow.

• Mask Allows you to apply a mask to your effect. For more information, 
see “Applying a mask to your Matrox effects” on page 120.

• Transparent Outside Mask Select this option to apply transparency 
outside the mask area. This allows you to define a mask area where you want 
the keying to be performed, and show only your underlying image outside 
the mask. For more information, see “Applying a mask to your Matrox 
effects” on page 120.

• Invert Key Select this to invert the key selection, giving you the opposite 
result of what you originally selected.

• Show Key as Output Select this to display the matte used to create your 
key effect. This enables you to further refine your key. For example, when 
you display the matte, your key color (such as green) appears as black, and 
opaque areas appear as white. If you notice some white spots that you want 
to key, you can adjust the key controls until the undesired white spots 
disappear.
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Using the chroma key graph to modify key 
colors and perform an auto key
To modify your key colors directly within the chroma key graph or perform an 
auto key, click the triangle next to the Graphical property to expand it:

• Map This is the default view when you first expand the Graphical 
property. You can drag the handles in the color spectrum to move the 
indicator to different regions in the cube to adjust the Hue, Aperture, 
Saturation, and Saturation Threshold. 

¦ Note This graph will contain a luminance spectrum only if you are creating a 
chroma key shadow effect. You can drag the handle in the luminance spectrum to 
adjust the Luminance.

• Plot Click this button to plot the colors and luminance values that are 
present in the current frame of your clip. You can drag the handles in the 
chroma plot graph to move the indicator to different regions in the graph to 
adjust the Hue, Aperture, Saturation, and Saturation Threshold. The 
luma plot histogram shows each luminance value present in your image as a 
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vertical line. A longer line indicates a higher amount of pixels in your image 
of that line’s luminance value. 

¦ Note The Plot graph will contain a luma plot histogram only if you are 
creating a chroma key shadow effect. You can drag the handle in the luma plot 
histogram to adjust the Luminance.

• Show Key Click this button to display the matte used to create your key 
effect. This enables you to further refine your key. For example, when you 
display the matte, your key color (such as green) appears as black, and 
opaque areas appear as white. If you notice some white spots that you want 
to key, you can adjust the key controls until the undesired white spots 
disappear.

• Auto Key Click this button to automatically key on the most common 
color at the current frame (except gray). Selecting Auto Key affects values 
for Hue, Aperture, Saturation, and Saturation Threshold. If your clip 
consists of a uniform key color that is evenly lighted, Auto Key will usually 
give you a good-quality chroma key. Alternately, you can use the eyedropper 
to select a color on which you want to key. 

You can use the eyedropper in two ways:

$ Click the eyedropper button and click on a color on which you want to 
key.

3

3
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eyedropper
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$ Click the eyedropper button and click and drag anywhere on your clip to 
select a rectangular area containing colors on which you want to key.

¦ Note The Show Key mode and any chroma key applied will be temporarily 
deactivated in the Program Monitor when using the auto key eyedropper. This 
allows you to see the original colors of your clip before any modifications 
were made.

• Indicator Click this button to turn the indicator on or off.

• Handles Click this button to turn the handles for the indicator on or off.
Creating a chroma key or chroma key shadow effect
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Overview of the Matrox luma key effect
You can apply a Matrox luma key to make certain areas of a foreground image 
transparent based on the luminance in that image, so that an underlying image 
can show through.

In the following example of a luma key effect, two video clips are combined to 
produce the effect of two cowboys riding through fire. Our foreground image is a 
video clip of a ring of fire against a black background, and our underlying image 
is a video clip of two men riding horses:

By luma keying on the particular luminance (brightness) of the black areas in the 
foreground clip, these areas become transparent and the corresponding areas of 
the underlying image show through in the composite image as follows:

Foreground image Underlying image

+

Result of luma key

=
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Creating a luma key effect
To set up a Matrox luma key effect, click the triangle next to Matrox Luma Key 
to expand the property list:

• Graphical Allows you to see a graphical representation of your changes 
when you adjust the property settings. You can adjust the luma key 
properties directly in the graph to select the luminance values on which you 
want to key. For more information, see “Using the luma key graph” on 
page 156.

• Transparency Use this control to set the transparency level of your key 
effect. Higher values indicate higher transparency. For example, a 
Transparency value of 100 makes the keyed area in your foreground image 
completely transparent, leaving the underlying image visible.

• Low Clip Use this to select the lower (darker) luminance values to be 
keyed. A Low Clip setting of 0 represents black, and a setting of 255 
represents white. Intermediate settings represent different shades of gray, 
from very dark to very light gray.

• Low Gain Use this to set the range of luminance values you want to be 
partially transparent based on the value set by the Low Clip control. As you 
increase the Low Gain setting, more luminance values become partially 
transparent to give you a softer-edged key.

A Low Gain setting of 100 provides the widest range for maximum 
softness. Alternately, a gain setting of 0 creates a hard key where the 
luminance values are either completely transparent or opaque. You can think 
Creating a luma key effect
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of the Low Gain control as defining a “Transparent to Opaque” range for 
keying the dark areas of your foreground image.

• High Clip This control is similar to Low Clip, except you use it to select 
the higher (brighter) luminance values to be keyed.

• High Gain This control is similar to Low Gain, except you use it to set the 
range of luminance values you want to be partially transparent based on the 
value set by the High Clip control. You can think of the High Gain control 
as defining an “Opaque to Transparent” range for keying the lighter areas of 
your foreground image.

The values you can select using the Low Clip and Low Gain controls are 
dependent on the High Clip and High Gain controls, and vice versa. This 
prevents the low and high controls from keying on the same luminance 
values.

• Mask  Allows you to apply a mask to your effect. For more information, 
see “Applying a mask to your Matrox effects” on page 120.

• Transparent Outside Mask Select this option to apply transparency 
outside the mask area. This allows you to define a mask area where you want 
the keying to be performed, and show only your underlying image outside 
the mask. For more information, see “Applying a mask to your Matrox 
effects” on page 120.

• Invert Key Select this to invert the key selection, giving you the opposite 
result of what you originally selected

• Show Key as Output Select this to display the matte used to create your 
key effect. This enables you to further refine your key settings. For example, 
when you display the matte, areas of your clip that are completely 
transparent appear as black, and opaque areas appear as white. If you notice 
some white spots that you want to key, you can adjust the key controls until 
the undesired white spots disappear.

Using the luma key graph
The luma key graph contains a luminance spectrum and a luminance eyedropper. 
You can drag the handles in the luminance spectrum to adjust the Transparency, 
Low Clip, High Clip, Low Gain, and High Gain properties.

Eyedropper 
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You can select luminance values on which to key by adjusting the Low Clip and 
High Clip handles, or you can use the luminance eyedropper to automatically 
pick the luminance value you want to key on. The eyedropper can be used in two 
ways:

• Click the eyedropper button and click on the color with the desired 
luminance value in your clip.

• Click the eyedropper button and click and drag anywhere on your clip to 
create a rectangular area containing the luminance values you want to select. 
The selected luminance will be an average of the luminance values contained 
within the rectangle.

¦ Note Any luma key displayed in the Program Monitor will be temporarily 
deactivated when using the luminance eyedropper. This allows you to see the 
colors of your clip before any modifications were made.

You can also adjust the softness of your key with the Low Gain, High Gain, and 
Transparency handles. All these adjustments affect the shape and size of the 
luminance selector as follows:

• Plot Click this button to see the luminance spectrum with a plot that shows 
each luminance value present in your image as a vertical line in the 
histogram. A longer line indicates a higher amount of pixels in your image of 
that line’s luminance value. You can drag the handles in the luma plot 
spectrum to adjust the Transparency, Low Clip, High Clip, Low Gain, and 
High Gain properties. Any adjustments made affect the shape and size of the 
luminance selector in the Luma Plot.

HIGH GAINLOW GAIN

TRANS
LOW CLIP HIGH CLIP
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Creating a wipe transition
The Matrox wipe transitions support standard dissolves, SMPTE wipes, and 
organic wipes with soft edges and color borders.

°To set up a Matrox wipe transition: 

Click the transition’s icon in your sequence, then click the Custom button in the 
Effect Controls panel. This opens the Customize Matrox Wipes dialog box:

1 Under Wipe Pattern, click the Select Pattern button and choose a pattern 
for your wipe.

2 If you would like to add a border to your wipe, select Enable under Border. 

$ Width Lets you adjust the width of your border by dragging the slider 
or entering a percentage in the text box.

$ Color Click this button to select a color for your border.
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$ Balance Lets you adjust the prominence of the border between image A 
and image B. For example, positive values make the border more 
prominent in image B, while negative values make the border more 
prominent in image A.

$ Reset Click this button to restore the default Border values.

3 Use the controls under Softness to create a soft edge on the border of your 
wipe. 

$ Nonlinear softness This option is selected by default. You may find it 
useful to clear this option when using certain wipe patterns. For example, 
nonlinear softness often provides better results when creating SMPTE 
wipes, while linear softness is usually preferable when creating organic 
wipes. 

$ Amount Lets you adjust the amount of softness by dragging the slider 
or entering a percentage in the text box. The higher the value, the less 
sharp the edge of your border or wipe will become. 

$ Reset Click this button at any time to restore the default Softness 
values.

4 Use the controls under Preview to preview your wipe transition:

$ Drag the slider beside the Play button to scrub through your transition.

$ Click the Play button or press the SPACEBAR to play back your transition. 
Select Loop if you’d like the wipe to play back continuously until you 
click Stop. 

You can adjust the wipe settings as your transition is playing to immediately 
see the result of your changes.

5 Use the controls under Presets to save and load your wipe transition 
settings. You can also create default settings for your wipe transitions.

$ Save Allows you to save your organic wipe settings to a file for future 
use. When you click the Save button, the Save As dialog box opens and 
allows you to name your effect and save it as a Matrox wipe transition 
(.mwt) file.

$ Load Click this button to load a previously created .mwt file.

$ Set as Default Sets your current wipe settings as the default settings 
for Matrox wipe transitions.

$ Restore Default Click this button to restore the default settings you 
specified using the Set as Default button.

For more information about setting up transitions, see your Adobe Premiere Pro 
documentation.
Creating a wipe transition
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Using the Matrox chroma clamper effect
You can use the Matrox chroma clamper effect to ensure that when you’ve 
applied effects that perform color space conversion on part of a clip, the clip’s 
colors remain constant throughout. Some Adobe Premiere Pro native effects 
perform color space conversions (YUV to RGB) that will clip RGB values to the 
acceptable range of 0-255 per color component. The clipping, however, is usually 
only required on clips that have very bright or highly saturated colors.

For example, if you split a clip that contains very bright or highly saturated colors 
and apply an Adobe basic 3D effect to one portion of the clip, you may notice 
minor color differences between the two halves on your video monitor. Applying 
the Matrox chroma clamper effect to the portion of the clip that does not have the 
Adobe effect ensures that colors remain constant throughout the clip.

Selecting your speed control method
You can choose the type of speed control that’s best suited for individual clips in 
your Premiere Pro projects. You can apply the Frame Blend option to a clip, 
which interpolates between the video fields or frames, and typically works well 
on standard or slow-paced video and camera pans. For fast action video you may 
get better results by clearing this option.

To change the speed control method for a clip in the Timeline panel, right-click 
the clip and select Frame Blend to use the speed control method that’s 
recommended for standard or slow-paced video and camera pans, or clear this 
option for fast-action video.
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Using Matrox A/V Tools

This chapter explains how to 
use Matrox A/V Tools to 
capture clips, grab 
single-frame images, and play 
back clips in a clip list.
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About Matrox A/V Tools
Matrox A/V Tools is an application that allows you to capture and play back 
clips. With A/V Tools, you can:

• Capture analog, SDI1, or HDMI video from your camera or VTR into .avi 
files on your computer.

• Use onscreen transport controls to navigate quickly and easily through clips 
on disk.

• Grab single-frame images and save them as .tga files, such as to create photo 
montages. 

• Change the order of clips in your clip list by simply dragging and dropping 
clips into the sequence you want.

Starting Matrox A/V Tools
1 Choose Start > Programs > Matrox Mtx.utils > Matrox AV Tools.

2 The Options dialog box pops up every time A/V Tools starts. For 
information about the settings in the Options dialog box, see “Defining your 
A/V Tools options” on page 166. To close the Options dialog box and start 
working with A/V Tools, click OK.

1 SDI is not supported on Matrox MXO2 Mini.
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Using the Matrox A/V Tools interface
Once you’ve specified your A/V Tools options, a dialog box similar to the 
following appears:

Here’s a brief description of the A/V Tools dialog box: 

0 New tab Use this tab to capture new clips to add to your clip list. See 
“Capturing clips” on page 187.

1 Edit tab Use this tab to edit clips, and update clip information. For details, 
see “Editing clips” on page 188.

2 Preview Window Allows you to preview video from your camera, VTR, 
or clips on disk. The preview is also displayed on your video monitor. 

3 CAM and Disk buttons These buttons let you switch between the 
following modes: 

2

3

4

5

6

7

8

0 1
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$ CAM mode lets you capture live video from your camera, or video on 
tape.

$ Disk mode lets you play back captured clips in your clip list.

4 Clip identification area This section contains several items to help you 
identify your clips. 

$ Tape ID Displays the name that you’ve assigned to the tape in your 
VTR. 

$ Clip ID Displays the base name for your new clips when using the New 
tab, or the name of the currently selected clip when using the Edit tab. For 
details, see “How A/V Tools assigns clip names” on page 187.

$ Comment Lets you enter comments that help you distinguish between 
clips in your clip list.

5 Transport controls A set of common transport controls that lets you 
easily navigate through clips on disk. For more information, see “Navigating 
through clips with the transport controls” on page 164.

6 Clip list A numbered list of clips and their properties. As you capture clips 
in A/V Tools, your clips are automatically added to the clip list. The clip list 
can be docked to the Matrox A/V Tools dialog box or float freely as a 
resizable window. For more information on using the clip list, see “Working 
with the clip list” on page 189. 

7 Status bar Displays information about the operation you’re currently 
performing in A/V Tools, such as clip information and if frames are dropped 
during a capture.

8 Float/dock clip list button This button lets you dock the clip list to the 
Matrox A/V Tools dialog box, or detach the clip list so that you can move 
and resize it. For more information, see “Detaching and resizing the clip list” 
on page 191.

Using the A/V Tools pop-up menu
When you right-click anywhere in the clip list, a pop-up menu appears containing 
commands for working with A/V Tools. All commands present in the A/V Tools 
pop-up menu are described in this chapter. 

Navigating through clips with the transport 
controls
A/V Tools includes a common set of transport controls for navigating through 
clips on your hard drive when working in Disk mode. 

¦ Note The transport controls are disabled in CAM mode.
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The transport controls are much like those on your VTR:

Most of these controls perform standard transport functions, but some can be 
used for special tasks:

• Scrub Drag the slider on the Positioner to scrub through any clip in your 
clip list. 

• Cue to In or Out point on disk Click the Rewind or Fast Forward 
button to cue to the beginning or end of a clip on disk. 

• View frame-by-frame Click the Frame Reverse or Frame Advance 
button.

• Play a clip on disk repeatedly Click the Loop button, then click the 
Play button.

Keyboard Shortcuts

Disk mode K

Play B

 Rewind Z

Fast Forward X

Frame Advance ’ (apostrophe)

Frame Reverse ; (semicolon)

Stop V

Loop A

Loop 
button

Positioner
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Changing the time code display
A value in a time code field can be displayed as a time code or a specific number 
of frames. The first time you run A/V Tools, the fields display time codes. To 
toggle between the two formats, press CTRL+SHIFT while the insertion point 
(flashing vertical bar) is in any time code field. 

For example, when working with NTSC clips, you could change a value of 24:04 
(24 seconds, 4 frames) to 724 frames by pressing CTRL+SHIFT, and then switch 
back to time codes again by pressing CTRL+SHIFT.

The time code format of your tape is indicated by the separator between the 
seconds and frames digits in the time code fields as follows: 

• A colon ( : ) indicates non-drop frame.

• A semicolon ( ; ) indicates drop frame.

Defining your A/V Tools options
Before capturing or playing back clips with A/V Tools, you need to specify 
various options, such as your editing video format and your capture and playback 
settings. 

°To define your options for A/V Tools:

1 Click the Options button. 

¦ Note The Options dialog box automatically pops up every time A/V Tools 
starts.

2 Under Capture Folder, specify the folder where you want to store your 
captured clips. For more information, see “Selecting your capture folder” on 
page 168. 
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3 Under Editing Video Format, select the video format and aspect ratio you 
want for your clips. For example, select NTSC and 4:3 if you want to capture 
and play back NTSC clips with a standard 4:3 aspect ratio.

Remarks
$ When you select an editing video format, many of the playback and 

capture settings are predetermined for you. All clips are captured to your 
selected video format, and clips added to the clip list must have the same 
frame size and frame rate. You can mix interlaced and progressive clips 
that have the same frame size and frame rate in a clip list.

$ Once your editing video format has been defined, it cannot be changed. 
You can run multiple instances of A/V Tools if you want to capture or 
play back clips with a different video format.

$ Your editing video format will automatically change if you load a .dvl file 
with a different format. For more information see, “Saving and loading a 
clip list” on page 189.

4 Under Display Time Code As, select the format that you want for 
displaying time codes in A/V Tools (applicable only if you’re using a video 
format that has a frame rate of 29.97 or 59.94). The format used is indicated 
by the separator between the seconds and frames digits in the time code 
fields as follows:

$ A colon ( : ) indicates non-drop frame.

$ A semicolon ( ; ) indicates drop frame.

5 Click the Playback Settings button to specify your playback settings (see 
“Defining your playback settings” on page 168).

6 Click the Capture Settings button to specify your capture settings (see 
“Defining your capture settings” on page 180). If capture is not supported for 
your selected editing video format, a message will be displayed to indicate 
that it is not supported. For information about the supported capture formats, 
see Appendix C, “Matrox MXO2 Supported Input and Capture Formats.”

7 Click OK to save your settings.
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Selecting your capture folder
You can select the folder where you want A/V Tools to store your captured clips 
by typing the drive and folder name directly into the Capture Folder box, or by 
using the Browse button.

To ensure the best capture and playback performance of your clips, save them on 
one of your A/V drives. 

A/V Tools will save your video and audio clips in a subfolder with the same 
name as the Tape ID. For example, if you selected D:\Matrox AV Tools Capture 
as your capture folder, all video and audio clips from tape “MyTape” will be 
saved in D:\Matrox AV Tools Capture\MyTape. 

Defining your playback settings
The Matrox Playback Settings dialog box has several pages that you can use to 
specify various settings for working with A/V Tools. When you select your 
editing video format in the Options dialog box, many settings are optimized for 
you.

Specifying your general settings
To specify your general settings for playback in A/V Tools:

1 Click the Options button in the Matrox A/V Tools dialog box.

2 Click the Playback Settings button. This displays the Matrox Playback 
Settings dialog box.

¦ Note You can also access the Matrox Playback Settings dialog box by 
right-clicking the clip list and selecting Playback Settings.

3 Click the General tab.

4 Under Scrubbing Mode, select Frame, 1st Field, or 2nd Field to indicate 
whether you want to display frames or only one field when you scrub your 
clips in the clip list using the transport controls. For example, you may want 
to scrub the first or second field to eliminate the flickering that can be seen in 
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your picture when you pause while scrubbing interlaced video. Scrubbing 
fields can also be used to check for any dropped fields that may have 
occurred in your video during a telecine process.

¦ Note When using a progressive editing video format, the scrubbing mode 
is set to Frame.

5 Under Video Processing Format, select either 8-bit or 10-bit to indicate 
the bit depth you want to use for processing video. This option is 
automatically set to 8-bit when using a 1440×1080i/p editing video format.

¦ Note If you select a 10-bit video processing format, you’ll be able to capture 
clips to Matrox 10-bit uncompressed format only.

6 Use the Preroll/Postroll frames for audio scrubbing sliders to specify the 
number of audio frames you want to be played before/after the location of 
the positioner when you scrub a clip. This lets you hear more audio to help 
you better identify sounds when scrubbing. For example, if you set the 
number of preroll frames for audio scrubbing to 3, you will hear the audio 
for the current frame and three previous frames when you scrub a frame in a 
clip.

¦ Note To return a slider to it’s default setting, click its D button. This button 
is available for all sliders in the Matrox dialog boxes.

7 Click OK to save your settings. 
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Specifying your video output settings
This section explains how to specify your video output settings for Matrox 
MXO2, MXO2 Rack, and MXO2 LE. For MXO2 Mini, see “Specifying your 
video output settings (MXO2 Mini)” on page 174.

You can specify various settings to configure the main and secondary outputs 
from your MXO2 system. Some of the settings are predetermined for you based 
on your editing video format. For a list of the supported video output formats, see 
“Playback using Adobe Premiere Pro, Matrox A/V Tools, and Matrox 
WYSIWYG” on page 272.

°To specify your video output settings:

1 Click the Options button in the Matrox A/V Tools dialog box.

2 Click the Playback Settings button. This displays the Playback Settings 
dialog box. 

3 Click the Video Output tab.
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4 Under Main Output and Secondary Output, you can specify the settings 
you want for your main and secondary outputs from MXO2. Depending on 
the editing video format you chose in the Options dialog box, you may not 
be able to change some of the settings.

$ Format Use this to select the video format you want for your outputs. 
Be aware that the format you select may not be supported on all the 
MXO2 outputs. For a list of the supported formats, see “Playback using 
Adobe Premiere Pro, Matrox A/V Tools, and Matrox WYSIWYG” on 
page 272.

$ Pulldown Method If this setting is available, select the pulldown 
method you want to be applied to your video output (Standard 2:3 or 
Advanced 2:3:3:2). Depending on your editing video format’s frame 
rate and the current video output format, a pulldown method may 
automatically be selected.

$ Aspect Ratio Conversion Use this to specify how you want your 
video to be output when upscaling or downscaling:

• 16x9 Letterbox Outputs the widescreen 16:9 picture in letterbox 
mode by adding black bars at the top and bottom of the picture for 
display on a standard 4:3 television screen.

• 4x3 Pillarbox Outputs the standard 4:3 picture in pillarbox mode by 
adding black bars to the left and right sides of the picture for display on 
a widescreen 16:9 television screen.

• Anamorphic Outputs the widescreen 16:9 picture as horizontally 
compressed 4:3 video, which retains the picture’s full vertical 
resolution for display on a widescreen television. To display the video 
with the correct proportions on an NTSC or PAL monitor, select the 
16:9 display setting on the monitor.

• Center Cut Outputs the widescreen 16:9 picture by evenly cropping 
the left and right sides of the picture for display on a standard 4:3 
television screen.

• Center Zoom Outputs the standard 4:3 picture by evenly cropping 
the top and bottom edges of the picture for display on a widescreen 
16:9 television screen.

¦ Note When aspect ratio conversion is applied to both the main and 
secondary outputs, the same setting will be applied to both outputs.

5 Under Analog Output, you can specify your analog output format, NTSC 
setup level, and output type:

$ Format Use this to specify whether you want the format for the analog 
outputs to be the same as the main or secondary output.
Defining your A/V Tools options



172

Cha
$ Output Type Specifies the analog video output type. If you’re 
outputting SD analog video, the output type will be set to All Available to 
indicate that the output will be available on all the analog outputs. If 
you’re outputting HD analog video, the output type will be set to 
Component.

$ Setup (NTSC) Use this to select the setup level you want for your 
NTSC analog video:

• 0 IRE Applies a setup level of 0 IRE. You should select this option 
only when working with a commercial DV device that uses the 
Japanese analog NTSC setup of 0 IRE. For example, if the video 
appears too bright when you play back DV clips on your NTSC 
monitor, you can change the setup to 0 IRE to output your DV clips at 
the correct brightness.

• 7.5 IRE Applies the standard NTSC setup level of 7.5 IRE.

$ YUV/RGB Select YUV or RGB to set the type of video signal that is 
sent from the component output. For example, select RGB if you 
connected the component output to a device that accepts an RGB signal.

6 Under HDMI Output, you can specify your HDMI output format and type.

$ Format Use this to specify whether you want the format for your 
HDMI output to be the same as the main or secondary output.

$ YUV/RGB Select the type of video signal that you want to be sent from 
the HDMI output:

• YUV Outputs YUV HDMI video. Select this only if you connected 
the HDMI output to a device that accepts a YUV signal.

• RGB - calibrated Outputs adjusted RGB HDMI video using the 
currently loaded Matrox HDMI calibration settings for your HDMI 
monitor or television. For details on calibrating your HDMI monitor 
and loading calibration settings using the Matrox HDMI Calibration 
Utility, see Chapter 7, “Calibrating Your HDMI Monitor for Video.”

• RGB - native Outputs native RGB HDMI video that does not apply 
any calibration compensation. This is useful when you want to output 
RGB HDMI video to a device other than an HDMI monitor or 
television, such as an HDMI recorder to perform an export to tape.

$ 3D Viewing Mode Select the 3D signal type that you want to be sent 
from the HDMI output to your 3D monitor:

• Disabled Select this if you’re not outputting 3D video, or to disable 
3D video output. You can still monitor 3D video, but you must select 
the correct viewing mode on your 3D monitor manually.

• Side-by-side Outputs horizontally compressed side-by-side 3D 
video (also referred to as side-by-side horizontal).
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• Over/Under Outputs over/under 3D video (also referred to as top 
bottom).

¦ Note This feature may not be supported on some 3D monitors.

7 Under SDI Output, specify whether you want the format for your SDI 
output to be the same as the main or secondary output.

8 Under Advanced, you can specify advanced video output settings.

$ Analog SC/H Phase Use this slider to advance or delay your analog 
video output’s subcarrier phase with respect to the horizontal sync of the 
genlock source (for composite video only).

¦ Note This setting is unavailable until a clip is added to the clip list and you 
click the Disk button.

$ Allow Super White/Allow Super Black Select Allow Super White 
to allow the highest luminance level of your video output to exceed the 
standard maximum white level. Select Allow Super Black to allow the 
lowest luminance level of your video output to fall below the standard 
black level. These options apply to all video outputs.

¦ Note Super white and super black should not be allowed when producing 
your final video production for broadcast.

9 Click OK to save your settings.
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Specifying your video output settings (MXO2 Mini)
You can specify various settings to configure your main analog output and 
secondary HDMI output from the MXO2 Mini. Some of the settings are 
predetermined for you based on your editing video format. For a list of the 
supported video output formats, see “Playback using Adobe Premiere Pro, 
Matrox A/V Tools, and Matrox WYSIWYG” on page 272.

°To specify your video output settings:

1 Click the Options button in the Matrox A/V Tools dialog box.

2 Click the Playback Settings button. This displays the Matrox Playback 
Settings dialog box.

3 Click the Video Output tab.

4 Under Analog Output (Main), you can specify the settings you want for 
your analog output from MXO2 Mini. Under HDMI Output (Secondary) 
you can specify the settings you want for your secondary HDMI output. 
Depending on the editing video format you chose in the Options dialog box, 
you may not be able to change some of the settings.

$ Format Use this to select the video format you want for your outputs. 
For a list of the supported formats, see “Playback using Adobe Premiere 
Pro, Matrox A/V Tools, and Matrox WYSIWYG” on page 272.
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$ Pulldown Method If this setting is available, select the pulldown 
method you want to be applied to your video output (Standard 2:3 or 
Advanced 2:3:3:2). Depending on your editing video format’s frame 
rate and the current video output format, a pulldown method may 
automatically be selected.

$ Setup (NTSC) Use this to select the setup level you want for your 
NTSC analog video (applies to main analog output only):

• 0 IRE Applies a setup level of 0 IRE. You should select this option 
only when working with a commercial DV device that uses the 
Japanese analog NTSC setup of 0 IRE. For example, if the video 
appears too bright when you play back DV clips on your NTSC 
monitor, you can change the setup to 0 IRE to output your DV clips at 
the correct brightness.

• 7.5 IRE Applies the standard NTSC setup level of 7.5 IRE.

$ Aspect Ratio Conversion Use this to specify how you want your 
video to be output when upscaling or downscaling:

• 16x9 Letterbox Outputs the widescreen 16:9 picture in letterbox 
mode by adding black bars at the top and bottom of the picture for 
display on a standard 4:3 television screen.

• 4x3 Pillarbox Outputs the standard 4:3 picture in pillarbox mode by 
adding black bars to the left and right sides of the picture for display on 
a widescreen 16:9 television screen.

• Anamorphic Outputs the widescreen 16:9 picture as horizontally 
compressed 4:3 video, which retains the picture’s full vertical 
resolution for display on a widescreen television. To display the video 
with the correct proportions on an NTSC or PAL monitor, select the 
16:9 display setting on the monitor.

• Center Cut Outputs the widescreen 16:9 picture by evenly cropping 
the left and right sides of the picture for display on a standard 4:3 
television screen.

• Center Zoom Outputs the standard 4:3 picture by evenly cropping 
the top and bottom edges of the picture for display on a widescreen 
16:9 television screen.

$ YUV/RGB (for analog output) Select YUV or RGB - native to set the 
type of video signal that is sent from the component output. For example, 
select RGB - native if you connected the component output to a device 
that accepts an RGB signal.

$ YUV/RGB (for HDMI output) Select the type of video signal that you 
want to be sent from the HDMI output:
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• YUV Outputs YUV HDMI video. Select this only if you connected 
the HDMI output to a device that accepts a YUV signal.

• RGB - calibrated Outputs adjusted RGB HDMI video using the 
currently loaded Matrox HDMI calibration settings for your HDMI 
monitor or television. For details on calibrating your HDMI monitor 
and loading calibration settings using the Matrox HDMI Calibration 
Utility, see Chapter 7, “Calibrating Your HDMI Monitor for Video.”

• RGB - native Outputs native RGB HDMI video that does not apply 
any calibration compensation. This is useful when you want to output 
RGB HDMI video to a device other than an HDMI monitor or 
television, such as an HDMI recorder to perform an export to tape.

$ 3D Viewing Mode Select the 3D signal type that you want to be sent 
from the HDMI output to your 3D monitor:

• Disabled Select this if you’re not outputting 3D video, or to disable 
3D video output. You can still monitor 3D video, but you must select 
the correct viewing mode on your 3D monitor manually.

• Side-by-side Outputs horizontally compressed side-by-side 3D 
video (also referred to as side-by-side horizontal).

• Over/Under Outputs over/under 3D video (also referred to as top 
bottom).

¦ Note This feature may not be supported on some 3D monitors.

5 Under Advanced, select Allow Super White to allow the highest 
luminance level of your video output to exceed the standard maximum white 
level. Select Allow Super Black to allow the lowest luminance level of your 
video output to fall below the standard black level. These options apply to 
both the main analog output and secondary HDMI output.

¦ Note Super white and super black should not be allowed when producing 
your final video production for broadcast.

6 Click OK to save your settings.
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Specifying your genlock settings

¦ Note This section does not apply to Matrox MXO2 Mini.

You can select the source to which you want to genlock all devices connected to 
your MXO2 system, as well as adjust the timing settings for all video outputs 
from MXO2.

¦ Note Before adjusting these settings, you must have a clip in the clip list and 
click the Disk button.

°To specify your genlock settings:

1 Click the Options button in the Matrox A/V Tools dialog box.

2 Click the Playback Settings button. This displays the Playback Settings 
dialog box. 

3 Click the Genlock tab.

4 From the Genlock Source list, select one of the following:

$ Internal Genlock to MXO2’s internal reference signal. Select this 
option only if you don’t have an external sync generator or other reliable 
external video sync source.

$ Black Burst Broadcast Quality Genlock to an external analog sync 
source connected to the reference (REF) input on MXO2. This must be a 
stable sync source, such as an external sync generator (bi-level black burst 
for SD or tri-level sync for HD), or a source VTR that has a built-in TBC.

$ Analog Input, SDI Input, and HDMI Input Genlock to your analog, 
SDI, or HDMI video source connected to the video input on MXO2.

¦ Note The status of your genlock source will be displayed, such as Locked 
or Not Locked, to indicate whether or not MXO2 is presently locked to your 
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selected genlock source. When you change the genlock source, distorted video 
and silent audio will be output until MXO2 locks to the new genlock source.

5 Under Genlock Video Format, select your genlock source’s video format. 
If you can’t select a video format, make sure that your genlock source 
matches the specified video format. When the genlock source is set to 
Internal, the genlock video format is set to your main video output format.

6 Under Advanced Settings, drag the Horizontal Delay and Vertical Delay 
sliders to adjust the horizontal and vertical timing of your video outputs with 
respect to your genlock source. This lets you compensate for cable delays 
within your system.

7 Click OK to save your settings.
pter 11, Using Matrox A/V Tools



179
Specifying your audio output settings
The audio output page lets you adjust various settings for your audio output from 
your MXO2 system. For example, you can adjust the volume of your analog 
audio output before or while playing back clips.

¦ Note Before adjusting these settings, you must have a clip in the clip list and 
click the Disk button.

°To specify your audio output settings:

1 Click the Options button in the Matrox A/V Tools dialog box.

2 Click the Playback Settings button. This displays the Matrox Playback 
Settings dialog box.

3 Click the Audio Output tab.

4 Under Analog Audio Volume, drag the sliders to adjust the volume of your 
analog audio output. By default, the sliders are locked so that they move 
together. To move each slider independently, click the lock button ( ) to 
disable it.

5 Under SDI Audio Output Format, select the bit depth you want for your 
embedded SDI audio output (20-bit or 24-bit). This setting is not available 
on MXO2 Mini.

6 Click OK to save your settings.
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Defining your capture settings
The Matrox Capture Settings dialog box has pages that you can use to specify 
your settings for capturing video and audio in A/V Tools. The settings available 
are based on your editing video format and your input source (video is always 
captured to your selected editing video format). For a list of the supported 
capture formats, see Appendix C, “Matrox MXO2 Supported Input and Capture 
Formats.” For a list of the supported video output formats for previewing your 
captured video, see “Supported video output formats during capture” on 
page 278.

¦ Note When you specify your capture settings in A/V Tools, VU meters will be 
displayed to let you monitor your audio input levels. For more information, see 
“Monitoring audio levels for capture” on page 186.

Specifying your video capture settings
You can capture video to MPEG-2 I-frame or uncompressed format, depending 
on your selected editing video format and source video format. For example, you 
can choose to capture analog NTSC clips to Matrox MPEG-2 I-frame .avi files.

°To specify your settings for capturing video in A/V Tools:

1 Click the Options button in the Matrox A/V Tools dialog box.

2 Click the Capture Settings button. This displays the Matrox Capture 
Settings dialog box. 

¦ Note You can also access the Matrox Capture Settings dialog box by 
right-clicking the clip list and selecting Capture Settings. 
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3 Click the Video Capture Settings tab.

4 From the Input Source list, select the type of input you want to capture. For 
example, to capture material from your HDMI source, select HDMI.

5 From the Input Format list, select the video format that matches your 
source video. If required, your source video will be scaled during capture to 
match your editing video format. The formats available depend on your 
selected input source. For information about the supported capture formats, 
see Appendix C, “Matrox MXO2 Supported Input and Capture Formats.”

6 From the Input Aspect Ratio list, select the aspect ratio of your SD source 
video (4:3 or 16:9). For example, to capture SD video that was recorded 
using the standard TV screen format, select 4:3. To capture SD video that 
was recorded using the widescreen 16:9 format, select 16:9. If you’re 
capturing HD video, the Input Aspect Ratio will be set to 16:9.

7 Under Capture Format, select your desired capture format from the list. 

$ Matrox 8-bit Uncompressed Captures video to 8-bit uncompressed 
format.

$ Matrox 10-bit Uncompressed Captures video to 10-bit 
uncompressed format. This is the only capture format available when 
using a 10-bit video processing format, and is not available when using an 
8-bit format. 

¦ Note If you want to capture to a format other than Matrox 10-bit 
Uncompressed, you can switch the video processing format (on the General 
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page) to 8-bit, and then change back to 10-bit after you’ve completed your 
capture.

$ Matrox MPEG-2 I-frame Captures video to MPEG-2 intra-frame 
format using the 4:2:2 Profile @ Main Level at a selected data rate (SD 
resolution only). 

$ Matrox MPEG-2 I-frame  HD Captures video to MPEG-2 intra-frame 
format using the 4:2:2 Profile @ High Level at a selected data rate (HD 
resolution only). This is the only capture format available when using a 
1440×1080i editing video format.

8 If you’re capturing to a Matrox MPEG-2 I-frame format, click the 
Configure button to configure your settings. The MPEG-2 I-frame settings 
for capture in Matrox A/V Tools are the same as when you capture using 
Adobe Premiere Pro. For more details, see “Selecting your MPEG-2 I-frame 
settings” on page 100.

9 Under Aspect Ratio Conversion, specify the type of aspect ratio 
conversion that you want to be applied to your captured video (used when 
upscaling or downscaling video during capture only):

$ 16x9 Letterbox Captures the widescreen 16:9 picture as letterbox 
video by adding black bars at the top and bottom of the picture for display 
on a standard 4:3 television screen.

$ 4x3 Pillarbox Captures the standard 4:3 picture as pillarbox video by 
adding black bars at the left and right sides of the picture for display on a 
widescreen 16:9 television screen.

$ Anamorphic Captures the widescreen 16:9 picture as horizontally 
compressed 4:3 video, which retains the picture’s full vertical resolution 
for display on a widescreen television. To display the video with the 
correct proportions on an NTSC or PAL monitor, select the 16:9 display 
setting on the monitor.

$ Center Cut Captures the widescreen 16:9 picture by evenly cropping 
the left and right sides of the picture for display on a standard 4:3 
television screen.

$ Center Zoom Captures the standard 4:3 picture by evenly cropping the 
top and bottom edges of the picture for display on a widescreen 16:9 
television screen.

10 Select Use Automatic Gain Control (AGC) if you want the gain of your 
composite or S-Video input signal to be adjusted automatically to 
compensate for very bright or dark images. This improves the brightness or 
contrast of your picture.

11 From the Input Type list, select the type of equipment you’re using for 
capture:
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$ Broadcast-quality Source Select this if your source device is 
broadcast-quality. This setting provides the best capture results for most 
devices.

$ Consumer-quality Source Select this if you’re having problems 
capturing video because your source device doesn’t meet 
broadcast-quality standards. For example, the capture may be interrupted 
when you try to capture from certain composite and S-Video devices, 
especially from low-quality VCRs. If this happens, selecting 
Consumer-quality Source will allow the video to be captured, but you 
may experience dropped frames during the capture.

¦ Note For any change to the input type to take effect, you must restart Matrox 
A/V Tools.

12 If your editing video format is 1080p @ 23.98 fps, 25 fps, or 29.97 fps, from 
the Output Format list, select the format (p or PsF) that you want for 
previewing your captured video. For example, if you’re capturing to 1080p 
@ 25 fps, you can choose to output 1080p or 1080PsF @ 25 fps video for 
preview.

13 Click OK to save your settings.
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Specifying your audio capture settings
You can specify various audio capture settings, such as to specify the type of 
audio files (either stereo .wav or mono .wav) that you want to create when 
capturing audio in A/V Tools. 

Remarks
• When you capture to an .avi file using A/V Tools, the clip’s video and audio 

are saved to the .avi file, and the clip’s audio is also saved to one or more 
separate .wav files. You could choose to edit the separate .wav files using 
audio post-processing software, such as Adobe Soundbooth. 

• The separate .wav files are not supported in the A/V Tools clip list, but you 
can import them into Adobe Premiere Pro.

°To specify your settings for capturing audio in A/V Tools: 

1 Click the Options button in the Matrox A/V Tools dialog box.

2 Click the Capture Settings button. This displays the Matrox Capture 
Settings dialog box. 

3 Click the Audio Capture Settings tab.

4 Under Input Source, select the audio input source you want to capture. This 
may be set for you based on your selected video input source. 

¦ Note When capturing HDMI embedded audio, only uncompressed 
embedded audio is supported.

5 Under Capture Format, select the bit-depth for your captured audio files. 
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6 If you want the VU meters to be displayed each time you configure your 
capture settings or start a capture in A/V Tools, select Show VU meters. 
This option is not available if you’re working with 1080i @ 29.97 fps video 
and using a 10-bit video processing format. For details on using the VU 
meters, see “Monitoring audio levels for capture” on page 186.

7 If you experience dropped frames during capture, select Disable audio 
preview to disable the audio preview only while you’re capturing material.

8 Under Capture Files, indicate whether you want to capture to stereo or 
mono audio files, and select which channels you want to save to separate 
.wav files.

$ From the File Type list, select Stereo to save your captured audio to 
stereo .wav files, or Mono to save your captured audio to mono .wav files. 

$ From the Filename lists, select which stereo pairs or mono channels you 
want to save to your .wav files (up to four stereo files or up to eight mono 
files depending on the type of audio being captured). Select None for the 
particular .wav files you don’t want to be created, or click the D (default) 
button for each Filename list if you want to capture only channels 1 and 
2. When A/V Tools saves each .wav file, it assigns a .Stereo.wav or 
.Mono.wav suffix to the base name you gave for the associated video file. 
For example, if you’ve named your video file MyFile.avi, the associated 
stereo audio files would be named MyFile.Stereo1.wav, 
MyFile.Stereo2.wav, etc. 

¦ Note The channels that you choose to save to the first stereo.wav file or first 
two mono.wav files will be embedded in the associated .avi file.

9 Click OK to save your settings. 
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Monitoring audio levels for capture
If you select Show VU meters on the Audio Capture Settings page, each 
time you configure your capture settings or start a capture in A/V Tools, VU 
meters will be displayed to let you monitor the levels of your currently selected 
audio input source.

¦ Note The VU meters won’t be available if you’re working with 1080i @ 29.97 
fps video and using a 10-bit video processing format.

As you play your audio source, the color of the input level is green at or below
–12 dBSF, yellow between –12 and –6 dBFS, and red above –6 dBFS. The 
clipping detectors will “light up” (become red) whenever audio clipping occurs. 
The peak level indicators are thin lines that show the highest level recently 
reached. These indicators will show the peak level for about two seconds or until 
a higher peak level is reached.

If needed, adjust the audio level on your source device to keep the average input 
level between –30 and –10 dBSF. 

Clipping 
detectors

Peak level 
indicators
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How A/V Tools assigns clip names
When using the New tab, Clip ID displays the base name for your new clips. For 
example, if the Clip ID is “MyClip,” A/V Tools will assign the name 
MyClip000.avi to the first new clip you capture, and continue naming clips 
sequentially (for example, MyClip001.avi, MyClip002.avi, etc.). Before 
capturing new clips, you can change the Clip ID to any base name you like. 

When editing clips using the Edit tab, Clip ID displays the name of the selected 
clip in the clip list. You can change the name by typing a new name in the Clip ID 
box on the Edit tab, then clicking Update. You can also change a clip ID directly 
in the clip list by typing a new name in the clip’s Clip ID box, then pressing 
ENTER.

¦ Note Changing the clip ID for a captured clip will not change the clip’s file 
name.

Capturing clips 
With A/V Tools you can capture live video from your camera, or video on tape. 
Capturing saves the clips as .avi files on your computer’s hard drive. 

¦ Note A/V Tools does not support capture from tape with device control.

Capturing live video
1 In the A/V Tools dialog box, click the CAM button. To capture live video, 

your device must be set to Camera mode.

2 In the Clip ID box, type the base clip name you’d like to be assigned to your 
clip. For more information, see “How A/V Tools assigns clip names” on 
page 187.

3 Click Capture.

4 A/V Tools will start capturing the clip. To stop the capture, click the Stop 
button.

5 Your captured clip is added to the clip list with its duration and an icon 
representing the first and last frames of the clip. 
How A/V Tools assigns clip names
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Capturing from tape without device control
1 In the A/V Tools dialog box, click the CAM button. To capture video from 

tape, your device must be set to VTR mode.

2 In the Tape ID box, type a name for the tape presently loaded in your VTR.

3 In the Clip ID box, type the base clip name you’d like to be assigned to your 
clip. For more information, see “How A/V Tools assigns clip names” on 
page 187.

4 Press the Play button on your device. You will see the video play back in the 
A/V Tools Preview Window and on your video monitor.

5 Click Capture.

6 A/V Tools will start capturing the clip. To stop the capture, click the Stop 
button.

7 Your captured clip is added to the clip list with its duration and an icon 
representing the first and last frames of the clip. 

Editing clips 
Matrox A/V Tools lets you update the clip ID and comment information for clips 
in your clip list, as well as change a clip’s In and Out icons.

Updating clip information
To update the clip ID and comment information for a clip, select the clip in the 
clip list and click the Edit tab. Type the new text in the text boxes, then click 
Update. For more information on the clip ID, see “How A/V Tools assigns clip 
names” on page 187.

Changing a clip’s In and Out icons
In and Out icons are the small icons representing the first and last frames of a 
clip in the clip list. These icons can be changed to better represent your clip.

°To change the In and Out icons of captured clips in the clip list: 

1 Use the transport controls to play back your clip in the preview window and 
on your video monitor. 

2 When you see the frame you want for the In icon, click Grab In Icon. A/V 
Tools automatically updates the icon.

3 When you see the frame you want for the Out icon, click Grab Out Icon. 
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Working with the clip list
The following sections explain how to add new clips to the clip list, play back 
clips, save and load clip lists, copy, move and delete clips, and how to detach and 
resize the clip list.

Adding clips 
You can add a clip or a series of clips (.avi files) to the clip list using any of the 
following methods:

• Drag an .avi file from a file management program, such as Windows 
Explorer, to the clip list. If you’re adding clips to an existing clip list, you 
can drag them to the bottom of the clip list, or place them in a specific 
position using the methods described in the section “Moving clips” on 
page 190.

• Right-click the clip list, then choose Import Clip from the pop-up menu (or 
double-click an empty area of the clip list). In the Open dialog box, select 
the .avi files you want to import, then click Open. 

Playing back clips
You can play back your clips one at a time, or in the same sequence as they 
appear in the clip list. To play back your clips: 

• Select a clip in the clip list and click the Play button on the transport 
controls.

• Right-click a clip on the clip list and choose Play.

• To play back multiple clips in sequence, select a range of clips in the clip list 
using SHIFT+click or select individual clips using control click, then use 
one of the afore-mentioned methods to play them back.

Saving and loading a clip list
To save a clip list, right-click the clip list. Choose Save As from the pop-up 
menu to save your current clip list as a .dvl file. 

You can load a clip list (.dvl) using any of the following methods:

• Right-click the clip list. Choose Open Clip List or Open Recent to select a 
recently opened clip list. 

• Drag a .dvl file from a file management program, such as Windows Explorer, 
to the clip list. 

• Double-click the .dvl file in Windows Explorer to start A/V Tools and load 
the clip list. Make sure that A/V Tools is not running when you do this.
Working with the clip list
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Remarks
$ The first time you double-click a .dvl file in Windows Explorer, you will 

need to specify Matrox A/V Tools as the program you want to use to open 
.dvl files. 

$ If you load a .dvl file to a clip list that already contains clips, it will 
replace the current clip list. If needed, your editing video format in A/V 
Tools will be changed to match the video format of the clips in the loaded 
clip list.

Copying clips
You can copy a clip or a series of clips in the clip list using either of the following 
methods:

• Select the clips you want to copy, right-click the clip list, then choose Copy 
from the pop-up menu. Select a clip in the clip list, then choose Paste to 
paste the copied clips above the currently selected clip.

• Select the clips you want to copy, then CTRL+drag the clips and drop them 
into the sequence you want.

¦ Note When copying a clip, the clip’s .avi file is not copied, only the reference 
to the clip on disk is copied. A/V Tools assigns the -Copy extension to the Clip ID 
of the copied clips.

Moving clips
You can change the order of clips in the clip list, such as to arrange clips in the 
order you want to play them back. To rearrange your clips, do any of the 
following: 

• Select the clips you want to move, then drag and drop them into the sequence 
you want. If you drag clips up in the clip list, the clips are inserted above the 
black line. If you drag clips down in the clip list, the clips are inserted below 
the black line. Releasing the mouse button places the clips in the list and 
ripples the position of all subsequent clips in the clip list.

• Select the clips you want to move, then right-click the clip list. Choose Cut 
from the pop-up menu to cut the clips. Select a clip in the clip list, then 
choose Paste to paste the clip above the currently selected clip. 

Deleting clips
Select the clips you want to delete, right-click the clip list, then choose one of the 
following from the pop-up menu: 

• To delete only the selected clips from the clip list, choose Delete Clip Only.

• To delete the selected clips and their corresponding files from your hard 
drive, choose Delete Clip+File. 
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Detaching and resizing the clip list
You can change the size of your clip list to suit your needs. First, detach the clip 
list from the Matrox A/V Tools dialog box by clicking the Float/dock clip list 
button ( ) above the clip list. Now the clip list can be freely moved and 
resized. To resize the clip list, drag the sides or corner of the clip list as needed. 
You can also use the standard Windows Maximize and Restore buttons in the 
top right corner of the window. 

After resizing, A/V Tools will automatically rearrange the clips in the clip list. To 
dock the clip list back to the Matrox A/V Tools dialog box, click the 
Float/dock clip list button, or click the Close button in the top right corner of 
the Clip List window. Once the window is docked again, A/V Tools will 
remember the previous size and location of the clip list for the next time you 
detach the clip list.

Grabbing a single-frame image
You can grab single-frame (still) images and save them as .tga files to use in your 
Adobe Premiere Pro projects. Your source video can be a clip on tape, a clip on 
disk, or live video.
Grabbing a single-frame image
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°To grab a single-frame image: 

1 Play back your source video. If it is on disk, you can use the transport 
controls to locate the clip

2 In the A/V Tools dialog box, click the Grab Image button to open the Grab 
Image dialog box.

3 When the frame you want is displayed in the Preview Window, click the 
Grab button. 

4 If you notice flickering in your image, you can choose to grab only one of 
the fields. From the Grab list, select Field 1 or Field 2. One field contains 
the odd-numbered scan lines in the frame, and the other field contains the 
even-numbered lines. Select the field that best displays your image. A/V 
Tools interpolates between the two consecutive scan lines to create the 
missing field. 

5 Click Save or Save As to save the image.

6 Click the Close button to return to the Matrox A/V Tools dialog box.

¦ Note If you do not specify a file name in the Save As text box, or if you select 
Auto Save, A/V Tools will assign a default name to the first grabbed image 
(such as MyImage01.tga or a name based on the last name you used) and 
continue naming images sequentially.
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Keyboard shortcuts
The following table provides a complete list of keyboard shortcuts available for 
using A/V Tools.

Keyboard Shortcuts

Disk mode K

CAM mode B

Play B

 Rewind Z

Fast Forward X

Frame Advance ’ (apostrophe)

Frame Reverse ; (semicolon)

Stop V

Loop A

Delete Clip Only DELETE

Delete Clip + File SHIFT+DELETE

Grab F5

Auto Save F6

Save F7

Import Clip CTRL+I

Select All CTRL+A

Cut CTRL+X

Copy CTRL+C

Paste CTRL+V

New Clip List CTRL+N

Open Clip List CTRL+O

Save Clip List CTRL+S
Keyboard shortcuts
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Your notes
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Using the Matrox WYSIWYG Plug-ins

This chapter explains how to 
use the Matrox WYSIWYG 
plug-ins available with Matrox 
MXO2 so that you can display 
the contents of your 
composition or animation on 
your video monitor.
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Overview
Together with your Matrox MXO2 hardware, the Matrox WYSIWYG Control 
Panel and Matrox WYSIWYG plug-ins let you display the contents of your 
composition or animation on your video monitor. This lets you see the exact 
color temperature, safe-title area, and any interlaced artifacts as you work.

You can preview video played back using the following applications that are 
supported by the Matrox WYSIWYG plug-ins:

• Adobe After Effects.

• Adobe Photoshop.

• Autodesk 3ds Max.

• Autodesk Combustion.

• eyeon Fusion.

• NewTek LightWave 3D.

Configuring the Matrox WYSIWYG Control 
Panel

The Matrox WYSIWYG Control Panel lets you specify the settings you want for 
previewing video on your video monitor. To use the Matrox WYSIWYG Control 
Panel, right-click the  icon on your Windows taskbar. If you don’t see the 

 icon, choose Start > All Programs > Matrox Mtx.utils > Matrox 
WYSIWYG Control Panel.

The Matrox HDMI Calibration Utility uses the Matrox WYSIWYG Control 
Panel to display specially designed graphics for calibrating your HDMI monitor 
for video. For details on calibrating your HDMI monitor, see Chapter 7, 
“Calibrating Your HDMI Monitor for Video.”

¦ Note By default, the Matrox WYSIWYG output to your video monitor is 
enabled. To disable it, clear the Enable WYSIWYG Output option in the 
Control Panel.

1 From the Project Format menu, select the format that matches your 
composition or animation, such as NTSC 4:3.

2 Choose Output Configuration to specify the video output settings you 
want for previewing your video. The available settings depend on your 
selected project format (editing video format), and are the same as those 
provided when using Matrox A/V Tools as explained in “Specifying your 
video output settings” on page 170 and “Specifying your video output 
settings (MXO2 Mini)” on page 174.

¦ Note The Genlock page is also available to let you adjust the genlock 
settings for your video output, if needed (not applicable to MXO2 Mini). For 
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details, see “You can specify various settings to configure your main analog 
output and secondary HDMI output from the MXO2 Mini. Some of the 
settings are predetermined for you based on your editing video format. For a 
list of the supported video output formats, see “Playback using Adobe 
Premiere Pro, Matrox A/V Tools, and Matrox WYSIWYG” on page 272.” on 
page 174.

3 From the Preview Type menu, select one of the following options for the 
preview:

$ Video Select this to view your composition or animation.

$ Alpha Channel Select this to view only your composition’s or 
animation’s grayscale alpha-key (matte) information.

4 From the Scaling menu, select one of the following options for your preview 
output:

$ Scale to fit Select this to scale your output to fit your video monitor. 
The aspect ratio of your project format will be preserved.

$ Original Size Select this to output your video without any scaling. If 
you are playing back HD clips in an SD project, your output will be 
centered on your video monitor.

Required steps to use the WYSIWYG plug-ins
The following sections list the steps required to use the Matrox WYSIWYG 
plug-in for each application in order to preview video on your video monitor.

¦ Note The following procedures may change with a subsequent release of the 
program.

Adobe After Effects
1 Start Adobe After Effects and import the footage you want to preview.

2 Drag the footage from the Project panel to the Composition panel.

¦ Note In order for the preview to be updated on your video monitor when you 
scrub the timeline, you must disable OpenGL for your previews. To do this, 
choose Edit > Preferences > Previews, and clear the Enable OpenGL option.

Adobe Photoshop
1 Start Adobe Photoshop and open the file you want to preview.

2 Choose File > Export > Matrox WYSIWYG Preview.

Autodesk 3ds Max 
1 Start Autodesk 3ds Max and open the file you want to preview.

2 Open the Render Scene dialog box by choosing Rendering > Render 
Setup.
Required steps to use the WYSIWYG plug-ins
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3 Click the Common tab.

4 Under Render Output, click Devices.

5 In the Select Image Output Device dialog box, select Matrox WYSIWYG 
Preview, and click OK.

6 Click Render.

Autodesk Combustion
1 Start Autodesk Combustion and open the file you want to preview.

2 Choose File > Preferences > Framebuffer.

3 In the menu beside Framebuffer Type, select Matrox WYSIWYG 
Preview, and click OK.

eyeon Fusion
1 Start eyeon Fusion and open the file you want to preview.

2 Right-click on the file, and choose View On > Matrox WYSIWYG 
Preview.

NewTek LightWave 3D
1 Start NewTek LightWave 3D and load the file you want to preview by 

choosing File > Load > Load Scene.

2 Click the Render tab.

3 Under Options on the left hand side of the screen, click Render Globals.

4 From the Render Display menu, select Matrox WYSIWYG Preview.

5 Under Render on the left hand side of the screen, click Render Frame.
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Using Matrox MXO2 with Live Media

Streaming Applications
This chapter explains how to 
use your Matrox MXO2 system 
as an input device to feed live 
video and audio to a media 
streaming encoding 
application.
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Overview
You can use your Matrox MXO2 system as an input device to feed live video and 
audio to a streaming media encoding application. This lets you stream media for 
broadcasting live events such as sports, concerts, news, educational seminars, and 
corporate meetings. For example, you can select any video and audio source 
connected to the MXO2 inputs as your A/V sources for use with Adobe Flash 
Media Live Encoder, scale the incoming video to the streaming format that you 
want using the MXO2 hardware scaler, and stream the live video and audio to a 
public distribution website or your dedicated IP hosting site. While working in 
your encoding application, live video and audio passthrough are provided so that 
you can monitor the source material that you’re encoding using the MXO2 video 
and audio outputs.

Because the MXO2 hardware scaler is used to scale your incoming video, you 
don’t need to perform any additional scaling in your encoding application. This 
feature provides high-quality scaling of HD and SD video for live media 
streaming, and frees up your system’s CPU to perform other tasks.

¦ Note You won’t be able to use your streaming media application with MXO2 
if you’re currently running another application that uses your MXO2 hardware, 
such as Matrox A/V Tools. You must close other applications that use your 
MXO2 hardware before starting your streaming media application.

Specifying your Matrox A/V settings for media 
streaming

To specify the settings you want for streaming live video and/or audio with 
Matrox MXO2:

1 Connect the video and audio input sources that you want to stream to the 
corresponding inputs on your MXO2 hardware.

¦ Note If you want to stream HDMI or SDI embedded audio only, you must 
have a valid HDMI or SDI video source containing the audio that you want to 
stream, although the video won’t be streamed. To perform audio-only 
streaming of other types of audio input, you’ll need to select a video source 
when you configure your Matrox A/V settings, but this source doesn’t need 
to be connected or have a valid video input signal unless you select an HDMI 
or SDI source.

2 Start your streaming media encoding application and select Matrox A/V 
Input as your source video and audio devices.

3 Click the button that your application provides for configuring your video 
device settings (you configure both your video and audio settings using the 
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source video device settings only). This displays a dialog box similar to the 
following:

4 From the Video Input Format list, select the video format that matches 
your source video. For a list of the video input formats supported on the 
various MXO2 inputs, see “Supported input formats” on page 266.

5 From the Video Input Source list, select the type of video input you want 
to stream. For example, to stream video from your composite source, select 
Composite. The available video input sources depend on your selected 
video input format.

6 From the Audio Input Source list, select your audio source. For example, if 
you want to stream channels 1 and 2 of your XLR (balanced analog) audio 
input, select XLR Channel 1-2. The available audio input sources depend on 
your selected video input source. You can stream stereo audio only (two 
input channels).

¦ Note When streaming HDMI embedded audio, only uncompressed 
embedded audio is supported.

7 From the Video Frame Size list, select the frame size you want for your 
streaming video. If required, your source video will be scaled to your 
selected frame size for use with your media encoding application.

8 From the Video Frame Rate list, select the frame rate that you want for 
your streaming video. The available frame rates depend on your selected 
video input format. For example, if your source video’s frame rate is 29.97, 
you can select a frame rate of 14.98 or 29.97.

¡ Important To avoid having your media encoding application perform 
additional scaling or frame rate conversions, make sure that the video frame 
Specifying your Matrox A/V settings for media streaming
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size and frame rate specified in your application match the frame size and 
frame rate that you selected for your Matrox A/V settings.

9 Click OK to save your settings and return to your media encoding 
application. You should see your selected video source play back in your 
application’s live preview window. If you don’t see your source video, check 
that your Matrox MXO2 hardware and selected video source are properly 
connected.

10 If you want to stream audio only, clear the option to enable video encoding 
in your application.

11 If your application provides an audio input volume control, you can use it as 
needed to adjust the volume of the incoming audio for streaming.

For details on how to specify additional encoding settings and stream your live 
video and audio, refer to the documentation for your streaming media encoding 
application.
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Using the Matrox Video for Windows

Codecs
This chapter explains how to 
use the Matrox Video for 
Windows codecs to render 
material to Matrox .avi files.



204

Cha
Overview
When using Video for Windows (VFW) programs to render material to an .avi 
file, you can use a Matrox VFW codec to create a Matrox .avi file. For example, 
you may want to render an animation to a Matrox MPEG-2 I-frame .avi file so 
that you can import the file as a realtime clip into your Adobe Premiere Pro 
projects on Matrox MXO2.

When rendering compositions or animations that have an alpha channel, you can 
select a “+ Alpha” Matrox VFW codec to render to a Matrox uncompressed or 
MPEG-2 I-frame .avi file that contains the alpha-key information. This .avi file 
will be automatically keyed when you place the clip in an Adobe Premiere Pro 
sequence.

The following sections explain the various settings that you need to make to 
render material to a Matrox .avi file using a VFW program. For details on 
exporting a Matrox sequence in Adobe Premiere Pro, see “Exporting to a Matrox 
.avi file” on page 104.

¦ Note Although Matrox has tested many VFW programs, there may be certain 
operational limitations when using the Matrox VFW codecs with some of these 
programs (as well as with untested programs).

Using VFW programs without the MXO2 
hardware

If you installed the Matrox VFW software codecs for use without the MXO2 
hardware (see “Installing the Matrox VFW software codecs on a system without 
the MXO2 hardware” on page 9), you can render and play back Matrox .avi files 
using your VFW program without having the MXO2 hardware. For example, if 
you captured clips to Matrox MPEG-2 I-frame format using Adobe Premiere Pro, 
you could edit and play back those clips on a system without the MXO2 
hardware, assuming that you installed the Matrox VFW software codecs on that 
system.
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Before you start rendering
Before you start rendering material to a Matrox .avi file, make the following 
settings in your VFW program:

• Set the frame size (width and height) of your rendered material to 
full-screen, depending on the codec that you’ll be using.

$ DV/DVCAM, DVCPRO, DVCPRO50, or MPEG-2 I-frame SD:

• 720 × 480 to render to NTSC or 486p format.

• 720 × 576 to render to PAL or 576p format.

$ Uncompressed SD:

• 720 × 486 to render to NTSC or 486p format.

• 720 × 576 to render to PAL or 576p format.

$ MPEG-2 I-frame HD:

• 1280×720 to render to 720p format.

• 1440×1080 to render to 1440×1080i/p format.

• 1920×1080 to render to full-size 1080i/p format.

$ DVCPRO HD or Uncompressed HD:

• 1280×720 to render to 720p format.

• 1920×1080 to render to 1080i/p format.

• Set the appropriate frame rate for the video format to which you are 
rendering. For example, if you are rendering to PAL format, set the frame 
rate to 25 fps.

• If available, select the “Recompress” option. This allows you to render video 
using the same compression format, frame size, and frame rate as your 
source video but using a different data rate, scanning mode (interlaced or 
progressive), or bit depth (8-bit or 10-bit).

• If you’ll be rendering audio, set the audio sample rate to 48 kHz and the 
sample size to 16-bit (mono or stereo).

• For best results, make sure that there is no data rate limit set in your program 
for rendered material. This ensures that your .avi files will be rendered at the 
particular data rate you select.

¦ Note Before rendering a lot of material, check that your rendered animations 
and transitions such as wipes and slides play back smoothly. If they appear 
jumpy, try adjusting the field dominance or field order for your rendered material. 
Before you start rendering
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Selecting color space conversion options
When you render material to an .avi file using a Matrox VFW codec, you can 
determine how you want the luminance levels and chroma information to be 
processed during the color space conversion that’s performed during the render.

¦ Note The default settings for color space conversion provide good results for 
most applications. We recommend that you change these settings only when 
needed for special purposes.

°To select the color space conversion options you want:

1 Choose Start > All Programs > Matrox Mtx.utils (or Matrox VFW 
Software Codecs) > Matrox VFW Codec Configuration.

2 In the provided dialog box under Color Space Conversion, select the 
options you want:

$ Standard Renders video using standard broadcast luminance levels. 
Super black and super white luminance levels are clipped.

$ Expanded Renders video using the full range of luminance levels. 
Super black and super white luminance levels are retained. You may want 
to use this setting, for example, to render material on which you’ll be 
applying luminance key effects.

¡ Important When rendering RGB graphics, selecting Expanded will 
create super black and/or white in your rendered images. For example, all 
black in your RGB graphics will become super black, and white will become 
super white. To render your RGB graphics with standard black and white 
levels, set your luminance range to Standard.
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$ Chroma filtering and Chroma interpolation Select these options to 
adjust the chroma bandwidth of RGB graphics. This improves images that 
have abrupt changes between different colors, such as a blue box on a 
black or white background. You should select these options for most 
animation and compositing work (computer-generated material). For most 
video editing programs, however, it’s best that you not select these 
options. If you find that your rendered images appear to be blurred, try 
clearing one or both of these options.

3 Click OK to save your settings. Any change you make to your selected 
luminance range setting (such as switching from Standard to Expanded) 
will only take effect the next time you start your VFW program.

Rendering material to a Matrox VFW .avi file
When you render material to an .avi file, such as when you render a finished 
composition or an animation, you must select the compressor (codec) you want 
to create the file. The compressor determines the quality of your rendered video. 
Refer to your program’s documentation for instructions on how to select a 
compressor for your .avi file.

If you want to export material from Adobe Premiere Pro to a Matrox .avi file, it’s 
recommended that you use the Matrox AVI export format as explained in 
“Exporting to a Matrox .avi file” on page 104.

°To create a Matrox VFW .avi file:

1 Select one of the following codecs from your program’s list of available 
compressors:

$ Matrox DV/DVCAM Renders video to DV or DVCAM format.

$ Matrox DVCPRO Renders video to DVCPRO format.

$ Matrox DVCPRO50 Renders video to DVCPRO50 or D-9 format.

$ Matrox DVCPRO HD Renders video to DVCPRO HD format.

$ Matrox MPEG-2 I-frame Renders video to MPEG-2 intra-frame 
format using the 4:2:2 Profile @ Main Level at a selected data rate (SD 
resolution only).

$ Matrox MPEG-2 I-frame + Alpha Renders video to MPEG-2 
intra-frame format with alpha using the 4:2:2 Profile @ Main Level at a 
selected data rate (SD resolution only).

$ Matrox MPEG-2 I-frame HD Renders video to MPEG-2 intra-frame 
format using the 4:2:2 Profile @ High Level at a selected data rate.

$ Matrox MPEG-2 I-frame HD + Alpha Renders video to MPEG-2 
intra-frame format with alpha using the 4:2:2 Profile @ High Level at a 
selected data rate.
Rendering material to a Matrox VFW .avi file



208

Cha
$ Matrox Uncompressed SD Renders video to 8-bit or 10-bit 
uncompressed SD format.

$ Matrox Uncompressed SD + Alpha Renders video to 8-bit or 10-bit 
uncompressed SD format with alpha.

$ Matrox Uncompressed HD Renders video to 8-bit or 10-bit 
uncompressed HD format.

$ Matrox Uncompressed HD + Alpha Renders video to 8-bit or 10-bit 
uncompressed HD format with alpha.

¦ Note The Matrox Offline HD codec is not supported for rendering clips. 
This codec is provided only for playback of legacy Matrox Axio offline HD 
projects.

2 If you’ve selected a Matrox codec that requires configuration, click the 
button provided by your program that allows you to configure your codec 
settings. For more details, see the following sections.

Configuring the Matrox DVCPRO HD codec
When you choose to configure the Matrox DVCPRO HD codec, a dialog box 
similar to the following appears:

From the Frame Rate list, make sure that you select the frame rate that matches 
the frame rate specified for rendering video in your editing application.

Configuring the Matrox Uncompressed codecs 
When you choose to configure a Matrox Uncompressed codec (SD or HD 
resolution), a dialog box similar to the following appears:
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1 Under Bit Depth, select the bit depth you want for your video. 

¦ Note Matrox RT.X2 does not support 10-bit uncompressed video.

2 Under Scan Mode, select the scan mode of your video. 

3 Click OK to save your selection. The settings you selected will be used each 
time you render material with your program, until you change the settings 
again.

Configuring the Matrox MPEG-2 I-frame codecs
When you choose to configure a Matrox MPEG-2 I-frame codec (SD or HD 
resolution), a dialog box similar to the following appears:

1 Drag the Data Rate slider until your desired data rate is displayed. The 
higher the data rate you select, the better the video quality will be. 
Depending on the capabilities of your system, however, you may not be able 
to smoothly play back video at a high quality using your VFW program. 

2 Beside Frame Rate, select a frame rate from the list. Make sure the frame 
rate you select is appropriate for the format to which you are rendering. 

3 To apply advanced settings to your MPEG-2 I-frame file, click the 
Advanced button.

¦ Note The default advanced settings should provide good results for most 
applications. It’s recommended that you change these settings only when 
needed for special purposes.

4 Beside DC Precision, select the bit-depth precision of the DC intra block. 
The higher the DC precision value that’s used to render your video, the more 
likely that the DC content will be increased at the expense of the AC content 
in the encoded stream. This may result in lowering the overall quality of the 
compressed stream at a specified data rate.

5 Under Zig Zag Order, select one of the following:
Rendering material to a Matrox VFW .avi file
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$ Regular Sets the regular (default) zig zag scanning pattern of the AC 
coefficient of the DCT block as defined in the ISO/IEC 13818-2 
(figure 7-2) specification documentation.

$ Alternate Sets an alternate zig zag scanning pattern of the AC 
coefficient of the DCT block as defined in the ISO/IEC 13818-2 (figure 
7-3) specification documentation. Use this setting when capturing or 
rendering video at a high data rate (for example, at a data rate of 100 
Mb/sec or higher).

6 Under Rounding Type, select one of the following:

$ MPEG-2 Rounds the AC coefficients up to the nearest whole number 
when calculating the quantization coefficient. 

$ Matrox Custom Truncates the AC coefficients to the lowest whole 
number when calculating the quantization coefficient. In some cases, this 
setting may yield less artifacts in graphics.

7 Select the Force Frame-based DCT setting to render macroblocks as 
frames rather than as fields. In some cases, graphics will yield less artifacts if 
this option is selected.

8 Click OK to save your settings. The settings you selected will be used each 
time you render material with your program, until you change the settings 
again.
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Using the Matrox MAX H.264 Codec

with Adobe Software
This chapter explains how to 
use the Matrox MAX H.264 
codec on your Matrox MXO2 
product with MAX technology 
to export material to Blu-ray 
Disc and other media formats 
from Adobe Media Encoder, 
Premiere Pro, and Encore.
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Exporting to Matrox MAX H.264 files using 
Adobe Media Encoder

If you have a Matrox MXO2 product with MAX technology, you can use the 
Matrox MAX H.264 codec on your MXO2 to quickly and easily export material 
to H.264 files for Blu-ray Disc and other media formats from Adobe Media 
Encoder. Matrox presets are provided for creating .264 elementary stream files in 
HD formats that are supported for Blu-ray Disc authoring using Adobe Encore, 
and .mp4 files for creating files suitable for the web and mobile devices.

Your Matrox .264 elementary stream files can be imported to Adobe Encore 
without having to transcode the files. If you prefer, you can choose to transcode 
your material to Matrox H.264 format for Blu-ray Disc authoring directly within 
Encore as explained in “Transcoding for Blu-ray Disc authoring in Adobe 
Encore” on page 217.

If you’d like to capture clips directly to Matrox MAX H.264 files, see Chapter 
16, “Using Matrox MAX H.264 Capture.”

Remarks
• When the Matrox MAX H.264 codec on your MXO2 is in use for export, 

your MXO2 inputs and outputs won’t be available. You’ll be able to continue 
working in Adobe Premiere Pro, but the video preview and output won’t be 
updated until the encoding is complete. In order to perform a capture, use 
Matrox A/V Tools, or use the Matrox WYSIWYG plug-ins, you’ll have to 
wait until the encoding is complete. These limitations, however, don’t apply 
if your system includes a Matrox CompressHD card. In this case, the Matrox 
MAX H.264 codec on your CompressHD card will always be used for the 
Matrox MAX H.264 encoding, and your MXO2 hardware will be available 
for other tasks.

• When you export an Adobe Premiere Pro sequence, the speed of the export 
is affected by the rendering of any non-realtime sections of the sequence. If 
your sequence’s video format matches your export format and you’ve 
rendered previews of non-realtime sections, you can select Use Previews in 
the Export Settings dialog box prior to performing your export. When you 
do this, Premiere Pro won’t need to render the non-realtime sections for 
which you’ve already created preview files. 

• If you want to export a single Adobe Premiere Pro sequence, you may find it 
more convenient and get faster results if you don’t export from Adobe Media 
Encoder, and instead perform a direct export as explained in “Performing a 
direct export of an Adobe Premiere Pro sequence” on page 216.
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°To export material to a Matrox MAX H.264 file:

1 Start Adobe Media Encoder and add the clip, sequence, or composition that 
you want to export as explained in your Adobe documentation, then click 
Settings to display the Export Settings dialog box.

¦ Note When using an Adobe program that employs Media Encoder for 
exporting material, the Export Settings dialog box will be displayed when 
you choose to perform the export, such as when you choose File > Export > 
Media to export a sequence using Adobe Premiere Pro.

2 From the Format list, select one of the following Matrox formats:

$ Matrox 264 (Blu-ray) Creates a .264 elementary stream file, which is 
supported for Blu-ray Disc authoring. Audio is exported as separate mono 
or stereo .wav files (PCM audio).

$ Matrox MP4 Creates an .mp4 file with embedded stereo AAC audio, 
which is suitable for the web and mobile devices.

3 From the Preset list, select the preset that matches the video format you 
want for your exported file. Appropriate video and audio settings are 
automatically set based on your selected preset.

¦ Note If you’re exporting to a Matrox .mp4 file, two types of presets will be 
available—Fast Encode and High Quality. Select a Fast Encode preset for fast 
encoding that leverages your system’s resources with the MXO2 hardware. 
Select a High Quality preset for high-quality encoding that is performed 
entirely by the MXO2 hardware, which frees your system’s resources for other 
tasks.
Exporting to Matrox MAX H.264 files using Adobe Media Encoder
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4 Select Export Video and Export Audio if you want to export both video 
and audio.

5 Click the Video tab to display the settings for your exported video.

6 Under Codec, click Configure to customize your Matrox MAX H.264 
codec settings as explained in “Specifying your Matrox MAX H.264 
settings” on page 220.

7 Under Video, you can customize the settings that you want for your 
exported video:

$ Frame Size Sets the width and height for your exported video. When 
exporting to a Matrox .264 file, the available frame sizes are 1920 x 1080 
and 1280 x 720. When exporting to a Matrox .mp4 file, you can select a 
frame size, or select Custom (Square Pixels) if you want to enter a 
custom size. If you enter an unsupported frame size, the closest supported 
frame size will be used.

$ Frame Rate Sets the frame rate for your exported video.
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$ Field Type Indicates the order in which the video fields are displayed, 
such as Upper First for interlaced HD video, or Progressive for all 
progressive video formats.

$ Aspect Ratio This is set to 16:9 when exporting to HD. When 
exporting to SD, you can select 4:3 to export to the standard TV screen 
format, or 16:9 to export to the widescreen 16:9 format.

$ Maintain aspect ratio when scaling Select this option if you’re 
scaling your source video for export, and you want to maintain your 
source video’s aspect ratio. Your source video will be exported as 
pillarbox video when exporting to a larger aspect ratio, or letterbox video 
when exporting to a smaller aspect ratio. If this option is not selected, 
scaled video that doesn’t match the specified aspect ratio for export will 
be exported as anamorphic video.

$ Use Matrox MAX hardware scaler Select this option if you’re 
scaling your source video for export, and you want to use the Matrox 
MAX hardware scaler to perform the scaling. This gives good 
performance when scaling to an HD resolution. If you’re downscaling to 
an SD or lower resolution, you can get a faster export by clearing this 
option, which allows Adobe to perform the scaling.

$ De-interlace video If you’re exporting interlaced video to a 
progressive format (such as 1080i to 720p), select this option to 
de-interlace the video for display on a monitor that displays lines 
progressively, such as an LCD or computer monitor. (This option won’t be 
present if you’re exporting to an interlaced format or your source video is 
progressive.)

8 Click the Audio tab to display the settings for your exported audio. The 
available settings depend on whether you’re exporting to a Matrox .264 or 
.mp4 file.
Exporting to Matrox MAX H.264 files using Adobe Media Encoder
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9 Under Audio, you can customize the settings that you want for your 
exported audio:

$ Audio Codec This is set to Uncompressed when exporting to a 
Matrox .264 file, or AAC when exporting to an .mp4 file. 

$ Sample Rate This is set to 48 kHz.

$ Output Channels Specifies the audio channels to be exported (set to 
Stereo when exporting to a Matrox .mp4 file).

¦ Note When exporting audio from an Adobe Premiere Pro sequence to a 
Matrox .264 file, the available output channels depend on the type of audio 
tracks being exported. For example, you can select Surround 5.1 to export 
5.1 surround tracks to six mono .wav files. For a 16-channel track, you can 
select Mono or Stereo to export the audio to a single mono or stereo .wav file.

$ Sample Size You can select 16-bit or 24-bit.

$ Bitrate For AAC audio, drag the bitrate slider to select the bitrate you 
want for your exported audio.

10 Click Start Queue to start the export (or from Premiere Pro, click Queue to 
send your export request to Adobe Media Encoder).

For more information about using Adobe Media Encoder and specifying export 
settings, see your Adobe Media Encoder or Premiere Pro documentation.

Performing a direct export of an Adobe 
Premiere Pro sequence

When you export an Adobe Premiere Pro sequence from within Adobe Media 
Encoder, additional processing is required to transfer the sequence from Premiere 
Pro to Media Encoder. If you want to export only a single sequence to a Matrox 
MAX H.264 file (.264 or .mp4 file), you may find it more convenient and get 
faster results by performing a direct export as explained in this section.

¦ Note A direct export can’t be used for batch encoding of Premiere Pro 
sequences. As well, you won’t be able to work in Premiere Pro while your 
sequence is being exported. If you want to batch encode sequences to Matrox 
MAX H.264 files or continue to work in Premiere Pro while exporting, you must 
export from Media Encoder. To avoid problems, don’t perform a direct export 
and use Media Encoder independently to export Matrox MAX H.264 files at the 
same time.

°To perform a direct export of a Premiere Pro sequence:

1 Unless you want to export your entire sequence, position the work area bar 
over the section of the sequence you want to export.

2 Choose File > Export > Media.
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3 In the Export Settings dialog box, select your desired Matrox format, 
preset, video settings, and audio settings as explained in “Exporting to 
Matrox MAX H.264 files using Adobe Media Encoder” on page 212 (see 
steps 2 to 9).

4 From the Source Range list in the Source panel, select the range you want 
to export, such as Work Area.

5 Click Export to immediately start your export.

Transcoding for Blu-ray Disc authoring in 
Adobe Encore

Instead of exporting material to a Matrox .264 file from Adobe Media Encoder or 
Premiere Pro and then importing the file into Adobe Encore for Blu-ray Disc 
authoring, you can choose to perform the transcoding directly within Encore. The 
transcoding will be accelerated using the Matrox MAX H.264 codec.

°To transcode to Matrox H.264 format for Blu-ray Disc authoring:

1 Start Adobe Encore, create a new Blu-ray project, and import the asset (clip 
or Premiere Pro sequence) that you want to transcode as explained in your 
Adobe Encore documentation.

2 Right-click the clip or sequence in the Project panel, choose Transcode 
Settings, and click Edit Quality Presets to display the Export Settings 
dialog box:

3 From the Format list, select Matrox H.264 Blu-ray, and from the Preset 
list, select the preset that matches the video format you want for the 
transcoding. Appropriate video and audio settings are automatically set 
based on your selected preset.
Transcoding for Blu-ray Disc authoring in Adobe Encore
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¦ Note Only Matrox presets that are compatible with your project’s settings 
will be available.

4 Click the Video tab to display the settings for your transcoded video.

5 Under Codec, click Configure to customize your Matrox MAX H.264 
codec settings as explained in “Specifying your Matrox MAX H.264 
settings” on page 220.

6 Under Video, you can customize the settings that you want for your 
transcoded video:

$ Frame Size Sets the width and height for your transcoded video.

$ Frame Rate Sets the frame rate for your transcoded video.

$ Field Type Indicates the order in which the video fields are displayed, 
such as Upper First for interlaced HD video, or Progressive for all 
progressive video formats.

$ Aspect Ratio This is set to 16:9.

$ De-interlace video If you’re transcoding interlaced video to a 
progressive format (such as 1080i to 720p), select this option to 
de-interlace the video for display on a monitor that displays lines 
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progressively, such as an LCD or computer monitor. (This option won’t be 
present if you’re transcoding to an interlaced format or your source video 
is progressive.)

$ Maintain aspect ratio when scaling Select this option if you’re 
scaling your source video for transcoding, and you want to maintain your 
source video’s aspect ratio. Your source video will be transcoded as 
pillarbox video when transcoding SD video to HD for Blu-ray Disc 
authoring. If this option is not selected, scaled video that doesn’t match 
the specified aspect ratio will be transcoded as anamorphic video.

$ Use Matrox MAX hardware scaler When scaling your source video 
for transcoding to HD for Blu-ray Disc, it’s recommended that you select 
this option to use the Matrox MAX hardware scaler to perform the 
scaling.

7 Click the Audio tab to display the settings for your transcoded audio.

8 Under Audio, you can customize the settings that you want for your 
transcoded audio:

$ Audio Codec This is set to Uncompressed.

$ Sample Rate This is set to 48 kHz.

$ Output Channels Specifies the audio channels to be transcoded.

¦ Note When transcoding audio from an Adobe Premiere Pro sequence to 
Matrox H.264 format for Blu-ray Disc authoring, the available output channels 
depend on the type of audio tracks being transcoded. For example, you can 
select Surround 5.1 to transcode 5.1 surround tracks.

$ Sample Size You can select 16-bit or 24-bit.

9 Click OK to save your settings. If you changed any of the preset settings, 
you’ll be prompted to name the preset.

10 Right-click the clip or sequence that you want to transcode in the Project 
panel, and choose Transcode Now to start the transcoding.
Transcoding for Blu-ray Disc authoring in Adobe Encore
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For more information about using Adobe Encore and specifying transcode 
settings, see your Adobe Encore documentation.

Specifying your Matrox MAX H.264 settings
When creating Matrox MAX H.264 files (Matrox .264 or .mp4 files), appropriate 
codec settings are applied based on the Matrox preset you selected. If needed, 
you can customize the settings that you want for the H.264 compression.

°To select your Matrox MAX H.264 settings:

1 Click the Configure button provided for the Matrox MAX H.264 codec 
settings.
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2 Under H.264 Level, select the H.264 level that you want for your encoded 
video. The available levels depend on your encoded video’s frame size and 
frame rate.

Remarks
$ Use H.264 level 4.0 if you want to create Matrox MAX H.264 files 

intended for mass replication of Blu-ray Discs. You can use either level 
4.0 or 4.1 if you want to author and burn individual copies that are 
compatible with Blu-ray Disc players.

$ Use H.264 level 3.1 to create HD video for use with Apple iPad.

3 Under Algorithm, select the entropy coding method to be used during 
compression:

$ CABAC Encodes the video stream using the H.264 Main profile. This is 
the only method available for Matrox .264 files.

$ CAVLC Encodes the video stream using the H.264 Baseline profile. 
This method is recommended when creating Matrox .mp4 files at small 
frame sizes, such as for Apple iPhone devices or the web.

4 Under Data Rate (Mb/sec), you can select the encoding type and various 
data rate settings for the H.264 compression.

$ Encoding Type From this list, select one of the following:

• Variable bit rate (VBR) Video is compressed at varying data rates 
based on the complexity of the video and your specified minimum and 
maximum data rates. The Matrox MAX H.264 codec analyzes and 
encodes each frame to deliver the highest possible quality at your target 
data rate.

• Constant bit rate (CBR) Video is compressed at your specified 
target data rate, which is useful when you need to limit or predict the 
size of your video file. However, if your video is very complex (such as 
scenes with many colors, sharp edges, or transitions), you’ll need to 

H.264 level
Maximum 
frame size

Maximum
frame rate 

(fps)

Maximum 
data rate 
(Mb/sec)

2.0 352×288 29.97 2

3.0 720×576 29.97 10

3.1 1280×720 29.97 14

4.0 1920×1080 29.97 20

4.1 1920×1080 29.97 50

4.2 1920×1080 59.94 50
Specifying your Matrox MAX H.264 settings
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specify a high target data rate to avoid having frames of blocky video in 
your file. 

¦ Note When creating Matrox .264 files for Blu-ray Disc authoring, it’s 
recommended that you use a constant bit rate.

• Target/Minimum/Maximum data rate Use these sliders to select 
your desired data rate. The higher the target data rate you select, the 
better the video quality will be. Only the Target data rate will be 
available if you selected Constant bit rate (CBR). If you selected 
Variable bit rate (VBR), all three sliders will be available so that you 
can set the target, minimum, and maximum data rates for the video 
compression.

¦ Note When customizing the settings for a Matrox .264 file, be aware that 
Matrox .264 files that have a data rate higher than about 30 Mb/sec may require 
transcoding in Adobe Encore. The maximum H.264 level and data rate 
accepted by Adobe Encore for Blu-ray Disc authoring with audio and video 
is level 4.1 at 35 Mb/sec.

• Source video complexity (Variable data rate only) Specifies the 
complexity level of your source video. A complex video can be defined 
as containing scenes with many colors, sharp edges, or transitions. The 
Matrox MAX H.264 codec uses this setting to determine how much 
compression is required in order to deliver high-quality video at your 
specified target data rate. The default setting (15) is suitable for most 
moderately complex videos. For simpler or more complex videos, you 
may need to adjust this setting to obtain the highest-quality encoding 
possible while respecting your target data rate. If the size of your 
encoded video is good but the quality can be improved, lower the 
complexity level setting. Your video will then be encoded with less 
compression. If the quality of your encoded video is good but the size 
is larger than expected, raise the complexity level setting. Your video 
will then be encoded with more compression. In any case, you may 
need to try different settings to get your desired results.

• Sample rate Determines how frequently the Matrox MAX H.264 
codec verifies the current data rate while encoding and compares it to 
your selected target data rate. If a discrepancy exists between the 
current and target data rates, the current data rate is adjusted as 
specified by the Data rate adjustment setting (see below).

• Data rate adjustment When the current encoding data rate does not 
match your specified target data rate, this setting determines how 
quickly the current data rate is adjusted to reach the target data rate. A 
gradual adjustment produces smoother transitions than a quick 
adjustment.
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5 Under GOP Structure, select the GOP structure that you want to be used to 
encode your video:

$ GOP type Select one of the following GOP types (can be changed for 
CABAC encoding only):

• Simple GOP Offers a fixed structure in how frames are referenced, 
and may be more easily decoded than advanced GOPs. This is the 
recommended GOP type when creating Matrox .264 files for Blu-ray 
Disc authoring.

• Advanced GOP (short/long) An advanced GOP has more 
structural flexibility than a simple GOP, is capable of using more 
reference frames, and therefore may provide better overall 
compression. For a “short” advanced GOP, the distance between P 
frames is always 4, and for a “long” advanced GOP, the distance 
between P frames is always 8. Advanced GOPs may not be compatible 
with some Blu-ray Disc players, and may cause stability issues in 
Adobe Encore when burning a Blu-ray Disc.

¦ Note The GOP type provides standard default values for the GOP size and 
the distance between P frames. You can change these default values as 
explained below.

$ GOP size Drag the slider to select the number of frames in the GOP 
(must be a multiple of the distance between P frames). When creating a 
Matrox .264 file for Blu-ray, the GOP size must be less than one second of 
video. For example, if the frame rate for your encoded video is 29.97 fps, 
the GOP size must be 29 frames or less.

$ Distance between P frames Drag the slider to select the number of 
frames between P frames in the GOP (can be changed for a simple GOP 
only).

6 Drag the Noise Filter slider to set the level of noise filtering that you want to 
apply to your video before encoding. Increasing the noise filter level reduces 
the amount of high frequencies in your source video by softening the 
high-detail portions of your video. Since high frequencies require more bits 
to encode, increasing the noise filter level leaves more bits available for the 
encoding of other frames, which can improve the overall quality of your 
encoded video. However, if you lose too much detail in your encoded video 
you may need to decrease the noise filter level.

7 Click OK to save your settings.
Specifying your Matrox MAX H.264 settings
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Your notes
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Using Matrox MAX H.264 Capture

This chapter explains how to 
use the Matrox MAX H.264 
Capture application to capture 
clips to various formats on 
Matrox MXO2 products with 
MAX technology or a Matrox 
CompressHD card.
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Overview
The Matrox MAX H.264 Capture application lets you use your Matrox MXO2 
product with MAX technology or a Matrox CompressHD card to capture clips 
directly to Matrox MAX H.264 files for Blu-ray Disc, the web, and mobile 
devices. You can also use this application to capture clips to Matrox MPEG-2 
I-frame or uncompressed .avi files.

You can capture material from any of your MXO2’s video and audio inputs, and 
monitor the source material that you’re capturing using the MXO2 video and 
audio outputs. Matrox presets are provided for capturing clips to various formats 
for creating .264, .mp4, and .avi files. This includes presets for creating .264 
elementary stream files in HD formats that are supported for Blu-ray Disc 
authoring using Adobe Encore, and .mp4 files suitable for the web and mobile 
devices. Your Matrox .264 elementary stream files can be imported to Adobe 
Encore without having to transcode the files.

Remarks
• When performing a capture, your MXO2 hardware won’t be available for 

use with any other application. For example, you’ll be able to work in Adobe 
Premiere Pro, but you won’t be able to perform a capture or export to a 
Matrox MAX H.264 file, and the video preview and output won’t be updated 
until your capture is complete.

• If your MXO2 hardware is in use by another application while running the 
Matrox MAX H.264 Capture application, you’ll get a warning and you 
won’t be able to perform a capture or preview your video input until your 
MXO2 hardware becomes available.

• If you want to run Adobe Encore at the same time as the Matrox MAX 
H.264 Capture application, you must set the default project player in Encore 
to Adobe Player.
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How to capture clips
1 Connect the video and audio input sources from which you want to capture 

clips to the corresponding inputs on your MXO2 hardware.

2 Choose Start > Programs > Matrox Mtx.utils> Matrox MAX H.264 
Capture.

3 Click Input Settings to select your video and audio input settings for 
capturing clips as explained in “Specifying your input settings” on page 228.

4 Click Output Settings to select your video and audio output settings for 
monitoring the source material that you’re capturing as explained in 
“Specifying your output settings” on page 230.

5 Select a preset for the type of clips that you want to capture. The Matrox 
presets available depend on the frame rate of your video input source.

6 Click the Advanced button to review the settings provided by your selected 
preset and make any required changes as explained in “Specifying your 
capture format settings” on page 232.
How to capture clips
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7 Click Capture to specify where you want to store your captured clips, the 
base filename to use, and start capturing clips as explained in “Starting your 
capture” on page 236.

Specifying your input settings
To specify your video and audio input settings for capturing clips, click the Input 
Settings button.

1 From the Video Input Format list, select the video format that matches 
your source video. For a list of the video input formats supported on the 
various MXO2 inputs for capturing clips, see “Supported input formats” on 
page 266.

¦ Note If you select a 1080PsF video input format, you won’t be able to 
capture to a 1080i format. As a workaround, select a 1080i video input format, 
even though your connected video input is actually 1080PsF.

2 From the Input Aspect Ratio list, select the aspect ratio of your SD source 
video (4:3 or 16:9). For example, to capture SD video that was recorded 
using the standard TV screen format, select 4:3. To capture SD video that 
was recorded using the widescreen 16:9 format, select 16:9. If you’re 
capturing HD video, the Input Aspect Ratio will be set to 16:9.

3 From the Video Input Source list, select the type of input you want to 
capture. For example, to capture material from your HDMI source, select 
HDMI. The available video input sources depend on your selected video 
input format.
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4 From the Audio Input Source list, select your audio source. For example, if 
you want to capture the embedded audio of your HDMI source, select HDMI 
(embedded audio). This may be set for you based on your selected video 
input source.

¦ Note When capturing HDMI embedded audio, only uncompressed 
embedded audio is supported.

5 From the Input Type list, select the type of equipment you’re using for 
capture:

$ Broadcast-quality Source Select this if your source device is 
broadcast-quality. This setting provides the best capture results for most 
devices.

$ Consumer-quality Source Select this if you’re having problems 
capturing video because your source device doesn’t meet 
broadcast-quality standards. For example, the capture may be interrupted 
when you try to capture from certain composite and S-Video devices, 
especially from low-quality VCRs. If this happens, selecting 
Consumer-quality Source will allow the video to be captured, but you 
may experience dropped frames during the capture.

6 Select Use Automatic Gain Control (AGC) if you want the gain of your 
composite or S-Video input signal to be adjusted automatically to 
compensate for very bright or dark images. This improves the brightness or 
contrast of your picture.

7 Click OK to save your settings. Your selected video source will play back in 
the Preview Window of the Matrox MAX H.264 Capture dialog box.

¦ Note If your source video is HD and you choose to capture to a Matrox .avi 
file, video in the Preview Window will be scaled to quarter-size, and the frame 
rate of video played back in the Preview Window may also be reduced. 
Specifying your input settings
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Specifying your output settings
To specify the output settings you want for monitoring the source material that 
you’re capturing, click the Output Settings button.

¦ Note For a list of the supported video output formats for previewing captured 
video, see “Supported video output formats during capture” on page 278.

1 Under Analog Output, you can specify the settings you want for your 
analog output from MXO2.

$ Output Type Specifies the analog video output type. If you’re 
outputting SD video on MXO2, MXO2 Rack, or MXO2 LE, this will be 
set to All Available to indicate that the output will be available on all the 
analog outputs. On MXO2 Mini, you can select Component, or 
Composite & S-Video if you’re outputting SD video. When outputting 
HD analog video, the output type will be set to Component (on MXO2 
Mini, the composite and S-Video outputs are invalid when outputting 
component video).

$ Setup (NTSC) Use this to select the setup level you want for your 
NTSC analog video:

• 0 IRE Applies a setup level of 0 IRE. You should select this option 
only when working with a commercial DV device that uses the 
Japanese analog NTSC setup of 0 IRE. For example, if the video 
appears too bright when you preview DV video on your NTSC monitor, 
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you can change the setup to 0 IRE to output the video at the correct 
brightness.

• 7.5 IRE Applies the standard NTSC setup level of 7.5 IRE.

$ YUV/RGB Select YUV or RGB to set the type of video signal that is 
sent from the component output. For example, select RGB if you 
connected the component output to a device that accepts an RGB signal.

$ Under HDMI Output, select the type of video signal that you want to be 
sent from the HDMI output:

• YUV Outputs YUV HDMI video. Select this only if you connected 
the HDMI output to a device that accepts a YUV signal.

• RGB - calibrated Outputs adjusted RGB HDMI video using the 
currently loaded Matrox HDMI calibration settings for your HDMI 
monitor or television. For details on calibrating your HDMI monitor 
and loading calibration settings using the Matrox HDMI Calibration 
Utility, see Chapter 7, “Calibrating Your HDMI Monitor for Video.”

• RGB - native Outputs native RGB HDMI video that does not apply 
any calibration compensation. Select this when you want to disable the 
currently loaded Matrox HDMI calibration settings and output RGB 
HDMI video from MXO2 using its native color settings for previewing 
video on your HDMI monitor.

2 Under SDI Audio Output Format, select the bit depth you want for your 
embedded SDI audio output (20-bit or 24-bit). This setting is not available 
on MXO2 Mini.

3 Under Analog Audio Volume, drag the sliders to adjust the volume of your 
analog audio output. By default, the sliders are locked so that they move 
together. To move each slider independently, click the lock button ( ) to 
disable it.

4 Under Advanced, you can use the Analog SC/H Phase slider to advance or 
delay your analog video output’s subcarrier phase with respect to the 
horizontal sync of the genlock source (for composite video only). This 
setting is not available on MXO2 Mini.

5 Click OK to save your settings.
Specifying your output settings
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Specifying your capture format settings
When you select a capture preset, appropriate capture format settings are 
automatically applied for you. To review or change any of these settings, click the 
Advanced button.

1 Under Video Capture Format, you can select the video format settings you 
want for your captured clips. For a list of the supported capture formats 
based on your selected video input format, see “Supported capture formats 
for Matrox MAX H.264 Capture” on page 269.

$ File Type Select one of the following Matrox formats:

• Matrox 264 (Blu-ray) Creates a .264 elementary stream file, which 
is supported for Blu-ray Disc authoring. Audio is captured as separate 
mono or stereo .aac files (AAC audio) or .wav files (PCM audio).

• Matrox MP4 Creates an .mp4 file with embedded stereo AAC audio, 
which is suitable for the web and mobile devices. 
pter 16, Using Matrox MAX H.264 Capture



233
• Matrox AVI Creates an MPEG-2 I-frame or uncompressed .avi file. 
Audio is embedded in the .avi file and also captured as separate .wav 
files (PCM audio).

$ Codec Type If you’re capturing to a Matrox .264 or .mp4 file, the codec 
will be set to Matrox MAX H.264. If you’re capturing to a Matrox .avi 
file, select the codec that you want to use for the capture:

• Matrox MPEG-2 I-frame Captures video to MPEG-2 intra-frame 
format using the 4:2:2 Profile @ Main Level (for SD resolutions) or 
High Level (for HD resolutions) at a selected data rate.

• Matrox 8-bit Uncompressed Captures video to 8-bit 
uncompressed format.

• Matrox 10-bit Uncompressed Captures video to 10-bit 
uncompressed format.

$ Configure Click this to configure your codec settings (for the Matrox 
MAX H.264 and MPEG-2 I-frame codecs only). The Matrox MAX H.264 
settings are the same as when you export clips as explained in “Specifying 
your Matrox MAX H.264 settings” on page 220. The Matrox MPEG-2 
I-frame settings are the same as when capturing clips using Adobe 
Premiere Pro as explained in “Selecting your MPEG-2 I-frame settings” 
on page 100.

$ Frame Size Sets the width and height for your captured video. The 
available frame sizes depend on your specified file type, codec, and 
source video format. When capturing to a Matrox .264 or .avi file, only 
standard SD and/or HD frame sizes are available. When capturing to a 
Matrox .mp4 file, you can select a frame size, or select Custom if you 
want to enter a custom size. If you enter an unsupported frame size, the 
closest supported frame size will be used.

$ Frame Rate Sets the frame rate for your captured video. When 
capturing to a Matrox .264 or .avi file, an appropriate frame rate is 
automatically set based on your selected frame size and the frame rate of 
your source video. When capturing to a Matrox .mp4 file, you can select a 
frame rate from the list of compatible frame rates. For example, if your 
source video is 29.97 fps, you can set the frame rate for your captured 
video to 14.98, 29.97, or 59.94. Frame rates of 50 and 59.94, however, are 
supported only when the frame size is set to 1280×720.

¦ Note When using the Matrox MAX H.264 codec to capture to a 1440×1080 
or 1920 ×1080 progressive video format, the highest supported frame rate is 
29.97 fps. The specified frame size and frame rate determine the H.264 levels 
available for your encoded video. For details on the maximum frame size and 
frame rate supported for each H.264 level, see “Specifying your Matrox MAX 
H.264 settings” on page 220.
Specifying your capture format settings
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$ Scan Mode Determines the scan mode of your captured video 
(Interlaced or Progressive). This may be automatically set for you 
based on your specified file type, frame size, and source video format.

$ Aspect Ratio This is set to 16:9 when capturing to HD. When 
capturing to SD, you can select 4:3 to capture to the standard TV screen 
format, or 16:9 to capture to the widescreen 16:9 format.

$ Aspect Ratio Conversion  If your source video and captured video 
have different aspect ratios, select the option that you want for the aspect 
ratio conversion:

• 16x9 Letterbox Captures the widescreen 16:9 picture as letterbox 
video by adding black bars at the top and bottom of the picture for 
display on a standard 4:3 television screen.

• 4x3 Pillarbox Captures the standard 4:3 picture as pillarbox video by 
adding black bars at the left and right sides of the picture for display on 
a widescreen 16:9 television screen. (This option is not available for 
frame sizes smaller than 720×576.)

• Anamorphic Captures the video as horizontally or vertically 
compressed video (the aspect ratio of your source video is not 
maintained).

• Center Cut Captures the widescreen 16:9 picture by evenly cropping 
the left and right sides of the picture for display on a standard 4:3 
television screen.

• Center Zoom Captures the standard 4:3 picture by evenly cropping 
the top and bottom edges of the picture for display on a widescreen 
16:9 television screen.

2 Under Audio Capture Format, you can select the audio format settings you 
want for your captured clips:

$ File Type Select one of the following formats for the type of audio files 
you want to capture (available for Matrox .264 files only):

• AAC Captures AAC audio to separate .aac files.

• WAV Captures PCM audio to separate .wav files.

¦ Note For Matrox .mp4 files, AAC audio is always embedded in the .mp4 
file. For Matrox .avi files, audio is always captured to .wav files, and the 
channels that you choose to save to the first stereo .wav file or first two mono 
.wav files will be embedded in the associated .avi file.

$ Channel Type Select Stereo to save your captured audio to stereo 
files, or Mono to save your captured audio to mono files. This is set to 
Stereo for Matrox .mp4 files.

$ Format Select the format for your captured audio (16-bit or 24-bit).
pter 16, Using Matrox MAX H.264 Capture
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$ Bit rate For AAC audio, drag the bit rate slider to select the bit rate (in 
kilobits per second) that you want for your captured audio.

$ From the Filename lists, select which stereo pairs or mono channels you 
want to capture for each file. 

• When capturing to a Matrox .mp4 file, you can select one stereo pair to 
be embedded in the .mp4 file (only one Filename list will be 
available). 

• When capturing to a Matrox .264 or .avi file, you can select up to four 
stereo channels or up to eight mono channels, depending on the type of 
audio being captured. Select None for the particular files that you 
don’t want, or click the D (default) button for each Filename list if you 
want to capture only channels 1 and 2. When Matrox MXO2 saves 
separate audio files, it assigns a .Stereo or .Mono suffix to the base 
name of the associated video file. For example, if you’re capturing to 
separate .wav files and your video file is named MyFile.001.264, the 
associated stereo audio files will be named MyFile.001.Stereo1.wav, 
MyFile.001.Stereo2.wav, etc. 

3 Under Automatic File Switch, you can indicate whether you want the 
capture to automatically switch to the next clip after a specified time or file 
size limit has been reached (available when capturing to Matrox .mp4 files 
only).

$ Every n minutes Select this option to specify the number of minutes 
after which you want the capture to switch to the next clip.

$ Every n GB Select this option to specify the maximum file size (in 
gigabytes) after which you want the capture to switch to the next clip.

¦ Note If you select both automatic file switch options, the capture will switch 
to the next clip based on the limit that is reached first (minutes or file size). 
Be aware that your captured clips won’t have exactly the same duration or file 
size because the capture must always end at a GOP boundary.

4 If you’d like to save your changes as a custom preset, click the Save ( ) 
button beside the preset list in the Matrox MAX H.264 Capture dialog box. 
You’ll then be prompted to enter a name for your custom preset.

¦ Note To delete a custom preset, select the preset and click the Delete ( ) 
button.
Specifying your capture format settings
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Starting your capture
Once you’ve specified your input, output, and capture format settings, you’re 
ready to start capturing clips. To do this, click the Capture button.

1 Enter the capture path and subfolder where you want to store your captured 
clips, or click Browse to select the location that you want.

2 A default filename will be provided as the base name for your captured clips. 
You can change this name if you want. When capturing to Matrox .mp4 files 
using the automatic file switching feature, your clips will be numbered 
sequentially with a three-digit suffix, such as MyClip.000.mp4, 
MyClip.001.mp4, and so on. 

¦ Note Each time you start a new capture, the base filename will be 
incremented accordingly with a _n suffix (for example, _1, _2, and so on).

3 Click Explore to open Windows Explorer. You can then go to your capture 
folder and delete any clips that you no longer need, and you’ll be able to see 
your clips being added as they are captured.

4 If you’re capturing to Matrox .mp4 files, you can select the automatic file 
switching options that you want, such as to switch to the next clip after a 
specified time limit. These options are the same as provided in the Matrox 
Capture Format Settings dialog box (see “Specifying your capture format 
settings” on page 232). 

5 To limit the capture to a maximum duration, enter the duration (in minutes) 
that you want in the Maximum Duration box. The capture will 
automatically stop once this limit has been reached.
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¦ Note Keep the maximum duration close to the actual maximum that you 
want. If the maximum duration is a lot longer than you need, the file size of 
your clips will be larger.

6 Make sure that your video source is playing in the Preview Window, and 
click Start Capture to start the capture (the button will change to Stop 
Capture). 

7 If you’re capturing to Matrox .mp4 files, you can click Switch File at any 
time during the capture to switch the capture to the next file.

8 To stop the capture before the maximum duration is reached, click the Stop 
Capture button.
Starting your capture
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Monitoring Your Matrox MXO2 System

This chapter explains how to 
use the Matrox X.info program 
to display important details 
about your Matrox MXO2 
system and installed hardware.
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Using X.info to display MXO2 information
The Matrox X.info program lets you display information about your Matrox 
MXO2 system and installed hardware, and provides warnings when certain 
problems arise, such as when the temperature of your MXO2 exceeds the 
maximum operating temperature.

Matrox X.info runs continuously to monitor your system, whenever your 
computer is turned on and the MXO2 is connected. You can open Matrox X.info 
to display system and hardware details by double-clicking the  icon on your 
Windows taskbar. 

¦ Note If you do not see the icon, right-click the notification area of the taskbar 
and choose Properties, clear the Hide inactive icons option, and click OK.

Displaying system information
To display information about your Matrox MXO2 system, select System from 
the Display Information About list. On this page, you can see Install 
Information, such as the install path and version of Matrox Mtx.utils. 

You can also create an HTML log file of your system information, which can be 
useful for troubleshooting. To create this log, use the Browse button under 
System Information Log to select the path and name of the log, then click 
pter 17, Monitoring Your Matrox MXO2 System
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Create. If Open file after scan is selected, the HTML system log opens after it 
is created.

If you had previously turned off certain Matrox warnings and want them to be 
re-enabled, click Re-enable Warnings. For example, some Matrox warnings 
provide an option to turn off the warning (that is, you can select Don’t display 
this message again). Clicking Re-enable Warnings allows these warnings to 
be displayed again.
Using X.info to display MXO2 information
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Displaying hardware information
To display information about your Matrox MXO2 hardware, select Hardware 
from the Display Information About list. This displays a page with hardware 
information (for example, serial number and production date). You can also 
monitor the current and maximum operating temperatures for your MXO2 
hardware.

¡ Important Whether or not you have opened Matrox X.info, if your MXO2 
exceeds the maximum operating temperature, you’ll receive a warning message 
with further instructions as explained in the section “Error notification” on 
page 243.
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Monitoring your MXO2’s operating 
temperatures
As shown in the X.info Hardware section, the MXO2 page displays the current 
and maximum operating temperatures for your Matrox MXO2 hardware. To 
avoid damage to your Matrox MXO2, make sure that you don’t operate your 
MXO2 at or near the maximum temperature for a prolonged period of time. You 
should target your MXO2 to operate at least 10°C below the maximum operating 
temperature.

You should monitor the temperature of your MXO2 periodically and take 
measures as needed to lower the room temperature and/or make sure that the 
MXO2 is not close to a heat source and the MXO2 ventilation holes are not 
obstructed.

Error notification
X.info provides temperature warnings and warnings for other possible MXO2 
hardware problems. Once X.info has detected a hardware problem, the Matrox 
X.info Notification dialog box will be displayed to give you details of the 
problem and further instructions. You will not be able to close this dialog box 
until the problem has been resolved.
Using X.info to display MXO2 information
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Understanding Pulldown

This appendix describes the 
available MXO2 pulldown 
methods.
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Overview
Depending on your editing video format, a pulldown may be required to convert 
23.98 fps video to 29.97 fps video for output on Matrox MXO2. When a 
pulldown is required for your video output, Matrox MXO2 performs either a 
standard 2:3 pulldown or an advanced 2:3:3:2 pulldown.

Standard 2:3 pulldown
Standard 2:3 pulldown is often used as part of the telecine process to transfer 
24 fps film footage to 29.97 fps interlaced video. This pulldown method is also 
used to convert any 23.98 fps progressive video to 29.97 fps interlaced video, 
such as for converting 486p @ 23.98 fps video to NTSC.

In order to convert 24 fps film or 23.98 progressive video to 29.97 fps interlaced 
video, additional video frames, and more specifically video fields, must be 
created and added to the video sequence. For example, to convert a sequence of 
four film or progressive frames, five frames of video are needed for a total of 10 
video fields. Therefore, one additional video frame or two video fields must be 
created. To accomplish this, the first and third frames of a four-frame film or 
progressive video sequence are each converted to two video fields. The second 
and fourth frames of the sequence are converted to three video fields to make up 
a total of five interlaced video frames.

The following diagram demonstrates the process:

Standard 2:3 pulldown is accomplished by representing the first frame of film or 
progressive video (frame A) as two fields of video (fields a1 and a2), the second 
frame (frame B) as three fields of video (fields b1, b2, and b3), the third frame 
(frame C) as two fields (fields c1 and c2), and the fourth frame (frame D) as three 
fields (fields d1, d2, and d3). This sequence repeats six times each second.

A B C D

a1 a2 b1 b2 b3 d2d1c2c1 d3

Film frames @ 24 fps or progressive frames @ 23.98 fps

Video fields @ 29.97 fps

Frame A Frame C Frame DFrame B Frame E
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Advanced 2:3:3:2 pulldown
Advanced 2:3:3:2 pulldown was developed as an alternative to the standard 
pulldown method for making frame rate conversions in DV video. It is used to 
convert 486p @ 23.98 fps video to NTSC (486i @ 29.97 fps) video. This 
conversion is used when video footage is acquired by a DV camera at 23.98 fps 
and recorded to DV tape with the recorder set for advanced pulldown (called 
24PA or 24P Advanced mode on some devices). Advanced 2:3:3:2 pulldown 
differs from standard 2:3 pulldown in that the two middle frames of the video 
sequence are each converted to three video fields.

The following diagram demonstrates the process:

Advanced 2:3:3:2 pulldown is accomplished by representing the first frame of 
progressive video (frame A) as two fields of video (fields a1 and a2), the second 
frame (frame B) as three fields of video (fields b1, b2, and b3), the third frame 
(frame C) as three fields (fields c1, c2, and c3), and the fourth frame (frame D) as 
two fields (fields d1 and d2).

A B C D

a1 a2 b1 b2 b3 d1c3c2c1 d2

Progressive frames @ 23.98 fps

Video fields @ 29.97 fps

Frame A Frame C Frame DFrame B Frame E
Advanced 2:3:3:2 pulldown
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Matrox MXO2 Connectors

This appendix describes the 
inputs and outputs for all MXO2 
products.
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Inputs
The following sections detail the MXO2, MXO2 Rack, MXO2 LE, and MXO2 
Mini inputs.

MXO2 inputs
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MXO2 Rack inputs
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MXO2 LE inputs

Component
video 

(HD/SD)
Pr

Composite
video

SDI
(HD/SD)

Component 
video

(HD/SD)
YPb

HDMI
(HD/SD)

Y/C
(S-Video)R (CH 2)

Analog audio
(unbalanced)

Analog audio
(unbalanced)

L (CH 1)

Analog
audio

(balanced)

CH 2CH 1

Matrox MXO2 LE

External 
reference

(REF)
endix B, Matrox MXO2 Connectors
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MXO2 Mini inputs

HDMI
(HD only)

S-Video
(see “Connecting 

S-Video devices to 
MXO2 Mini” on 

page 44)

Analog audio
(unbalanced)Component video 

(HD/SD)
PbY

Matrox MXO2 Mini

Pr
L

(CH 1)
R

(CH 2)

Composite 
video (CVBS)

Y

Pb
(Y)

Pr
(C)

Host
(see “Connecting 

MXO2 Mini to your 
computer” on 

page 42)

Power
(see “Powering 
MXO2 Mini” on 

page 40)
Inputs
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Input connector descriptions
This section describes the Matrox MXO2, MXO2 Rack, and MXO2 LE inputs. 
For MXO2 Mini inputs, see “Input connector descriptions (MXO2 Mini)” on 
page 256.

¦ Note Depending on your MXO2 hardware, some of the following connectors 
may not be available or may be available in a limited capacity only. Some 
connectors on your MXO2 hardware may not appear exactly as shown below.

External reference (REF) Allows you to genlock all devices 
connected to your MXO2 system to an external genlock source 
(bi-level analog black burst for SD, or analog tri-level sync for 
HD). MXO2 Rack features an additional REF OUT connector 
with loop through that allows you to daisy chain the genlock 
reference input to another device’s reference input.

¡ Important If you connected an external genlock 
source to MXO2 Rack’s REF IN connector, and you’re 
not using the REF OUT connector, you must terminate 
the reference signal by connecting a BNC 75-ohm 
terminator to REF OUT.

To compensate for cable delays, timing-offset controls that 
align your video output relative to your external genlock source 
are available (see “Specifying your genlock settings” on 
page 84).

HDMI Provides an input for HD HDMI video (either YUV 
or RGB), and up to eight channels of uncompressed embedded 
audio, from a digital HDMI device. HDCP sources and SD 
video are not supported on this input. Connect a standard 
HDMI video/audio cable from a camera, VTR, or other video 
input source.

SDI Provides an input for use with a digital SDI device. This 
input supports HD-SDI and SD-SDI video, and up to eight 
channels of embedded audio. Connect an SDI video/audio cable 
from a camera, VTR, or other video input source.

(MXO2 and 
MXO2 LE)

(MXO2 Rack)
endix B, Matrox MXO2 Connectors



255
Component video (Y, Pb, Pr) Provide inputs for use with an 
analog component device, and support HD and SD video. 
Connect component Y, Pb, Pr video cables from a camera, 
VTR, or other video input source. 

Y/C (S-Video) Provides an input for use with an analog 
S-Video device (SD only). Connect an S-Video cable from a 
camera, VTR, or other video input source.

Composite video (CVBS) Allows you to input SD video 
from an analog NTSC or PAL device. Connect a composite 
video cable from a camera, VTR, or other video input source.

AES/EBU digital audio Allows you to input stereo digital 
audio. Connect a coaxial BNC audio cable from a camera, 
VTR, audio mixer, or other audio input source.

¦ Note Not available on MXO2 LE.

Analog audio (balanced) Allows you to input balanced 
stereo analog audio. Connect XLR cables from a camera, VTR, 
audio mixer, or other audio input source.

Analog audio (unbalanced) Allows you to input unbalanced 
stereo analog audio. Connect RCA cables from a camera, VTR, 
audio mixer, or other audio input source.
Inputs
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Input connector descriptions (MXO2 Mini)
This section describes the Matrox MXO2 Mini inputs. For other MXO2 products, 
see “Input connector descriptions” on page 254.

¦ Note Analog A/V cables connected to Matrox MXO2 Mini must be limited to 
less than three meters to comply with EEC and EMC directives.

HDMI Provides an input for HD HDMI video (either YUV 
or RGB), and up to eight channels of uncompressed embedded 
audio, from a digital HDMI device. HDCP sources and SD 
video are not supported on this input. Connect a standard 
HDMI video/audio cable from a camera, VTR, or other video 
input source.

Component video (Y, Pb, Pr) Provide inputs for use with an 
analog component device, and support HD and SD video. 
Connect component Y, Pb, Pr video cables from a camera, 
VTR, or other video input source.

¦ Note When you connect an analog component device 
to MXO2 Mini, you won’t be able to connect an 
S-Video or composite device at the same time.

S-Video Input connectors Pb and Pr allow you to connect the 
MXO2 S-Video adapter cable for use with an analog S-Video 
device (SD only). Connect an S-Video cable, via the MXO2 
S-Video adapter cable, from a camera, VTR, or other video 
input source. For an illustration on how to connect S-Video 
devices to MXO2 Mini, see “Connecting S-Video devices to 
MXO2 Mini” on page 44.

Composite video (Y) Allows you to input SD video from an 
analog NTSC or PAL device. Connect a composite video cable 
from a camera, VTR, or other video input source.

Analog audio (unbalanced) Allows you to input unbalanced 
stereo analog audio. Connect RCA cables from a camera, VTR, 
audio mixer, or other audio input source.
endix B, Matrox MXO2 Connectors
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Outputs
The following sections detail the MXO2, MXO2 Rack, MXO2 LE, and MXO2 
Mini outputs.

MXO2 outputs
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MXO2 Rack outputs
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MXO2 LE outputs

Component
video 

(HD/SD)
Pr

Composite
video

SDI A
(HD/SD)

SDI B
(HD/SD)

Component 
video

(HD/SD)

Y Pb

HDMI
(HD/SD)

Y/C
(S-Video) R (CH 2)

Analog audio
(unbalanced)

Analog audio
(unbalanced)

L (CH 1)

Analog
audio

(balanced)

CH 2CH 1

Matrox MXO2 LE
Outputs
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MXO2 Mini outputs

Matrox MXO2 Mini

Component video 
(HD/SD)

PbY Pr

Analog audio
(unbalanced)

L
(CH 1)

R
(CH 2)

S-Video
(see “Connecting 

S-Video devices to 
MXO2 Mini” on 

page 44)

Composite 
video (CVBS)

Y

Pb
(Y)

Pr
(C)

HDMI
(HD/SD)

Host
(see “Connecting 

MXO2 Mini to 
your computer” 

on page 42)

Power
(see “Powering 
MXO2 Mini” on 

page 40)
endix B, Matrox MXO2 Connectors
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Output connector descriptions
This section describes the Matrox MXO2, MXO2 Rack, and MXO2 LE outputs. 
For MXO2 Mini outputs, see “Output connector descriptions (MXO2 Mini)” on 
page 263.

¦ Note Depending on your MXO2 hardware, some of the following connectors 
may not be available or may be available in a limited capacity only. Some 
connectors on your MXO2 hardware may not appear exactly as shown below.

HDMI Provides an output for HD/SD HDMI video, and up to 
eight channels of embedded audio, to a digital HDMI device. 
HDCP is not supported on this output. This output supports 1:1 
pixel mapping for accurate monitoring on your HDMI display 
of NTSC, PAL, 1280×720, and 1920×1080 video. Connect a 
standard HDMI video/audio cable to an HDMI monitor, VTR, 
or other digital HDMI device. You can also connect directly to a 
home theatre system for surround sound monitoring.

¦ Note The HDMI output supports YUV and RGB 
devices.

HDMI monitor calibration is available through this output. Use 
the Matrox HDMI Calibration Utility to calibrate your HDMI 
monitor (see Chapter 7, “Calibrating Your HDMI Monitor for 
Video”). 

SDI A and SDI B Provide two simultaneous outputs of the 
same HD-SDI or SD-SDI video, with up to eight channels of 
embedded audio. For each output, connect an SDI video/audio 
cable to a video monitor, VTR, or other SDI device. You can 
also perform surround sound monitoring through the SDI 
output by connecting to a third-party device, such as an SDI 
audio de-embedder.

Component video (Y, Pb, Pr) Allows you to output HD or 
SD video to an analog component device. Connect component 
Y, Pb, Pr video cables to a video monitor, VTR, or other 
component device.

¦ Note The component output supports YUV and RGB 
devices.
Outputs
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Y/C (S-Video) Provides an output for SD video to an analog 
S-Video device. Connect an S-Video cable to a video monitor, 
VTR, or other S-Video device.

Composite video (CVBS) Allows you to output SD video to 
an analog NTSC or PAL device. Connect a composite video 
cable to a video monitor, VTR, or other NTSC or PAL device.

AES/EBU digital audio Allows you to output stereo digital 
audio. Connect a coaxial BNC audio cable to a VTR, audio 
mixer, speakers, or other audio device.

¦ Note Not available on MXO2 LE.

Analog audio (balanced) Allows you to output 
balanced stereo analog audio. Connect XLR 
cables to a VTR, audio mixer, speakers, or other 
audio device.

Analog audio (unbalanced) Provide outputs 
for unbalanced analog audio. Matrox MXO2 offers outputs for 
channels one to six, or three stereo pairs suitable for 5.1 
surround sound monitoring. Connect RCA cables to a VTR, 
audio mixer, speakers, or other audio device.
endix B, Matrox MXO2 Connectors
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Output connector descriptions (MXO2 Mini)
This section describes the Matrox MXO2 Mini outputs. For other MXO2 
products, see “Output connector descriptions” on page 261.

¦ Note Analog A/V cables connected to Matrox MXO2 Mini must be limited to 
less than three meters to comply with EEC and EMC directives.

HDMI Provides an output for HD/SD HDMI video, and up to 
eight channels of embedded audio, to a digital HDMI device. 
HDCP is not supported on this output. This output supports 1:1 
pixel mapping for accurate monitoring on your HDMI display 
of NTSC, PAL, 1280×720, and 1920×1080 video. Connect a 
standard HDMI video/audio cable to an HDMI monitor, VTR, 
or other digital HDMI device. You can also connect directly to a 
home theatre system for surround sound monitoring.

¦ Note The HDMI output supports YUV and RGB 
devices.

HDMI monitor calibration is available through this output. Use 
the Matrox HDMI Calibration Utility to calibrate your HDMI 
monitor (see Chapter 7, “Calibrating Your HDMI Monitor for 
Video”). 

Component video (Y, Pb, Pr) Allows you to output HD or 
SD video to an analog component device. Connect component 
Y, Pb, Pr video cables to a video monitor, VTR, or other 
component device.

¦ Note The component output supports YUV and RGB 
devices. When you connect an analog component device 
to MXO2 Mini, you won’t be able to connect an 
S-Video or composite device at the same time.

S-Video Output connectors Pb and Pr allow you to connect 
the MXO2 S-Video adapter cable for outputting SD video to an 
analog S-Video device. Connect an S-Video cable, via the 
MXO2 S-Video adapter cable, to a video monitor, VTR, or 
other S-Video device. For instructions on how to connect 
S-Video devices to MXO2 Mini, see “Connecting S-Video 
devices to MXO2 Mini” on page 44.
Outputs
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Composite video (Y) Allows you to output SD video to an 
analog NTSC or PAL device. Connect a composite video cable 
to a video monitor, VTR, or other NTSC or PAL device.

Analog audio (unbalanced) Provide outputs for unbalanced 
analog audio channels one and two, or one stereo pair. Connect 
RCA cables to a VTR, audio mixer, speakers, or other audio 
device.
endix B, Matrox MXO2 Connectors
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information on the video input 
and capture formats that are 
supported on MXO2.
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Supported input formats
The following table shows the video input formats that are supported on the 
MXO2 video inputs for capturing video. For descriptions of the MXO2 inputs, 
see “Inputs” on page 250. 

Matrox MXO2 input

Video input 
format

HDMI SDI1 Component S-Video Composite

NTSC — Z Z Z Z

PAL — Z Z Z Z

720p @ 50 fps Z Z Z — —

720p @ 59.94 fps Z Z Z — —

1080i @ 25 fps Z Z Z — —

1080i @ 29.97 fps Z Z Z — —

1080PsF @ 23.98 fps — Z Z — —

1080PsF @ 24 fps — Z — — —

1080PsF @ 25 fps Z Z Z — —

1080PsF @ 29.97 fps Z Z Z — —

1080p @ 23.98 fps Z Z — — —

1080p @ 24 fps Z Z — — —

1080p @ 25 fps Z Z — — —

1080p @ 29.97 fps Z Z — — —

1080p @ 30 fps Z Z — — —
1 SDI is not supported on Matrox MXO2 Mini.
endix C, Matrox MXO2 Supported Input and Capture Formats
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Supported capture formats for Adobe 
Premiere Pro and Matrox A/V Tools

The following table lists the supported capture formats on Matrox MXO2 
products, based on your editing video format and selected input source in Adobe 
Premiere Pro or Matrox A/V Tools. 

Matrox MXO2 input1

Editing video 
format2 HDMI SDI3 Component S-Video Composite

NTSC NTSC4, 720p @ 59.94 fps, or 1080i/p5/PsF @ 29.97 fps NTSC NTSC

PAL PAL6, 720p @ 50 fps, or 1080i/p5/PsF @ 25 fps PAL PAL

486p @ 23.98 fps7 1080p @ 23.98 fps 1080p5/PsF @23.98 fps — —

486p @ 29.97 fps — — — — —

576p @ 25 fps — — — — —

720p @ 23.98 fps — — — — —

720p @ 25 fps — — — — —

720p @ 29.97 fps — — — — —

720p @ 50 fps PAL6, 720p @ 50 fps, or 1080i/p5/PsF @ 25 fps PAL PAL

720p @ 59.94 fps NTSC4, 720p @ 59.94 fps, or 1080i/p5/PsF @ 29.97 fps NTSC NTSC

1440×1080i @ 25 fps 1080i @ 25 fps — —

1440×1080i @ 29.97 fps 1080i @ 29.97 fps — —

1440×1080p @ 23.98 fps — — — — —

1440×1080p @ 25 fps — — — — —

1440×1080p @ 29.97 fps — — — — —

1080i @ 25 fps PAL6, 720p @ 50 fps, or 1080i @ 25 fps PAL PAL

1080i @ 29.97 fps NTSC4, 720p @ 59.94 fps, or 1080i @ 29.97 fps NTSC NTSC

1080p @ 23.98 fps 1080p @ 23.98 fps 1080p5/PsF @ 23.98 fps — —

1080p @ 24 fps 1080p @ 24 fps 1080p/PsF @ 24 fps — — —

1080p @ 25 fps PAL6, 720p @ 50 fps, or 1080p5/PsF @ 25 fps PAL PAL

1080p @ 29.97 fps NTSC4, 720p @ 59.94 fps, or 1080p5/PsF @ 29.97 fps NTSC NTSC

1080p @ 30 fps 1080p @ 30 fps — — —
1 For details on capturing input from a DV-1394 device connected to your system using Adobe 

Premiere Pro, see “Specifying your video capture settings” on page 91.
2 Video is always captured to the editing video format.
3 SDI is not supported on Matrox MXO2 Mini.
4 NTSC is not supported on the HDMI input.
5 1080p is not supported on the component input.
6 PAL is not supported on the HDMI input.
7 Capture to 486p @ 23.98 fps is not supported for .m2v captures.
Supported capture formats for Adobe Premiere Pro and Matrox A/V Tools
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Supported capture formats for Avid Media 
Composer

The following table lists the supported capture formats on Matrox MXO2 
products, based on your project’s video format and selected input source in Avid 
Media Composer.

Matrox MXO2 input

Project video 
format1 HDMI SDI2 Component S-Video Composite

30i NTSC NTSC3, 720p @ 59.94 fps, or 1080i/p4/PsF @ 29.97 fps NTSC NTSC

23.976p NTSC NTSC3, 720p @ 59.94 fps, or 1080i/p4/PsF @ 29.97 fps NTSC NTSC

24p NTSC — — — — —

25i PAL PAL5, 720p @ 50 fps, or 1080i/p4/PsF @ 25 fps PAL PAL

24p PAL — — — — —

25p PAL PAL5, 720p @ 50 fps, or 1080i/p4/PsF @ 25 fps PAL PAL

720p/23.976 NTSC3, 720p @ 59.94 fps, or 1080i/p4/PsF @ 29.97 fps NTSC NTSC

720p/25 PAL5, 720p @ 50 fps, or 1080i/p4/PsF @ 25 fps PAL PAL

720p/29.97 — — — — —

720p/50 PAL5, 720p @ 50 fps, or 1080i/p4/PsF @ 25 fps PAL PAL

720p/59.94 NTSC3, 720p @ 59.94 fps, or 1080i/p4/PsF @ 29.97 fps NTSC NTSC

1080i/50 (25 fps) PAL5, 720p @ 50 fps, or 1080i @ 25 fps PAL PAL

1080i/59.94 (29.97 fps) NTSC3, 720p @ 59.94 fps, or 1080i @ 29.97 fps NTSC NTSC

1080p/23.976 1080p @ 23.98 fps 1080p4/PsF @ 23.98 fps — —

1080p/24 1080p @ 24 fps 1080p/PsF @ 24 fps — — —

1080p/25 PAL5, 720p @ 50 fps, or 1080p4/PsF @ 25 fps PAL PAL

1080p/29.97 NTSC3, 720p @ 59.94 fps, or 1080p4/PsF @ 29.97 fps NTSC NTSC
1 Video is always captured to the project’s video format.
2 SDI is not supported on Matrox MXO2 Mini.
3 NTSC is not supported on the HDMI input.
4 1080p is not supported on the component input.
5 PAL is not supported on the HDMI input.
endix C, Matrox MXO2 Supported Input and Capture Formats
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Supported capture formats for Matrox MAX 
H.264 Capture

The following table lists the supported captureformats when using the Matrox 
MAX H.264 Capture application to capture clips to Matrox .264, .mp4, and .avi 
files, based on your selected video input format. For a list of the video input 
formats supported on the various MXO2 inputs for capturing clips, see 
“Supported input formats” on page 266.

Captured file format

Video input format Matrox 264 (Blu-ray) Matrox MP4 Matrox AVI

NTSC
720p @ 59.94 fps or 
1080i @ 29.97 fps

720p @ 59.94 fps, 
Any_1p @ 14.98 fps, or 

Any_p @ 29.97 fps

NTSC, 720p @ 59.94 fps, or 
1080i/p @ 29.97 fps

PAL
720p @ 50 fps or 
1080i @ 25 fps

720p @ 50 fps, 
Any_p @ 12.5 fps, or 

Any_p @ 25 fps

PAL, 720p @ 50 fps, or
1080i/p @ 25 fps

720p @ 50 fps
720p @ 50 fps or 
1080i @ 25 fps

720p @ 50 fps, 
Any_p @ 12.5 fps, or 

Any_p @ 25 fps

PAL, 720p @ 50 fps, or 
1080i/p @ 25 fps

720p @ 59.94 fps
720p @ 59.94 fps or 
1080i @ 29.97 fps

720p @ 59.94 fps, 
Any_p @ 14.98 fps, or 

Any_p @ 29.97 fps

NTSC, 720p @ 59.94 fps, or 
1080i/p @ 29.97 fps

1080i @ 25 fps
720p @ 50 fps or 
1080i @ 25 fps

720p @ 50 fps, 
Any_p @ 12.5 fps, or 

Any_p @ 25 fps

PAL, 720p @ 50 fps, 
1440×1080i2 @ 25 fps, or 

1080i @ 25 fps

1080i @29.97 fps
720p @ 59.94 fps or 
1080i @ 29.97 fps

720p @ 59.94 fps, 
Any_p @ 14.98 fps, or 

Any_p @ 29.97 fps

NTSC, 720p @ 59.94 fps, 
1440×1080i2 @ 29.97 fps, or

1080i @ 29.97 fps

1080p/PsF @ 23.98 fps
 720p @ 23.98 fps or 
1080p @ 23.98 fps

Any_p @ 11.99 fps or 
Any_p @ 23.98 fps

486p @23.98 fps or
1080p @ 23.98 fps

1080p/PsF @ 24 fps
720p @ 24 fps or 
1080p @ 24 fps

Any_p @ 12 fps or 
Any_p @ 24 fps

1080p @ 24 fps

1080p/PsF @ 25 fps 720p @ 50 fps
720p @ 50 fps, 

Any_p @ 12.5 fps, or 
Any_p @ 25 fps

PAL, 720p @ 50 fps, or 
1080p @ 25 fps

1080p/PsF @ 29.97 fps  —
 Any_p @ 14.98 fps or 

Any_p @ 29.97 fps
NTSC, 720p @ 59.94 fps, or

1080p @ 29.97 fps

1080p @ 30 fps —
Any_p @ 15 fps or 

Any_p @ 30 fps
1080p @ 30 fps

1 Any_ represents a custom frame size that you can enter for your Matrox .mp4 file as explained in 
“Specifying your capture format settings” on page 232.

2 1440 ×1080i is supported with the Matrox MPEG-2 I-frame HD codec only.
Supported capture formats for Matrox MAX H.264 Capture
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Your notes
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Matrox MXO2 Supported Output

Formats
This appendix provides 
information on the video output 
formats that are supported on 
MXO2.
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Supported video output formats for playback
This section lists the formats that are supported on the main and secondary 
MXO2 video outputs during playback, depending on the application used. For 
descriptions of the MXO2 outputs, see “Outputs” on page 257.

Playback using Adobe Premiere Pro, Matrox 
A/V Tools, and Matrox WYSIWYG
The following table shows the formats that are supported on the main and 
secondary MXO2 video outputs during playback using Adobe Premiere Pro, 
Matrox A/V Tools, and the Matrox WYSIWYG plug-ins, based on your selected 
editing video format 

Matrox MXO2 output

ing video format Main output1 Secondary output2

NTSC

NTSC NTSC, 720p @ 59.94 fps, or 1080i/p3/PsF @ 29.97 fps 

720p @ 59.94 fps NTSC or 720p @ 59.94 fps

1080i @ 29.97 fps NTSC or 1080i @ 29.97 fps

1080PsF @ 29.97 fps
NTSC or 1080p3/PsF @ 29.97 fps

1080p @ 29.97 fps3,4

PAL or DV-PAL

PAL PAL, 720p @ 50 fps, or 1080i/p3/PsF @ 25 fps

720p @ 50 fps PAL or 720p @ 50 fps

1080i @ 25 fps PAL or 1080i @ 25 fps

1080PsF @ 25 fps
PAL or 1080p3/PsF @ 25 fps

1080p @ 25 fps3,4

86p @ 23.98 fps

NTSC NTSC, 480p @ 59.94 fps5, 720p @ 59.94 fps, 1080i @ 29.97 fps, o
1080p3/PsF @ 23.98 fps480p @ 59.94 fps4,5

720p @ 59.94 fps NTSC, 480p @ 59.94 fps5, or 720p @ 59.94 fps

1080i @ 29.97 fps NTSC, 480p @ 59.94 fps5, or 1080i @ 29.97 fps

1080PsF @ 23.98 fps
NTSC, 480p @ 59.94 fps5, or 1080p3/PsF @ 23.98 fps

1080p @ 23.98 fps3,4

86p @ 29.97 fps

NTSC
NTSC, 480p @ 59.94 fps5, 720p @ 59.94 fps, or 1080i/p3/PsF @ 29.97

480p @ 59.94 fps4,5

720p @ 59.94 fps NTSC, 480p @ 59.94 fps5, or 720p @ 59.94 fps

1080i @ 29.97 fps NTSC, 480p @ 59.94 fps5, or 1080i @ 29.97 fps

1080PsF @ 29.97 fps
NTSC, 480p @ 59.94 fps5, or 1080p3/PsF @ 29.97 fps

1080p @ 29.97 fps3,4
endix D, Matrox MXO2 Supported Output Formats
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576p @ 25 fps

PAL
PAL, 576p @ 50 fps5, 720p @ 50 fps, or 1080i/p3/PsF @ 25 fps

576p @ 50 fps4,5

720p @ 50 fps PAL, 576p @ 50 fps5, or 720p @ 50 fps

1080i @ 25 fps PAL, 576p @ 50 fps5, or 1080i @ 25 fps

1080PsF @ 25 fps
PAL, 576p @ 50 fps5, or 1080p3/PsF @ 25 fps

1080p @ 25 fps3,4

20p @ 23.98 fps

NTSC
NTSC, 480p @ 59.94 fps5, or 720p @ 59.94 fps

480p @ 59.94 fps4,5

720p @ 59.94 fps
NTSC, 480p @ 59.94 fps5, 720p @ 59.94 fps, 1080i @ 29.97 fps, or

1080p3/PsF @ 23.98 fps

1080i @ 29.97 fps 720p @ 59.94 fps or 1080i @ 29.97 fps

1080PsF @ 23.98 fps
720p @ 59.94 fps or 1080p3/PsF @ 23.98 fps

1080p @ 23.98 fps3,4

720p @ 25 fps

PAL
PAL, 576p @ 50 fps5, or 720p @ 50 fps

576p @ 50 fps4,5

720p @ 50 fps PAL, 576p @ 50 fps5, 720p @ 50 fps, 1080i/p3/PsF @ 25 fps

1080i @ 25 fps

720p @ 50 fps or 1080i/p3/PsF @ 25 fps1080PsF @ 25 fps

1080p @ 25 fps3,4

20p @ 29.97 fps

NTSC
NTSC, 480p @ 59.94 fps5, or 720p @ 59.94 fps

480p @ 59.94 fps4,5

720p @ 59.94 fps NTSC, 480p @ 59.94 fps5, 720p @ 59.94 fps, 1080i/p3/PsF @ 29.97 f

1080i @ 29.97 fps 720p @ 59.94 fps or 1080i @ 29.97 fps

1080PsF @ 29.97 fps
720p @ 59.94 fps or 1080p3/PsF @ 29.97 fps

1080p @ 29.97 fps3,4

720p @ 50 fps

PAL
PAL, 576p @ 50 fps5, or 720p @ 50 fps

576p @ 50 fps4,5

720p @ 50 fps PAL, 576p @ 50 fps5, 720p @ 50 fps, or 1080i @ 25 fps

1080i @ 25 fps 720p @ 50 fps or 1080i @ 25 fps

20p @ 59.94 fps

NTSC
NTSC, 480p @ 59.94 fps5, or 720p @ 59.94 fps

480p @ 59.94 fps4,5

720p @ 59.94 fps NTSC, 480p @ 59.94 fps5, 720p @ 59.94 fps, or 1080i @ 29.97 fps

1080i @ 29.97 fps 720p @ 59.94 fps or 1080i @ 29.97 fps

Matrox MXO2 output

ing video format Main output1 Secondary output2
Supported video output formats for playback
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0×1080i @ 25 fps

PAL PAL

720p @ 50 fps 720p @ 50

1080i @ 25 fps PAL or 1080i @ 25 fps

×1080i @ 29.97 fps

NTSC NTSC

720p @ 59.94 fps 720p @ 59.94 fps

1080i @ 29.97 fps NTSC or 1080i @ 29.97 fps

×1080p @ 23.98 fps

NTSC
NTSC or 480p @ 59.94 fps5

480p @ 59.94 fps4,5

720p @ 59.94 fps 720p @ 59.94 fps or 1080p3/Psf @ 23.98 fps

1080i @ 29.97 fps

NTSC, 480p @ 59.94 fps5, 1080i @ 29.97 fps, or 1080p3/PsF @ 23.98 1080PsF @ 23.98 fps

1080p @ 23.98 fps3,4

0×1080p @ 25 fps

PAL
PAL or 576 @ 50 fps5

576p @ 50 fps4,5

720p @ 50 fps 720p @ 50 fps

1080PsF @ 25 fps
PAL, 576p @ 50 fps5, or 1080p3/PsF @ 25 fps

1080p @ 25 fps3,4

×1080p @ 29.97 fps

NTSC
NTSC or 480p @ 59.94 fps5

480p @ 59.94 fps4,5

720p @ 59.94 fps 720p @ 59.94 fps

1080PsF @ 29.97 fps
NTSC, 480p @ 59.94 fps5, or 1080p3/PsF @ 29.97 fps

1080p @ 29.97 fps3,4

1080i @ 25 fps

PAL PAL or 1080i @ 25 fps

720p @ 50 fps 720p @ 50 fps or 1080i @ 25 fps

1080i @ 25 fps PAL, 720p @ 50 fps, or 1080i @ 25 fps

080i @ 29.97 fps

NTSC NTSC or 1080i @ 29.97 fps

720p @ 59.94 fps 720p @ 59.94 fps or 1080i @ 29.97 fps

1080i @ 29.97 fps NTSC, 720p @ 59.94 fps, or 1080i @ 29.97 fps

080p @ 23.98 fps

NTSC
NTSC, 480p @ 59.94 fps5, 1080i @ 29.97 fps, or 1080p3/PsF @ 23.98 

480p @ 59.94 fps4,5

720p @ 59.94 fps 720p @ 59.94 fps, 1080i @ 29.97 fps, or 1080p3/PsF@ 23.98 fps

1080i @ 29.97 fps
NTSC, 480p @ 59.94 fps5, 720p @ 59.94 fps, 1080i @ 29.97 fps, or

1080p3/PsF @ 23.98 fps
1080PsF @ 23.98 fps

1080p @ 23.98 fps3,4

Matrox MXO2 output

ing video format Main output1 Secondary output2
endix D, Matrox MXO2 Supported Output Formats
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Edit
1080p @ 24 fps
1080PsF @ 24 fps4,6

1080p/PsF @ 24 fps3,6

1080p @ 24 fps3,4

1080p @ 25 fps

PAL
PAL, 576p @ 50 fps5, or 1080p3/PsF @ 25 fps

576p @ 25 fps4,5

720p @ 50 fps 720p @ 50 fps or 1080p3/PsF @ 25 fps

1080PsF @ 25 fps
PAL, 576p @ 50 fps5, 720p @ 50 fps, or 1080p3/PsF @ 25 fps

1080p @ 25 fps3,4

080p @ 29.97 fps

NTSC
NTSC, 480p @ 59.94 fps5, or 1080p3/PsF @ 29.97 fps

480p @ 59.94 fps4,5

720p @ 59.94 fps 720p @ 59.94 fps or 1080p3/PsF @ 29.97 fps

1080PsF @ 29.97 fps
NTSC, 480p @ 59.94 fps5, 720p @ 59.94 fps, or 1080p3/PsF @ 29.97 

1080p @ 29.97 fps3,4

1080p @ 30 fps 1080p @ 30 fps3,4 1080p @ 30 fps3

in output on MXO2 Mini is always analog.
condary output on MXO2 Mini is always HDMI.
80p is supported on the HDMI and SDI outputs only.
t available on MXO2 Mini.
0p @ 59.94 fps and 576p @ 50 fps are supported on the HDMI output only.
80PsF @ 24 fps is supported on the SDI output only.

Matrox MXO2 output

ing video format Main output1 Secondary output2
Supported video output formats for playback
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2
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108
Playback using Avid Media Composer
The following table shows the formats that are supported on the main and 
secondary MXO2 video outputs during playback using Avid Media Composer, 
based on your project’s video format.

¡ Important If the main and secondary output formats don’t match and the 
video quality for playback is not set to Full Quality, the secondary output will be 
blanked on MXO2, MXO2 Rack, and MXO2 LE. On MXO2 Mini, however, 
either the main analog or secondary HDMI output will be blanked depending on 
whether you selected analog or HDMI as the Priority Output (never blanked) 
setting.

Matrox MXO2 output

ject video format Main output1 Secondary output2

30i NTSC, 
3.976p NTSC, or 

24p NTSC

NTSC NTSC, 720p @ 59.94 fps, or 1080i/p3/PsF @ 29.97 fps 

720p @ 59.94 fps NTSC or 720p @ 59.94 fps

1080i @ 29.97 fps NTSC or 1080i @ 29.97 fps

1080PsF @ 29.97 fps
NTSC or 1080p3/PsF @ 29.97 fps

1080p @ 29.97 fps3,4

5i PAL, 24p PAL, 
or 25p PAL

PAL PAL, 720p @ 50 fps, or 1080i/p3/PsF @ 25 fps

720p @ 50 fps PAL or 720p @ 50 fps

1080i @ 25 fps PAL or 1080i @ 25 fps

1080PsF @ 25 fps
PAL or 1080p3/PsF @ 25 fps

1080p @ 25 fps3,4

720p/23.9765, 
720p/29.97, or 

720p/59.94

NTSC
NTSC, 480p @ 59.94 fps6, or 720p @ 59.94 fps

480p @ 59.94 fps6

720p @ 59.94 fps NTSC, 480p @ 59.94 fps5, 720p @ 59.94 fps, or 1080i @ 29.97 fps

1080i @ 29.97 fps 720p @ 59.94 fps or 1080i @ 29.97 fps

20p/25 or 720p/50

PAL
PAL, 576p @ 50 fps6, or 720p @ 50 fps

576p @ 50 fps6

720p @ 50 fps PAL, 576p @ 50 fps6, 720p @ 50 fps, or 1080i @ 25 fps

1080i @ 25 fps 720p @ 50 fps or 1080i @ 25 fps

1080i/50 (25 fps)

PAL PAL or 1080i @ 25 fps

720p @ 50 fps 720p @ 50 fps or 1080i @ 25 fps

1080i @ 25 fps PAL, 720p @ 50 fps, or 1080i @ 25 fps

0i/59.94 (29.97 fps)

NTSC NTSC or 1080i @ 29.97 fps

720p @ 59.94 fps 720p @ 59.94 fps or 1080i @ 29.97 fps

1080i @ 29.97 fps NTSC, 720p @ 59.94 fps, or 1080i @ 29.97 fps
endix D, Matrox MXO2 Supported Output Formats
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Pro
1080p/23.9765

NTSC
NTSC, 480p @ 59.94 fps6, 1080i @ 29.97 fps, or 1080p3/PsF @ 23.98 

480p @ 59.94 fps6

720p @ 59.94 fps 720p @ 59.94 fps, 1080i @ 29.97 fps, or 1080p3/PsF@ 23.98 fps

1080i @ 29.97 fps
NTSC, 480p @ 59.94 fps6, 720p @ 59.94 fps, 1080i @ 29.97 fps, or

1080p3/PsF @ 23.98 fps
1080PsF @ 23.98 fps

1080p @ 23.98 fps3,4

1080p/245
1080PsF @ 24 fps4,7

1080p/PsF @ 24 fps3,7

1080p@ 24 fps3,4

1080p/25

PAL
PAL, 576p @ 50 fps6, or 1080p3/PsF @ 25 fps

576p @ 25 fps6

720p @ 50 fps 720p @ 50 fps or 1080p3/PsF @ 25 fps

1080PsF @ 25 fps
PAL, 576p @ 50 fps5, 720p @ 50 fps, or 1080p3/PsF @ 25 fps

1080p @ 25 fps3,4

1080p/29.97

NTSC
NTSC, 480p @ 59.94 fps6, or 1080p3/PsF @ 29.97 fps

480p @ 59.94 fps6

720p @ 59.94 fps 720p @ 59.94 fps or 1080p3/PsF @ 29.97 fps

1080PsF @ 29.97 fps
NTSC, 480p @ 59.94 fps6, 720p @ 59.94 fps, or 1080p3/PsF @ 29.97 f

1080p @ 29.97 fps3,4

ain output on MXO2 Mini is always analog.
condary output on MXO2 Mini is always HDMI.
80p is supported on the HDMI and SDI outputs only.

ot available on MXO2 Mini.
 downconvert a 720p/23.976, 1080p/23.976, or 1080p24 sequence to SD to record a digital cut, you must chang
ur project’s format (project type) to SD (see “Exporting your sequence to tape” on page 69).
0p @ 59.94 fps and 576p @ 50 fps are supported on the HDMI output only.
80PsF @ 24 fps is supported on the SDI output only.

Matrox MXO2 output

ject video format Main output1 Secondary output2
Supported video output formats for playback
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Supported video output formats during 
capture

This section lists the formats that are supported on the MXO2 video outputs for 
previewing your captured video using various capture applications. For 
descriptions of the MXO2 outputs, see “Outputs” on page 257.

Adobe Premiere Pro and Matrox A/V Tools
The following table shows the formats that are supported on the MXO2 video 
outputs for previewing your captured video, based on your editing video format 
in Adobe Premiere Pro or Matrox A/V Tools.

Matrox MXO2 output

Editing video format HDMI SDI1 Component S-Video Composite

NTSC NTSC

PAL PAL

DV-PAL 576p @ 50 fps PAL

486p @ 23.98 fps 480p @ 59.94 fps NTSC

486p @ 29.97 fps 480p @ 59.94 fps NTSC

576p @ 25 fps 576p @ 50 fps PAL

720p @ 23.98 fps 720p @ 59.94 fps — —

720p @ 25 fps 720p @ 50 fps — —

720p @ 29.97 fps 720p @ 59.94 fps — —

720p @ 50 fps 720p @ 50 fps — —

720p @ 59.94 fps 720p @ 59.94 fps — —

1440×1080i @ 25 fps 1080i @ 25 fps — —

1440×1080i @ 29.97 fps 1080i @ 29.97 fps — —

1440×1080p @ 23.98 fps — — — — —

1440×1080p @ 25 fps — — — — —

1440×1080p @ 29.97 fps — — — — —

1080i @ 25 fps 1080i @ 25 fps — —

1080i @ 29.97 fps 1080i @ 29.97 fps — —

1080p @ 23.98 fps 1080p/PsF @ 23.98 fps 1080PsF @ 23.98 fps — —

1080p @ 24 fps 1080p/PsF @ 24 fps2 — — —

1080p @ 25 fps 1080p/PsF @ 25 fps 1080PsF @ 25 fps — —

1080p @ 29.97 fps 1080p/PsF @ 29.97 fps 1080PsF @ 29.97 fps

1080p @ 30 fps 1080p @ 30 fps — — —
1 SDI is not supported on Matrox MXO2 Mini.
2 1080PsF @ 24 fps is supported on the SDI output only.
endix D, Matrox MXO2 Supported Output Formats
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Avid Media Composer
The following table shows the formats that are supported on the MXO2 video 
outputs for previewing your captured video, based on your project’s video format 
in Avid Media Composer.

Matrox MXO2 output

Project video format HDMI SDI1 Component S-Video Composite

30i NTSC or
23.976p NTSC

NTSC

25i PAL or 25p PAL PAL

720p/23.976 or 
720p/59.94

720p @ 59.94 fps — —

720p/25 or 720p/50 720p @ 50 fps — —

1080i/50 (25 fps) 1080i @ 25 fps — —

1080i/59.94 (29.97 fps) 1080i @ 29.97 fps — —

1080p/23.976 1080p/PsF @ 23.98 fps 1080PsF @ 23.98 fps — —

1080p/24 fps 1080p/PsF @ 24 fps2 — — —

1080p/25 fps 1080p/PsF @ 25 fps 1080PsF @ 25 fps — —

1080p @ 29.97 fps 1080p/PsF @ 29.97 fps 1080PsF @ 29.97 fps
1 SDI is not supported on Matrox MXO2 Mini.
2 1080PsF @ 24 fps is supported on the SDI output only.
Supported video output formats during capture
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Matrox MAX H.264 Capture
The following table shows the formats that are supported on the MXO2 video 
outputs for monitoring the source material that you’re capturing using the Matrox 
MAX H.264 Capture application, based on your selected video input format. For 
a list of the video input formats supported on the various MXO2 inputs for 
capturing clips, see “Supported input formats” on page 266.

Matrox MXO2 output

Video input format HDMI SDI1 Component S-Video Composite

NTSC NTSC

PAL PAL

720p @ 50 fps 720p @ 50 fps — —

720p @ 59.94 fps 720p @ 59.94 fps — —

1080i @ 25 fps 1080i @ 25 fps — —

1080i @ 29.97 fps 1080i @ 29.97 fps — —

1080PsF @ 23.98 fps 1080PsF @ 23.98 fps — —

1080PsF @ 24 fps — 1080PsF @ 24 fps — — —

1080PsF @ 25 fps 1080PsF @ 25 fps — —

1080PsF @ 29.97 fps 1080PsF @ 29.97 fps — —

1080p @ 23.98 fps 1080p @ 23.98 fps — — —

1080p @ 24 fps 1080p @ 24 fps — — —

1080p @ 25 fps 1080p @ 25 fps — — —

1080p @ 29.97 fps 1080p @ 29.97 fps — — —

1080p @ 30 fps 1080p @ 30 fps — — —
1 SDI is not supported on Matrox MXO2 Mini.
endix D, Matrox MXO2 Supported Output Formats
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Matrox MXO2 specifications

General
• Video formats NTSC, PAL, NTSC-EIAJ, 1080i/p/PsF, 720p, 576p, 480p

• Regulatory compliance

$ FCC Class A, CE Mark Class A, ACMA C-Tick Mark, VCCI

$ RoHS Directive 2002/95/EC

• Dimensions

$ Length 330 mm (13”)

$ Width 241 mm (9.5”)

$ Height 51 mm (2”)

• External AC/DC adapter

$ 100-240 VAC 50-60 Hz

$ Input: IEC320-C14 inlet

$ Output: +12V DC, 3A max

$ Dimensions: L 104 mm  × W 46 mm × H 36 mm (4.1” × 1.8” × 1.4”)

• Total power consumption 15 watts

Connections
• Genlock reference input

$ HD analog tri-level sync or SD analog bi-level black burst

$ BNC connector (75 Ω), terminated

• RS-422 D-sub connector (9 pins)

Video
• HDMI

$ HD input and output

• HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (10-bit)

• Eight channels of embedded audio

• Standard Type A HDMI connector (19 pins)

$ SD output

• HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (10-bit)

• Eight channels of embedded audio

• Standard Type A HDMI connector (19 pins)

• SDI

$ HDTV input

• HD-SDI with eight channels of embedded SDI audio
endix E, Matrox MXO2 Specifications
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• 24-bit, 48 kHz

• Compliant with SMPTE 292M, SMPTE 299M

• BNC connector (75 Ω), terminated

• Equalized input for maximum cable length support

$ HDTV output

• HD-SDI with eight channels of embedded SDI audio

• 24-bit, 48 kHz

• Compliant with SMPTE 292M, SMPTE 299M

• BNC connector (75 Ω)

$ SDTV input

• SD-SDI with eight channels of embedded audio

• 24-bit, 48 kHz

• BNC connector (75 Ω), terminated

• Equalized input for maximum cable length support

• Compliant with SMPTE 259M-C, SMPTE 272M

$ SDTV output

• SD-SDI with eight channels of embedded audio

• 24-bit, 48 kHz

• BNC connector (75 Ω)

• Compliant with SMPTE 259M-C, SMPTE 272M

• S-Video and composite video input

$ SDTV input

• PAL, NTSC, NTSC-EIAJ

• BNC connector for composite (75 Ω), terminated

• 4-pin mini-DIN S-Video connector (75 Ω), terminated

• 12-bit ADC

• 2x oversampling

• Anti-aliasing filtering

• Automatic gain control

$ SDTV output

• PAL, NTSC, NTSC-EIAJ

• BNC connector for composite (75 Ω)

• 4-pin mini-DIN S-Video connector (75 Ω)

• 12-bit DAC

• 8x oversampling
Matrox MXO2 specifications
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• Analog component video input

$ HDTV input

• EIA-770.3 compliant

• BNC connectors (75 Ω)

• 12-bit ADC

• Anti-aliasing filtering

$ HDTV output

• EIA-770.3 compliant

• BNC connectors (75 Ω)

• 12-bit DAC

• 2x oversampling

$ SDTV input

• Betacam, Betacam SP (NTSC and NTSC-EIAJ)

• SMPTE/EBU N10 (PAL)

• BNC connectors (75 Ω)

• 12-bit ADC

• 4x oversampling

• Anti-aliasing filter

$ SDTV output

• Betacam, Betacam SP (NTSC and NTSC-EIAJ)

• SMPTE/EBU N10 (PAL)

• BNC connectors (75 Ω)

• 12-bit DAC

• 8x oversampling

• Analog video performance

$ HDTV analog component video (passthrough)

• Frequency response Y: +/- 1.0 dB max to 28 MHz

• Frequency response Pb, Pr: +/- 1.0 dB max to 12 MHz

• Component channel delay: < 8 ns

• Component S/N (Y, Pb, Pr): > 50 dB, unified weighted

$ SDTV S-Video and composite video (passthrough)

• Amplitude error: < 4%

• Frequency response: +/- 0.5 dB max to 5 MHz

• 2T pulse response: 1.0% max

• Diff. Gain: < 2%, Diff. Phase: < 1 degree
endix E, Matrox MXO2 Specifications
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• S/N: > 58 dB, unified weighted

$ SDTV analog component video (passthrough)

• Frequency response Y: +/- 0.5 dB max to 5 MHz

• Frequency response Pb, Pr: +/- 1.0 dB max to 2 MHz

• Component channel delay: < 8 ns

• Component S/N (Y, Pb, Pr): > 54 dB, unified weighted

Audio
• Unbalanced analog audio inputs

$ 1x stereo pair

$ RCA connectors

$ Input impedance: Hi-Z

$ Line level with 18 db headroom (max level)

• Unbalanced analog audio outputs

$ 3x stereo pair

$ RCA connectors

$ Output impedance: 100 Ω

$ Line level with 18 db headroom (max level)

• Balanced analog inputs

$ 1x stereo pair

$ 2x XLR female connectors

$ Nominal levels: +4 dBu (+4 dBm)

$ Input impedance: Hi-Z

$ Headroom (max level): 18 db

• Balanced analog outputs

$ 2x stereo pair

$ 4x XLR male connectors

$ Nominal levels: +4 dBu (+4 dBm)

$ Output impedance: 50 Ω

$ Headroom (max level): 18 db

• Unbalanced digital (AES/EBU) input

$ 1x stereo pair

$ BNC connector (75 Ω), terminated

$ Maximum input level: 5 Vp-p

• Unbalanced digital (AES/EBU) output

$ 1x stereo pair
Matrox MXO2 specifications
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$ BNC connector

$ Output impedance: 75 Ω

$ Nominal output level: 1Vp-p

• Balanced and unbalanced analog audio performance

$ Sampling frequency: 48 kHz (using 64x oversampling)

$ Quantization: 24 bits

$ S/N: > 85 db

$ THDN at 1 kHz, nominal level: < 0.05%

Environmental specifications
• Minimum/maximum ambient operating temperatures: 0 to 40º C

• Minimum/maximum storage temperature: –40 to 75º C

• Maximum altitude for operation: 3,000 meters

• Maximum altitude for transport: 12,000 meters

• Operating humidity: 20 to 80% relative humidity (non-condensing)

• Storage humidity: 5 to 95% relative humidity (non-condensing)

Matrox MXO2 Rack specifications

General
• Video formats NTSC, PAL, NTSC-EIAJ, 1080i/p/PsF, 720p, 576p, 480p

• Regulatory compliance

$ FCC Class A, CE Mark Class A, ACMA C-Tick Mark, VCCI

$ RoHS Directive 2002/95/EC

• Dimensions (without rackmount brackets)

$ Length 437 mm (17.2”)

$ Width 208 mm (8.2”)

$ Height 86 mm (3.4”) (two rack units)

• Dimensions (with rackmount brackets)

$ Length 483 mm (19”)

$ Width 208 mm (8.2”)

$ Height 89 mm (3.5”) (two rack units)

• AC power

$ 100-240 VAC 50-60 Hz

$ Input: IEC320-C14 inlet

$ Output: +12V DC, 3A max
endix E, Matrox MXO2 Specifications
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• Total power consumption 15 watts

Connections
• Genlock reference input

$ HD analog tri-level sync or SD analog bi-level black burst

$ BNC connector (75 Ω)

• Genlock reference output

$ HD analog tri-level sync or SD analog bi-level black burst

$ Loop through

$ BNC connector (75 Ω)

• RS-422 D-sub connector (9 pins)

Video
• HDMI

$ HD input and output

• HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (10-bit)

• Eight channels of embedded audio

• Standard Type A HDMI connector (19 pins)

$ SD output

• HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (10-bit)

• Eight channels of embedded audio

• Standard Type A HDMI connector (19 pins)

• SDI

$ HDTV input

• HD-SDI with eight channels of embedded SDI audio

• 24-bit, 48 kHz

• Compliant with SMPTE 292M, SMPTE 299M

• BNC connector (75 Ω), terminated

• Equalized input for maximum cable length support

$ HDTV output

• HD-SDI with eight channels of embedded SDI audio

• 24-bit, 48 kHz

• Compliant with SMPTE 292M, SMPTE 299M

• BNC connector (75 Ω)
Matrox MXO2 Rack specifications
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$ SDTV input

• SD-SDI with eight channels of embedded audio

• 24-bit, 48 kHz

• BNC connector (75 Ω), terminated

• Equalized input for maximum cable length support

• Compliant with SMPTE 259M-C, SMPTE 272M

$ SDTV output

• SD-SDI with eight channels of embedded audio

• 24-bit, 48 kHz

• BNC connector (75 Ω)

• Compliant with SMPTE 259M-C, SMPTE 272M

• S-Video and composite video input

$ SDTV input

• PAL, NTSC, NTSC-EIAJ

• BNC connector for composite (75 Ω), terminated

• 4-pin mini-DIN S-Video connector (75 Ω), terminated

• 12-bit ADC

• 2x oversampling

• Anti-aliasing filtering

• Automatic gain control

$ SDTV output

• PAL, NTSC, NTSC-EIAJ

• BNC connector for composite (75 Ω)

• 4-pin mini-DIN S-Video connector (75 Ω)

• 12-bit DAC

• 8x oversampling

• Analog component video input

$ HDTV input

• EIA-770.3 compliant

• BNC connectors (75 Ω)

• 12-bit ADC

• Anti-aliasing filtering

$ HDTV output

• EIA-770.3 compliant

• BNC connectors (75 Ω)
endix E, Matrox MXO2 Specifications
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• 12-bit DAC

• 2x oversampling

$ SDTV input

• Betacam, Betacam SP (NTSC and NTSC-EIAJ)

• SMPTE/EBU N10 (PAL)

• BNC connectors (75 Ω)

• 12-bit ADC

• 4x oversampling

• Anti-aliasing filter

$ SDTV output

• Betacam, Betacam SP (NTSC and NTSC-EIAJ)

• SMPTE/EBU N10 (PAL)

• BNC connectors (75 Ω)

• 12-bit DAC

• 8x oversampling

• Analog video performance

$ HDTV analog component video (passthrough)

• Frequency response Y: +/- 1.0 dB max to 28 MHz

• Frequency response Pb, Pr: +/- 1.0 dB max to 12 MHz

• Component channel delay: < 8 ns

• Component S/N (Y, Pb, Pr): > 50 dB, unified weighted

$ SDTV S-Video and composite video (passthrough)

• Amplitude error: < 4%

• Frequency response: +/- 0.5 dB max to 5 MHz

• 2T pulse response: 1.0% max

• Diff. Gain: < 2%, Diff. Phase: < 1 degree

• S/N: > 58 dB, unified weighted

$ SDTV analog component video (passthrough)

• Frequency response Y: +/- 0.5 dB max to 5 MHz

• Frequency response Pb, Pr: +/- 1.0 dB max to 2 MHz

• Component channel delay: < 8 ns

• Component S/N (Y, Pb, Pr): > 54 dB, unified weighted
Matrox MXO2 Rack specifications
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Audio
• Balanced analog inputs

$ 2x stereo pair

$ 4x XLR female connectors

$ Nominal levels: +4 dBu (+4 dBm)

$ Input impedance: Hi-Z

$ Headroom (max level): 18 db

• Balanced analog outputs

$ 4x stereo pair

$ 8x XLR male connectors

$ Nominal levels: +4 dBu (+4 dBm)

$ Output impedance: 50 Ω

$ Headroom (max level): 18 db

• Unbalanced digital (AES/EBU) input

$ 2x stereo pair

$ 2x BNC connector (75 Ω), terminated

$ Maximum input level: 5 Vp-p

• Unbalanced digital (AES/EBU) output

$ 2x stereo pair

$ 2x BNC connector

$ Output impedance: 75 Ω

$ Nominal output level: 1Vp-p

• Balanced analog audio performance

$ Sampling frequency: 48 kHz (using 64x oversampling)

$ Quantization: 24 bits

$ S/N: > 85 db

$ THDN at 1 kHz, nominal level: < 0.05%

Environmental specifications
• Minimum/maximum ambient operating temperatures: 0 to 40º C

• Minimum/maximum storage temperature: –40 to 75º C

• Maximum altitude for operation: 3,000 meters

• Maximum altitude for transport: 12,000 meters

• Operating humidity: 20 to 80% relative humidity (non-condensing)

• Storage humidity: 5 to 95% relative humidity (non-condensing)
endix E, Matrox MXO2 Specifications
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Matrox MXO2 LE specifications

General
• Video formats NTSC, PAL, NTSC-EIAJ, 1080i/p/PsF, 720p, 576p, 480p

• Regulatory compliance

$ FCC Class A, CE Mark Class A, ACMA C-Tick Mark, VCCI

$ RoHS Directive 2002/95/EC

• Dimensions

$ Length 237 mm (9.3)”

$ Width 241 mm (9.5”)

$ Height 51 mm (2”)

• External AC/DC adapter

$ 100-240 VAC 50-60 Hz

$ Input: IEC320-C14 inlet

$ Output: +12V DC, 3A max

$ Dimensions: L 104 mm × W 46 mm × H 36 mm (4.1” × 1.8” × 1.4”)

• Total power consumption 15 watts

Connections
• Genlock reference input

$ HD analog tri-level sync or SD analog bi-level black burst

$ BNC connector (75 Ω), terminated

• RS-422 D-sub connector (9 pins)

Video
• HDMI

$ HD input and output

• HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (10-bit)

• Eight channels of embedded audio

• Standard Type A HDMI connector (19 pins)

$ SD output

• HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (10-bit)

• Eight channels of embedded audio

• Standard Type A HDMI connector (19 pins)

• SDI

$ HDTV input

• HD-SDI with eight channels of embedded SDI audio
Matrox MXO2 LE specifications
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• 24-bit, 48 kHz

• Compliant with SMPTE 292M, SMPTE 299M

• BNC connector (75 Ω), terminated

• Equalized input for maximum cable length support

$ HDTV output

• HD-SDI with eight channels of embedded SDI audio

• 24-bit, 48 kHz

• Compliant with SMPTE 292M, SMPTE 299M

• BNC connector (75 Ω)

$ SDTV input

• SD-SDI with eight channels of embedded audio

• 24-bit, 48 kHz

• BNC connector (75 Ω), terminated

• Equalized input for maximum cable length support

• Compliant with SMPTE 259M-C, SMPTE 272M

$ SDTV output

• SD-SDI with eight channels of embedded audio

• 24-bit, 48 kHz

• BNC connector (75 Ω)

• Compliant with SMPTE 259M-C, SMPTE 272M

• S-Video and composite video input

$ SDTV input

• PAL, NTSC, NTSC-EIAJ

• BNC connector for composite (75 Ω), terminated

• 4-pin mini-DIN S-Video connector (75 Ω), terminated

• 12-bit ADC

• 2x oversampling

• Anti-aliasing filtering

• Automatic gain control

$ SDTV output

• PAL, NTSC, NTSC-EIAJ

• BNC connector for composite (75 Ω)

• 4-pin mini-DIN S-Video connector (75 Ω)

• 12-bit DAC

• 8x oversampling
endix E, Matrox MXO2 Specifications



293
• Analog component video input

$ HDTV input

• EIA-770.3 compliant

• BNC connectors (75 Ω)

• 12-bit ADC

• Anti-aliasing filtering

$ HDTV output

• EIA-770.3 compliant

• BNC connectors (75 Ω)

• 12-bit DAC

• 2x oversampling

$ SDTV input

• Betacam, Betacam SP (NTSC and NTSC-EIAJ)

• SMPTE/EBU N10 (PAL)

• BNC connectors (75 Ω)

• 12-bit ADC

• 4x oversampling

• Anti-aliasing filter

$ SDTV output

• Betacam, Betacam SP (NTSC and NTSC-EIAJ)

• SMPTE/EBU N10 (PAL)

• BNC connectors (75 Ω)

• 12-bit DAC

• 8x oversampling

• Analog video performance

$ HDTV analog component video (passthrough)

• Frequency response Y: +/- 1.0 dB max to 28 MHz

• Frequency response Pb, Pr: +/- 1.0 dB max to 12 MHz

• Component channel delay: < 8 ns

• Component S/N (Y, Pb, Pr): > 50 dB, unified weighted

$ SDTV S-Video and composite video (passthrough)

• Amplitude error: < 4%

• Frequency response: +/- 0.5 dB max to 5 MHz

• 2T pulse response: 1.0% max

• Diff. Gain: < 2%, Diff. Phase: < 1 degree
Matrox MXO2 LE specifications



294

App
• S/N: > 58 dB, unified weighted

$ SDTV analog component video (passthrough)

• Frequency response Y: +/- 0.5 dB max to 5 MHz

• Frequency response Pb, Pr: +/- 1.0 dB max to 2 MHz

• Component channel delay: < 8 ns

• Component S/N (Y, Pb, Pr): > 54 dB, unified weighted

Audio
• Unbalanced analog audio inputs

$ 1x stereo pair

$ RCA connectors

$ Input impedance: Hi-Z

$ Line level with 18 db headroom (max level)

• Unbalanced analog audio outputs

$ 1x stereo pair

$ RCA connectors

$ Output impedance: 100 Ω

$ Line level with 18 db headroom (max level)

• Balanced analog inputs

$ 1x stereo pair

$ 2x XLR female connectors

$ Nominal levels: +4 dBu (+4 dBm)

$ Input impedance: Hi-Z

$ Headroom (max level): 18 db

• Balanced analog outputs

$ 1x stereo pair

$ 2x XLR male connectors

$ Nominal levels: +4 dBu (+4 dBm)

$ Output impedance: 50 Ω

$ Headroom (max level): 18 db

• Balanced and unbalanced analog audio performance

$ Sampling frequency: 48 kHz (using 64x oversampling)

$ Quantization: 24 bits

$ S/N: > 85 db

$ THDN at 1 kHz, nominal level: < 0.05%
endix E, Matrox MXO2 Specifications
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Environmental specifications
• Minimum/maximum ambient operating temperatures: 0 to 40º C

• Minimum/maximum storage temperature: –40 to 75º C

• Maximum altitude for operation: 3,000 meters

• Maximum altitude for transport: 12,000 meters

• Operating humidity: 20 to 80% relative humidity (non-condensing)

• Storage humidity: 5 to 95% relative humidity (non-condensing)

Matrox MXO2 Mini specifications

General
• Video formats NTSC, PAL, NTSC-EIAJ, 1080i/p/PsF, 720p, 576p, 480p

• Regulatory compliance

$ FCC Class A, CE Mark Class A, ACMA C-Tick Mark, VCCI

$ RoHS Directive 2002/95/EC

• Dimensions

$ Length 166 mm (6.5”)

$ Width 110 mm (4.3”)

$ Height 40 mm (1.6”)

• Operating voltages and power consumption

$ Included AC/DC adapter: 100-240 V AC 50-60 Hz (5 V DC, 3 A max)

$ MXO2 Mini unit: 5-25 V DC, 2.5 mm barrel-type connector

• 9 watts power consumption

Connections

Video
• HDMI video

$ HD input and output

• HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (10-bit)

• Eight channels of embedded audio

• Standard Type A HDMI connector (19 pins)

$ SD output

• HDMI Y,Cb,Cr 4:2:2 (10-bit) / RGB (10-bit)

• Eight channels of embedded audio

• Standard Type A HDMI connector (19 pins)
Matrox MXO2 Mini specifications
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• Composite video (not available if using analog component input/output)

$ SDTV input

• PAL, NTSC, NTSC-EIAJ

• RCA connector

• 10-bit ADC

• 4x oversampling

• Anti-aliasing filtering

• Automatic gain control

$ SDTV output

• PAL, NTSC, NTSC-EIAJ

• RCA connector

• 12-bit DAC

• 16x oversampling

• S-Video (not available when using analog component input/output)

$ SDTV input

• PAL, NTSC, NTSC-EIAJ

• RCA connectors

• 10-bit ADC

• 4x oversampling

• Anti-aliasing filtering

• Automatic gain control

$ SDTV output

• PAL, NTSC, NTSC-EIAJ

• RCA connectors

• 12-bit DAC

• 16x oversampling

• Analog component video (not available when using composite, or S-Video 
input/output)

$ HDTV input

• EIA-770.3 compliant

• RCA connectors

• 10-bit ADC

• Anti-aliasing filtering

$ HDTV output

• EIA-770.3 compliant
endix E, Matrox MXO2 Specifications
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• RCA connectors

• 12-bit DAC

• 4x oversampling

$ SDTV input

• Betacam, Betacam SP (NTSC and NTSC-EIAJ)

• SMPTE/EBU N10 (PAL)

• RCA connectors

• 10-bit ADC

• 2x oversampling

• Anti-aliasing filter

$ SDTV output

• Betacam, Betacam SP (NTSC and NTSC-EIAJ)

• SMPTE/EBU N10 (PAL)

• RCA connectors

• 12-bit DAC

• 16x oversampling

• Analog video performance

$ HDTV analog component video

• Frequency response Y: +/- 1.0 dB max to 28 MHz

• Frequency response Pb, Pr: +/- 1.0 dB max to 12 MHz

• Component channel delay: < 8 ns

• Component S/N (Y, Pb, Pr): > 50 dB, unified weighted

$ SDTV S-Video and composite video

• Amplitude error: < 4%

• Frequency response: +/- 0.75 dB max to 5 MHz

• Diff. Gain: < 2%, Diff. Phase: < 1 degree 

• S/N: > 54 dB, unified weighted

$ SDTV analog component video

• Frequency response Y: +/- 0.75 dB max to 5 MHz

• Frequency response Pb, Pr: +/- 1.0 dB max to 2 MHz

• Component channel delay: < 8 ns

• Component S/N (Y, Pb, Pr): > 54 dB, unified weighted
Matrox MXO2 Mini specifications
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Audio
• Unbalanced analog audio inputs

$ 1x stereo pair

$ RCA connectors

$ Input impedance: > 10 kΩ

$ Line level with 18 db headroom (max level: +8 dBv)

• Unbalanced analog audio outputs

$ 1x stereo pair

$ RCA connectors

$ Output impedance: < 200 Ω

$ Line level with 18 db headroom (max level: +8 dBv)

• Unbalanced analog audio performance

$ Sampling frequency: 48 kHz (using 128x oversampling)

$ Quantization: 24 bits

$ S/N: > 90 db

$ THDN at 1 kHz, nominal level: < 0.02%

$ Frequency response: +/- 0.5 dB, 20 Hz to 20 kHz

$ Channel separation: > 100 db

Environmental specifications
• Minimum/maximum ambient operating temperatures: 0 to 40º C

• Minimum/maximum storage temperature: –40 to 75º C

• Maximum altitude for operation: 3,000 meters

• Maximum altitude for transport: 12,000 meters

• Operating humidity: 20 to 80% relative humidity (non-condensing)

• Storage humidity: 5 to 95% relative humidity (non-condensing)
endix E, Matrox MXO2 Specifications
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Matrox PCIe host adapter specifications

Matrox PCIe host ExpressCard/34 adapter
(for laptops)

$ Standard ExpressCard/34

$ Dimensions: L 96 mm × W 33 mm × H 13 mm (3.8” × 1.3” × 0.5”)

Matrox PCIe host adapter (for desktops)
$ Standard low-profile PCIe (x1) card

$ PCB dimensions

• 66 mm × 69 mm (2.6” × 2.7”)

• overall thickness including components: 19 mm (0.75”)
Matrox PCIe host adapter specifications
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Appendix F, Matrox Customer Support

How to get Matrox customer support
If you have a problem that you’re unable to solve by referring to the 
documentation for your Matrox product, please contact your Matrox 
representative. He or she should be able to help you quickly correct any 
installation or system configuration problem.

If your representative is unable to solve your problem, contact Matrox for further 
information and assistance.

Registration
You can register your Matrox product in the Matrox Support section of our 
website at www.matrox.com/video/support.  

Only registered users are entitled to customer support, software updates, special 
promotional offers, and access to our user forum.

Keep up to date with our website
In addition to registering your Matrox product, our website offers you 
up-to-the-minute information about Matrox products and software updates. Be 
sure to place our site in your favorites or bookmarks: 
www.matrox.com/video/support.

Contacting us
Matrox is proud to offer worldwide customer support. Please use the contact 
information for your Matrox product and area as provided on our website at 
www.matrox.com/video/support.

http://www.matrox.com/video/support
http://www.matrox.com/video/support
www.matrox.com/video/support
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10-bit Uncompressed codec

See Matrox 10-bit Uncompressed codec
264 files

capturing 226, 232
exporting directly from Premiere Pro 216
exporting from Adobe Media Encoder 213

3D viewing mode
setting for HDMI output 57, 61, 79, 83, 172, 176

3ds Max WYSIWYG plug-in
See Autodesk 3ds Max WYSIWYG plug-in

8-bit Uncompressed codec
See Matrox 8-bit Uncompressed codec

A
A/V Tools

See Matrox A/V Tools
AAC audio

capturing with Matrox MAX H.264 files 232, 234
exporting with Matrox MAX H.264 files 213, 216

Adobe After Effects WYSIWYG plug-in
about 196
required steps 197
See also Matrox WYSIWYG plug-ins

Adobe Encore
capturing material for DVD authoring 91
exporting sequence for DVD authoring 107
transcoding to Matrox MAX H.264 for Blu-ray 217

Adobe Flash Media Live Encoder
using with MXO2 200

Adobe Media Encoder
exporting Matrox AVI files 104
exporting Matrox MAX H.264 files 212

Adobe Photoshop WYSIWYG plug-in
about 196
required steps 197
See also Matrox WYSIWYG plug-ins

Adobe Premiere Pro
applying Matrox video effects 119
applying Matrox video transitions 119
audio output settings 86
available Matrox effects 118
capture settings 91
creating Matrox chroma key effects 148

overview 147
creating Matrox color correction

primary 122
secondary 137

creating Matrox luma key effect 155
overview 154

creating Matrox wipe transitions 158
creating new Matrox project  72
displaying warnings in Events panel  74
DV-1394 output settings 87
enabling/disabling Motion effect  76
enabling/disabling realtime effects  76
exporting sequence to Matrox AVI file  104
exporting sequence to Matrox MAX H.264 file 213, 
216
exporting sequence to tape 111
general settings 75
genlock settings 84
loading Matrox sequence preset  72
sequence settings 74
setting up Matrox RS-422 device control 107
setting up scratch disks 72
speed changes 160
updating drivers for DV-1394 devices 10
video output settings

MXO2 Mini  81
MXO2, MXO2 Rack, and MXO2 LE 77

video preview settings 90
Advanced pulldown

description of  247
See also Standard pulldown

After Effects WYSIWYG plug-in
See Adobe After Effects WYSIWYG plug-in

Analog audio volume
adjusting 65, 86, 179, 231

Anamorphic video
capturing 68, 94, 182, 234
outputting 56, 60, 78, 82, 171, 175

Aspect ratio
conversion setting for video capture 68, 94, 182, 
234
conversion setting for video output  55, 60, 78, 82, 
171, 175
selecting for source video 68, 93, 181, 228
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Audio applications
setting MXO2 as default audio playback device 10

Audio capture settings
in Adobe Premiere Pro 95
in Avid Media Composer 66
in Matrox A/V Tools 184
in Matrox MAX H.264 Capture 234
monitoring audio levels  69, 98, 186
selecting channels 96, 185, 234

Audio levels
monitoring for capture 69, 98, 186

Audio output settings
in Adobe Premiere Pro 86
in Avid Media Composer 64
in Matrox A/V Tools 179
in Matrox MAX H.264 Capture 230

Auto balance
performing using color correction 132

Auto key
performing using the chroma key graph 151
performing using the selective key graph 145

Autodesk 3ds Max WYSIWYG plug-in
about 196
required steps 197
See also Matrox WYSIWYG plug-ins

Autodesk Combustion WYSIWYG plug-in
about 196
required steps 198
See also Matrox WYSIWYG plug-ins

Automatic Gain Control
selecting 69, 94, 182, 229

AVI files
capturing using Adobe Premiere Pro 91
capturing using Matrox A/V Tools 180, 187
capturing using Matrox MAX H.264 Capture 226
exporting using Adobe Premiere Pro 104
naming in Matrox A/V Tools 187
rendering using Matrox VFW codecs 204, 207

Avid Media Composer
audio output settings 64
capture settings 66
creating new project on MXO2 54
exporting sequence to tape 69
genlock settings 62
video output settings

MXO2 Mini 58
MXO2, MXO2 Rack, and MXO2 LE 54

B
Battery

connecting to MXO2 14
connecting to MXO2 LE 32
requirements and guidelines 3

Blu-ray Disc
capturing files for 226, 232
exporting files for 212, 213
transcoding files for 217

C
Calibration, monitor

See HDMI monitor calibration
Capture format

selecting for audio capture 96, 184, 234
selecting for video capture 93, 181, 232
supported on MXO2

in Adobe Premiere Pro and Matrox A/V Tools 
267
in Avid Media Composer 268
in Matrox MAX H.264 Capture 269

Capturing using Adobe Premiere Pro
monitoring audio levels for 98
specifying Matrox settings for 91

Capturing using Avid Media Composer
monitoring audio levels for 69
specifying Matrox settings for 66

Capturing using Matrox A/V Tools 187
from tape without device control 188
live video 187
monitoring audio levels for 186
specifying audio settings for 184
specifying video settings for 180

Capturing using Matrox MAX H.264 Capture
about 226
how to capture clips 227
saving and deleting custom presets 235
specifying capture format settings for 232
specifying input settings for 228
specifying output settings for 230
starting the capture 236

Center cut video
capturing 68, 94, 182, 234
Index
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outputting 56, 60, 78, 82, 171, 175
Center zoom video

capturing 68, 94, 182, 234
outputting 56, 60, 78, 82, 171, 175

Chroma clamper effect
using 160

Chroma filtering and chroma interpolation
for rendering to VFW files 207

Chroma key effect
creating 148
overview 147
using the chroma key graph 151

Chroma key graph
using 151

Chroma key shadow effect
creating 148
overview 147

Clip information
updating in Matrox A/V Tools 188

Codec
Matrox 10-bit Uncompressed 93, 105, 181, 233
Matrox 8-bit Uncompressed 93, 105, 181, 233
Matrox DV/DVCAM 105
Matrox DVCPRO 105
Matrox DVCPRO HD 105
Matrox DVCPRO50 105
Matrox MAX H.264 212, 220
Matrox MPEG-2 IBP 102
Matrox MPEG-2 I-frame 93, 100, 105, 182, 233
Matrox MPEG-2 I-frame HD 93, 100, 182
Matrox VFW codecs 207

Color balance graph
using 129

Color correction
adjusting tonal range 128
color matching clips 133
performing an auto balance 132
primary 122
secondary 137

using the selective key graph 142
using RGB curves 126
using Split View in the Program Monitor 125
using the color balance graph 129
using the luma mapping graph 135
using the Split View option 124

Color matching clips
using color balance graph 133

Color pass effect
creating with secondary color correction 146

Color space conversion options
for rendering to VFW files 206

Combustion WYSIWYG plug-in
See Autodesk Combustion WYSIWYG plug-in

Compressor
selecting for VFW render 207

Computer system
connecting to your MXO2 16
connecting to your MXO2 LE 34
connecting to your MXO2 Mini 42
connecting to your MXO2 Rack 25
requirements 2

Connections
AC power

for MXO2 14
for MXO2 LE 32
for MXO2 Mini  40
for MXO2 Rack 24

available on Matrox MXO2 14
available on Matrox MXO2 LE 32
available on Matrox MXO2 Mini  40
available on Matrox MXO2 Rack 22
battery

for MXO2 14
for MXO2 LE 32

MXO2 LE to computer 34
MXO2 Mini to computer 42
MXO2 Rack to computer 25
MXO2 to computer  16
RS-422

for MXO2 18
for MXO2 LE 36
for MXO2 Rack 27

typical
for MXO2 19
for MXO2 LE 37
for MXO2 Mini  45
for MXO2 Rack 28
Index
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Customer support 302

D
Device control

in Adobe Premiere Pro
capturing material 91
exporting to tape using DV-1394 115
exporting to tape using RS-422 112
obtaining frame-accurate RS-422 export to tape 
114
requirements for using Matrox RS-422 110
setting up Matrox RS-422 107

in Avid Media Composer
capturing using RS-422 66
exporting to tape using RS-422 69

RS-422
connection for MXO2 18
connection for MXO2 LE 36
connection for MXO2 Rack 27

Digtal Cut tool
setting output for  69

Drivers
installing for MXO2 hardware 8
updating for display card 9
updating for DV-1394 devices with Adobe Premiere 
Pro 10

Drop frame time code
displaying in Matrox A/V Tools 167

Dropped frames in video playback
reporting 76

DV-1394 device
in Adobe Premiere Pro

output settings for  87
selecting as source 92
updating drivers for 10

DV-1394 device control
exporting to tape in Adobe Premiere Pro 115

DVCPRO HD material
in Adobe Premiere Pro

capturing native 93
exporting to DV-1394 device 115

DVL files
saving and loading 189

E
Editing video format

selecting in Matrox A/V Tools 167
Effect presets 119
Error notification

in Events panel 74
with X.info 243

Events panel
displaying warnings in 74

Exporting to disk
Matrox AVI files 104
Matrox MAX H.264 files 212
MPEG-2 for DVD authoring 107
See also Rendering using VFW programs

Exporting to tape
using Adobe Premiere Pro 111

DV-1394 device control 115
enabling DV-1394 output for DVCPRO HD 87
Matrox RS-422 device control 112

using Avid Media Composer 69
ExpressCard

See PCIe host ExpressCard/34 adapter
eyeon Fusion WYSIWYG plug-in

about 196
required steps 198
See also Matrox WYSIWYG plug-ins

F
Firmware

updating for MXO2 8
Fusion WYSIWYG plug-in

See eyeon Fusion WYSIWYG plug-in

G
General settings

in Adobe Premiere Pro 75
in Matrox A/V Tools 168

Genlock settings
in Adobe Premiere Pro 84
in Avid Media Composer 62
in Matrox A/V Tools 177

Genlock source
reporting lost signal during video playback 76
selecting 62, 84
Index



307
Genlock video format
selecting 63, 85

GFX files
installing for Matrox wipes 8
uninstalling 11

H
H.264 files

capturing 226
exporting 212

Hardware information
displaying with X.info 242

Hardware, MXO2
before you install 6
installing 6
safety precautions 6
specifications 281

HDMI monitor calibration
calibrating your HDMI monitor 48
enabling and disabling the Matrox HDMI calibra-
tion settings 50
loading Matrox HDMI calibration settings 50
overview 48

Hibernation mode
using with MXO2 11

Horizontal delay
adjusting 63, 85, 178

I
Input aspect ratio

selecting 68, 93, 181, 228
Input device

selecting 92
Input format

selecting 68, 93, 181, 201, 228
Input source

selecting for audio capture 68, 96, 184, 229
selecting for audio streaming 201
selecting for video capture 67, 92, 181, 228
selecting for video streaming 201

Inputs on MXO2 Mini
analog RCA audio 256
available 253
component (Y, Pb, Pr) 256
composite (Y) 256
HDMI 256

S-Video (Pb, Pr) 256
Inputs on MXO2, MXO2 Rack, and MXO2 LE

AES/EBU audio 255
analog RCA audio 255
analog XLR audio 255
available on MXO2 250
available on MXO2 LE 252
available on MXO2 Rack 251
component (Y, Pb, Pr)  255
composite (CVBS) 255
HDMI 254
REF 254
SDI 254
S-Video (Y/C) 255

Internet site, Matrox 302
Isolating colors in a clip

using secondary color correction 146

K
Key colors

modifying using the chroma key graph 151
Keyboard shortcuts

for Matrox A/V Tools 193

L
Letterbox video

capturing 68, 94, 182, 234
outputting 56, 60, 78, 82, 171, 175

License agreement i
VFW software codecs v

LightWave 3D WYSIWYG plug-in
See NewTek LightWave 3D WYSIWYG plug-in

Live media streaming
about  200
specifying A/V settings for 200

Luma key effect
creating 155
overview 154
using the luma key graph 156

Luma key graph
using 156

Luma mapping graph
using 135

Luminance range settings
for rendering to VFW files 206
Index



308
M
M2V files

capturing using Adobe Premiere Pro 91, 99
Mask

applying to Matrox effects 120
applying using Select Mask 121

Matrox
contacting us 302
WWW site 302

Matrox 10-bit Uncompressed codec
selecting for capture in A/V Tools 181
selecting for capture in Matrox MAX H.264 Capture 
233
selecting for capture in Premiere Pro 93
selecting for export in Premiere Pro 105

Matrox 8-bit Uncompressed codec
selecting for capture in A/V Tools 181
selecting for capture in Matrox MAX H.264 Capture 
233
selecting for capture in Premiere Pro 93
selecting for export in Premiere Pro 105

Matrox A/V Tools
about 162
audio capture settings 184
audio output settings 179
CAM button 163
capture settings 180
capturing clips 187
capturing from tape without device control  188
capturing live video 187
changing In/Out icons 188
clip ID and clip names 187
clip list 189

adding clips 189
copying clips 190
deleting clips 190
detaching and resizing 191
moving clips 190
playing back clips 189
saving and loading 189

defining options 166
Disk button 163
editing clips 188
general settings 168
genlock settings 177
grabbing a single-frame image 191

keyboard shortcuts 193
pop-up menu 164
selecting pulldown method for output 175
time code

displaying 166
transport controls 164
video capture settings 180
video output settings

for MXO2 Mini 174
MXO2, MXO2 Rack, and MXO2 LE 170

Matrox DV/DVCAM codec
selecting for export in Premiere Pro 105
selecting for VFW render 207

Matrox DVCPRO codec
selecting for export in Premiere Pro 105
selecting for VFW render 207

Matrox DVCPRO HD codec
configuring for VFW render 208
selecting for export in Premiere Pro 105
selecting for VFW render 207

Matrox DVCPRO50 codec
selecting for export in Premiere Pro 105
selecting for VFW render 207

Matrox effect patterns
installing 8
removing 11

Matrox HDMI Calibration Utility
using 48

Matrox MAX H.264 Capture
about 226
how to capture clips 227
saving and deleting custom presets 235
specifying capture format settings for 232
specifying input settings for 228
specifying output settings for 230
starting the capture 236

Matrox MAX H.264 codec 212
for transcoding in Adobe Encore 217
specifying settings for 220

Matrox MAX H.264 files
capturing 227
exporting directly from Premiere Pro 216
exporting from Adobe Media Encoder 212

Matrox MPEG-2 IBP codec
configuring in Adobe Premiere Pro 102
Index
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Matrox MPEG-2 I-frame + Alpha codec
configuring for VFW render 209
selecting for VFW render 207

Matrox MPEG-2 I-frame codec
configuring for VFW render 209
configuring in Premiere Pro 100
selecting for capture in A/V Tools 182
selecting for capture in Matrox MAX H.264 Capture 
233
selecting for capture in Premiere Pro 93
selecting for export in Premiere Pro 105
selecting for VFW render 207

Matrox MPEG-2 I-frame HD + Alpha codec
configuring for VFW render 209
selecting for VFW render 207

Matrox MPEG-2 I-frame HD codec
configuring for VFW render 209
configuring in Premiere Pro 100
selecting for capture in A/V Tools 182
selecting for capture in Premiere Pro 93
selecting for VFW render 207

Matrox Mtx.utils
installing 8
removing 11

Matrox Player
using as the default 73

Matrox project
creating in Premiere Pro 72
realtime playback capabilites in Premiere Pro 74

Matrox RT technology
enabling/disabling 76

Matrox Uncompressed HD + Alpha codec
configuring for VFW render 208
selecting for VFW render 208

Matrox Uncompressed HD codec
configuring for VFW render 208
selecting for VFW render 208

Matrox Uncompressed SD + Alpha codec
configuring for VFW render 208
selecting for VFW render 208

Matrox Uncompressed SD codec
configuring for VFW render 208
selecting for VFW render 208

Matrox VFW software codecs
installing 9

removing 11
Matrox video effects

filtering in Effects panel  118
how to apply 119

Matrox video transitions
filtering in Effects panel  118
how to apply 119

Matrox WYSIWYG Control Panel
using 196

Matrox WYSIWYG plug-ins
about  196
installing 9
re-installing 9
removing 9
required steps 197

Matrox X.info
using 240

Media Composer
See Avid Media Composer

Mobile devices
capturing files for  226, 232
exporting files for  212, 213

Monitor calibration
See HDMI monitor calibration

Monitoring your system
with X.info 240

Motion effect
enabling/disabling realtime 76

MP4 files
capturing 226, 232
exporting directly from Premiere Pro 216
exporting from Adobe Media Encoder 213

MPEG-2 IBP codec
See Matrox MPEG-2 IBP codec

MPEG-2 I-frame codec
See Matrox MPEG-2 I-frame codec

MPEG-2 I-frame HD codec
See Matrox MPEG-2 I-frame HD codec

MTX files
loading Matrox HDMI calibration settings 50
saving Matrox HDMI calibration settings 49

Mulit-camera sequence
displaying camera previews on video monitor 73
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N
NewTek LightWave 3D WYSIWYG plug-in

about 196
required steps 198
See also Matrox WYSIWYG plug-ins

Non-drop frame time code
displaying in Matrox A/V Tools 167

NTSC setup level
selecting for analog video 56, 60, 79, 82, 172, 
175, 230

NTSC XDCAM IMX clips
creating custom Matrox sequence preset for 73

O
Outputs on MXO2 Mini

analog RCA audio 264
available 260
component (Y, Pb, Pr)  263
composite (Y) 264
HDMI 263
S-Video (Pb, Pr)  263

Outputs on MXO2, MXO2 Rack, and MXO2 LE
AES/EBU audio 262
analog RCA audio 262
analog XLR audio 262
available on MXO2 257
available on MXO2 LE 259
available on MXO2 Rack 258
component (Y, Pb, Pr)  261
composite (CVBS) 262
HDMI 261
SDI 261
S-Video (Y/C) 262

P
Panasonic VariCam

capturing material from 94
PCIe host adapter

connecting to MXO2 17
connecting to MXO2 LE 35
connecting to MXO2 Mini 43
connecting to MXO2 Rack 26
installing 7
specifications 299

PCIe host ExpressCard/34 adapter
connecting to MXO2 17

connecting to MXO2 LE 35
connecting to MXO2 Mini 43
connecting to MXO2 Rack 26
installing 7
removing 7
specifications 299

Photoshop WYSIWYG plug-in
See Adobe Photoshop WYSIWYG plug-in

Pillarbox video
capturing 68, 94, 182, 234
outputting 56, 60, 78, 82, 171, 175

Player settings
defining 73

Power
connecting to MXO2 14
connecting to MXO2 LE 32
connecting to MXO2 Mini 40
connecting to MXO2 Rack 24
functionality in MXO2 14
functionality in MXO2 LE 32
See also Battery

Power adapter plugs
connecting for MXO2 Mini 40

Preconfigured Matrox video effects
applying 119

Premiere Pro
See Adobe Premiere Pro

Proc amps
adjusting using Matrox color correction 138

Pulldown
description of advanced 247
description of standard 246

Pulldown method
selecting for output 55, 60, 78, 82, 171, 175

R
Registering your Matrox product 302
Rendering using Matrox VFW codecs

before you start 205
selecting color space conversion options 206
selecting compressor 207

Reporting dropped frames
during video playback 76

Reporting lost genlock
during video playback 76
Index
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Returning procedure iv
RGB

setting for component output 56, 61, 79, 82, 172, 
175, 231
setting for HDMI output 57, 61, 79, 83, 172, 175, 
231

RGB curves
using 126

RS-422
connection to MXO2 18
connection to MXO2 LE 36
connection to MXO2 Rack 27
See also Device control

RS-422 device control
in Adobe Premiere Pro

obtaining frame-accurate export to tape 114
requirements for using 110
setting up 107

in Avid Media Composer
using for capture 66
using for export to tape 69

S
SC/H Phase

adjusting 57, 80, 173, 231
Scratch disks

specifying 72
Scrubbing audio

specifying preroll/postroll frames 75, 169
Scrubbing mode

selecting 168
Secondary color correction

creating a color pass effect 146
Select Mask

using 121
Selective key graph

using 142
Sequence preset

creating custom for NTSC XDCAM IMX clips 73
loading for MXO2 72

Sequence settings
in Adobe Premiere Pro 74

Service, returns iv
Setup level

selecting for NTSC analog video 56, 60, 79, 82, 
172, 175, 230

Sleep mode
using with MXO2 11

Software installation
Matrox effect patterns 8
Matrox Mtx.utils  8
Matrox VFW software codecs 9
Matrox WYSIWYG plug-ins 9

Sound card
using to output audio from Avid Media Composer 
65
using to output audio from Premiere Pro 87

Specifications
host ExpressCard/34 adapter 299
Matrox MXO2 282
Matrox MXO2 LE 291
Matrox MXO2 Mini  295
Matrox MXO2 Rack 286
PCIe host adapter  299

Speed changes
selecting speed control method 160

Split View
using 124
working with in the Program Monitor  125

Standard pulldown
description of  246
See also Advanced pulldown

Style conventions, used in this manual  3
Super black

allowing for output video 58, 61, 80, 83, 173, 176
Super white

allowing for output video 58, 61, 80, 83, 173, 176
System information

displaying with X.info 240
System requirements 2

T
Technical support 302
Temperature

monitoring for MXO2 hardware 243
TGA files

creating using Matrox A/V Tools 191
Time code

displaying in Matrox A/V Tools 166, 167
Transcoding

to Matrox MAX H.264 for Blu-ray 217
Index
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V
VariCam capture 94
Vertical delay

adjusting 63, 85, 178
Video capture settings

in Adobe Premiere Pro 91
in Avid Media Composer 66
in Matrox A/V Tools 181
in Matrox MAX H.264 Capture 232

Video for Windows programs 204
rendering Matrox AVI file  207

Video for Windows software codecs
installing 9
removing 11

Video formats
expressed in this manual 4
See also Video input formats
See also Video output formats

Video input formats
supported on MXO2 266
See also  Capture format

Video output formats
supported on MXO2 during capture

in Adobe Premiere Pro and Matrox A/V Tools 
278
in Avid Media Composer 279
in Matrox MAX H.264 Capture 280

supported on MXO2 during playback
in Adobe Premiere Pro, Matrox A/V Tools, and 
Matrox WYSIWYG 272
in Avid Media Composer 276

Video output settings
in Adobe Premiere Pro

for MXO2 Mini 81
for MXO2, MXO2 Rack, and MXO2 LE 77

in Avid Media Composer
for MXO2 Mini 58
for MXO2, MXO2 Rack, and MXO2 LE 54

in Matrox A/V Tools
for MXO2 Mini 174
for MXO2, MXO2 Rack, and MXO2 LE 170

in Matrox MAX H.264 Capture 230
Video preview settings

in Adobe Premiere Pro 90

Video processing format 75, 169
VU meters 98, 186

W
Warnings

displayed for hardware issues by X.info 243
displaying in Adobe Premiere Pro’s Events panel 74
re-enabling using X.info 241

Warranty i
WAV files

capturing using Adobe Premiere Pro 95
capturing using Matrox A/V Tools 184
capturing using Matrox MAX H.264 Capture 232, 
234
exporting with Matrox MAX H.264 files 213, 216, 
219

Web
capturing files for 226, 232
exporting files for 212, 213

Wipe transitions
creating 158

WWW site, Matrox 302
WYSIWYG Control Panel

See Matrox WYSIWYG Control Panel
WYSIWYG plug-ins

See Matrox WYSIWYG plug-ins

X
X.info

error notification 243
hardware information 242
monitoring temperatures 243
system information 240
using 240

XDCAM IMX clips
creating custom NTSC sequence preset for 73

XMP files
created for M2V clips 99

Y
YUV

setting for component output 56, 61, 79, 82, 172, 
175, 231
setting for HDMI output 57, 61, 79, 83, 172, 175, 
231
Index



Compliance Statements
USA
FCC Compliance Statement
Remark for the Matrox hardware products supported by this guide
This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant to Part 15 of the FCC Rules. These limits are designed to 
provide reasonable protection against harmful interference when the equipment is operated in a commercial environment. This equipment generates, uses, and can radiate 
radio frequency energy and, if not installed and used in accordance with the instructions manual, may cause harmful interference to radio communications. Operation of 
this equipment in a residential area is likely to cause harmful interference in which case the user will be required to correct the interference at his own expense.

WARNING
Changes or modifications to this unit not expressly approved by the party responsible for the compliance could void the user’s authority to operate this equipment. The 
use of shielded cables for connection of the equipment and other peripherals is required to meet FCC requirements.

Canada
(English) Industry Canada Compliance Statement
Remark for the Matrox hardware products supported by this guide
These digital devices do not exceed the Class A limits for radio noise emission from digital devices set out in the Radio Interference Regulation of Industry Canada.

(Français) Conformité avec les exigences de l’Industrie Canada
Remarque sur les produits matériels Matrox couverts par ce guide
Ces appareils numériques n’émettent aucun bruit radioélectrique dépassant les limites applicables aux appareils numériques de Classe A prescrites dans le Règlement sur 
le brouillage radioélectrique édicté par Industrie Canada.

Europe
(English) European user’s information – Declaration of Conformity
Remark for the Matrox hardware products supported by this guide
These devices comply with EC Directive 2006/95/EC for a Class A digital device. They have been tested and found to comply with EN55022/CISPR22 and 
EN55024/CISPR24. In a domestic environment these products may cause radio interference in which case the user may be required to take adequate measures. To meet 
EC requirements, shielded cables must be used to connect the equipment and other peripherals. Analog A/V cables connected to Matrox MXO2 Mini must be limited to 
less than three meters to comply with EEC and EMC directives. These products have been tested in a typical Class A compliant host system. It is assumed that these 
products will also achieve compliance in any Class A compliant system.

(Français) Informations aux utilisateurs Européens – Déclaration de conformité
Remarque sur les produits matériels Matrox couverts par ce guide
Ces unités sont conformes à la directive communautaire 2006/95/EC pour les unités numériques de classe A. Les tests effectués ont prouvé qu’elles sont conformes aux 
normes EN55022/CISPR22 et EN55024/CISPR24. Le fonctionnement de ces produits dans un environnement résidentiel peut causer des interférences radio, dans ce cas 
l’utilisateur peut être amené à prendre les mesures appropriées. Pour respecter les impératifs communautaires, les câbles de connexion entre l’équipement et ses 
périphériques doivent être blindés. Afin de se conformer aux exigences des directives de la CEE et de l’EMC, les câbles analogiques audio/vidéo reliés à Matrox MXO2 
Mini ne doivent pas dépasser trois mètres. Ces produits ont été testés dans un système hôte typique compatible classe A. On suppose qu’ils présenteront la même 
compatibilité dans tout système compatible classe A.

(Deutsch) Information für europäische Anwender – Konformitätserklärung
Anmerkung für die Matrox Hardware-Produktunterstützung durch dieses Handbuch
Diese Geräte entsprechen EG Direktive 2006/95/EC für ein digitales Gerät Klasse A. Sie wurden getestet und entsprechen demnach EN55022/CISPR22 und 
EN55024/CISPR24. In einer Wohnumgebung können diese Produkte Funkinterferenzen erzeugen, und der Benutzer kann genötigt sein, entsprechende Maßnahmen zu 
ergreifen. Um EG-Anforderungen zu entsprechen, müssen zum Anschließen des ausrüstung und anderer Peripheriegeräte abgeschirmte Kabel verwendet werden. 
Analoge A/V Kabel, die an Matrox MXO2 Mini angeschlossen werden, müssen eine Länge von weniger als drei Metern aufweisen um den EWG-und EMV-Richtlinien 
zu entsprechen. Diese Produkt wurden in einem typischen, der Klasse A entsprechenden, Host-System getestet. Es wird davon ausgegangen, daß diese Produkte auch in 
jedem Klasse A entsprechenden System entsprechend funktionieren.

(Italiano) Informazioni per gli utenti europei – Dichiarazione di conformità
Nota per i prodotti hardware Matrox supportati da questa guida
Questi dispositivi sono conformi alla direttiva CEE 2006/95/EC relativamente ai dispositivi digitali di Classe A. Sono stati provati e sono risultati conformi alle norme 
EN55022/CISPR22 e EN55024/CISPR24. In un ambiente domestico, questi prodotti possono causare radiointerferenze, nel qual caso all’utente potrebbe venire richiesto 
di prendere le misure adeguate. Per soddisfare i requisiti CEE, l’apparecchiatura e le altre periferiche vanno collegati con cavi schermati. I cavi analogici A/V collegati a 
Matrox MXO2 Mini devono essere limitati a meno di tre metri per essere conformi  alle direttive di contabilità elettromagnetica e del EEC. Questi prodotti sono stati 
provati in un tipico sistema host conforme alla Classe A. Inoltre, si dà per scontato che questi prodotti acquisiranno la conformità in qualsiasi sistema conforme alla 
Classe A.

(Español) Información para usuarios europeos – Declaración de conformidad
Observación referente a los productos de hardware de Matrox apoyados por este manual
Estos dispositivos cumplen con la directiva de la CE 2006/95/EC para dispositivos digitales de Clase A. Dichos dispositivos han sido sometidos a prueba y se ha 
comprobado que cumplen con las normas EN55022/CISPR22 y EN55024/CISPR24. En entornos residenciales, estos productos pueden causar interferencias en las 
comunicaciones por radio; en tal caso el usuario deberá adoptar las medidas adecuadas. Para satisfacer las disposiciones de la CE, deberán utilizarse cables apantallados 
para conectar el equipo y demás periféricos. Los cables análogos de A/V conectados con Matrox MXO2 Mini se deben limitar a menos de tres metros para conformidad 
con las directivas del EEC y del EMC. Estos productos han sido sometidos a prueba en un típico sistema anfitrión que responde a los requisitos de la Clase A. Se supone 
que estos productos cumplirán también con las normas en cualquier sistema que responda a los requisitos de la Clase A.
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